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Liebe Leserin, lieber Leser,

inzwischen ist es gang und gibe, zu einem Vortrag auch eine PowerPoint-
Prasentation zu erstellen — sei es fiir die Schule, an der Uni oder am Arbeits-
platz. Seltener, aber auch das kommt vor, ist der Einsatz solcher Prasenta-
tionen im privaten Rahmen, z.B. fiir Diashows. Das Prinzip ist einfach: Sie
unterstiitzen IThren miindlichen Vortrag durch schriftliche Informationen
und haben dariiber hinaus noch Méglichkeiten, das Ganze mit Bildern und
Effekten aufzupeppen.

So schwer ist das ja nicht, mogen sich manche nun denken — aber Sie miis-
sen zugeben: Wirklich gelungene, originelle Prasentationen sieht man sel-
ten. Meistens sind die Folien sehr {iberladen und uniibersichtlich; sie len-
ken das Publikum ab und verfehlen damit ihren eigentlichen Zweck. An
diesem Punkt kommt unser Buch ins Spiel: In praktischen Anleitungen und
natiirlich mit anschaulichen Beispielen zeigt Thnen der Prasentationscoach
Matthias Garten, wie man Folien interessant macht, ohne zu iibertreiben.
Wenn Sie seine kreativen Anregungen aufnehmen und seine Ratschlége zu
den »Dos and Don’ts« der Prasentationsgestaltung beherzigen, werden Sie
Thre Zuhorer und Zuschauer beim néchsten Mal mit einer professionellen
PowerPoint-Prasentation beeindrucken.

Natiirlich wurde dieses Buch mit gréfter Sorgfalt geschrieben und herge-
stellt. Sollten Sie dennoch einmal Fehler finden oder inhaltliche Anregungen
haben, freue ich mich, wenn Sie mit mir in Kontakt treten. Fiir konstruktive
Kritik bin ich dabei ebenso dankbar wie fiir lobende Worte. Doch zunéchst
einmal wiinsche ich Thnen viel Freude beim Lesen!

Ihre Maike Liibbers
Lektorat Vierfarben

maike.luebbers@vierfarben.de


mailto:luebbers@vierfarben.de
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Vorwort

Dieser kreative Ratgeber richtet sich an alle, die bessere Prasentationen er-
stellen wollen. Es ist dabei sehr flexibel aufgebaut. Sie konnen es konven-
tionell, also von vorne nach hinten lesen, Sie konnen sich aber auch nur ein-
zelne Kapitel herauspicken oder von einer Idee zur néchsten springen und
sich inspirieren lassen. Fiir einen Teil der Kapitel sind keine Vorkenntnisse
erforderlich, bei den Schritt-fiir-Schritt-Anleitungen ist es jedoch hilfreich,
schon die eine oder andere Prasentation mit PowerPoint erstellt zu haben.

Das Buch bietet Thnen dariiber hinaus Informationen zu den Grundlagen
der Prasentationsgestaltung, beispielsweise zu Themen wie Weilsraum,
Bildersuche, Platzierung u.v. m. Nehmen Sie sich die Zeit und probieren Sie
die Erkenntnisse direkt in Threr Prasentation aus.
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Fiir alle, die gerne »basteln«, finden sich aufserdem Schritt-fiir-Schritt-An-
leitungen, um noch fitter in PowerPoint zu werden. Sollten Sie gerade dabei
sein, eine Prasentation zu erstellen, und daher wenig Zeit haben, kénnen
Sie vielleicht die vorgefertigten Elemente gebrauchen, die auf der beilie-
genden DVD zu finden sind. Sie konnen sie schnell in Ihre Prasentation ein-
fligen und damit weiterarbeiten.

Dieses Buch lasst sich auch mit einer dlteren PowerPoint-Version als 2010
verwenden, denn an vielen Stellen werden Ideen, Konzepte und Beispiele
aufgezeigt, die auch fiir frithere Versionen gelten. Die Schritt-fiir-Schritt-
Anleitungen sind auf die Version 2010 ausgelegt, konnen aber zum grofSten
Teil auch mit PowerPoint 2007 durchgearbeitet werden. Manchmal finden
sich dabei die Meniipunkte an anderer Stelle wieder, und manche Befehle
gibt es nur in der neuen Version, z.B. einige 3D-Ubergénge oder verschie-
dene Befehle fiir die Videobearbeitung. Mit PowerPoint 2003 konnen Sie
das Buch als Gestaltungsgrundlage und Ideengeber nutzen. Sehr viele Bei-
spielfolien konnen auch in 2003 integriert werden, doch die Anleitungen
lassen sich dann nur sehr eingeschrankt durcharbeiten. Falls Sie noch keine
2010er-Version haben, hier ein Tipp: Kaufen Sie sich die preiswerte Varian-
te Office 2010 Home and Student, dann profitieren Sie maximal von diesem
Buch.

Die Befehlsketten sind immer so aufgebaut, dass zunichst der Hauptmenii-
punkt angegeben ist, danach wird das Untermenii bzw. die Befehls- oder
auch Aufgabengruppe genannt, danach der Befehl und dann die Auswahl.
Beispiel: Start » Folien » Layout » Leer, d.h., der Hauptmeniibefehl ist Start,
die Befehlsgruppe Folien, der Befehl oder die Funktion Layout und die Aus-
wahl Leer (leere Folie).

Sie finden im Buch zahlreiche Ideen zur Ausgestaltung von Folien, viele
Schritt-fiir-Schritt-Anleitungen sowie Informationen zu den Grundlagen
der Présentationsgestaltung. Wenn Sie zum Beispiel gerade dabei sind,
Textfolien zu erstellen oder zu liberarbeiten, schlagen Sie einfach das Kapi-
tel »Text« auf und schauen nach, welche Darstellungsmoglichkeiten es fiir
Textfolien gibt. So konnen Sie schnell und einfach Thre Présentation opti-
mieren.



Noch eine wichtige Anmerkung: Das Buch gibt Ihnen viele Ratschlidge und
Anregungen, wobei jedoch zu beriicksichtigen ist, dass einzelne Gestal-
tungsregeln und Tipps nur fiir bestimmte Arten von Prasentationen gelten.
(Siehe dazu z.B. auch meine Biicher Best Business Presentations und 30 Mi-
nuten fiir die professionelle Multimediaprdsentation.) Sicherlich gelten fiir
eine Messeprésentation, die Zuschauer an den Messestand ziehen soll, an-
dere Malf3stébe als fiir eine Finanzprasentation, bei der die Folien zugleich
als Handout verwendet werden. Soweit moglich, werde ich versuchen, ei-
nen moglichst breiten Querschnitt zu schaffen.

Ich mochte mich zu guter Letzt sehr herzlich bei den Menschen bedanken,
die mich unterstiitzt haben und ohne die das Buch nicht so geworden wire,
wie es heute ist. Dazu gehoren vor allem meine liebe Frau Susanne Garten,
aber auch Daniela Bernhardt, Antigone Wessel und Carolin Panzer. Mein
Dank gilt auch allen anderen, die mir direkt oder indirekt geholfen haben.

Wenn Sie Fragen, Ideen, Anregungen oder Kommentare haben, schreiben
Sie mir einfach eine E-Mail an kontakt@smavicon.de. Weitere Informatio-
nen finden Sie auch unter der Homepage meiner Firma, www.smavicon.de,
und der Blog-Site www.smavicon.eu.

Thr
Matthias Garten
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Kapitel 1— Professionelles Prasentationsdesign

Kapitel 1
Professionelles Prasentationsdesign

In diesem Kapitel lernen Sie, Ihre Présentationen professioneller aussehen zu
lassen. Zum einen geht es um bekannte Gestaltungsregeln und -richtlinien,
zum anderen geht es aber auch um Tricks und Kniffe. In vielen Details unter-
scheidet sich der Profi vom Amateur. Mit diesem Kapitel erlernen Sie einige
dieser Details und werden dann Présentationen wie ein Profi gestalten.
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Sie werden u. a. lernen, was ein Gestaltungsraster ist und wie Sie damit Ihre
Prisentationen interessanter gestalten konnen. Es gibt verschiedene Prinzi-
pien der Gestaltung, die Ihnen dabei helfen, Folien professionell aussehen
zu lassen. Mit Farben und Designeffekten lasst sich leicht ein einheitlicher
Look erzeugen, und viele Bilder machen Ihre Présentationen interessanter
und abwechslungsreicher. Dennoch sollten Sie auf geniigend Weifsraum
achten — warum, das erfahren Sie im Folgenden ausfiihrlich. Zu guter Letzt
zeige ich Thnen, wie Sie die Spielrdume des Corporate Designs geschickt
nutzen.

Das professionelle Gestaltungsraster

Das Gestaltungsraster ist die unsichtbare Hilfskonstruktion hinter einer
Préasentation und besteht aus einer Konstruktion von Hilfslinien bezogen
auf ein Prasentationsformat. Haufig werden Angaben zur typographischen
Gestaltung (z.B. Schriftarten und -gré3en), zur Nutzung von Bildern und
grafischen Elementen erginzt.

Die professionelle Prasentation wird unter anderem an zwei Parametern er-
kannt, die Sie leicht umsetzen kénnen:

1. Es gibt ein definiertes Gestaltungsraster.
2. Das Raster wird in der Préasentation durchgingig eingehalten.

Gerade der zweite Punkt ist sehr wichtig, denn ein Zuschauer beurteilt unbe-
wusst, ob es eine Durchgéngigkeit gibt, und diese vermittelt — ebenfalls un-
bewusst — ein Gefiihl von Sicherheit. Achten Sie daher auf folgende Punkte:

¢ Sind die Titel immer an der gleichen Stelle angeordnet und ausgerichtet?
® Erhalten die Titel immer die gleiche Schriftart, Schriftgroe usw.?

® Haben die Inhalte je nach Gliederungsebene immer die gleiche Anord-
nung, Ausrichtung, Schriftart, Schriftgrof3e usw.?

® Wird der linke, obere, rechte und untere Rand immer eingehalten?



Das professionelle Gestaltungsraster

® Sind die Bilder in das Raster eingepasst?
® Werden immer dieselben Farben verwendet?

Einige Beispiele fiir Gestaltungsraster kennen Sie sicherlich schon aus
PowerPoint. Solche vordefinierten Raster finden Sie zum Beispiel iiber
Start » Folien » Layout.

BlH9-G @ &-E-|= Prase|
[ratei Start Einfilgen Enfniir Uberginge Animationen Bildschirmpras
|fj & L—I ||§|Layout' pi R
- 3 | Larissa |
Einfligen Meue G E 3
o Folie =

Twischenablage @

Falien Gliederung

ol

,_.
I

[

Titel und Inhalt Abschnitts-
dberschrift

Titelfoliz

Zweei Inhalte Wergleich Mur Titel

Leer Inhalt mit _Bild mit
Uberschrift Uberschrift =

] |

Falls Sie das Gestaltungsraster erweitern, anpassen oder verdndern moch-
ten, konnen Sie einfach den Folienmaster anpassen (Ansicht » Masteransich-
ten » Folienmaster). Legen Sie dazu zunéchst eine neue Prdsentation an,
und wéhlen Sie iiber Start » Folien » Layout das Layout Titel und Inhalt aus.
Schreiben Sie jeweils einen Satz in das Feld fiir den Titel und in das fiir den
Inhalt. Klicken Sie auf Ansicht » Masteransichten » Folienmaster. Klicken Sie
jetzt den Textrahmen fiir den Titel an, und verdndern Sie die Breite des Rah-
mens etwa um die Halfte. Schlief3en Sie dann die Ansicht {iber den Knopf
Masteransicht schlieBen. Wie Sie sehen, hat sich die Anordnung bzw. das

Raster der Folie verandert.
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Ein eigenes Gestaltungsraster anlegen

Spannend wird es, wenn Sie nicht das Standardraster von PowerPoint, son-
dern ein eigenes Raster verwenden. Sie konnen dann mit dem neuen Layout
spielen, Ideen ausprobieren und mehr Pep in die Prasentation bringen. Al-
lein durch das veranderte Raster unterscheidet sich Ihre Prasentation dann
schon von anderen.

Im folgenden Beispiel finden Sie eine 16:9-Présentation mit einem neuen
Gestaltungsraster:

1. Um zunichst das Seitenformat als Grundlage anzulegen, wihlen Sie
Entwurf » Seite einrichten und bei Papierformat die Option Bildschirm-
prasentation (16:9). Schliel3en Sie den Dialog. Als Layout verwenden Sie
eine »leere« Prasentation, indem Sie Start » Folien » Layout » Leer wih-
len.
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2.

3.

Ein eigenes Gestaltungsraster anlegen

Um eine Tabelle als Rastergrundlage einzufiigen, fiigen Sie {iber Einfi-
gen » Tabellen » Tabelle eine Tabelle mit fiinf Spalten und fiinf Zeilen ein.
Ziehen Sie die Tabelle folienfiillend auf, damit sie sich {iber die gesamte
Folie erstreckt.

BE?D-0 G k-E-|+

md Einfiigen Entwsurf Uberginge Animationen Bildschirmprisentation Uberpriifen Ansicht Add-Ins

1 _ = = ™ = . 3
T EHE - W P2d QU ERAETO €
Tabelle|  Grafik Clipart Screenshot Fotozlbum | Formen Smark&rt Diagramm | Hyperling Aktion | Textfeld Kopf- und WordArt’ Formel Symbol | wid
- b # * Funzzile & £ - 1
|| 5x5 Tabelle | Tllustrationen | Hyperlinks | Text | Symbole
I 1 o e K K DA S T Ky A URE T
I o
I
Sannw
] o [ N | | ) [N
I o
I
[ Tabelle einfiigen...
Eﬂ Tabelle zeichnen
E Excel-Tabelle einflgen..,

SRR

PowerPoint bietet Thnen Fiihrungslinien an, die Sie bei der Gestaltung
unterstiitzen. Um sie einzublenden, driicken Sie die Tasten + .
In der Standardeinstellung richten sich, nachdem die Fithrungslinien
eingeschaltet wurden, alle Folienelemente an diesen Hilfslinien aus.
Ebenfalls mit + konnen die Linien wieder ausgeblendet wer-
den. Eine Ausrichtung der Folienelemente erfolgt dann nicht mehr.

Im néchsten Schritt geht es darum, die Fiihrungslinien entlang den
Spalten und Zeilen aufzubauen. Doch bevor Sie damit loslegen, miis-
sen Sie erst das Ausrichte-Raster ausschalten. Klicken Sie dazu mit der
rechten Maustaste auf den Hintergrund neben der Folie, und wahlen
Sie Raster und Fiihrungslinien aus dem Kontextmenii. Entfernen Sie im
Dialogfenster das Hakchen bei Objekte am Raster ausrichten.
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Veranderungen an Fiihrungslinien

Veranderungen an einer Fiihrungslinie konnen nicht rlickgangig
gemacht werden. Verschoben ist verschoben, kopiert ist kopiert, ge-
I6scht ist geloscht! Bevor Sie also eine solche Liste bearbeiten, tber-
legen Sie genau, welchem Zweck sie dienen soll.

5. Sie kénnen nun beginnen, Hilfslinien aufzubauen. Folgende Funktio-
nen stehen IThnen zur Verfiigung:

® Um eine Fiihrungslinie zu verschieben, klicken Sie sie mit der Maus an
und ziehen sie dann mit gedriickter linker Maustaste an die passende
Stelle. Einfacher geht es, wenn Sie sie auf3erhalb der Folie anklicken.

® Um eine Fiihrungslinie zu kopieren, driicken Sie die -Taste und
ziehen die Linie mit gedriickter linker Maustaste an die gewtiinschte
Position.

® Um schlief3lich eine Fithrungslinie zu l6schen, ziehen Sie sie an eine
Stelle aul3erhalb der Folie.
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Falle 3von3 | Tark T | [ElEm T %O ‘:;-'a_!:
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Ein eigenes Gestaltungsraster anlegen

6. Speichern Sie die Priisentation nun. Danach duplizieren Sie die Folie, in-
dem Sie links in die Folieniibersicht klicken und + (D] driicken.
Loschen Sie dann auf der ersten Folie die Tabelle. Daraufhin sehen Sie
auf der Folie nur noch die Hilfslinien. Dank der duplizierten Folie haben
Sie dennoch jederzeit Zugriff auf die Tabelle und kénnen die Hilfslinien
spater noch einmal passgenau versetzen.
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=l o A | BFaren - — o

7] T 5 Hintergrunatosmate = (f
Fali e I.__II ot M I_IJ il I 9 D:m mimm‘m“ Z a Seit Fali il Ll \NEMI‘
alicrmaster — Maaterd atshalter 7] Futmeilen i _ Hintrrgrunagrana en suikleraen irribeasichien; aiterarsich
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7. Um den Folienmaster an- =
zupassen, wihlen Sie An- Musterfolie
sicht » Masteransichten »
Folienmaster, und richten
Sie die Platzhalter fiir Ti- Gestaltungsraster,
teltext, Textbereich, Bild- die vom Standard abweichen, |
bereiche usw. an den .
Hilfslinien, also dem neu-
en Raster aus. Passen Sie
Schriftarten, Textausrich-

tungen und Hintergrund-
farbe Thren Vorstellungen an (siehe das Beispiel fiir eine fertige Musterfo-
lie mit neuem Gestaltungsraster in der Abbildung).
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Informationsrelevanz

Jedes einzelne Folienelement stellt eine Information dar. Eine gute Gestal-
tung riickt nur die wirklich relevanten Informationen in den Blickpunkt und
lasst die unwichtigen Informationen weg, ohne die inhaltliche Aussage zu
verdndern.

Stellen Sie sich bei der Folienerstellung oder -iiberarbeitung die folgenden
Fragen:

® Gibt es redundante Informationen auf der Folie?

® Welche Linien, Gitter, Rahmen, Legenden, Nachkommastellen usw. kon-
nen weggelassen werden, ohne den Inhalt zu verdndern?

® Wie lasst sich die Textmenge beschranken, um nur die wichtigsten Infor-
mationen darzustellen?

® Wie soll der Zuschauer eine Folie »lesen«, damit sie fiir ihn Klarheit be-
kommt?

Zum besseren Verstandnis habe ich im Folgenden einige Beispiele einge-
fiigt. Sie sehen immer die Originalfolie (vorher) sowie die verdnderte Folie

(nachher).
Verkehrstrager am Knotenpunkt Verkehrstrager am Knotenpunkt
2%
1%

/ Schiene
B StraBe / 1,9%
mSchiene rafe Luft
.f::‘ s;:,s; ‘ 6,1%
B Wasser Wasser

0,5%

Tortendiagramm zu Verkehrstrigern (vorher/nachher): Rahmen und Legende wurden
weggelassen, und die Farbgebung wurde modernisiert.
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CO,-Emissionen im Verkehr COZ-Emissjoaent im Verkehr
In Mio.

743
T [ —
A/ B

mBahn
mShahe

Mio. t

— CiLuft
- mBnnenschififahrt

1985 1990 1495 1499
wBahn mStafe wluft ®Binnenschifffahrt

Balkendiagramm zu CO,-Emissionen (vorher/nachher): Gitterlinien, Rahmen und Nach-
kommastellen wurden weggelassen, die 3D-Darstellung wurde in 2D verdndert, die
Balkenoptik wurde modernisiert.

Top 100: Filme (2002 bis 2007) Top 100: Filme (2002 bis 2007)
| bl Fimitet |
T
1Crash
s o2 Csha
TP hight ol the Museum 2The Departed RNr_ Filmtitel
e Constant Cnenar
FThe Break-Up 3The Pursuit of Happiness 45Hitch
T 4Little Miss Sunshine 46Pirates of the Caribbean: Dead Man's Chest
g“w . SWalk the Line 47 Pirates of the Caribbean: Black Pearl
e P GMIr_ and Mrs. Smith
O s 7The Devil Wears Prada 550cean's Twelve
APtz he Cotbbosn Blaok Paat &Blood Diamand 56 Flags of our Fathers
9The Notebook &7 Borat
L — 10Hatel Rwanda 58The Bourne Ulimatum
& 11Babel 5@Michael Clayton
B 12Casino Royale
;R: g”'“":'m“'r :33:3?:1 i g;zﬁan‘s Thirteen
SR
ok Catr 15The Hofday
;;w sos 16The lllusionist 90The Bourne Identity
3&:’5""1 Denwnts 17 Milkion Dollar Baby
3NThe Lake Huuse =) Aam Legend 180hick 981 Am Legend
$1Strangur then Fictian ncorsenrt Tnith €81 o Fronmcs Yau Chack 2nd Lany 16The Aviator
i Maaiand kst s e s 20Syriana
34The Frstge B00s Baby Gone

Filmcharts (vorher/nachher): Da es in dieser Prisentation darum geht, die Wertigkeit
verschiedener Filme aufzuzeigen, ist das Weglassen von Informationen gerechtfertigt.

WeiRraum

Jeder ausgebildete Grafiker, Designer oder Drucker kennt den Begriff Weils-
raum - alternativ auch Leerraum oder negativer Raum genannt. Der Begriff
steht fiir die Flache auf einer Folie, auf der nichts aulser dem Hintergrund
zu sehen ist, d. h., der Weiraum ist das Gegenstiick zu dem Platz, den Text,
Bilder oder Diagramme einnehmen.
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Weillraum fokussiert

Ein ausreichend groller Weilfraum zeugt von Klarheit, Reinheit, Aufge-
rdumtheit, Konzentration und Qualitdt. Dagegen erscheinen vollgestopf-
te Folien wie eine Bedrohung, wie ein unaufgerdumtes Zimmer mit viel
Krimskrams, wenig fokussiert und nicht auf das Wichtigste konzentriert.
Das lenkt vom Ziel der Présentation ab und erzeugt eine falsche Wirkung.
Fragen werden nicht beantwortet, und es ist z. B. unklar, was der Zuschauer
sich merken soll, was wichtig und was unwichtig ist.

Die Regel lautet also: Gestalten Sie Ihre Prasentationen mit entsprechend
viel Weildraum. Die Grol3e des Weilsraums hangt vom Inhalt ab. Sie konnen
sich auch an bekannten Regeln wie dem Goldenen Schnitt oder der Dreier-
Regel orientieren (siehe Kapitel 3, »Bilder pfiffig prasentieren«). Prinzipiell
gilt: Je mehr Flache eine Folie hat und je weniger Informationen dargestellt
werden, desto fokussierter und klarer kommt die Botschaft der Folie an.

Um WeifSraum zu schaffen, konnen Sie Inhalte auch tiber mehrere Folien
verteilen. Im folgenden Beispiel wurde eine Folie in zwei Folien aufgeteilt,
mit dem Ziel, mehr Klarheit und einen deutlichen Fokus zu gestalten.
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Produktprisentation mit Nutzen

Der Erfolg einer Prasentation bleibt Vorgehen:
Ihnen versagt, wenn Sie zu viele - Beschreiben Sie 4 Punkte:
Produkteigenschaften und -vorteile - Produkteigenschaften
zeigen, die nicht die Erwartungen des Vorteile
Kunden treffen. Benutzen Sie daher
keine Eigenschaftslisten! Nutzen

- Grinde

Beginnen Sie mit einem
tiberzeugenden Argument.

- Setzen Sie lhre Persinlichkeit ein.

- Arbeiten Sie mit gedruckten
Unterlagen.

- Halten Sie Beweise bereit.

Erst dem Kunden zuhéren und dann Thre Argumente priisentieren

Die Ausgangsfolie ist sehr reich an Informationen, insbesondere an Text.

Produktprisentation mit Nutzen ‘

»Der Erfolg einer Prasentation bleibt
Ihnen versagt. wenn Sie zu viele
Produkteigenschaften und -vorteile
zeigen, die nicht die Erwartungen des
Kunden treffen.«

Benutzen Sie daher keine
Eigenschaftslisten!

In der Aufteilung wurde zundichst nur der erste Textteil libernommen.
Die Masterfolie und die Fldchenaufteilung wurden verdndert, der
WeifSraum vergréfSert. Die Folie wirkt nun sehr viel aufgerdumter.
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Produktprisentation mit Nutzen ‘ . - ¥ jin

Vorgehen
= Beschreiben Sie 4 Punkte:
Produkteigenschaften
- Vorteile
Mutzen
Grincle
 Beginnen Sie mit einem
Uberzeugenden Argument.
- Setzen Sie |hre Personlichkeit ein.

Arbeiten Sie mit gedruckten
Unterlagen,

= Halten Sie Beweise bereit.

Erst dem Kunden zuhoren und dann Ihre Argumente prisentieren

Teil 2 der Ausgangsfolie enthdlt nun nur noch die Aufzdhlung und
wirkt dadurch sehr klar und sachlich.

Durchgangigkeit

Durchgéngigkeit (Einheitlichkeit) bedeutet, dass die Folien einen einheit-
lichen Stil haben. Sie schaffen damit einen hohen Wiedererkennungswert
(Wiederholung), und ein Zuschauer kann sehr schnell erkennen, dass die
Présentation aus Ihrer Hand stammt. In grofsen Unternehmen gibt es haufig
detaillierte Vorgaben fiir das offentliche Auftreten, die auch fiir Prasenta-
tionsgestaltungen gelten, doch wenn das nicht der Fall ist, liegt es in Threm
Ermessen, wie Sie mit der Einheitlichkeit umgehen. Das Corporate Design,
also die durchgingige Unternehmenserscheinung, schlie3t Farben, Schrif-
ten, Logos usw. ein und kann sich auch durch grafische Gestaltungselemen-
te, Formen, Hintergriinde oder Anordnungen herstellen lassen.

Vieles davon, also Farben, Schriften oder Hintergriinde, wird in Power-
Point durch die Designs (Entwurf » Designs) abgedeckt. Durchgéngigkeit
geht aber noch einen Schritt weiter. Ab PowerPoint 2007 wird das sehr gut
unterstiitzt, z. B. durch vordefinierte Effekte (Entwurf » Designs » Effekte).



Durchgingigkeit

Damit es leichter ist, in der Présentation Durchgéngigkeit zu gewahrleisten,
hilft eine Folienbibliothek. Eine Folienbibliothek ist letztlich eine Samm-
lung von vordefinierten Folienelementen, zum Beispiel Grafikelementen.
Sie konnen sie selbst anlegen oder in Teilen auch schon fertig kaufen. Die
Abbildung zeigt z. B. eine Folie aus einer Folienbibliothek, aus der Sie sich
Vorlagen fiir Blockpfeile kopieren konnen. (Eine vollstindige Folienbiblio-
thek finden Sie auf der beiliegenden DVD unter dem Namen Folienbiblio-
thek_Muster.pptx.)

Beispiel 2 Beispiel 2

@ Beispiel 4 Beispiel 4

Als Alternative zu Folienbibliotheken kénnen Sie sich, um Durchgingigkeit
zu erreichen, auch gleich Musterfolien anlegen. Im Folgenden sehen Sie
drei Musterfolien aus einer ganzen Sammlung. Alle Folien haben einen ein-
heitlichen Stil: Sie basieren auf den Farben Weif3, Blau und Rot, die Textrah-
men sind abgerundet, transparent und mit dem Rand der Folie verbunden,
und der Text ist sehr kurz und in Stichworten gehalten.
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Eine Folienbibliothek anlegen

Bei der folgenden Ubung legen wir eine Folienbibliothek mit Gestaltungs-
elementen an, die in der gesamten Prdsentation immer wieder verwendet
werden sollen. Die Wiederverwendung von Elementen wirkt ebenfalls
durchgangig.

1. Zunichst miissen Sie ein Design festlegen. Legen Sie dazu eine neue
Folie an. Wihlen Sie fiir die Ubung iiber Entwurf » Designs als Design

Cronus aus. Tippen Sie als Titeliiberschrift auf der ersten Folie »Folien-
bibliothek« ein.
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2.

Eine Folienbibliothek anlegen

Uber Start » Folien » Neue Folie legen Sie eine weitere Folie mit dem
Layout Nur Titel an. Tippen Sie »Formen (1)« als Titel ein. In diesem
Schritt legen wir die Formen fest, die spater in unserer Folienbibliothek
erscheinen und die fiir die Bearbeitung von Prisentationen verwendet
werden konnen. Uber Start » Zeichnung » Formen wihlen Sie Rechteck
aus. Zeichnen Sie ein Quadrat auf die Folie (indem Sie beim Aufziehen
mit der linken Maustaste einfach die (¢ ]-Taste gedriickt lassen). Kli-
cken Sie das Rechteck an, und versehen Sie es {iber Start » Zeichnung »
Schnellformatvorlagen mit dem Format Intensiver Effekt — Akzent 3. Mer-
ken Sie sich diesen Effekt. Letztlich wirken alle Elemente und Formen
dann aus einem Guss, wenn Sie immer den gleichen intensiven Effekt
wéhlen, unabhingig davon, welche Farbe Sie gerade verwenden.

Z s o = R
schirmprasentation Uberpriifen Ansicht  Add-Ins Format o @
W o=, =, == 4z, | Terichtung - EENYE= [h ‘ DaFullettekt = @A Suchen
= =7 é

[ 5] Test ausrichten + AlLLd G- I Formkontur = | 35 Ersetzen «
= 3 - Ar\nrdr\en Schneliformat
BAS T in Smartart konvertiersn | | % SN g w vorlagen = | =) Formeffekte = | Ly Markieren +
5| Absatz : -
i | b | Ahc

A2 e 0 B B e L Z L 2k R

. . . I I I

Formen (1)
o T
. . ‘m| ‘m| . |,um‘ |Ah.:

Andere Designfillungen Intensiver Effekt - Blaugrin, Akzent 3 [

[ B

Duplizieren Sie die Form zweimal (iiber + (b)), und verschieben
Sie die Rechtecke dann so, wie in der folgenden Abbildung zu sehen.
Wihlen Sie als Formatierung Intensiver Effekt — Akzent 1 und Intensiver
Effekt — Akzent 2 aus. Damit haben Sie eine Basis erstellt, hier drei Qua-
drate, die fiir Thre gesamte Prasentation verbindlich sind. Die Muster-
folie konnte zum Beispiel als Agendafolie eingesetzt werden, oder die
Rechtecke werden als Grundlage fiir weitere Formen verwendet.
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4. Definieren Sie auf weiteren Folien je nach Bedarf andere Objekte wie

Pfeile, Kreise, Figuren usw., und ordnen Sie ihnen jeweils den intensi-

ven Effekt zu. So konnen Sie eine Folienbiblio-

Formen (1) thek mit Elementen aufbauen, auf die Sie im-
mer schnell zuriickgreifen kénnen.

Anordnung und Nahe

Jedes Element auf einer Folie sollte bewusst

angeordnet werden und iiber eine unsichtbare

32

Linie verbunden sein. Das hilft IThnen, die Folie
harmonisch zu gestalten und sie fiir den Zuschauer strukturiert und logisch
aussehen zu lassen.

Ndhe bedeutet in dem Zusammenhang, dass Folienelemente, die thema-
tisch zusammengehoren, auch auf der Folie nah beieinanderstehen. Dem
Zuschauer fallt es so leichter, die Logik im Aufbau der Folie zu erkennen
und Zusammenhénge zu verstehen.

Die folgenden beiden Folien demonstrieren dies: Im ersten Beispiel stehen
die inhaltlich zusammengehorenden Texte nah beieinander. Der Claim »Wir
koénnen nicht nicht wirken!« gilt {ibergreifend und ist daher etwas abgesetzt.

Michael Moesslang
SELF-PRESENSATION®

Personliche Wirkung

PRESENSATION®
Wirkungsvoll prisentieren




Im néchsten Beispiel ist der Claim, der zum Logo gehort, nah am Logo an-
geordnet. Titel, Untertitel und Datum sind auf der Folie gruppiert und nicht
dariiber verteilt. Sehr schon ist auch zu sehen, wie viel WeiRraum auf der
Folie gelassen wurde.

METRO Group

ZUM HANDELN GESCHAFFEN.

MADE TO TRADE.

METRQ Group Konzernprofil.

Tt Seplenber 2005 ML TRO 4G 2000

Gegensatze

Das Prinzip des Gegensatzes bedeutet die Verdeutlichung von Unterschie-
den zwischen einzelnen Folienelementen. Dadurch machen Sie die Folie
interessanter, lenken die Aufmerksamkeit Ihres Publikums und strukturie-
ren die Folie, was es dem Zuschauer erleichtert, die Zusammenhénge zu
erkennen. AufRerdem konnen Sie auf diese Weise wichtige Punkte besser
herausstellen. Gegensatze konnen auf verschiedene Arten erreicht werden,
wie die folgende Abbildung veranschaulicht.

Meistens wird schon intuitiv mit dem Gegensatzprinzip gearbeitet. Zum Bei-
spiel gestaltet man Spalteniiberschriften einer Tabelle anders als den Rest
der Tabelle, oder man hebt ein Wort hervor, weil es besonders wichtig ist.
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Grolte Form Abstufung Farbe Nahe
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Farbauswahl und -gestaltung

Uber Farbauswahl und -gestaltung gibt es einen riesigen Fundus an Litera-
tur, angefangen bei Leonardo da Vinci iiber Goethe und Kiippers bis hin zu
neueren Werken wie der Farbpsychologie, z.B. Das grofse Buch der Farben
von Klausbernd Vollmar (Konigsfurt Urania 2009).

Farben unterliegen Trends! Das heif3t, es gibt nicht »die Farbe« oder »die Farb-
regel«. Dennoch gibt es einige praktische Hinweise fiir die tagliche Praxis.

Farbechtheit priifen

Schauen Sie sich lhre Prasentation vorab schon mit dem Projektor
an, um die Farbechtheit zu prufen.

Die Farben, die Sie am Monitor Ihres Rechners sehen, wirken anders als die
in der Beamerprojektion. So kann es vorkommen, dass ein Gelb auf einmal
orange ist oder ein Rot zu einem Braun wird. Gleichen Sie daher die Farbe
direkt in der Projektion an. Wenn Sie nicht wissen, welchen Projektor Sie
fiir die Prasentation nutzen werden, orientieren Sie sich bei den Farbwerten
an den reinen Grundténen wie Rot, Blau oder Griin.



Kontraste schaffen und Abstufungen einbauen

Gestalten Sie Texte kontrastreich (im Verhaltnis von Text und Hin-
tergrund), damit sie gut gelesen werden kdnnen. Nutzen Sie Farb-
abstufungen fiir einen professionellen Look.

Die meisten PC-Monitore haben einen wesentlich gréferen Kontrast-
umfang als die Projektoren. Das bedeutet, dass ein Projektor nur einen Teil
der Farben richtig darstellen kann; den Rest ordnet er anderen Farbwerten
zu. Im ungiinstigsten Fall kann dies dazu fithren, dass der Text nicht lesbar
ist, selbst wenn er auf Threm Bildschirm perfekt ausgesehen hat.

PowerPoint bietet seit der Version 2007 einige Moglichkeiten der Farb-
abstufung und macht es Thnen damit sehr leicht, die richtige Auswahl zu
treffen. Wenn Sie mehrere Elemente auf einer Folie haben, nutzen Sie die
Abstufungen (verschiedene Helligkeitsstufen) einer Grundfarbe. Damit lie-
gen Sie fast immer richtig.

Im folgenden Beispiel sind die einzelnen Phasen des Phasendiagramms
farblich hervorgehoben und koénnen flexibel angepasst werden, je nach-
dem, welche Phase Sie gerade besprechen. Die entsprechende PowerPoint-
Datei Farbgestaltung.pptx finden Sie auf der beiliegenden DVD.

Phase 1 Phase 3 Phase 4

Seit der Version 2007 enthilt PowerPoint zusammen mit dem Masterlayout
verschiedene Grundfarbenreihen, die sogenannten Designfarben. Sie finden
sie unter Entwurf » Designs » Farben. Die Grundfarben, die Sie sehen, sind
von Microsoft definiert und stehen allen Mastervorlagen bzw. Designs zur
Verfiigung. Wenn Sie ein Design wechseln, werden demnach automatisch
auch die Grundfarben gewechselt. Sie konnen aber dennoch die Grundfar-
ben anpassen, indem Sie eine andere Zusammenstellung wéhlen.
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Wenn Thnen keine der Farbzusammenstellungen gefillt, konnen Sie {iber
Entwurf » Designs » Farben » Neue Designfarben erstellen... auch eigene
Designfarben kreieren. Die Farbwerte konnen Sie dann zum Beispiel an Thr
Corporate Design anpassen.

BlEH9-8 Q- k- B+ =
mn Einfligen | Entwurf Ubergiange Animationen Bildschirmprasentation Uberpriifen Ansicht Add-Ins

A A ‘,‘ B Farben 'l 51 Hinternrundfarmate « _
a a a %D = | Integriert =
Seite  Falienausrichtung LLCT T LLiL L] L el s mreEEEEE

einrichten X Larissa

Seite einrichten | Designs Graustufe

Ananke
Apotheke
Austin

(]

| x 122 0 0 B B d 2

Couture
Cronus
Dactylos
Deimos
Elementar
Essenz
Executive
Galathea
Ganymed
Haemera
Hardcover
Huorizont
Hyperion
Tapetus
Klarheit

Lysithea -
Meue Designfarben erstellen..,

Farben des Foliendesigns zurlicksetzen

| R - R R - R R - R R R - R -

Geeignete Farbabstufungen finden

In dieser Ubung geht es darum, zu erkennen, welche Farben im Allgemei-
nen fiir Thre Prasentation geeignet sind.

1. Nachdem Sie eine neue Folie angelegt haben (Layout Leer), fiigen Sie
auf einer leeren Folie ein Rechteck ein (Start » Zeichnung » Formen).

2. Klicken Sie in der gleichen Befehlsgruppe (Zeichnung) die Schaltfliche
Fiilleffekt an (sie zeigt einen Farbtopf). Hier finden Sie eine Reihe von
Abstufungen fiir die Grundfarben. Die Farben, die zueinandergehoren,



Ein Inhaltsverzeichnis mit Farbabstufungen anlegen

sind immer senkrecht untereinander angeordnet. Probieren Sie einfach
verschiedene Farbabstufungen aus.

o B =R

)

thirmprizentation Uberprifen Anzicht Add-Ins Format
= sz Il Textrichtung - E~NOoO D—\ |* .Fuueffekt =| &3 suchen

1=
[ et ausrichten - ALLY - | Designfarben |-
Anordnen Schneliformat- |
B smarrtkomertieren - || % S T lF Dokl ; B EEENEEN,.
|
Ahsatz ]

b 5 Zeichhung
[ 42 D B B e 2 D 2B B A 1;. Iﬂ?‘
| Standardfs Dunkelblau, Text 2, dunkler 25%

| Keine Fillung

2 Weitere Flllfarben..
@ sid..

@ Farbveraur »
| B struktur 3

Im folgenden Abschnitt stelle ich Thnen eine weitere Moglichkeit vor, Farb-
abstufungen auf Thren Folien gewinnbringend einzusetzen.

Ein Inhaltsverzeichnis mit Farbabstufungen anlegen

In dieser Ubung legen wir ein Inhaltsverzeich-
nis zu vier Themen an. Das aktuell behandelte
Thema soll dabei jeweils hervorgehoben wer-

. . . Thema2
den. Alle Farben sind aufeinander abgestimmt: -
Es gibt zwei Farbabstufungen bzw. -akzente auf
Basis eines Orangetons (siehe Abbildung).
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1. Legen Sie zunichst eine neue Folie mit Layout Leer an. Oben links zeich-
nen Sie ein Rechteck (Start » Zeichnung » Formen) und tippen »Thema
1« in dessen Textfeld ein (dazu klicken Sie einfach das Rechteck an und
legen mit dem Schreiben los).

2. Zum Formatieren klicken Sie es mit der rechten Maustaste an, dann er-
scheint ein Kontextmenii. Fiillen Sie das Rechteck {iber Fiilleffekt (die
Schaltfliche mit dem Farbtopf) mit einem Grundton - in unserem Fall
Orange, Akzent 6, dunkler 25%.

Schriftfarbe passend zum Hintergrund wahlen

Bei einem dunklen Hintergrund (z.B. heller 20% oder heller 40%) soll-
ten Sie eine helle Schriftfarbe (heller 60% oder heller 80%) wahlen
und umgekehrt, um die Lesbarkeit zu gewahrleisten.

|calibrim - 24~ A" A7 == L L

rr=EEA-BER S

Thema 1 Designfarben

||||ii|i|§

Standardfarben Orange, Akzent & dunkler 25%
[ 1 FEEEER

Eeine Fillung

Wieitere FQllfarben..,
Eild..,

Earbwerlauf L3

BEEe:

Struktur [3

3. Wihlen Sie bei Formkontur (das ist die Schaltfliche direkt neben dem
Farbtopf im Kontextmenii) die gleiche Farbe wie bei Fiilleffekt (vgl. vor-
herige Abbildung). Passen Sie gegebenenfalls die Schriftfarbe an (Start »
Schriftart » Schriftfarbe oder auch direkt im Kontextmenti).

4. Duplizieren Sie nun das erste Rechteck, und platzieren Sie es neben
dem ersten Rechteck. Ziehen Sie es in die Breite, wie in der Abbildung



6.

Ein Inhaltsverzeichnis mit Farbabstufungen anlegen

zu sehen. Setzen Sie Fiilleffekt auf Keine Fiillung und Formkontur auf die
gleiche Farbe wie beim ersten Rechteck.

Markieren Sie dann beide Rechtecke, und driicken Sie + (D], um
sie zu duplizieren. Platzieren Sie die neuen Rechtecke unterhalb der
beiden anderen. Andern Sie den Text in »Thema 2« und die Farbe der
Formkontur auf einen anderen Helligkeitswert, der sich einerseits von
der Schriftfarbe und andererseits von der Fiillfarbe unterscheidet — in
unserem Beispiel Orange, Akzent 6, heller 40%. Andern Sie den Fiilleffekt
fiir das Rechteck mit »Thema 2« ebenfalls auf den neuen Farbwert.

Designfarben |
H EEEEEEN

| II ﬁ ]
I I I i I I I ‘Orange, Akzent g, heller 40%

Standardfarben
[ ] | AEEEEE

Eeine Fillung

Weitere Fallfarben..,
Bild...

Earbverlauf >

B e

Struktur »

Um die restlichen Felder des Inhaltsverzeichnisses zu erstellen, markie-
ren Sie die untersten Rechtecke, duplizieren sie mit + (D] und
platzieren sie an dritter Stelle. Andern Sie den Textinhalt entsprechend,
z.B. in »Thema 3«, »Thema 4« usw.

Hin und wieder kann es sein, dass der Abstand der Rechtecke zueinan-
der schwankt, also mal ein bisschen grof3er, mal ein bisschen kleiner ist.
Um das zu beheben, gibt es eine einfache Mdéglichkeit: Markieren Sie
die (vier) Rechtecke, die untereinanderstehen, und wéhlen Sie Start »
Zeichnung » Anordnen » Ausrichten » Vertikal verteilen. Markieren Sie
immer nur eine Spalte mit Rechtecken, andernfalls versucht das Pro-
gramm, den Abstand aller Rechtecke auszugleichen. Das Gleiche ma-
chen Sie noch einmal mit den anderen (vier) Rechtecken.
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8.

10.

1"
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Um nun die Folie fiir das nidchste Thema zu erstellen, klicken Sie links
in die Folieniibersicht, und driicken Sie + [D]. Die Folie wird
dupliziert.

Klicken Sie daraufhin das Rechteck mit »Thema 1« an, und wéhlen Sie
Start » Zwischenablage » Format ilibertragen. Wenn Sie den Mauscursor
auf die Folie ziehen, sehen Sie, dass sich der Cursor zu einem »Pinsel«
verandert hat.

Klicken Sie dann das Rechteck mit »Thema 2« an. Fiilleffekt, Format-
kontur, Schriftfarbe — alles wird auf das neue Rechteck iibertragen.
Dann miissen Sie umgekehrt ein helles Format auf das erste Rechteck
iibertragen, weil Sie auf dieser Folie ja nur das Thema 2 hervorheben
wollen.

Um auch die Rechtecke fiir Thema 3 und Thema 4 passend einzufar-
ben, gehen Sie genauso weiter vor.



Designeffekte
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Format iibertragen

Formatierungen kopieren und an einer
anderen Stelle snwenden,

Doppelklicken Sie auf diese Schaltfliche,
um dieselbe Formatierung auf mehrere
Stellen im Dokument anzuwenden,

e Drucken Sie FL um die Hilfe anzuzeigen.

L e e

Designeffekte

Um Ihre Prasentation in einem speziellen Stil zu erstellen, konnen Sie ne-
ben der Farbauswahl auch noch Designeffekte verwenden.

Entscheiden Sie sich fiir einen Stil

Um ein moglichst einheitliches Erscheinungsbild zu erreichen, soll-
ten Sie bei den Schnellformatvorlagen in einem Stil bleiben und
nicht mischen.

Legen Sie eine neue Prisentation an, und zeichnen Sie beispielsweise ein
beliebiges Rechteck (Start » Zeichnung » Formen). Tippen Sie einen Text in
das Rechteck, und 6ffnen Sie dann die Auswahl der Schnellformatvorla-
gen (Start » Zeichnung » Schnellformatvorlagen). Sie sehen jetzt pro Farbe
(Akzent) sechs Stilmoglichkeiten: farbige Konturen, farbige Fiillungen oder
beides, subtile, moderate oder intensive Effekte. Treffen Sie Ihre Auswahl
jedoch nur innerhalb einer Reihe; springen Sie also nicht von subtil zu in-
tensiv oder Ahnliches. Entscheiden Sie sich bei Threr gesamten Préisentation
fiir einen Stil.
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Die Grundlage fiir die Schnellformatvorlagen sind die Designeffekte. Uber
Entwurf » Designs » Effekte konnen Sie sich die verschiedenen Moglichkei-
ten ansehen. Andern Sie hier einfach mal den Designeffekt, und schauen
Sie sich danach die Schnellformatvorlagen an.
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Bilder als Starken einer Prasentation

Bilder als Starken einer Prasentation

Lassen Sie mich an dieser Stelle ein wenig zum Thema Bilder ausholen,
denn Bilder haben eine Reihe von Vorteilen fiir die Wirkung einer Prasen-
tation. Der Profi konzentriert sich daher darauf, sinnvolle und erinnerbare
Bilder in seine Prasentationen einzubauen. Hier die wichtigsten Griinde,
die fiir die Verwendung von Bildern sprechen:

® Aufmerksamkeit: Bilder stellen sehr schnell
Kontakt zum Zuschauer her. Plakate mit ei-
nem markanten Bild, z. B. von einer Person,
ziehen die groRte Aufmerksamkeit auf sich.
Hingegen werden Plakate, auf denen nur
Text steht, als langweilig und wenig interes-
sant empfunden.

¢ Schnelle Informationsaufnahme: Uber-

legen Sie mal, wie lange Sie brauchen, um
einen Satz zu lesen oder einen ganzen Text
zu erfassen. Bilder dagegen werden in einem
Bruchteil von Sekunden vom Gehirn aufge-
nommen.

® Gespeicherte Gefiihle: Bilder haben eine
emotionale Wirkung und beeinflussen unse-
re Gefiihle. Sie stimulieren Menschen, brin-

gen sie zum Lachen, motivieren, machen

traurig, geben Kraft und vieles mehr. Den-

ken Sie zum Beispiel an Thre letzte private Feier, bei der
Sie viel gelacht haben. Wenn Sie sich die Bilder von der
Feier nachher anschauen, werden sie Sie vermutlich wie-
der in gute Stimmung versetzen und damit ein positives
Gefiihl in Thnen hervorrufen.

® Steuern und Lenken: Bilder haben Steuerungs- und
Lenkungscharakter. Denken Sie an Logos von Unterneh-
men oder an Verkehrsschilder. Letztere steuern z.B. Thr
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Verhalten. Diesen Effekt konnen Sie sich auch in Prasentationen zunutze
machen.

Nachhaltigkeit: Bilder und Bewegtbilder werden besser behalten als Tex-
te. Doch dies haben auch viele Menschen in der Werbebranche verstan-
den, und die Bilderflut hat dazu gefiihrt, dass wir Bilder, die wir schon
einmal gesehen haben, nicht mehr speichern. Die Herausforderung be-
steht also darin, Bilder zu verwenden, die bislang wenig verbreitet sind,
oder gar neue Bilder zu gestalten, die es in dieser Form noch nicht gab.

Sehen Sie sich beispielsweise das nédchste Bild an. Es wird sehr haufig
fiir das Thema Partnerschaft verwendet. Leider hat der Zuschauer dieses
Bild in verschiedenen Varianten

schon in Broschiiren, im Inter-
net, in Prisentationen oder in
Filmen gesehen. Es wird nicht
speziell mit Threr Prasentation
verkniipft, und die Wahrschein-
lichkeit, dass dieses Bild im Ge-
déchtnis bleibt, ist sehr gering.

Um es noch deutlicher zu machen, zeige ich Thnen im Folgenden zwei Foli-
en, die wir fiir einen Kunden erstellt haben. Ausgangspunkt war eine klassi-
sche Tabelle, wie sie sehr haufig in Prasentationen vorkommt.

Ranking der besten Produkte
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Die besten Produkte

Produkt1 Produkt2 Produkt3
LOGO Firma 4 1 |LOGO 1
Firma 2 Firma 5 2 |Fmas | 2
Firma 2 LOGO 3 [Firma7? 3




Welche Folie konnen Sie leichter und damit ldnger im Gedéchtnis behal-
ten? Ich tippe mal, dass Thre Antwort darauf die zweite Folie ist. Der Grund
ist das Bild, das wir in Verbindung mit den Informationen besser behalten
konnen. Diese Folie konnte, im Gegensatz zur ersten, von den meisten Zu-
schauern auch noch nach einer Woche beschrieben werden.

Sie haben nun die Vorteile der Verwendung von Bildern kennengelernt. In
den folgenden Kapiteln wird es noch haufiger um die Arbeit mit Bildern ge-
hen. In Kapitel 2, »Texte spannender gestalten«, lernen Sie zum Beispiel,
wie Sie den Ubergang von einer Textfolie zu einer Bildfolie schaffen. Das
Kapitel 3, »Bilder pfiffig prasentierenc, hilft Ihnen, passende Bilder zu fin-
den und sie pfiffig aufzubereiten.

Spielraume des Corporate Designs

»Das Corporate Design muss aber eingehalten werden« oder »Das CD
schrankt uns zu sehr ein« — das gehort zu den haufigsten Aussagen, die ich
im Rahmen von Beratungen und der Erstellung von Prédsentationen hore.
Dabei lassen sich auch unter CD-Malf3gaben interessante Prasentationen ge-
stalten. Ich stelle mir das immer vor wie bei einem Kiinstler. Der Pinsel, die
Farben, die Leinwandgroe — all das ist vorgegeben, dennoch ist der Inhalt
jedes Mal ein anderer. Denken Sie an Kiinstler wie Mird oder van Gogh, die
zahlreiche Werke mit einem unverkennbaren Stil erstellten.

Der gro3te Spielraum eroffnet sich, wenn Sie abwechslungsreiche Varian-
ten und Anordnungen von folgenden Elementen verwenden:

® Bilder

® Bildausschnitte
® Formen

® Texte

® Aufzdhlungen

® Hervorhebungen

® Animationen
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Variante 1 — Aufzdhlungsvariante mit Variante 2 — Vier Blécke
SmartArts
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Variante 3 — Ellipse mit vier Bereichen Variante 4 — Ellipse an das Logo angepasst

Es gibt noch eine weitere Variante, ndmlich eine animierte Version (siehe
beiliegende DVD: Spielraeume_smavicon.pptx). Wie Sie sehen, wurden alle
Varianten an das Corporate Design angepasst und sind dennoch vollig un-
terschiedlich aufgebaut. Losen Sie sich von der Standardaufzdhlung, und
schaffen Sie Abwechslung.

Die Folien des nichsten Beispiels zu »Mobile Computing« stammen urspriing-
lich von einem Unternehmen mit sehr strengen Corporate-Design-Richtlini-
en. In ihnen ist genau festgehalten, was beziiglich des Logos, der Schriften,
des Rasters und der Farben eingehalten werden muss. Freirdume ergeben
sich in der Aufbereitung des Textes, in seiner Anordnung innerhalb des Ras-
ters, der Bildgestaltung, der Umsetzung mit Formen und Symbolen, der ani-
mativen Ausgestaltung und in spielerischen Elementen. Die Richtlinien, z. B.
beziiglich der Kopf- und Fuldzeilengestaltung, des Logos, der Schriftarten
und der Farben, wurden zur Zufriedenheit der Corporate-Communications-
Abteilung umgesetzt, doch der Freiraum wurde kreativ genutzt.

Corporate Design

Das Corporate Design (CD) eines Unternehmens ist die Festlegung
eines einheitlichen Erscheinungsbildes vor allem fir seine Produkte
und Kommunikationsmittel (wie Plakate oder die Internetseite). Es
ist ein Teilbereich der Corporate Identity (Cl), also wortlich der »Un-
ternehmenspersonlichkeit«.
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Mobile Computing.

Einzug in den Unternehmensalltag.

SmartPhones, Netbooks, ...

Das Thema der Présentation sind mobile Internetgeriite.

Mobile Computing.
Einzug in den Unternehmensalltag.

Uberall online: unterwegs im Auto, im Hotel, im Café, ..

Das Bild fiillt den gesamten Inhaltsbereich. Der Text »Uberall online ...« vor dem
Bild wird mit einem halbtransparenten, dunkleren Rechteck unterlegt.



Spielrdume des Corporate Designs

Kommunikationsszenarien heute

Status

Anstelle von Text werden Symbole verwendet.

Kommunikationsszenarien heute

Bedrohungen

Diebstahl : - Viren, Trojaner

Abhtren

Die Textboxen symbolisieren die »Bedrohungen«. Der Text tiberlagert
die Grafiken, um damit eine zusdtzliche Symbolik zu schaffen.
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Kommunikationsszenarien heute
Losung

Sicherheitszone

Ein Oval wird eingeblendet, das die Sicherheitszone zeigen soll.

Kommunikationsszenarien heute

Top-Leistungen

Treffsicherheit
B Proaktive Sicherheit
B Keine Chance fiir Angreifer

Power-System
B RegelmaBige Checks
®  Kontinuierliche Verbesserung

Anstelle von reinem Text wurden zwei Bilder eingefiigt, die die Textaussagen
unterstiitzen. Die Darstellung unterscheidet sich von der Standardaufzdhlung
und schafft dadurch eine neue Sichtweise.
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Auch an diesem Beispiel konnen Sie sehen, welche kleinen und gré3eren
Spielrdume genutzt werden konnen. Eine Idee ist, mit unterschiedlichen
Bildern, Bildgro3en und -ausschnitten zu arbeiten. Setzen Sie in Thren Pra-
sentationen mehr Symbolik und aussagekréftige Grafiken ein, um Abwechs-
lung zu schaffen.

Emotionalitat und Sachlichkeit

Das Thema der Betonung von Gefiihl (Emotion) oder Verstand (Ratio) hat
sicher schon Heerscharen von Prasentationserstellern und Referenten be-
schéftigt. Wie emotional darf eine Prisentation sein? Sollte man sie doch
lieber sachlich halten? Eine pauschale Antwort darauf gibt es nicht. Mei-
ne lautet: Es ist immer abhéngig vom Kontext, also im Zusammenhang mit
dem Thema, dem Inhalt, den Zuschauern, dem Raum und dem Zeitpunkt
zu sehen. Dazu verschiedene Beispiele:

e Ein Hochschullehrer erldutert seinen Studenten die mathematische Her-
leitung fiir eine Formel.

® Ein Ingenieur prasentiert vor einem Fachpublikum die Konstruktion ei-
ner neuen Tragflache.

¢ Fin Finanzvorstand présentiert die neue Bilanz.

® Eine Marktforscherin zeigt den Marketingverantwortlichen einer Sham-
poomarke das Ergebnis einer Wettbewerberanalyse.

® Ein Vertriebsmitarbeiter stellt seinen Kunden die neue Altersvorsorge
vor.

® Eine Marketingleiterin prasentiert Vertriebsleuten die Produktneuheit,
mit der Endverbraucher mehr Strom sparen.

¢ Ein Trainer motiviert Mitarbeiter zum positiven Denken und Handeln.

Diese Beispiele reichen von der Vermittlung von faktenorientiertem Wissen
(reiner Information) bis hin zu handlungsorientierter Uberzeugungsarbeit.
In dem Maf3e, in dem Menschen zu Verhaltensdnderungen gebracht werden
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sollen, z.B. in Bezug auf Motivation, Verkauf und Begeisterung, muss die
Emotionalitdt der Prasentation zunehmen.

Sachlichkeit in der Gestaltung erreichen Sie wiederum durch:

® klare, eckige Formen (z.B. Quadrat, Dreieck, Raute)
® kiihle Farben (z.B. Blautone, Grauténe, Schwarz)

® gerade Linien

¢ technische Zeichnungen und Konstruktionen

Emotionalitit hingegen erzielen Sie durch:

® weiche, runde Formen (z.B. Kreis, Oval)
¢ warme Farben (z.B. Orange, Gelb, Rot)
® Kurven, Bewegungen

® Fotos (z.B. Menschen, Landschaften)

Weiterfiithrende Informationen zu Emotion und Ratio erhalten Sie beispiels-
weise unter www.presentation-booster.de.

Die Top 11 des Prasentationsdesigns

Dieser Abschnitt ist praktisch die Zusammenfassung der vorangegangenen
Abschnitte mit den elf wichtigsten Inhalten fiir eine professionelle Prasen-
tationsgestaltung:

1. Gestaltungsraster: Arbeiten Sie mit den Standardlayouts (Start » Folien »
Layout), oder nutzen Sie ein eigenes Raster, um Professionalitit zu zeigen.
Bauen Sie mithilfe von Fithrungslinien und Tabellen ein eigenes Gestal-
tungsraster.

2. Informationsrelevanz: Welche Informationen lassen sich auf der Folie
entfernen, ohne den Inhalt zu verdndern (doppelte Informationen, Be-
schriftungen, Striche usw.)?
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10.

WeiRraum: Nutzen Sie den Weilfraum (Leerraum) auf der Folie, um
klarer zu kommunizieren.

Durchgingigkeit: Arbeiten Sie mit einem einheitlichen Aussehen
(»Look«). Nutzen Sie dazu die Moglichkeiten, die PowerPoint Thnen
ab der Version 2007 bietet, z.B. Designs und Schnellformatvorlagen.
Erstellen Sie sich eine Folienbibliothek, d.h. eine Sammlung von Stan-
dardfolien und -elementen fiir Thre Prisentationen. Das hilft Thnen da-
bei, schnell ein einheitliches Aussehen hinzubekommen.

Anordnung und Nihe: Uberlegen Sie sich, welche Elemente (Text, Bild
usw.) zusammengehoren, und platzieren Sie diese nah beieinander.

Gegensitze: Mithilfe des Prinzips der Gegensétze konnen Sie wichtige
Informationen herausstellen und die Folien spannender gestalten. Ver-
dndern Sie einen oder mehrere der folgenden Parameter: Grofde, Form,
Abstufung, Farbe und Néhe.

Sinnvolle Farbauswahl und -gestaltung: Es gibt hierbei drei wichti-
ge Aspekte:

1. Schauen Sie sich die Farben am Projektor an.
2. Gestalten Sie kontrastreich.
3. Nutzen Sie Farbabstufungen.

Designeffekte: Setzen Sie gezielt Designeffekte ein, um einen individu-
ellen Look zu erzielen, z. B. {iber die Schnellformatvorlagen.

Bilder: Nutzen Sie viele Bilder in Ihren Prasentationen, denn diese blei-
ben besser in Erinnerung (Nachhaltigkeit), erzeugen Kontakt (Aufmerk-
samkeit), werden schneller verarbeitet (schnelle Informationsaufnah-
me), erzeugen Gefiihle (Erinnerungen) und haben Steuerungscharakter
(Steuern und Lenken).

Spielrdume des Corporate Designs: Nutzen Sie die Spielrdume, in-
dem Sie alternative Aufzdhlungsmoglichkeiten, andere Hervorhebun-
gen, andere und neue Formen oder sinnvolle Animationen einsetzen.
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11. Emotionalitat und Sachlichkeit: Fragen Sie sich, welchen Zweck Sie
mit Threr Présentation verfolgen. Wollen Sie gezielt Gefiihle ansprechen
oder sollen schlicht Informationen {ibermittelt werden? Emotionalitét
schaffen Sie z. B. mit warmen Farben und weichen Formen; Sachlichkeit
erzeugen u. a. kalte Farben und gerade, klare Formen.
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Texte spannender gestalten

Bei Prasentationen geht es naturgemaf} darum, Informationen zu vermit-
teln. Ublicherweise wird dafiir in erster Linie Text eingesetzt. So banal das
klingen mag — schon die Gestaltung einer simplen Aufzéhlung kann dariiber
entscheiden, ob der Zuschauer Thnen folgen kann oder nicht. In diesem Ka-
pitel wird es also darum gehen, Ihnen zu zeigen, wie Sie Wort und Schrift

sinnvoll einsetzen und welche Fehler Sie vermeiden sollten.

Kapitel 2 — Texte spannender gestalten
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Kapitel 2 — Texte spannender gestalten

Sie werden lernen, welche Funktionen Sie fiir die professionelle Textgestal-
tung brauchen und wie Sie damit Text und Schrift sinnvoll gestalten. Text
lasst sich spannend aufbereiten, u. a. durch die Verwendung von Bildern. Im
Zuge dessen zeige ich Thnen auch, wie Sie gelungene Uberginge zwischen
Text und Bild schaffen. Zum Thema Spannung und Abwechslung gehort da-
riber hinaus, welche interessanten Alternativen PowerPoint Ihnen anstelle
von Standardaufzéhlungen bietet. Da man bei Prasentationen héufig nicht
umhinkommt, Zitate zu verwenden, erfahren Sie zu guter Letzt auch noch,
wie Sie sie professionell gestalten, sodass sie ihre Wirkung voll entfalten.

Wichtige Funktionen fiir Texte

Vermutlich werden Sie die meisten Basisfunktionen zur Textformatierung
kennen. Dazu zéhlen fiir mich Funktionen wie SchriftgrofRe, -farbe und
-schnitt (kursiv, fett usw.) oder auch Absatzformatierungen wie linksbiin-
dig, rechtsbiindig oder zentriert. Im Folgenden wird daher nur ein sehr gro-
ber Uberblick iiber die Textfunktionen gegeben. Lediglich einzelne Aspekte
und Ideen, die Texte auf Ihren Folien besser aussehen lassen, werden ndher
betrachtet.

Die Standardformatierungen fiir die Schriftart finden Sie in der Befehls-
gruppe Start » Schriftart. In diesem Abschnitt werde ich Thnen weitere Mog-
lichkeiten aufzeigen, die die Textgestaltung interessanter machen.

SchriftgroBe SchriftgroRe
SchriftgroBe  eine Stufe vergroRern eine Stufe verkleinern

Auswabhl der Schriftart \ / Schriftart-
- formatierung

= N i =y zurlicksetzen
Calibri [Textkérpe = 18 = A A7 )

LF & U 8 abe AV~ Ax- | A - <«— Schriftfarbe
-—

Fettf///smmz:arc'\ \ .l Dialogfeld-

] starter
Kursiv GroR-/Klein-
Unterstreichen Durchstreichen schreibung
Schatten Buchstabenabstand
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Prinzipiell erhalten Sie mehr Details oder weitere Funktionen und Feinhei-
ten zu der Schriftformatierung, wenn Sie in der Befehlsgruppe Schriftart
den Dialogfeldstarter (den kleinen

Pfeil unten rechts in der Gruppe) [siwn =R
anklicken. Der Dialog erscheint nur, | vt [zsenstond |

Schriftart Flr westlichen Text: Schriftschnitt: Schriftgrad:
+Textkirper Iz‘ Standard Iz‘ 18 =
Gesamten Text

Schriftfarbe &v Unterstreichung | {ohne) E| Unkerstreichungsfarbe | oy

Effekie

wenn Text auf Ihrer Folie steht. Tip-
pen Sie am besten ein paar Worter

in einen Platzhalter oder in einen

Freitext (Start » Zeichnung » Formen M. pyrchgpeatcen il
[7] Doppelt durchgestrichen ) [7] arofbuchstaben
» Textfeld), und klicken Sie anschlie- B toboeiok  sbwand o o] B 2o sgiten
Tiefgestellt

Bend auf den Dialogfeldstarter.

Besonders interessant ist die Unter-

streichung. Gerade wenn Sie wichti-

ge Worter hervorheben wollen, bietet diese Funktion viele Varianten, die
Ihre Folien von anderen abheben. Probieren Sie verschiedene Moglichkei-
ten aus. Priifen Sie jedoch in jedem Fall auch die Darstellung an der Lein-
wand mit einem Beamer, denn je nach Modell kann es zum Flimmern der
Unterstreichung kommen.

Spationierung ist ein Begriff aus der Typografie und bezeichnet den Abstand
von Buchstaben und Wortern (Laufweite). Um eine Schrift gut lesen zu kon-
nen, muss der Abstand der Buchstaben zueinander unterschiedlich grof3
sein. Vergleichen Sie zum Beispiel die Kombinationen 1l und ww. Bei Il muss
fiir bessere Lesbarkeit der Abstand der Buchstaben weiter sein als bei ww.
PowerPoint bietet die Moglichkeit, die Spationierung in kleinen Schritten
einzustellen. Klicken Sie dazu im Dialog Schriftart auf den Reiter Zeichen-
abstand.

Schriftart R

[_S_ctri‘tart | Zeichenabstand

Abstand: GesperftEI Innerhalb von: 1,2 1 Pt
V| Upterschneidung ab: |12 > Punkk

[ ok | [ abbrechen
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Markieren Sie eine Zeile Text, und wéhlen Sie im Feld Abstand Gesperrt (fiir
eine Verbreiterung des Abstands) und bei Innerhalb von dann beispielsweise
»1,2 pt« aus. Nachdem Sie den Dialog mit OK geschlossen haben, sehen Sie
den Text mit weiterem Abstand zwischen den Buchstaben.

Einen moderaten Abstand wahlen

Der Leser soll es einfach haben, die Texte zu lesen. Extrem gesperr-
te oder extrem schmale Abstande erschweren das Lesen, deshalb
sollten Sie hier nur moderate Anderungen vornehmen. Uberhaupt
sollten Sie darauf achten, diese Anpassung nur selten und nur fuir
einzelne Worter vorzunehmen. Und denken Sie auch daran, dass der
Abstand vor und hinter dem gesperrten Wort ebenfalls vergroRert
werden muss.

Eine Verdnderung der Absténde hilft Thnen u. a. in folgenden Fillen:

1. Sie haben eine Zeile geschrieben, und wegen genau eines Wortes wird
die Zeile umbrochen. Hier hitten Sie die Moglichkeit, den Zeichen-
abstand zu verkleinern (eng), um das Wort noch mit in die erste Zeile
zu setzen.

2. Sie stellen fest, dass zwei aufeinanderfolgende Buchstaben ein Wort op-
tisch in zwei Teile trennen, weil der Abstand zwischen den Zeichen zu
grol} ist. Das passiert zum Beispiel bei »&dlteren« Schriftarten wie Arial
oder Times New Roman. Verkleinern Sie den Zeichenabstand zwischen
den zwei Buchstaben.

3. Sie benutzen eine Schriftart mit dem Zusatz condensed, in der die Buch-
staben eng beieinanderstehen (enge Laufweite). Sperren Sie in diesem
Fall die Texte (vergrof3ern Sie den Zeichenabstand), um sie besser lesen
zu koénnen.

Wie bei der Befehlsgruppe Schriftart finden Sie in der Gruppe Absatz (iiber
Start) eine Reihe von Standardbefehlen, die Sie sicherlich kennen, z.B. die
Ausrichtung des Absatzes am linken oder rechten Rand.



Wichtige Funktionen fiir Texte

Eine Gliederungsebene

Nummerierte tiefer oder héher stufen

Aufzihlung (entsprechend den definierten Zeilenabstand
Gliederungsebenen
im Masterlayout) Textrichtung,

z.B. horizontal,
Aufzéhlungszeichen \ / um 90°Grad
(Bullet) \ gedreht usw.
. Vertikale Ausrichtung

| des Absatzes innerhalb

einer Textbox oder

/ AutoForm
Absats & \

Zentrierter/ Absatz in

eine SmartArt

Absatz .
konvertieren

Linksblindiger
Absatz

Rechtsbiindiger Blocksatz Anzahl der Spalten
Absatz in einem Absatz

Weitere Details eréffnen sich Thnen wieder iiber den Dialogfeldstarter. Hier
konnen Sie Zeilenabstidnde, Einziige usw. einstellen.

st [ =
Einziige und Abstande

Allgemein

Ausrichtung: | Zentriert E[

Einzug

Yar Texk: IJ 1] C Ohjektdaten: ;-(ohne) E[ Inmerhalb von:

Abstand
Yar: 'IJ Pt ; Zeilenabstand: ;EinFach EI [ali o
Mach:  |OPE.
) e

Besonders interessant in der Befehlsgruppe Absatz ist die
Funktion In eine SmartArt-Grafik konvertieren. Mit ihrer
Hilfe konnen Sie Text schnell in eine ansprechende Form
bringen (siehe dazu auch den Abschnitt »SmartArts statt
Aufzdhlungszeichen« ab Seite 97).

vou

11
4
i
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Markieren Sie ein paar Zeilen Text, und klicken Sie auf die Schaltflache In
SmartArt-Grafik konvertieren. Wihlen Sie aus den Moglichkeiten eine aus,
und sehen Sie sich das Ergebnis auf der Folie an. (Mehr zum Thema Smart-
Art-Grafiken erfahren Sie im Abschnitt »SmartArts statt Aufzdhlungszei-
chen« ab Seite 97).

Im Zusammenhang mit der Absatzformatierung gibt es eine wichtige Tas-
tenkombination, auf die ich hier noch einmal gesondert eingehen mochte,
weil sie in jeder Prasentation gebraucht wird. Es geht um zwei verschiedene
Arten des Zeilenumbruchs, ndmlich harte und weiche Umbriiche. Um Ihnen
die Unterschiede deutlich zu machen, legen wir eine neue Folie mit dem
Layout Titel und Inhalt an. In das Inhaltsfeld geben Sie den Text »Das ist eine
sehr lange Zeile, die einmal absichtlich umbrochen werden soll.« ein.

Der Standardweg diirfte Ihnen bekannt sein, es ist die Taste [« ]. Brechen
Sie die Zeile nach dem Komma auf diese Weise »hart« um. Sie sollten jetzt

die zweite Zeile ebenfalls mit einem Aufzdhlungszeichen (Bullet) sehen.
Machen Sie den Umbruch wieder riickgéngig ((Strg] + (2]).

Probieren Sie nun einen weichen Umbruch mit der Tastenkombination
(o] + aus. Wie Sie sehen, erscheint kein Aufzidhlungszeichen, und Sie
vermeiden damit Fehler auf Threr Folie.

Ausgangslage

e Das ist eine sehr lange Zeile, die einmal absichtlich umbrochen
werden soll.

Harter Umbruch (Enter-Taste)

e Das ist eine sehr lange Zeile,

¢ die einmal absichtlich umbrochen werden soll.

Weicher Umbruch (Umschalt-Taste + Enter-Taste)

e Das ist eine sehr lange Zeile,
die einmal absichtlich umbrochen werden soll.

Entscheiden Sie sich normalerweise bewusst, in welchem Fall Sie Text in
die Platzhalter des Folienlayouts schreiben und wann eher die Freitext-
Funktion (Start » Zeichnung » Formen » Textfeld) sinnvoll ist? Generell hat



Wichtige Funktionen fiir Texte

es ndmlich viele Vorteile, die Standardplatzhalter der Layouts zum Beispiel
fir Titeltext, Inhaltstext usw. zu nutzen:

1. Thre Texte sind immer im Gestaltungsraster positioniert.

2. Thre Folien haben ein einheitliches Schriftbild, d.h. Grol3e, Farbe oder
Schnitt bleiben identisch.

3. Anderungen am Design werden automatisch auf alle Folien iibernom-
men.

4. Die Texte werden in der Gliederung angezeigt.

Aufgrund dieser und weiterer Vorteile sollten Sie so lange wie moglich mit
Platzhaltern arbeiten. Stellen Sie sich nur mal vor, die Corporate-Design-
Vorgaben wiirden gedndert, dann wére es fiir Sie ein Leichtes, die Folien
entsprechend zu dndern. Denn Sie dndern nur die Mastervorlagen (Master-
layout), und schon sind alle Folien entsprechend angepasst.

® Regel 1: Benutzen Sie Platzhalter so lange, wie Sie ihre Grof3e und Posi-
tion nicht 4&ndern miissen.

EEH9-09 % Bz
Start | Einfugen  Enbwurf  Ubergdnge  Animationen  Bildschimprisentation  Uberprifen  Ansicht  Add-ns
[ g [Staeut-| S = Ul Y Ea
= E Larissa B -
Einfugen Neue Formen Anordnen 5
- J Falie ~ - - ge
Zwischenablage 1 Absatz Zeichnuing
| = E] B b 1 e D 2 L B L B e 1D e 2]

1 Titelfolie Titel und Inhalt Abschniths- s
Gberschrift

durch Klicken hinzufligen

Zwel Inhalte Vergleich Hur Titel sh Klicken hinzufligen

Leer Inhalt mit Bild mit
Uberschrift Uberschrift

UL e G e
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Es kommt vor, dass Sie Position und Grof3e des Platzhalters im Rahmen
Ihres Gestaltungsrasters (siehe Kapitel 1, »Professionelles Prasentations-
design«) anpassen miissen und es kein passendes Layout gibt. In diesem Fall
gilt Folgendes:

® Regel 2: Wenn Sie Grolse und Position des Platzhalters dndern miissen,
verdndern Sie das Masterlayout, und fligen Sie ein neues Layout hinzu
(siehe Kapitel 1). Die Grenzen der Anpassung des Folienlayouts werden
erreicht, wenn Sie sehr viel mit Formen und Bildern arbeiten oder nahezu
auf jeder Folie ein neues Masterlayout erforderlich ist. Hiufig miissen Sie
sehr viele Platzhalter erstellen. In diesen Fallen arbeiten Sie einfacher mit
den Freitexten (Textfeldern). Hierzu lesen Sie am besten den Abschnitt
»Vier Text-Platzhalter im Folienmaster« ab Seite 65.

® Regel 3: Wenn die Anzahl der Platzhalter auf einer Folie wéachst (mehr
als acht) oder Sie bei jeder Folie ins Masterlayout wechseln miissen, ist es
einfacher, mit Freitext zu arbeiten (siehe dazu den Abschnitt »Freitexte
richtig nutzen« ab Seite 68).

® Regel 4: Fiir Sondertexte oder Texte in AutoFormen sollten Sie freie Text-
felder nutzen.

Mit PowerPoint konnen
Sie Texte dariiber hinaus At Awebat

Farmat

. ¥ Fullleffelt = A\ Textfillung
effektvoll in Szene setzen. :'f A A vy
Le Formkontur ~ » Textkontur =

Sobald Sie einen Text auf o romefreits- Teceffelte -
der Folie angeklickt ha- - WOHAL-FOTInae
ben, sind die Effektfunk-
tionen iiber Zeichentools »
Format » WordArt-Formate
aufrufbar. Wenn Sie auf den kleinen Pfeil rechts unten am Feld klicken
(Weitere), erhalten Sie eine grof3ere Auswahl an WordArt-Effekten.

1411051 eB 17 01819 i weitere

Ein Grafikformat fir Text
auswahlen

Auflerdem finden sich in der Befehlsgruppe WordArt-Formate unter Text-
effekte Moglichkeiten wie Schatten, Spiegelung, Leuchten, Abschragung, 3D-
Drehung und Transformieren.
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Texteffekte eignen sich besonders, wenn es nur um einzelne Worter bzw.
kurze Satze geht und eine 3D-Wirkung erzielt werden soll, z. B. wenn Sie
Text rdumlich platzieren wollen. Aul’erdem sind Texteffekte sinnvoll, wenn
es um eine Angleichung an Formen und Bilder im Sinne einer grafischen
Gestaltung geht, z. B. wenn Sie Text als Plakette, Stempel, Medaille, Pyrami-
de oder Ahnliches abbilden wollen. Die Beispielpriasentation WordArt_Mus-
ter.pptx finden Sie auf der beiliegenden DVD.

feichentools

:ntation Uberprifen Ansicht Add-Ins

A

Format

é + [y Ebene nachvorne = |2 &usrichten +
g - qh Ebene nach hinten - !ﬁGruppleren
(| By suswahibereich S Drehen = e

1] 408 cm

4| 4

‘WordAr-Formate

e r—— A . Kein Schatten A [E]
EERTOEIINEED| o ]
Spiegelung 3
Auben
Leuchten 3
/ A A
o ' o
/\  Abschragun »
A s
® / / \
- ﬁ'\ 3D-Drehung 2 Y \
WO rd dm‘ Transformieren * ;\ < /:‘ =

Innen

ﬂ A A A

itel durch Klicken hinzuflige
A A A

\ A / &
.................. '-\_ _'.'_'\\_ J"

Perspektive

r

v
o
] = s

i I:l Weitere Schatten.., —
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Einen Texteffekt erstellen

In diesem Abschnitt zeige ich Ihnen nun ein Beispiel fiir einen Texteffekt,

namlich eine abgeschrédgte 3D-Perspektive.

1. Offnen Sie die PowerPoint-Datei New-Message_Monitor.pptx, die Sie auf

der beiliegenden DVD finden. Tippen Sie mithilfe der Freitextfunktion
(Start » Zeichnung » Formen » Textfeld) oder iiber den Platzhalter den
Text »new message« ein. Wahlen Sie als Schriftgroe »88 pt« aus.

2. Uber Zeichentools » Format » WordArt-Formate wihlen Sie ein Grafik-

format als Texteffekt aus, z. B. Fiillung — Orange, Akzent 6, Warme matte
Abschragung.

e Animationen Bildschirmprasentation Uberpriifen Ansicht Add-Ins Format

chvorne = |2 Ausrichten

4]

S Fallefrert - | Gilt fiir markierten Text
ch hinten * Eﬁ:lsll:pp\eren

soc |- O Formkontur v :&
7 ) Formeffekte = A A /) \ A arelch L Dreken +
al N A= =

| Anaordnen

Tite A A A A peN
""""""""""""""""" A A A A A lken

N L AAA
AAAA.

Filllung - Orange, &kzent 6, Warme matte Abschrigung

g A5 wiordart |J

3. Fiir den zweiten Texteffekt wihlen Sie Zeichentools » WordArt-Formate »

Texteffekte » 3D-Drehung » Perspektive links (Stufe 3).



Vier Text-Platzhalter im Folienmaster anlegen

chirmprasentation Uberprifen Ansicht Add-Ins Format

A Flilleffekt = A Tefullung = D Ebene nachvame [ Ausrichten - il %02 em

& Formkontur ~ A A A - | ETexteontur = | Ll Ebene nach hinten = [8] Gruppieren e
= | Textetfekte =| | B Auswahlbereich S Drehen + o 1801 o

¢ Formeffekte -

[ Wordart-Formate | Anordnen Grijite
[z g B B g2  Schatten i R R (IR
Spiegelung » | Keine Drehung -~
T.t I d h K Leuchten »
I e u rc Parallel

A o

ﬁ\ ID-Drehung  * -
F o

oSadfl <

Perspektive

an
% Weitere 3D-Einstellungen..,

oLy

4. Verschieben Sie dann den Text in Richtung des Monitors, und drehen Sie
ihn mithilfe des Ankersymbols am Text. Sie konnen auch mit der rechten
Maustaste auf den Textrahmen klicken, dann aus dem Kontextmenii GroRe
und Position » Drehung wihlen und den Wert »252°« eingeben.

Aber nicht die Effekte, auch die Verteilung des Textes ist Wichtig, wie Sie im
folgenden Abschnitt sehen werden.

Vier Text-Platzhalter im Folienmaster anlegen

Gerade wenn Sie Text »sauber« platzieren und dabei ein bestimmtes Text-
gestaltungsraster hiufiger verwenden wollen, bietet es sich an, ein eigenes
Layout im Master zu bauen.
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1. Legen Sie eine neue, leere Prisentation an. Dann wechseln Sie in den
Folienmaster (Ansicht » Masteransichten » Folienmaster). Wahlen Sie
das Layout Titel und Inhalt. Klicken Sie mit der rechten Maustaste auf
Layout, und wéhlen Sie Duplizieren aus dem Kontextmendi.

Von nun an arbeiten Sie auf dem duplizierten Layout. Verkleinern Sie

den Platzhalter fiir den Inhalt auf ein Viertel der Grof3e. Moglichkeit A:
Klicken Sie auf einen der Eckmarker, und ziehen Sie den Platzhalter mit
gedriickter Maustaste kleiner. Moglichkeit B: Klicken Sie mit der rech-
ten Maustaste auf den Platzhalter, wiahlen Sie GroBe und Position » Hohe
und Breite aus dem Kontextmenii, und geben Sie bei Héhe »6,07 cm«

und bei Breite »11,23 cm« ein.

b

Stat  Einfigen  Uberginge  Amemationen  Uberprfen  Anpent  Adddm

4 Hintergrunctormate *

| e

bearbeiten

+ Textmasterformate
durch Klicken
bearbeiten
— Zweite Ebene

* Dritte Ebene
= Vierte Ebene
» Finfre Ebene

Hintergrunegranken auibsersdem

' : Titelmasterformat durch Klicken

o B8 2

)

(3] 5|

idhtung | MaRsran
froirey

B8

4

-

Klicken Sie danach auf den Rahmen des Platzhalters, und duplizieren

Sie den Platzhalter mit + (D). Platzieren Sie die Kopie rechts da-
neben an ihre neue Stelle. Wiederholen Sie diesen Schritt fiir die ande-

ren beiden Rahmen.

66



Vier Text-Platzhalter im Folienmaster anlegen
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Titelmasterformat durch Klicken
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— Zweite Ebene

* Dritte Ebene
= Viarte Ebens
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Platzhalter einfiigen

Alternativ kdnnen Sie anstelle von Duplizieren auch die Funktion
Platzhalter einfiigen in der Befehlsgruppe Masterlayout verwenden.
Mit dieser Funktion kdnnen Sie spater beim Ausfullen des Platzhal-
ters die Auswahl auf bestimmte Folienelemente einschranken, z. B.
auf ein Bild, eine Tabelle oder Ahnliches.

4. Um das Ergebnis zu testen, schlieRen Sie das Masterlayout iiber Mas-
teransicht schlieen. Legen Sie iiber Start » Folien » Neue Folie eine neue
Folie an, und wahlen Sie als Layout das neue Layout aus. Fiillen Sie die
Platzhalter beispielsweise mit Text oder Bildern.

Bl 92- 0 & k-5l = B on
Follenmaster | Stat  Elnfiigen - Hi Oberpre Anticht  AddIns a @
3 R L2sche 5 Ta_ | E@rarten- o 3
i | [ Tited [ E

e — IR Umherennen Al schritt arten - —
Follenmaster Lavout t Flatzhatter [J1 Funzeilen De:ngr; . auskilenden Sefte  Folienausrichtung | Masteransicht
einfigen  sinfligen W Beibehalizn sinfagen = - [@]Emexte - elnrichten - schllsfian
Matter bearbeften Masterayout Design bearbetten Selte sinrichten chilefian
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Freitexte richtig nutzen

Bei der Verwendung von Freitexten passieren manchmal merkwiirdige Din-

ge.

1.

2.

4.
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In diesem Abschnitt zeige ich Thnen, worauf Sie achten sollten.

Offnen Sie eine neue Prisentation, oder legen Sie in einer bestehenden
Prisentation eine Leerfolie an (Start » Folien » Layout » Leer).

Wiéhlen Sie Start » Zeichnung » Formen » Textfeld, und klicken Sie mit
der linken Maustaste in die Folie. Schreiben Sie den folgenden Text:
»Die Zeile kann sehr lang werden und wird nicht am Blattende umbro-
chen. Sie geht iiber die Folie hinaus.«

Um einen Freitext (ein Textfeld) mit Zeilenldngenbegrenzung zu erstel-
len, wéhlen Sie Start » Zeichnung » Formen » Textfeld, und ziehen Sie un-
terhalb des zuvor geschriebenen Satzes mit gedriickter linker Maustaste
einen Rahmen auf. Schreiben Sie den folgenden Text: »In einem schma-
leren Textrahmen wird der Text automatisch umbrochen. Probieren Sie
es aus, indem Sie einfach diesen Text schreiben.«

Caten mttame + (11 ¢ A 47 # 2. ]E.

FrUusa¥un A-EE3E N0

Die Zeile kann sehr lang werden und wird nicht am Blattende umbrochen. Sie geht liber die Folie hinaus.
L)

In einem schmaleren Textrahmen
wird der Text automatisch

sumbrochen. Probieren Sie es aus,
indem Sie einfach diesen Text
schreiben.

Wenn Sie nachtraglich dndern wollen, ob der Text rechts iiber den Fo-
lienrand hinauswandert oder in der Textbox umbrochen wird, klicken
Sie mit der rechten Maustaste auf das Textfeld und im Kontextmenii auf
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Form formatieren. Wenn Sie dann bei Textfeld » Innerer Seitenrand » Text

in Form umbrechen ein Hikchen setzen, konnen Sie den automatischen

Zeilenumbruch erzwingen.

‘Form formatieren @

Filng Textfeld
Linienfarbe Textlayout
Linienart Vertikale Ausrichtung: | Oben E
Schatten Textrichtung:  Horizontal 3
Spiegelung Automatisch anpassen
Leuchten und weiche Kanten ) Grofie nicht automatisch anpassen
aD-Format O Text bei Uberlauf verkleinern

@ Grofie der Form dem Text anpassen
3D-Drehung g e

Innerer Seitenrand

EBildkorrekturen

Links: 0,25 em = Oben: [0,13 em
Eildfarbe = =

Rechts: |0,25 em | Unten: (0,13 em =
Kinstlerische Effekke 7] Text in Farm umbrechen
Zuschneiden

Spalten...
Grife
Position
Textfeld
Alternativtext

Schiiefien

Sinnvolle Textgestaltung

Eine der haufigsten Fragen, die mir gestellt werden, ist die, wie viel Text
auf einer Folie stehen sollte. In diesem Abschnitt geht es nicht nur um diese
Frage, sondern auch darum, wie der Text gestaltet werden kann, um ihn
prasentationstauglich zu machen.

In der Standardliteratur finden sich verschiedene Regeln fiir die Textmenge,
beispielsweise die 7x7-Regel, die 4x4-Regel oder die 1-7-7-Regel.

Die 7x7-Regel besagt: Gestalten Sie pro Folie maximal 7 Zeilen (7 Aufzih-
lungszeilen) mit maximal 7 Wortern pro Zeile. Fiir einfachere Zusammen-
hénge gilt die 4x4-Regel, d. h. 4 Zeilen mit maximal 4 Wortern pro Zeile. Die
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1-7-7-Regel besagt, dass man nur ein Argument pro Folie zeigen sollte und

darauf wiederum die 7x7-Regel anwendet.

Einerseits sind diese Regeln recht einfach umzusetzen, doch andererseits
sind sie besonders dann mangelhaft fiir die Wirkung einer Prasentation,
wenn sie auf jeder Folie angewendet werden. Das wirkt sehr schnell lang-
weilig, und die Zuschauer lesen nicht mehr, sondern hoéren nur noch dem
Vortragenden zu (was nicht grundsatzlich schlecht ist, doch die Folien sind
ja gerade dazu da, das Verstdndnis zu unterstiitzen). Wenn Sie Thre Folie
mit einer sinnvollen Textmenge ausstatten und eine positive Wirkung erzie-

len wollen, wenden Sie fiir sich besser die beiden Ansétze an, die ich Thnen

im Folgenden vorstelle.

Nach dem ersten Ansatz beantworten Sie zunéchst die Frage, um welchen
Prdsentationstyp es sich handelt, und aufgrund dessen fillen Sie die Ent-
scheidung iiber die Textmenge. Eine grof3e Rolle spielt dabei auch die Ziel-
gruppe der Prisentation. Menschen, die es gewohnt sind, schnell zu lesen
und viel Text in kurzer Zeit zu erfassen, konnen entsprechend mehr Text auf

einer Folie verarbeiten als andere. Hierzu einige Beispiele:

® Messe- bzw. Teaser-Prasentation: Das Ziel der Messeprédsentation ist
es, Besucher neugierig zu machen und an den Messestand zu ziehen. Wie
viel Text lesen Zuschauer, wenn sie am Messestand vorbeigehen? Eher
wenig. Nutzen Sie fiir Messe- bzw. Teaser-Préasentationen also sehr wenig
Text, d. h. nur ein bis sieben Worter pro Folie. Vor allem, wenn Sie inter-
nationales Publikum haben, ist es leichter, mit Bildern und Infografiken

zu arbeiten, weil diese iiberall auf der Welt verstanden werden.

® Prisentation eines neuen Produkts, z.B. Marketing- und Verkaufs-
prasentation: Ihr Ziel ist es, den Auf3endienst und dariiber hinaus auch
Interessenten und Kunden zu begeistern und zu informieren (das Stich-
wort lautet also Infotainment). Sie sollten einerseits sehr emotionale Fo-
lien, also Folien mit vielen Bildern und Multimedia, aber wenig Text (ein
bis sieben Worter) einsetzen. Andererseits sollten Sie sachliche Folien
préasentieren, die Produkteigenschaften anhand von Zahlen, Daten und
Fakten belegen. Diese Folien konnen z.B. nach der 7x7-Regel gestaltet
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sein. Insgesamt sollte der sachliche Teil nicht mehr als 50% und nicht
weniger als 20 % der Priasentation ausmachen.

® Verhaltensbezogene Trainings- und Schulungspriasentationen, z.B.
Personlichkeitsentwicklungsseminare, Kommunikation oder Fiih-
rung: Thr Ziel ist es, eine Verhaltensdnderung bei den Teilnehmern her-
beizufiihren. Die Prasentation sollte nur zur Erklarung und Emotionali-
sierung verwendet werden. Setzen Sie daher wenig Text eine: maximal
ein bis zwei Zeilen Text pro Folie.

® Sachbezogene Trainings- und Schulungsprisentationen, z.B. Soft-
wareschulungen oder Maschinenlehrgang: Hierbei soll viel Wissen
und reichlich Information bei den Teilnehmern verankert werden. Da
die Prasentation damit gleichzeitig auch als Dokumentation verstanden
werden kann, darf auf den Folien auch mehr Text stehen: maximal fiinf
Zeilen Text pro Folie. Wichtig ist hier die gute Strukturierung der Folien
und gegebenenfalls die Arbeit mit Liickentexten (man lasst Worter weg,
sodass der Teilnehmer das Wort selbst ergdnzen muss).

® Projekt- und Beratungspréasentationen: Das Ziel dieser Art Prisenta-
tionen ist die umfangreiche Dokumentation des Projekts oder der Bera-
tung. Da es sich hier nicht mehr um eine klassische Vortragsprasentation
handelt, sondern um eine Informationssammlung, konnen die Folien
sehr viel Text umfassen. Die Textmenge ist unbegrenzt, die Obergrenze
bildet jedoch die lesbare Schriftgréfde. Ein Ausdruck der Prisentation
sollte am besten vor der Live-Prasentation an die Teilnehmer verteilt wer-
den, damit sie sich einlesen konnen.

Aus diesen Beispielen lassen sich zwei Regeln ableiten, anhand derer man
die Textmenge bestimmen kann:

1. Je emotionaler ein Thema besetzt ist oder je deutlicher es dabei um die
sogenannten Soft Skills (»weiche« Faktoren) geht, z.B. im Bereich der
Personlichkeitsentwicklung, desto weniger Text darf auf der Folie ste-
hen. Meine Empfehlung: gar kein Text oder maximal ein Satz.

2. Je mehr die Prasentation einer Dokumentation dhnelt, desto mehr Text
darf auf den Folien stehen. Die Obergrenze der Textmenge ist durch
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die Schriftgrofse bzw. Lesbarkeit bestimmt. Eine Prasentation mit viel
Text sollte jedoch vor der Live-Prasentation an die Teilnehmer ausgeteilt
werden.

Textmengen
Dokumentation — Prasentation

Text- viel Text
menge

wenig Text

Présentation

Dokumentation

Der zweite Ansatz fiir die Bestimmung der Textmenge orientiert sich am
Fokus. Es geht dabei darum, worauf oder auf wen die Aufmerksamkeit des
Publikums gerichtet wird: auf den Vortragenden oder auf die multimediale
Préasentation. Worauf soll sich der Zuschauer konzentrieren? Soll er lesen
oder dem Referenten zuhoren?

Bei sehr vollen Folien sieht das Szenario im Normalfall so aus, dass alle
Zuschauer zu Beginn einer Prasentation den Text »brav« lesen, aber dem
Referenten nicht richtig zuhéren. Da Zuhoren an sich aber einfacher und
bequemer ist, horen sie im Laufe der Prasentation mit dem Lesen auf und
konzentrieren sich nur noch auf das Zuhoren. Haufig tritt noch ein weiterer
Effekt auf: Werden auf den Folien alle Texte gleichzeitig angezeigt, lesen die
Zuschauer sie durch und sind dann gelangweilt, vor allem wenn der Refe-
rent jede Zeile noch einmal vorliest.
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Die Rede nicht als Prasentationstext verwenden

Kirzen Sie die Texte auf Ihren Folien, und tragen Sie den Rest miind-
lich vor. Die Langfassung des Texts bzw. Ihr Redemanuskript kdnnen
Sie, wenn notig, auch in die Notizen packen.

In der Prasentationslehre herrscht dariiber Einigkeit, dass der Referent
wichtiger ist als die visuelle Prasentation. Der Fokus sollte also weitestge-
hend auf den Referenten gerichtet sein. Die Prasentation dient der medialen
Unterstiitzung und soll die Zuschauer vor allem auf der visuellen Ebene an-
sprechen. Der zweite hier vorgestellte Ansatz zur Bestimmung der Textmen-
ge arbeitet mit einer zeitlichen Begrenzung fiir die Darbietung einer Folie.
Es gilt die 20-Sekunden-Regel: Eine Folie oder Informationseinheit muss in
maximal 20 Sekunden von den Zuschauern verstanden werden kénnen, da-
mit der Referent im Vordergrund steht und wahrgenommen wird.

Die 20-Sekunden-Regel

Text- viel Zeit
menge

wenig Zeit

Prasentation

max. 20 Sekunden
pro Falie bzw.
Informationseinheit
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Der Ansatz beruht darauf, die maximale Aufmerksamkeit auf den Referen-
ten zu richten. Eigentlich bedeutet das sogar, dass die 20 Sekunden das Ma-
ximum sind - besser sind Werte zwischen 5 und 10 Sekunden. Eine Infor-
mationseinheit kann dabei zum Beispiel eine Zeile Text sein oder aus einem
Text und einem Bild bestehen. In diesem Zusammenhang wird auch noch
einmal deutlich, warum Texte gut lesbar sein sollten. Je schneller ein Zu-
schauer die Information aufnehmen kann, desto eher richtet er seine Auf-
merksamkeit wieder auf den Referenten. Wenn Sie Texte dagegen drehen
oder knallig bunt gestalten, erschwert das das Lesen und kostet damit Zeit.

Satze und Worter Worter nichtvon oben
nicht um mehr als 45 Grad drehen nach unten laufen lassen

ganz schwierig

ZmMmzO0 - 4=x—=™m4wvm>m

—Izrn—N—-n-nrnoxx—m—lbg

Sie haben zwei Ansétze kennengelernt, wie und wann Sie die Textmenge
begrenzen kénnen. Einige Referenten zeigen z. B. nur noch Stichworter, um
die Aufmerksamkeit moglichst rasch wieder auf sich zu lenken. Das hat al-
lerdings den Nachteil, dass Informationen und Handlungsaufforderungen
verloren gehen konnen. Dariiber hinaus héngt es mit dem Prasentationsstil
des Referenten zusammen, wie informativ die Folien sein miissen, und es
sollte im Einzelfall entschieden werden, was das Richtige ist.
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Sinnvolle Schriftgestaltung

Eine gute Schriftgestaltung in Prasentationen verlangt vor allem eines,
ndmlich eine gute Lesbarkeit. Stellen Sie sich vor, Sie sitzen in einem Raum
ganz hinten und koénnen von den Folien nichts erkennen. Im Normalfall
sind Sie ziemlich gefrustet und schalten vermutlich ab.

Lesbarkeit hidngt von verschiedenen Parametern ab, z.B. von Schriftart,
Stil, Grol3e und Farbe. Daneben spielt auch die Anmutung eine Rolle: Wirkt
die Schrift verspielt, sachlich, alt, innovativ?

In der Typografie werden zwei Schriftarten unterschieden: Serifenschriften
und serifenlose Schriften. Serifenschriften (z.B. Times New Roman) haben
an den Enden der Buchstaben oben und unten kleine »Fiildchen, die die Le-
serlichkeit fordern. Solche Schriften wer-
den héufig fiir langere Texte gebraucht.
Serifenlose Schriften (z.B. Calibri) dage- SerifenSChrift
gen haben diese Fiilchen nicht und sind
daher in ldngeren Texten schlechter les-

bar. Dafiir sind sie aber fiir Uberschriften Se rife n I ose SCh I"ift

und kurze Texte in Prisentationen besser

geeignet.

Gute Schriftarten fiir Prasentationen sind zum Beispiel:

® Verdana
® Tahoma
® Trebuchet
¢ Calibri

Die ersten drei Schriften haben den Vorteil, dass sie auf jedem Windows-PC
vorhanden sind. Die Calibri ist nur dann nutzbar, wenn mindestens Office
2007 installiert ist. Dieses Problem konnen Sie allerdings umgehen, indem
Sie die Schriftart zusammen mit Ihrer PowerPoint-Présentation speichern,
sie also einbetten. Der Vorteil: Sie haben die passende Schriftart immer
dabei und kénnen auch an fremden Computern »sauber« prasentieren.
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Die Schrifteinbindung hat jedoch einen kleinen Haken: Ihre Prasentation
braucht mehr Speicherplatz, was eventuell beim Mail-Versand Schwierig-
keiten bereiten konnte.

Einbettung immer neu einstellen

Die Schriftart wird nur in der jeweiligen PowerPoint-Datei eingebet-
tet! Wenn Sie eine neue Prasentation erstellen, ist die Option nicht
automatisch aktiv, und Sie mussen das Speichern der Schriftart neu
einstellen.

Die Funktion der Schrifteinbettung erreichen Sie iiber Datei » Optionen »
Speichern » Schriftarten in der Datei einbetten. Stellen Sie dort am besten
Alle Zeichen einbetten ein. Wenn Sie Speicherplatz sparen wollen, geniigt
die Option Nur die in der Prasentation verwendeten Zeichen einbetten. (In
PowerPoint 2007 finden Sie die Optionen, wenn Sie oben links auf die Of-
fice-Schaltflache und dann auf PowerPoint-Optionen klicken).

PmrPéinl-Dpliumn

Allgemeln

Dokumentprifung

Speichemn

Sprache

Erweitert

Mendbend anpassen

Symbolleizte flir den Schinellzugriff
Add-In:

Sicherheltscenter

o
H Speichermethode far Dokumente anpaszen.
Prisentationen speichern
Dateien in diesem Format speichern: PowrerPoint- Prasentation E‘
V] autowiederherstellen.Inf i speichern alle |10 % Minuten
[¥] Belm Schliehen anne Speichern dis lebrte autamatizch gespelcherte Verslon helbehalten
Dateispeicherort far Autoii tellen:  CA\Users\adminbAppData\R i \PowerPoi
Standardspeicherort: CUsers\AdmintDooumentsh,
Otflinebeaibeitungsoptionen 1lir Dateien auf dem Dokumentuverwallungsserver
Ausgecheckbe Deteien speichern ing .
Speigherort far Senerentwiirfe
@ Zwisch icher far Offic
Speicherort fir Serversnnwidfe: | CALL in\Doa kS Point-Entalinfes, Durchguchen.
o um i Dateien aul
| Data Fusammenty gsal srugen beim 2 L e
beim Freigeben dieser F 51 Frefteste-Teutfelder pab E
| schriftarten in dar Datei sinbettan
' Mur die in der Prasentation Zrichen einbetten fmum Red der Dateig

@ Alle Zeichen einbetten [rum Bearbeiten durch andere Personen)

Abbrechen |
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Ein weiterer Parameter fiir die gute Lesbarkeit eines Textes ist die Schrift-
grofSe, die in Punkt (pt) angegeben wird. Die optimale Schriftgrofe fiir Pra-
sentationen lasst sich mithilfe einer von mir entwickelten Naherungsformel
leicht berechnen. Die Formel bezieht sich auf serifenlose Standardschriften
wie die bereits genannten. Die Schriftgrof3e hangt demnach von zwei Para-
metern ab: von der Hoéhe der Projektionsfliche (Hohe der Leinwand bzw.
projizierten Fldche) und vom Abstand der Zuschauer in der letzten Stuhl-
reihe zur Leinwand. Die Formel lautet also wie folgt:

Abstand letzte Stuhlreihe zu Leinwand in m mal 4,8 pt geteilt durch Hohe der
Leinwand in m gleich Schriftgrofse in pt

Und hier zum Verstdndnis ein Beispiel fiir die Berechnung: Der Abstand
von der letzten Stuhlreihe betrégt 10 Meter, die Leinwand ist 3 Meter hoch.
Man rechnet also Folgendes: 10 m x 4,8 pt / 3 m. Das Ergebnis ist 16, d.h.,
eine Schrift in der Gré3e 16 Punkt konnte unter diesen Umstdnden gut ge-
lesen werden. Unterschreiten Sie diese Schriftgréf3e fiir den Text nicht. Die
Schrift des Titels kann weit groRer sein, zum Beispiel 24 Punkt.

Wenn Sie die Rdumlichkeiten nicht kennen, miissen Sie die Werte schéitzen.
Als Anhaltspunkt kann dann die Zuschauermenge gelten. Uberlegen Sie,
wie viele Personen in eine bestimmte Raumgrof3e passen. Wenn Sie z. B.
100 Personen erwarten, liegt die Raumgrof3e bei geschitzten 10 x 20 m,
der Abstand zur Leinwand betragt ca. 15 m, die Leinwandho6he etwa 2,5 m,
d.h., Sie rechnen 15 m x 4,8 pt / 2,5 = 28,8 pt. Nach meiner Erfahrung lie-
gen Sie mit Schriftgroflen zwischen 22 und 28 Punkt im Normalfall auf der
sicheren Seite.

Wenn Sie wiederkehrende Veranstaltungen in einem bestimmten Konfe-
renzraum planen, kénnen Sie natiirlich auch live testen. Lassen Sie sich
eine Folie mit verschiedenen Schriftgrof3en anzeigen, und finden Sie so die
optimale Grolse heraus. Dabei konnen Sie auch gleich noch iiberpriifen,
ob die anderen Parameter fiir die Lesbarkeit passen, z.B. die Schriftfarbe.
Als Vorlage konnen Sie dafiir einfach und komfortabel die Présentation
Sehtest.pptx von der beiliegenden DVD auf Thr Masterlayout {ibertragen.
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*Schriftgrofe 72 Punkt

*SchriftgroRe 60 Punkt

* SchriftgroRe 48 Punkt

* SchriftgroRe 36 Punkt

* SchriftgrofRe 28 Punkt

» Schriftgréle 24 Punkt
« Schriftgréfe 20 Punkt

+ Schriftgrofie 18 Punkt
*  Schriftgrofie 16 Punkt

= Schuiftgriifie 14 Punkt
. Schaifegrofle 12 Punky
= Schofigrohe 10 Purdt

Eine gute Lesbarkeit zeichnet sich vor allem dadurch aus, dass die Schrift
sich deutlich vom Hintergrund oder dem dahinterliegenden Motiv abhebt.
Das bedeutet: Wenn die Schriftfarbe hell ist, sollte der Hintergrund dunkel
sein und umgekehrt. Gestalten Sie Hintergriinde und Text sehr kontrast-
reich! Die Tabelle zeigt einige Beispiele fiir Farbkombinationen.

Schrift Hintergrund
Weif3 Dunkelgrau
Schwarz Beige
Dunkelblau Hellgelb

So einfach diese Regel ist, so schwierig kann ihre Umsetzung in der Realitét
werden. Denn ein Teil der Projektoren hat Probleme mit der Darstellung
des vollen Kontrastumfangs, wie es Laptops oder PC-Monitore konnen. Der
Beamer ordnet die »Fehlfarben« dann einfach einer anderen Farbe zu. Im
ungiinstigsten Fall unterscheiden sich die Schriftfarbe und der Hintergrund
dann kaum noch, d.h., der Text ldsst sich gar nicht mehr lesen. Mein Tipp
lautet daher: Testen Sie die Farben vor der Priasentation am Projektor aus.
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Uber die Lesbarkeit hinaus hat die Verwendung unterschiedlicher Farben
auch eine psychologische Wirkung. Studien belegen, dass bestimmte Farb-
kombinationen auch bestimmte Stimmungen erzeugen. Die Abbildung
zeigt einige Beispiele.!

Die beste Fernwirkung hat Die beste Nahwirkung hat
schwarze Schrift schwarze Schrift
auf gelbem Grund. auf weiRem Grund (Papier).

Weille Schrift auf blauem Grund Weil3e Schrift auf rotem Grund

wird als positives Signal wird als Verbots- oder
betrachtet. Achtungssignal betrachtet.

Rotgedrucktes erweckt den Eindruck von unwichtiger Information.

zu lesen und

!

desto unwichtiger erscheint

Eine zu grofde Anzahl an Schriftarten, -gréf3en und -formatierungen (Farbe,
Schnitt usw.) auf einer Folie wirkt sehr beliebig und ungestaltet. Orientie-
ren Sie sich daher lieber an folgenden Grundsétzen:

1. Benutzen Sie nur ein bis zwei unterschiedliche Schriftarten, z.B. eine
fiir den Titeltext und eine fiir den Flie3text (Inhalt).

2. Eine zusatzliche Schriftart konnen Sie noch fiir Sondereffekte verwen-
den, z. B. Hinweisschilder.

3. Beim Schriftformat (z.B. Farbe oder Schnitt) sollten Sie bei einem Stil
bleiben. Abweichungen, z. B. ein fetter oder kursiver Schriftschnitt, soll-
ten nur fiir hervorgehobene Textstellen gelten.

4. Definieren Sie feste SchriftgréfRen, z. B. eine fiir die Uberschrift, eine bis
drei fiir den FlieBtext und eine fiir Sondereffekte.

1 In Anlehnung an Eva Heller: Wie Farben wirken: Farbpsychologie. Farbsymbolik.
Kreative Farbgestaltung. rororo 2004.
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Im folgenden Beispiel habe ich die Schriftart Calibri fiir Titel und Inhalt ver-
wendet und die Sonderschrift Kristen ITC fiir besondere Effekte eingesetzt.

TitelUberschrift mit 44 Punkt

* Erste Ebene des FlieBtextes mit 32 Punkt

— Zweite Ebene mit 28 Punkt
* Dritte Ebene mit 24 Punkt

o Vierte Ebene mit 24 Punkt gonder-

» Flinfte Ehene mit 24 Punkt effexte

* Hervorhebungen in Fettschrift

Die Gestaltung und deren Wirkung unterliegen sehr deutlichen Trends. Din-
ge, die vor zehn Jahren sehr schick waren, konnen heute veraltet und riick-
stindig wirken (es sei denn, sie geh6ren wiederum zu einem Retro-Trend).
Bezogen auf das Thema Schrift heif3t das, dass 20 Jahre alte Schriften wie
Arial oder Times New Roman nicht nur technisch fehlerhaft, sondern inzwi-
schen auch aus der Mode sind und in einer aktuellen Prasentation nichts
mehr verloren haben. Nutzen Sie neuere Schriften wie Verdana, Tahoma,
Trebuchet oder Calibri, die dariiber hinaus technisch einwandfrei sind. Mit
der Calibri haben Sie zudem auch eine Schriftart, die gerade im Trend liegt.

Interpretation — Der Weg zur Botschaft

Sie haben in den vorangegangenen Abschnitten gelesen, dass Referenten
im Vordergrund stehen und Texte je nach Préasentationsart kurz gehalten
werden sollen. AuRerdem wissen Sie, dass Bilder schnell verarbeitet wer-
den konnen und dariiber hinaus weitere Vorteile besitzen (siehe dazu Ka-



Interpretation — Der Weg zur Botschaft

pitel 3, »Bilder pfiffig présentieren«). Was liegt also néher, als eine Technik
einzusetzen, um aus Texten ein Bild oder mehrere Bilder zu machen? Wenn
Sie Thre Botschaften in Bilder »libersetzenc, transportieren Sie die Botschaft
einer Folie besser und machen sie leichter merkbar. Das Vorgehen besteht
aus fiinf Schritten:

1. Legen Sie die Botschaft der jeweiligen Folie fest.
2. Schreiben Sie die Inhalte als Text auf die Folie.

3. Kopieren Sie den Text in die Notizseiten.
4

Reduzieren Sie den Text auf der Folie auf das Wesentliche — der Notizen-
bereich enthélt ja immer noch den vollstdndigen Text.

5. Uberlegen Sie, wie der Text auf der Folie aussagekriftig bebildert wer-
den kann.

Nun zeige ich Thnen diese Schritte noch mal im Detail anhand einer Bei-
spielprdsentation fiir den »EnterTrainer« Alexander Munke. Die folgende
Abbildung zeigt die Schritte 1 und 2, d. h., deren Inhalte und die gewiinsch-
te Botschaft wurden festgelegt. Die meisten Prasentationen horen an dieser
Stelle mit der Gestaltung auf — ein Verlust, wie sich im Folgenden zeigen
wird.

Ohne diese drei lauft nichts

» Als gute Fithrungskraft wissen Sie, dass die
folgenden Parameter zusammengehdren und
incinandergreifen:

— Verbindlichkeit
— Vereinbarungen
— Management

» Gibtes Probleme bei einem Parameter,
funktionieren die anderen auch nicht mehr,
und cs stockt iiberall.
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In den néchsten Schritten (3 und 4) werden die Texte gekiirzt. Letztlich
sind drei Worter besonders interessant, ndmlich Verbindlichkeit, Vereinba-
rung und Management. Der Rest des Textes wird in die Notizen iibertragen.
Dazu markieren Sie den Text, driicken + (], wechseln in die Notiz-
seite und driicken + [v]. AnschlieBend wird der Text auf der Folie
gekiirzt.

Ohne diese drei lauft nichts

» Verbindlichkeit
» Vereinbarungen
* Management

Nicht immer ist es sinnvoll, nur Stichworter auf der Folie zu nennen, denn
dadurch kann der Sinn verloren gehen. Im Beispiel wird der Sinn jedoch
mithilfe der Bebilderung wiederhergestellt.

Im Schritt 5 ist Kreativitat gefragt. Wir haben hier iiberlegt, wie man ein-
leuchtend zeigen kann, dass alle drei Parameter einerseits zusammengeho-
ren und andererseits miteinander »verzahnt« sind (unsere Interpretation
der Zusammengehorigkeit). So kam es zur Wahl der Zahnréder als Motiv,
das sehr plakativ darstellt, dass alles nur funktioniert, wenn alle Parameter
ineinanderlaufen. Um es noch plastischer zu machen, wurden die Zahnra-
der sogar animiert. Die Botschaft, ndmlich »das Zusammenspiel der drei
Fithrungsgrundséatze«, wurde damit bildlich untermauert und einpréagsam
gestaltet. Auf diese Weise wird aus einer textlastigen eine bildhafte Prasen-
tation.



Aufzdhlungen

Alexander Munke

Ohne diese drei lauft nichts

fv rt; \Ld['tﬁke't Er;a e;n;‘.ﬁt._
|Verbi g, TRARe l_’ /9 T
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" e

| Vefeinba rugen
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Aufzahlungen

Aufziahlungen mit klassischen Symbolen wie Spiegelstrich, Rechteck, Drei-
eck, Kreis und Raute sind der Standard in PowerPoint. Jeder Anfanger be-
ginnt damit, und Microsoft macht es leicht, mit diesen Symbolen zu arbei-
ten. Das Fatale daran ist, dass sich alle Prasentationen dadurch dhneln, die
Aufmerksambkeit der Zuschauer nimmt ab, und es entsteht wenig Abwechs-
lung und Spannung.

Der Profi weil3, dass er dieses Muster durchbrechen muss, um die Wirkung
der Prasentation zu verbessern. Er variiert die klassische Aufzdhlungsform
—etwa durch individuelle Aufzdhlungssymbole oder Text-Bild-Kopplungen.
Diese sollten immer kontextbezogen sein, d. h. zum Inhalt und/oder der Ge-
staltung einer Folie passen. In den folgenden Abschnitten finden Sie alter-
native Ideen fiir Textaufzdhlungen, mit deren Hilfe Sie Thre Présentationen
aufpeppen und ihre Wirkung steigern konnen.

Moderne oder kontextorientierte Aufzahlungssymbole kénnen zum Beispiel
ein Logo oder ein gezeichnetes Symbol sein. Das Aufzahlungszeichen (auch
Bullet) sollte immer in Zusammenhang mit dem Inhalt oder der Gestal-
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tung der Folie stehen (Kontextorientierung). Geht es in einer Prasentation
beispielsweise um Limonaden mit verschiedenen Geschmacksrichtungen,
konnen als Aufzdhlungszeichen die entsprechenden Friichte aufgegriffen
werden, z.B. Orangen, Apfel oder Zitronen. Fiir ein Fitnessstudio kénnten
Hanteln oder Gewichte verwendet werden. Bei einem Automobilzulieferer
bieten sich Ziindkerzen, Scheinwerfer oder Ahnliches als Motive an.

Nutzen Sie solche kreativen Extras jedoch sparsam, und setzen Sie sie sinn-
voll ein. Andernfalls wirken sie wie Spielerei, nutzen sich schnell ab und
lenken von der eigentlichen Prasentation ab!

Wihlen Sie nur Zeichen, die einfach zu erken- -
& Pfeil nach oben

nen sind. Komplexe Bilder als Aufzéhlungszei- £ PRIl fieGEral
chen bewirken eher, dass der Zuschauer sich %1 Pfeil nach unten
fragt, was das Zeichen eigentlich bedeuten Bd Option wird nicht gewahlt

soll. Denken Sie auch immer daran, dass die Option wird gewahlt

‘ , L Gliick

Zeichen ausreichend grof$ sein miissen, um er- ® Gliick
uc

kannt zu werden. Die entsprechenden Einstel- X Ungliick

lungen nehmen Sie iiber Start » Absatz » Num-
merierung und Aufzdhlungszeichen vor. Geben
Sie im Feld Gr6Re des Dialogs »120%« bis »150%« ein, dann sind die Zei-
chen ausreichend grof3.

Natur
Natur (lat. natura, von nasci,
»entstehen, geboren werden«)

" bezeichnet alles, was nicht vom
Menschen erschaffen wurde

Begriff wird heute oft widerspriichlich
verwendet '

Das Thema wird hier durch ein Blatt symbolisiert. Wichtig ist, dass das Aufzdh-
lungszeichen gut zu erkennen ist.
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Ihr Logo als Aufzdhlungszeichen verwenden

Sie konnen beliebige Grafikformate als Aufzédhlungszeichen verwenden, am
besten eignen sich jedoch .png-Dateien, denn diese kdnnen transparente
Bereiche enthalten und fiigen sich damit harmonischer in die Folie ein.

Vorteile unserer Praxis

e
AN

“% 24 stunden Rufbereitschaft

- bestens ausgebildetes Personal

Y,

v

-

" Behandlungen speziell fiir Sduglinge

Auch das Logo einer Firma kann als Aufzdhlungszeichen dienen.

lhr Logo als Aufzahlungszeichen verwenden

In diesem Abschnitt zeige ich Ihnen, wie Sie Ihr Firmenlogo als Aufzéh-
lungszeichen nutzen und so Threr Prisentation eine individuelle Anmutung
geben.

1. Legen Sie eine neue Prisentation bzw. eine neue Folie an. Geben Sie
einen Titel sowie ein paar Zeilen Inhaltstext ein, und fiigen Sie ein Logo
hinzu (Einfiigen » Bilder » Grafik). Sie konnen auch mit der Beispieldatei
Aufzdhlungszeichen_Modern.pptx arbeiten, die Sie auf der beiliegenden
DVD finden.

2. Um das Logo einzufiigen, markieren Sie alle Zeilen, klicken mit der
rechten Maustaste darauf und wéhlen aus dem Kontextmenii Aufzah-
lungszeichen » Nummerierung und Aufzdhlungszeichen.
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Im Dialogfenster klicken Sie auf die Schaltflache Bild. Ein weiteres Dialog-
fenster namens Bildaufzdhlungszeichen offnet sich. Hier klicken Sie auf Im-

portieren.
’Nummerierung und Sufzahlungszeichen ' Iil
[Bitdsufzshiungszeichen Co )|
Ik cichions | .
* o — ® | [¥inhale von Office.com einschiiefien
Kein(e) L o - . -
. O - = :I
g — DO » v — ™ -
P poe— DO » r—
— B ) — v —
Grofe: 100 ._:.. % von Text
Earbe Anpassen...
Zuriicksetzen E Abbrecher -‘. | |
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Im néchsten Fenster, Clips zum Organizer hinzufiigen, wéhlen Sie die Grafik-
datei mit Threm Logo aus und bestatigen die Wahl mit Offnen.

| 2] Clips zurm O'rgan'izer-.h'{nzuf.iigen
{ 'U [E » Bibliotheken » Bilder » ~ [ 44 ][ sitder durchsuchen A
[ Bildaufzshlungszeichen [
Organisieren « Meuer Ordner =] - f i =
Text suchen:
[B] Micrasoft PowerPaint — Bibliot.. Anordnen nach: Ordr [¥] Inhalte von Office.com einschiefien
w0 Favoriten - |
M Desktop
4L Downloads "
E.: Zuletzt hesucht i
L
M Desktop Beispielbilder MP Naviga
A Bibliotheken |
|| Bilder |
=| Eigene Bilder |
Eiffertliche Rilder ~| (R = -
Clipname: LOGO.png ~ |Alle Clip Organizer Dateitype
Tools = Hinzufiigen lv Abby llmportieren... I I [ol's I l Abbrechen

Wahlen Sie daraufhin das Logo iiber den Dialog Bildaufzdhlungszeichen aus,
bestitigen Sie die Wahl mit OK, und klicken Sie im folgenden Dialog wieder
auf OK.

Das Ergebnis sehen Sie in der folgenden Abbildung.

Moderne Aufzahlungszeichen @

@ miissen kontextorientiert sein
@ dirfen nicht wie Spielerei wirken
@ schaffen Abwechslung

@ bringen Spannung
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Smileys als Aufzahlungszeichen einfligen

Smileys als Aufzdhlungszeichen helfen Zuschauern, die Tendenz einer Aus-
sage schneller zu erkennen. Achten Sie dabei jedoch darauf, nur wenige
verschiedene Farben zu verwenden, damit es nicht zu spielerisch aussieht.
Mit Smileys kénnen Sie zum Beispiel zeigen, was gut, was neutral und was
negativ war.

1. Duplizieren Sie die Folie mit dem vorherigen Beispiel, und klicken Sie in
die erste Zeile. Driicken Sie die rechte Maustaste, und wihlen Sie erneut
Aufzahlungszeichen » Nummerierung und Aufzdhlungszeichen aus dem
Kontextmenii. Danach klicken Sie auf die Schaltfliche Anpassen, um in
den Dialog Symbol zu gelangen. Wéhlen Sie hier als Schriftart Wing-
dings und als Zeichen das lachende Smiley. Anschlief3end bestétigen Sie
beide Dialogfenster mit OK.

ymbol
Schriftart: Wingdings [+]

#<]3da] ol ¢ |'8|o|==|E] e
=B 2|0 e B =& @ e
BRI C BE R R EEE
o ||| b e |m|x|Glo||#ly TG M
Zulstzt verwendste Symbole:
1l1lelelglole|™|t]z2]<]|2]+|x]=|pu|a

Wingdings: 74 Zeichencode: |74 won: | Symbal (dezimal) E

[ oK ] ’ Abbrechen J
,{

2. Klicken Sie dann in die zweite Zeile, und klicken Sie sich wie zuvor
durchs Menii. Nun wéahlen Sie aber nicht das lachende, sondern das
weinende Smiley aus. Die dritte Zeile versehen Sie dann mit einem neu-
tralen und die vierte wieder mit einem lachenden Smiley.



Smileys als Aufzdhlungszeichen einfiigen

Smileys als Aufzahlungszeichen

© missen kontextorientiert sein

@ dirfen nicht wie Spielerei wirken
© schaffen Abwechslung

© bringen Spannung

P

3' Bis jetzt sind die Smlleys Nummeﬁemng und &ufzihlungszeichen ﬂ
schwarz-weil}. Wenn die Zu-

Aufzahlungszeichen i_uu-nmagiaung
schauer noch schneller er-

kennen sollen, was gut oder e e .
schlecht ist, konnen Sie die Kein(e) . ; .
Smileys noch zusatzlich ein- ¢ — - -

farben. Klicken Sie dazu ein-
fach jede Zeile an, und rufen
Sie erneut den Dialog Num-
merierung und Aufzdhlung

. .. ERer | [ 1 Text 5

auf. Dort wihlen Sie im Feld Gobe: (100 [=f *YORTEX Bid...

. . .. q v
Farbe beispielsweise Griin fiir Barbe [-ﬁ‘? | Anpassen...

.. . Automatisch |

das lachende, Rot fiir das wei- —— Il Actomatisc

. Zurichse pesignfarben 1 CK ‘ [ Abbrechen ]
nende und Grau fiir das neut- E EEEEEEN

rale Smiley.

4. Vielleicht ist IThnen aufgefal- o I I I I I u I L

" Standardfarben |
len, dass der Abstand des Auf- am EEEEEE

zahlungszeichens zum Text
mitunter sehr knapp ist. Um
das zu dndern, miissen Sie
den Einzug anpassen. Blenden Sie dazu zunéchst das Lineal ein (iiber
Ansicht » Anzeigen » Lineal), und verdndern Sie dann den Einzug mit-
hilfe der Schieberegler. Ziehen Sie den unteren Regler mit gedriickter
Maustaste nach rechts und den oberen nach links.
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Kopplung von Text und Bild

Text-Bild-Kopplungen heben sich erfrischend von den klassischen Aufz&h-
lungsformen ab. Anstelle von Aufzdhlungszeichen werden gleich ganze Bil-
der oder Zeichnungen verwendet. Diese werden libersichtlich auf der Folie
angeordnet, z.B. im Kreis, und mit Text verkniipft. In den folgenden Bei-
spielen sehen Sie, dass immer ein Text zu einem Bild gehort. Die gesamte
Folie wirkt dann besonders gut, wenn die Bilder mit ihren Texten jeweils
nacheinander eingeblendet werden (vgl. dazu die Prasentation Text-Bild-
Kopplungen.pptx auf der beiliegenden DVD). So baut sich die Folie langsam
auf, was Spannung erzeugt und die Informationen gut nachvollziehbar
macht.

Naturlichkeit

Da jeder Orangen kennt, kann der Text das Bild tiberdecken. Durch eine
Abschrdgung hebt sich der Text jedoch kontrastreich ab.



Kopplung von Text und Bild

Ein Apfel besteht aus ...

Das Bild des Apfels wurde in Einzelteile zerlegt (siehe Kapitel 3, »Bilder pfiffig
prisentieren«), und der Text wurde in rechteckige Felder geschrieben, die hinter
dem Apfel liegen.

Gesunde Ernahrung

Erdbeeren

Zitronen

Vier Kreissegmente wurden jeweils mit einem Bild gefiillt. Der Text steht in
Rechtecken hinter den Kreissegmenten.
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trailer image business

unsere _
Produkte §

lizenz consulting | signal internet

In diesem Business-Portrdt wurden die Texte durch Bilder und Symbole
verstdrkt.

Texte und Bilder koppeln

1. In diesem Beispiel erstellen wir eine Text-Bild-Kopplung mit einzelnen
Text- und Bildelementen. Das hat den Vorteil, dass die Elemente spater
einmal sehr leicht animiert werden konnen.

2. Legen Sie fiir dieses Beispiel zunichst eine neue Présentation bzw. eine
neue Folie mit dem Layout Nur Titel an (Start » Folien » Layout » Nur Ti-
tel) an. Schreiben Sie »Produkteigenschaften«in das Titelfeld, und blen-
den Sie mit + die Fiihrungslinien ein.

3. Ziehen Sie mit gedriickter [ ¢ ]-Taste eine kreisférmige AutoForm auf der
Folie auf. Sie finden diese Formen tiiber Start » Zeichnung » Formen »
Standardformen » Kreis (in PowerPoint 2007 hiel die Form noch Torte,
und so sieht das Symbol auch eher aus). Verschieben Sie den Mittelpunkt
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des Kreises mit gedriickter Maustaste genau auf den Schnittpunkt der

Fiihrungslinien.
Zeichentools
Irmprésentation Uberpriifen Ansicht Add-Ins Format
e 11§} Textrichtung - GCENNOI@ Dl_—l |_ 4
S | gE j’
[ 5] Test ausrichten oOAL Lk - H = =
— Anordnen Schneliformat-
= T2In smarthrt korvertieren = || eyttt A - worlagen = =
Absatz | Zeichnung

‘|-12-|‘\-|-1|J-|-|-|-B-|‘\-|-E|-|-\‘|-4-|-\-|-2-|-\‘|-EI-|-|‘\-2-|-|-\-4-|-|‘\-6-|-|-\-8-|-|-|1D-|-|-\-12-||

Produktei nschaften

@

4. Um nur ein Viertel der »Torte« anzuzeigen, klicken Sie den
Rautenmarker an (die gelbe Raute am hochsten Punkt des
Kreises) und ziehen ihn mit gedriickter Maustaste nach links
unten, bis nur noch ein Viertel des Kreises iibrig ist. Arbeiten
Sie an dieser Stelle sehr genau. 3

Zoom

Wenn Sie den Kreis oder ein anderes Element anklicken und tiber
die Zoomfunktion vergroRern, wird die Ansicht automatisch immer
so vergrollert, dass dieses Objekt im Fokus bleibt.
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5. Klicken Sie dann diesen Viertelkreis an, und drii-
cken Sie + (D], um das Stiick zu duplizie-
ren. Legen Sie das neue Viertel biindig auf das
erste, sodass beide Formen deckungsgleich sind.
Die Fithrungslinien helfen Ihnen dabei, denn sie
»ziehen« das Viertel quasi an.

6. Drehen Sie nun das neue Viertel mithilfe des
Drehmarkers (der griine »Knopf« iiber dem
Kreis) um 90° nach rechts, um den Kreis mit
Vierteln zu fiillen. Genauso machen Sie es mit
den letzten beiden Vierteln.

7. Sobald der Kreis vollstindig ist, markieren Sie
das rechte obere Viertel. Wahlen Sie iiber Zei-
chentools » Format » Formenarten » Fiilleffekt »
Bild das Bild mit dem Feuer aus (die Datei Feuer.
jpg finden Sie auf der beiliegenden DVD), und
bestatigen Sie die Auswahl iiber die Schaltflache
Einfligen.

8. Fiir das obere linke Viertel wihlen Sie auf die
gleiche Weise das Bild Himmel.jpg, fiir unten
links das Bild Wasser.jpg und fiir unten rechts das Bild Rutschfest.jpg aus.

9. Um die Darstellung noch ein wenig zu verschénern, markieren Sie alle
Viertel, indem Sie mit gedriickter linker Maustaste einen Rahmen iiber
alle Viertel spannen und die Maustaste loslassen. Der Markierungs-
rahmen sollte um ca. 30% groller sein als der Kreis. Wahlen Sie {iber
Zeichentools » Format » Formenarten » Formkontur die Einstellung Kein
Rahmen. (In PowerPoint 2007 heifRt der Punkt Keine Gliederung). Uber
Zeichentools » Format » Formenarten » Formeffekte » Abschragung for-
matieren Sie dann alle Viertel als Kreis.
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Entuurt Uberginge Animationen Bildschirmprédsentation Uberpriifen Ansicht Add-Ins Format Format
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icken Sie, um Motizen hirzuzuflgen By Weitere 3D-Einstellungen...

o0

10. Nun miissen Sie noch vier zu den Vierteln passende Texte einfiigen.
Ziehen Sie dafiir zunéchst {iber Start » Zeichnung » Formen ein Recht-
eck auf. Kopieren Sie es dreimal ([Strg] + (D]), und verschieben Sie
die Rechtecke an die entsprechenden Stellen. Schreiben Sie anschlie-
Bend folgende Texte in die Rechtecke (dazu einfach das Rechteck an-
klicken und lostippen):

e windstabil
® feuerfest
® wasserdicht

e rutschsicher
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Produkteigenschaften

windstabil d « 4 feuerfest

wasserdicht % ‘,‘ g ' rutschsicher

1.

12.

Nun formatieren Sie die Textfelder noch. Markieren Sie dazu alle
Rechtecke (am besten, indem Sie jedes Rechteck mit gedriickter
(Strg]-Taste anklicken). Uber Start » Zeichnung » Schnellformatvorla-
gen wihlen Sie einen Effekt aus, z. B. Intensiver Effekt — Akzent 6. Legen
Sie die Rechtecke iiber Start » Zeichnung » Anordnen dann hinter den
Kreis (mit der Option In den Hintergrund). Stellen Sie dariiber hinaus
eine geeignete Schriftgrof3e ein, z. B. 24 Punkt.

Zum Schluss konnen Sie alle Rechtecke und Viertel markieren und
ca. 1 cm nach unten verschieben, um sie etwas mittiger auf der Fo-
lie zu platzieren. Deaktivieren Sie die Fiihrungslinien, indem Sie

+ driicken.



SmartArts statt Aufzihlungszeichen

Produkteigenschaften

windstabil ; . feuerfest

wasserdicht S rutschsicher

Anstelle von Text-Bild-Kopplungen konnen Sie auch Text-Video- oder Text-
Animations-Kopplungen verwenden. So etwas bietet sich an, wenn Sie etwa
fiir eine Messeprédsentation besonders ausdrucksstarke Folien einsetzen
wollen, um Besucher an Ihren Stand zu ziehen. Bei anderen Présentations-
arten sollten Sie jedoch eher darauf verzichten, da diese Methoden oft als
Spielerei aufgefasst werden.

SmartArts statt Aufzahlungszeichen

Mit SmartArts haben Sie eine fantastische Méglichkeit, von der klassischen
Textaufzdahlung wegzukommen und interessantere Alternativen zu gestal-
ten. In der klassischen Priasentationslehre werden SmartArts auch als Struk-
turgramme bezeichnet. In der Version PowerPoint 2003 hief3en sie schema-
tische Darstellung. Allerdings gab es in der 2003er-Version lediglich sechs
verschiedene Darstellungsarten, ndmlich Zyklus, Radial, Venn, Pyramide,
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Zieldiagramm und Organigramm. PowerPoint 2007 stellt schon ca. 110
SmartArts zur Verfiigung, und in der 2010er-Version sind es bereits iiber
200, was die wachsende Bedeutung der SmartArts widerspiegelt.
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In der folgenden Tabelle finden Sie eine Auflistung, wann Sie welches
SmartArt am besten verwenden konnen.

SmartArt-Typ Zweck

Liste Nicht aufeinander aufbauende Informatio-
nen anzeigen

Prozess Schritte in einem Prozess oder auf einer
Zeitachse anzeigen, d. h. aufeinander auf-
bauende Informationen

Zyklus Einen kontinuierlichen Prozess anzeigen

Hierarchie Entscheidungsstruktur anzeigen, Organi-
gramm erstellen

Beziehung Verbindungen veranschaulichen

Matrix Anzeigen, wie sich Teile auf ein Ganzes
beziehen

Pyramide Anzeigen von abhangigen und proportiona-
len Beziehungen

Grafik Auswahl von SmartArt-Typen, in die man

(nur in PowerPoint 2010)

Grafiken bzw. Bilder einbinden kann

Die im Folgenden gezeigten Beispiele finden Sie auch auf der beigelegten
DVD als Datei SmartArt-Beispiele.pptx.



SmartArts statt Aufzihlungszeichen

Die drei Wirkungsverstarker

Ansprechende
Visualisierung

Spannende Interessante
Dramaturgie Rhetorik

Professionelle

(’sentationen

Beispiel fiir das SmartArt »Zusammenlaufendes Radial« aus der Gruppe
»Beziehung«

Qualitat ist Ubergreifend

e

' Produkt- | Preis- [ | Service- / 1\ . [ | Produkt-
| s | trans- zuver- | | kenn-
qualitat | schutz

parenz . ldssigkeit ' . zeichnung

Beispiel ftir das SmartArt »Lineares Venn« aus der Gruppe »Beziehung«
Im néchsten Beispiel wurden zwei SmartArt-Grafiken {ibereinandergelegt:

links Vertikale Formel aus der Gruppe Prozess, rechts Vertikale Aufzahlung
aus der Gruppe Liste.
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Ursache und Wirkung

Spannende
Dramaturgie
nachhaltige Erinnerung

Ansprechende ( Professionelle )haheAufmerksamkeir

Visualisierung " Prasentationen

bessere Zielerreichung

Interessante
Rhetorik

Die letzte Abbildung dieses Abschnitts zeigt das SmartArt Zusammenlau-
fendes Radial aus der Gruppe Beziehung. Uber SmartArt-Tools » Entwurf »
SmartArt-Formatvorlagen » Farben dndern lasst sich die farbliche Darstellung
von SmartArts komfortabel &ndern.

Qualitatskriterien

Datenschutz
Service- — Produkt-
zuverlassigkeit kennzeichnung

Preis- Qualitats- Produkt-
transparenz \ kriterien | qualitat

\ .

\ /

W, \d///
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SmartArts formatieren

Das folgende Beispiel zeigt Thnen, wie Sie SmartArts auf einfache Art und
Weise optisch anpassen und aufwerten kénnen.

1.

SmartArts formatieren

Legen Sie zundchst folgende
Ausgangsfolie mit dem Layout
Titel und Inhalt an, oder laden
Sie die Prasentation SmartArts.

SmartArts

* (ber 200 SmartArts in PowerPoint 2010

. verflighar
pptx von der beiliegenden DVD. - _ L ]
* weitere gibt es zusatzlich online
Um diese einfache Aufzihlung * Vorteil: interessantere Folien

in ein SmartArt zu konvertieren,
klicken Sie auf den Textrahmen,
oder markieren Sie alle Textzeilen. Uber Start » Absatz » In SmartArt
konvertieren konnen Sie sich eine Vorauswahl an SmartArts anzeigen
lassen. Fiir eine Vorschau fahren Sie einfach mit der Maus iiber die ein-
zelnen Varianten. Wahlen Sie schlieflich mit einem Klick Vertikale Auf-
zahlung aus.

Bildschirmprasentation Uberprirfen Ansicht  Acrobat Farmat

sz, I Tetrichtung ENNOO0O D—\ |'*w SrFullefrert - @4 Suchen
T EdTedt ausninten v A1LL=28 |- j 2 Formbontur = | 35 Ersemzen -

Annldnen Schneliformat: —
3210 Smartrt kenvertieren =| | % S {3 A= yorlagen~ =) Formeffekte v | [ Harkieren =

-~ 2| Bearbeiten

= E A7 18 1 19 2000 2100 2240 2301 Y

Q.
" e
[

aa._ ¢ mas

QQEHH@@

T Weiters SmartArt-Grafiken...

AN

Absaf

W ([0 b

Uiber 200 SmartArts in PowerPoint 2010
verfugbar

weitere gibt es zuséatzlich online
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3. Nachdem Sie sich fiir ein SmartArt entschieden haben, erscheinen zwei
zusatzliche Meniis (SmartArt-Tools » Entwurf und SmartArt-Tools » For-
mat); auBerdem sehen Sie links neben dem SmartArt ein Textfeld, mit
dessen Hilfe Sie schnell Anderungen am Inhalt durchfiihren kénnen,
z.B. Text korrigieren oder 16schen, ganze Zeilen 16schen, Aufzéahlungs-
punkte hoher oder tiefer stufen usw. Driicken Sie in diesem Textfeld
nach der dritten Zeile die [ < ]-Taste, und geben Sie dann »Fazit« ein —
das SmartArt wird erweitert.

SmartArts

Geben Sie hies Turen Text ein =
& G 200 St s i Porwarf o
gt
* wstes Gt e cusstgich ankne

otk e TR ROk
- Rl |

Uber 200 SmartArts in PowerPoint 2010 verfiighar

4. Klicken Sie dann mit der Maus in diese letzte Zeile, und driicken Sie ent-
weder einfach die (5, ]-Taste (Tabulator), oder wihlen Sie alternativ
SmartArt-Tools » Entwurf » Grafik erstellen » Tiefer stufen. Sie sehen die
Verdnderung unmittelbar in der SmartArt-Grafik.

tiber 200 SmartArts in PowerPoint 2010
verflighar

weitere gibt es zusatzlich online
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Die Grundstruktur des SmartArts verandern

5. Um das SmartArt nun noch zu formatieren, wihlen Sie SmartArt-Tools »
Entwurf » SmartArt-Formatvorlagen. Wiahlen Sie dort als Format bei-
spielsweise Abgesenkt aus, dann wirkt das SmartArt interessanter und

moderner.

& Nach oben -- -- : | \:'.'U BHB! ‘_u_ll!_l_wllll‘oillw

4 == 1=t =1 il — I ¥
= * | | S —

'_E=I2§:-§
SmartArts

tiber 200 SmartArts in PowerPoint 2010 verfligbar

Die Grundstruktur des SmartArts verandern

Das Ziel dieses Beispiels ist es, eine Folie mit einem SmartArt zu erstellen,
das einen Prozess darstellt. Normalerweise zeigt die SmartArt-Voreinstel-
lung den Prozess von oben nach unten an; wir wollen den Verlauf nun aber
umkehren. Das klingt sehr einfach, doch ist ein solches SmartArt in Power-
Point nicht enthalten. Darum miissen wir es uns selbst »bauenx.

1. Zunichst legen Sie eine neue Folie an und wihlen als Layout Titel und
Inhalt (wie immer iiber Start » Folien » Neue Folie). Tippen Sie als Uber-
schrift »sWie ich die Dinge geregelt kriege« ein.
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St Enfegen  Enowr  Oberginae  Animotionen  Sischimprieriation  Uberorifen  Awict  edd
TN k) = T
EER S5 Zurticksetzen | =-
Einfagen FNDTiL;E' e ansinie | ¥ & D § abe - pu- (A= < o | Formen anordne
Zwischenabla., & Folien Schriftart Absatz Zeich
' (142 00 0 e CB e B e e U L U2 L O 2 e e e B B D12 ]
) [ = d
&
- Wie ich die Dinge geregelt kriege
=
H = Text durch Klicken hinzufligen
&
= d O
+
o
o

2. Klicken Sie dann auf das Symbol SmartArt-Grafik einfiigen im Platzhalter
Inhalt, und wahlen Sie im daraufhin erscheinenden Dialogfenster Pro-

zess > Vertikaler Prozess aus.

AEE T -
I alle =
5= Liste
e ] GEE T EEp oo
2:.? " -
Gin Herarchie Ose0es wias IDESES ENEmES i
ﬁ Beziehung
i ‘: -
: = Vo o0 Hi=e
A= Pyramide = v
vertikaler Prozess
3] .
S === — Higrmit zeigen Sie die Entwicklung oder die
- schrittabfolge einer Aufgabe, eines
=] Prozesses oder eines Workflows von oben
nach unten an. Dies eignet sich optimal Far
-“ “ Tek der Ebene 1, da der vertikale Platz
[ - - | [ begrenzt ist.
&= =1 >
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3. Tippen Sie folgende Texte in das Textfeld neben der SmartArt-Grafik
ein:

® Tun

e Uberpriifen

® Ordnen

® Durcharbeiten
® Erfassen

4. VergroRern Sie die Schrift so weit wie moglich, also auf ca. 24 bis 28
Punkt. Dazu klicken Sie einfach auf den Rahmen der SmartArt-Grafik
und driicken + (2] + [.]. Um die Schrift hingegen zu verklei-
nern, driicken Sie + (o] + [.]. Thre Folie sollte nun folgender-
malSen aussehen.

Wie ich die Dinge geregelt kriege

Geben Sie hier Thren Text ein 52

® Tun

» Uberpriifen
* Orcnen

« Durcharbeiten Uberpriifen
» Erfassen

Ordnen

Durcharbeiten

Erfassen

Vertikaler Prozess...

5. Wenn Sie genau hinschauen, sehen Sie, dass die Pfeile von oben nach
unten zeigen. Die Pfeile miissen also noch gedreht werden. Klicken Sie
dazu den untersten Pfeil an, halten Sie die [ « ]-Taste gedriickt, und mar-
kieren Sie auch alle anderen Pfeile. Klicken Sie dann mit der rechten
Maustaste auf den markierten Bereich. Uber Form formatieren » 3D-Dre-
hung im Kontextmenti stellen Sie den Wert Z unter Drehung auf »180°«
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ein und schlielfen den Dialog. Jetzt zeigen die Pfeile nach oben. Alter-
nativ konnen Sie auch GréRe und Position » GroBe » Drehung wahlen.

Fiung 3D-Drehung
Linsanfarbe

| Woreinst=bungen: o
Lind=nart
Schatten [ Preuna . §
Spisgelung B o4 E]
Leucheen und weicke Kanter 1 o % Iﬁ ’E}
3D-Format 4 e !.e) E]
| 30-Orehurg .

=T Geben Sie einen Wert zwischen 0° und 359,9° ein.
Bidkorrekburen
Text

BidFarbe ] Hlacher Text
Kinstlerischz Effekte | Objektposition
Zuschnedden Distanz vom Boden: 0Pt =
==
Fosition
Textfeld
Alernativbext

6. Zu guter Letzt verschonern Sie noch die Textboxen, indem Sie sie etwas
verbreitern. Dazu markieren Sie alle Textboxen und ziehen sie iiber ei-
nen der Markerpunkte breiter.

Wie ich die Dinge geregelt kriege
Tun
Uberpriifen
Ordnen
Durcharbeiten

Erfassen
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Der Einsatz von Zitaten

Wie Sie anhand dieses Beispiels gesehen haben, sind SmartArts auch nach-
traglich verdnderbar und bieten IThnen daher sehr viele flexible Méglichkei-
ten der Gestaltung.

Der Einsatz von Zitaten

Zitate sind ein beliebtes Mittel, um Botschaften zu transportieren. Die ein-
fachste Variante ware, den Text wie bei Zitaten iiblich in Anfiithrungszei-
chen zu setzen und so auf eine Folie zu bringen. Doch auch Zitate werden
mit einem zugehorigen Bild besser behalten. Bilder im Hintergrund unter-
stiitzen die Wichtigkeit der Aussage, Rahmen fiir Texte und Bilder schaffen
z.B. Klarheit und Stabilitat. Die folgenden Abbildungen zeigen einige Bei-
spiele dazu, wie man Zitate gekonnt in Szene setzt.

Vision

,Fenster bauen -
mit klarem Blick auf die

Zukunft

Die perfekte Symbiose: Das Dachfenster, um das es im Zitat geht, ist zugleich
der Bildrahmen, in dem der Zitierte zu sehen ist.
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i@shalb die Pfefferminzia."

Fritz und Elke Schmidt, seit 42 Jahren
bei der Krankenkasse Pfefferminzia

Diese sehr schlichte, sehr reduzierte Darstellung konzentriert sich klar auf die
Botschaft.
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Kapitel 3
Bilder pfiffig prasentieren

Die meisten Bilder in einer Priasentation wiirden besser wirken, wenn sie
passender ausgewahlt oder nachbearbeitet worden wiaren. Manchmal ge-
niigt schon eine richtige Auflésung bzw. Grol3e, und schon sieht das Bild
wesentlich besser aus. Auch die richtige Platzierung und eine klare Bildaus-
sage im Zusammenhang mit dem Folieninhalt spielen eine entscheidende
Rolle. Sie haben bereits in Kapitel 2, »Texte spannender gestaltenc, gelesen,
dass Bilder besonders wichtig fiir die Wirkung und Nachhaltigkeit einer
Préasentation sind. In diesem Kapitel lernen Sie nun, wie Sie Ihre Folien mit
den passenden Bildern ideenreich gestalten.
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Sie werden lernen, was Sie bei der Verwendung von Bildern grundsétzlich
beachten sollten und woher Sie Bilder {iberhaupt beziehen konnen. Wie Sie
die ausgewahlten Bilder bearbeiten und verdndern und sie dann richtig auf
der Folie platzieren, wird der nichste Schritt sein. Damit in Zusammenhang
steht auch, welche Moglichkeiten Sie iiberhaupt haben, Bilder interessant
darzustellen. Diese Frage werde ich anhand von verschiedenen Beispielen
klaren. Zu guter Letzt zeige ich Thnen noch zwei »technische« Aufgaben:
Wie »l6sen« Sie eine Person oder ein Objekt vom Hintergrund (freistellen),
um es vor einen beliebigen anderen Hintergrund legen zu kénnen? Und
wie komprimieren Sie die Bilder am besten, damit Sie Ihre PowerPoint-
Préasentation problemlos per E-Mail versenden konnen?

Die Auswabhl ist entscheidend

Sie wollen sicher wissen, wie man das Beste aus den Bildern einer Prisenta-
tion herausholt. Ein iberaus wichtiger Aspekt ist natiirlich die Bildauswahl.
Der andere wichtige Punkt ist die Bildgestaltung, auf die wir im Abschnitt
»Grundlagen der Bildgestaltung« ab Seite 116 noch zu sprechen kommen.

Gehen Sie zunéchst mal davon aus, dass ein Profi seine Bilder sehr genau
auswahlt und sie auch verdndert, wenn sie die Aussage der Folie bzw. Pra-
sentation nicht (geniigend) unterstiitzen. Um das passende Bild zu finden,
sollten Sie fiir sich folgende Fragen beantworten:

1. Was ist die Aussage bzw. Botschaft der Folie?
2. Welches Bildmotiv konnte diese Aussage unterstiitzen?

3. Wie und wo lésst sich ein solches Bild beschaffen (siehe dazu den Ab-
schnitt »Bildbeschaffung« ab Seite 112)?

4. Was muss gegebenenfalls am Bild gedndert werden, damit es interes-
sant, spannend und professionell aussieht?

Wenn Sie die Folie selbst erstellen, diirfte Thnen klar sein, was sie aussa-
gen oder welche Botschaft sie vermitteln soll. Wenn Sie die Prasentation fiir



Die Auswahl ist entscheidend

jemand anderen iiberarbeiten, versuchen Sie die Folie vorher wirklich zu
verstehen, oder wenden Sie sich fiir Riickfragen an den Auftraggeber.

Seien Sie kreativ, und sammeln Sie einfach erst mal Ideen (Brainstorming).
Dabei ist wichtig, dass Sie Bildideen nicht gleich bewerten, sondern einfach
wertneutral sammeln. Sobald Sie eine gewisse Anzahl beisammen haben,
beginnen Sie im zweiten Schritt mit der Auswertung. Beurteilen Sie die Bil-
der vor allem danach, welches die Botschaft aus Sicht der Zuschauer am
besten unterstiitzt. Reduzieren Sie die Ideensammlung auf maximal drei.
Gehen Sie dann zum néchsten Schritt iiber, der Bildbeschaffung (siehe den
Abschnitt »Bildbeschaffung« ab Seite 112).

Wenn Sie in einem Unternehmen arbeiten, das eine corporate-design-
konforme Bilddatenbank hat, werden Sie jetzt sagen, dass IThnen die Bilder
vorgegeben sind und Sie nicht viele Méglichkeiten haben. In diesem Fall
sollten Sie sich zumindest darauf konzentrieren, wie Sie die Bilder veran-
dern koénnen, um sie spannender und interessanter aussehen zu lassen.
Zum besseren Verstdandnis habe ich hier ein Beispiel angefiihrt, das in der
Prasentationspraxis haufiger vorkommt. Auf dem Chart ist die vereinfachte
Umsatzentwicklung eines Unternehmens zu sehen. Die Botschaft »Wachs-
tum« steht dabei im Vordergrund und wird durch das Bildmotiv unterstiitzt.

Wachsender Umsatz

2000 2007 2008 2009 2010 201
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Das Motiv fiir Wachstum kann z.B. eine Pflanze sein, ein Miinzstapel, ein
Stapel Geldscheine oder Ahnliches. Die Wahl ist natiirlich auch davon ab-
héngig, in welcher Branche die Présentation eingesetzt werden soll.

Die folgende Tabelle zeigt noch weitere Beispiele fiir mégliche Motive.

Aussage

Mégliches Bildmotiv

Sachen, Ideen, Dienstleistungen
usw. sind abhangig voneinander
oder hangen zusammen

Zahnrader, die ineinandergreifen,
Fischernetz,

gewebter Teppich,

Turmbau

»Wir haben ein individuell zusam-
menstellbares System.«

Baukasten mit einzelnen Bauele-
menten aus Holz, Kunststoff etc.,
Lego-Bausteine

Marktfihrer

Sportler, der sein Ziel erreicht (z.B.

Marathon-Laufer oder Radfahrer),
Siegertreppchen,
Berggipfel

»Wir liefern Qualitat.« Diamant oder Brillant neben dem
Produkt,

Glanzpunkt auf dem Produkt

»Wir sind serviceorientiert.« Butler mit weillen Handschuhen,
Silbertablett,
jemand, der einem Reiter aufs

Pferd hilft

Bildbeschaffung

Die Bildrecherche und -beschaffung (auf Neudeutsch auch Artbuying ge-
nannt) ist ein wichtiger Bestandteil der Erstellung einer professionellen
Présentation. Der erste Punkt, den Sie klaren sollten, ist das Budget. Wie viel
diirfen Sie gute Bilder kosten? Gerade wenn Sie Zeit sparen und dennoch
eine optimale Wirkung erreichen wollen, ist es sinnvoll, auf kostenpflich-



Bildbeschaffung

tige Angebote zuriickzugreifen. Professionelle Bilddatenbanken bieten Ih-
nen dann schnelle Suchfunktionen und einen umfangreichen Bildbestand.
Auch ohne Budget werden Sie natiirlich fiindig werden, allerdings miissen
Sie dann etwas mehr Zeit fiir die Bildsuche einplanen und kostenfreie Bild-
archive nutzen.

Ein zweiter wichtiger Punkt sind die Nutzungsrechte. Sie brauchen immer
zumindest die Freigabe desjenigen, der das Bild erstellt hat (z.B. der Foto-
graf). Manchmal brauchen Sie auch die Freigabe durch das Motiv: Wenn
zum Beispiel die Person, die auf dem Bild zu sehen ist, mit einer Verwen-
dung in einer Prasentation nicht einverstanden ist, diirfen Sie es nicht nut-
zen. Wenn Sie auf der sicheren Seite sein wollen, kldren Sie die rechtliche
Frage, bevor Sie ein Bild erwerben.

In diesem Zusammenhang mochte ich noch einen Hinweis zu den Begrif-
fen lizenzfrei und lizenzpflichtig einfiigen. Lizenzfreie Bilder konnen Sie frei
verwenden, d.h., Sie konnen sie in Threr Prisentation, im Internet, in einer
Broschiire, in einem Videoclip oder Ahnlichem einsetzen. Lizenzpflichtige
Bilder bezahlen Sie separat bei jeder Nutzung.

Einer der wichtigsten Punkte fiir den Einsatz von Bildern ist natiirlich deren
Qualitdt. Dazu gehort vor allem die Auflosung, also die Grol3e des Bildes.
Verwenden Sie fiir PowerPoint nur Bilder mit einer Mindesthéhe von 600
Pixeln, anderenfalls sehen sie unscharf (»verpixelt«) und damit unschén
aus.

BildgroRe
Die optimale Bildauflésung fuir den Einsatz in Prasentationen be-
tragt 960 x 720 Pixel.

Eine PowerPoint-Standardfolie hat ein Seitenverhiltnis von 4 zu 3 (25,4 cm
%X 19,05 cm). Wenn Sie ein Bild vollflachig auf die Folie legen mochten,
brauchen Sie eine Pixelauflésung von 960 x 720 Pixel. Die Information zur
Pixelgrof3e erhalten Sie, wenn Sie im Windows-Explorer mit der Maus iiber
den Dateinamen fahren: Ein sogenannter Quicktipp wird eingeblendet. Sie
konnen auch mit der rechten Maustaste auf die Bilddatei klicken und die
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Grof3e im Kontextmenii (mit Windows XP iiber Eigenschaften » Dateiinfo »
Erweitert, mit Windows 7 iiber Eigenschaften » Details » Bild) herausfinden.
Alternativ laden Sie das Bild einfach in PowerPoint und schauen, wie grof3
es im Verhéltnis zur Folie ist.

Wenn Sie Bilder iiber Dritte beschaffen wollen, z.B. Thre Marketingabtei-
lung oder eine Werbeagentur, kann es sein, dass Sie gefragt werden, welche
Auflésung das Bild haben soll. Meistens erwartet man dann einen dpi-Wert
von Thnen. dpi ist die Abkiirzung fiir Dots per Inch, also »Punkte pro Zoll«.
Bei einer DIN-A4-Seite geniigen 96 dpi.

Nach diesen Vorbemerkungen finden Sie hier nun einige Anregungen und
Hinweise zu Bildquellen. In der folgenden Tabelle habe ich zunéchst mal
vier Gruppen von Bildarchiven im Internet aufgefithrt. Sie unterscheiden
sich durch die GrofSe des Archivs, die Art der Bildmotive, die Suchqualitat
(Schnelligkeit und Suchergebnis) und den Preis fiir die Bilder.

URLs Besonderheiten Preise
pro Bild
www.gettyimages.de Die groRte Bilddatenbank der Lizenzfreie Fotos ab
Welt. Hier finden Sie zu fast 10,- £, lizenzpflichtige

jedem Suchbegriff ein Bild, zu Fotos ab 100,— €
Politik, Wirtschaft u.v.m. Die
Datenbank umfasst sowohl
lizenzfreie (LF) als auch lizenz-
pflichtige (LP) Bilder.

www.ccvision.de, Diese Datenbanken enthal- Zwischen 1,—€ und
www.mev.de, ten sehr schone Fotostrecken 100,—€
www.istockphoto.de, (Bildfamilien) und viele un-

www.fotolia.de terschiedliche Bildstile. Sehr

professionelle Bilder, gute
Suchergebnisse.

www.imagepoint.biz, Hierbei handelt es sich um klei- | Zwischen 1,—€ und
www.photos.com, nere Datenbanken mit weniger | 30,—€
www.shutterstock.com Auswahl.
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URLs Besonderheiten Preise

pro Bild
www.pixelio.de, Diese Datenbanken werden Zwischen 0,—€ und
www.photocase.de, meistens von Privatpersonen 5-€
www.freepixels.com, gespeist. Die Qualitat ist sehr

www.fotodatenbank.com | durchwachsen, die Auswahl
eher klein, die Suchergebnis-
se sind maRig. Daflr sind die
meisten Bilder kostenfrei.

Auch Suchmaschinen wie Google, Yahoo, MSN usw. bieten eine Bildersuche
an. So finden Sie meist schnell ein passendes Bild. So schnell und praktisch
diese Art der Bildsuche jedoch ist, so problematisch ist sie haufig auch. Oft
ist die Bildqualitit stark beeintrachtigt, die Auflésung zu gering und die
Nutzungsrechte sind nicht geklart. Aus professioneller Sicht féllt die Ent-
scheidung haufig gegen diese Bilder aus. Wenn Sie dennoch Suchmaschi-
nen nutzen wollen, kldren Sie auf jeden Fall die rechtlichen Aspekte. Mit ein
wenig Geschick finden Sie einen Urheber und kénnen diese Punkte direkt
mit ihm klaren.

Auch iiber Wissensportale wie Wikipedia findet man haufig Bilder mit Mo-
tiven, die von allgemeinem und o6ffentlichem Interesse sind, z.B. Gebaude
und Kultureinrichtungen oder auch Prominente. Der Vorteil: Diese Bilder
sind immer mit einem rechtlichen Hinweis zur Nutzung versehen. Wenn Sie
Gliick haben, finden Sie hier das eine oder andere Bild zum Nulltarif.

Sie kénnen natiirlich auch Fotos (Digitalfotos, Papierfotos, Dias etc.) oder
Zeichnungen aus Threm eigenen Archiv und von Verwandten, Freunden
oder Bekannten verwenden. Die Bilder haben einen hohen personlichen
Bezug und dariiber hinaus den Vorteil, dass sie passend erstellt werden kon-
nen. Lassen Sie sich dennoch eine schriftliche Freigabe fiir die Verwendung
des Motivs vom Fotografen und ggf. auch von den darauf abgebildeten Per-
sonen geben. Jede Person besitzt das Recht am eigenen Bild — von daher ist
die Einwilligung der abgebildeten Person sehr wichtig.
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Bilder lassen sich nicht nur knipsen, sondern auch mithilfe spezieller Soft-
ware erstellen, z.B. mit 3D-Programmen (wie 3dmax oder Cinema 4D)
oder Zeichenprogrammen (CorelDRAW, Adobe Illustrator, SmoothDraw,
Artweaver u.a.). Der Vorteil: Sie schaffen ein eigenes Werk, das einzigartig
ist und Thre Prasentation damit von vielen anderen abheben wird. Beden-
ken Sie allerdings auch, dass Sie fiir die Erstellung einige Zeit veranschla-
gen miissen.

Bei Business-Prasentationen sind schnell einige Hundert Euro fiir Bilder
aus Bildarchiven ausgegeben. Wenn Sie nur ein kleines Budget haben, ver-
suchen Sie, einen Fotografen auf Stunden- oder Halbtagsbasis zu buchen.
Ein Fotograf kann Ihnen einzigartiges Material produzieren, und dariiber
hinaus gewahrleistet diese Methode Thnen Rechtssicherheit. Gerade wenn
es um individuelle Fotos, ganze Bildstrecken oder einen bestimmten Bildstil
geht, ist der Fotograf aus meiner Sicht zu bevorzugen.

Grundlagen der Bildgestaltung

Nachdem Sie ein passendes Bild gefunden haben, lernen Sie in diesem Ab-
schnitt, es professionell und wirkungsvoll zur Geltung zu bringen. Dabei
gibt es einige Punkte zu beachten.

Der Bildstil beschreibt die Art und Weise, wie ein Motiv dargestellt wird.
Das lasst sich am besten mit einer Schrift vergleichen: Hier konnen Sie die
Schriftart (Times, Arial, Brush oder handgeschrieben), den Schriftschnitt
(z.B. kursiv oder fett), die Schriftfarbe und vieles andere einstellen. Bei ei-
nem Bild funktioniert das dhnlich. Ein Bildstil l4sst sich an vielen Dingen
festmachen, z.B.:

® BildgroRe
® Bildausschnitt (GrofSaufnahme, Nahaufnahme, Totale, Halbtotale usw.)
® Motivanschnitt

® Farbgebung



Den Bildstil festlegen

® Verhaltnis von Schirfe/Unschérfe
® Bildeffekte

Professionelle Priasentationen heben sich vor allem dadurch hervor, dass
sich ein Bildstil durch die gesamte Présentation zieht. Beispielsweise konnen
alle Bilder von den gleichen Farben dominiert sein. Oder denken Sie an Wer-
bespots oder -plakate, bei denen Sie sofort wissen, um welche Firma oder
welches Produkt es geht, ohne dass Sie sich die Details angeschaut haben
- Sie haben es lediglich aufgrund eines bestimmten Stils erkannt. Das heil3t
wiederum auch, dass sich Thre Prasentation bei den Zuschauern einpriagen
wird, wenn Sie dafiir einen eigenen Stil festlegen und ihm treu bleiben.

Den Bildstil festlegen

Mit PowerPoint konnen Sie sehr einfach einen Bildstil festlegen. Wie das
geht, zeige ich Thnen in diesem Abschnitt.

1. Legen Sie zunéchst eine neue Folie mit dem Layout Titel und Inhalt an.
Klicken Sie auf der Folienmitte auf das Symbol fiir Grafik aus Datei ein-
fugen, und suchen Sie sich ein Bild aus, beispielsweise das Bild Hohen-
salzburg.jpg von der beiliegenden DVD.

Titel durch Klicken hinzufligen

+ Text durch Klicken hinzufiigen

n7
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2. Wenn Sie das Bild anklicken, erscheint ein zusitzliches Meniiband Bild-
tools » Format, mit dessen Hilfe Sie das Bild weiter bearbeiten und ge-
stalten konnen.

(@9 00 -2

= = 3
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._jjj Kinstlerische Effekte = ‘[}i T = | 52 Bildlayout = E’QAuswambere\ch Sk - ras
Anpassen Bildformatvorlagen Ty Anordnen GriBe -

3. Uber Bildtools » Format » Bildformatvorlagen kénnen Sie den Bildstil also
ganz einfach verdndern. Hier finden Sie eine grofse Auswahl an vorge-
fertigten Bildformaten bzw. -stilen. Wahlen Sie zum Beispiel Gedreht,
weil. Schon haben Sie Thr Bild mit einem besonderen Effekt versehen.
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Bildstrecken

Bildstrecken

Bevor ein professioneller Fotograf iiberhaupt mit der Arbeit beginnt, defi-
niert er zusammen mit dem Kunden einen bestimmten Bildstil. Erst danach
finden die Fotoaufnahmen statt. Fotografen sprechen dann auch davon,
dass sie Bildstrecken erstellen. Bildstrecken eignen sich hervorragend fiir
die Gestaltung von Prasentationen, aber natiirlich auch fiir Broschiiren,
Homepages usw. Sie tragen zu einem einheitlichen und in sich schliissigen
Auftreten bei, was besonders bei Unternehmens- und Imageprasentationen
wichtig ist, denn diese sollen das Unternehmen nach aufSen hin reprasen-
tieren.

Das folgende Beispiel zeigt den Unternehmensberater und Marketingprofi
Christian Gortz (www.marketingtip.de), fotografiert von Gregor Pfitzer. Der
einheitliche Bildstil ist geprédgt von den Farben Grau, Silber, Schwarz und
Rot. Auflerdem sind Mobel, Accessoires, Requisiten, Lampen usw. modern,
aber dezent gehalten. Der Fokus liegt immer auf den Personen. Auch das
Gegentiber des Beraters tritt im gleichen Stil auf. Das Beispiel eignet sich
vor allem fiir Dienstleistungen und Beratungsunternehmen, denn der Stil
wirkt serios, kompetent, sachlich und wegen des Rots auch aktiv.
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Im zweiten Beispiel dieses Abschnitts zur Schmuckkunst von Zori Rosic (Fo-
tograf: Gregor Pfitzer) geht es darum, Anmut und Kreativitat zu zeigen. Die-
ser Stil zeichnet sich durch eine Kombination von Schérfe und Unschérfe
aus. Dieser Bildstil eignet sich beispielsweise fiir Endverbraucherprodukte
(Schmuck, Shampoo usw.), weil dadurch ein Highlight des Produkts her-
vorgehoben werden kann und die unwichtigen Details in der Unschérfe ver-
schwinden konnen.



Bildstrecken

)
Das néachste Beispiel verwendet Kieselsteine als Clear-Style Soft-Style
Metapher, und das in zwei Varianten, nadmlich
links im Clear-Style und rechts im Soft-Style.
Beide Stile eignen sich fiir Berufe in den Berei- .
chen Gesundheit, Coaching usw. oder fiir The- .
men wie Balance oder Ruhe. Der Clear-Style ist S
ein sehr klarer und reiner Bildstil. Dazu kénnen
beispielsweise ein weiller Hintergrund oder ‘ .
Bildelemente gehoren, die sehr scharf und da- .
mit deutlich abgebildet sind. Im Gegensatz dazu
wirkt der Soft-Style bei »weichen« Themen wie
Sanftheit oder Ausgeglichenheit sehr gut. Am -.
besten sollten Sie dafiir Pastellfarben und Duo- i
Tone (also Darstellungen mit zwei Farbtonen)
verwenden.

Das letzte Beispiel zeigt einen Stil aus Figuren und Objekten. Alle Objekte
sind computergeneriert und im Duo-Ton gehalten. Dieser Illustrationsstil
eignet sich z. B. fiir Prasentationen von IT- und Telekommunikationsunter-
nehmen, weil er technisch und modern wirkt. Mit solchen Objekten lassen
sich auch Abldufe und Prozesse besonders gut darstellen.
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Neben diesen Bildstilen gibt es zahlreiche weitere Moglichkeiten fiir Bild-
strecken, z. B. folgende:

® Fiir »schnelle« oder »sportliche« Themen kann man sehr gut Bilder mit
Bewegungsunschirfe einsetzen, die die Dynamik unterstreichen.

® Wenn man zeigen will, dass man genau hinschaut oder eine Sache sehr
genau nimmt, kann man Nah- bzw. Makroaufnahmen von Objekten ver-
wenden. Wenn Sie also Nahaufnahmen von Werkzeugen zeigen, wie z. B.
Lot oder Lineal, kann das mit Prazision, Bodenstandigkeit usw. assoziiert
werden.

Sie haben nun gelernt, was einen Bildstil oder auch eine Bildstrecke ausma-
chen kann. Nun konnen Sie zukiinftig bei Priasentationen, Broschiiren oder
Werbematerialien versuchen, einen Bildstil herauszufiltern.

Bildspannung

Prédsentationen leben von spannenden Bildern. Spannung kénnen Sie auf
verschiedene Arten erzeugen, z.B. durch ungewohnliche Bildmotive, unge-
wohnliche Perspektiven oder interessante Bildausschnitte:



Bildspannung

® Das Bildmotiv ist in dem Prasentationsumfeld ungewohnlich, z.B. die
Oberfldche eines Planeten im Zusammenhang mit Elektroprodukten
wie Steckdosen und Lichtschaltern, das schnellste Auto der Welt im Zu-
sammenhang mit einer Produktpréasentation iiber Waschmittel oder die
Fliigeloberflache eines Marienkéfers im Zusammenhang mit einer Unter-
nehmensprasentation eines Stahlkonzerns.

Beispiele fiir Bilder mit einer ungewohnlichen Perspektive wiren z. B. die
Makroaufnahme einer Orange, die Luftbildaufnahme einer Schafherde
oder die Weitwinkelaufnahme eines Fu3balltors.

Schon sehr lange ist bekannt, dass Bilder, die nach der Regel des Golde-
nen Schnitts aufgebaut sind, interessanter wirken. Eine Vereinfachung
dieser Regel ist die sogenannte 3er-Regel. Sie teilen das Bild in drei mal
drei gleich grolse Segmente ein, wie in der folgenden Abbildung zu se-

hen. Der Motivschwerpunkt muss an einem der Kreuzungspunkte liegen.
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Ein Bild mithilfe der 3er-Regel verbessern

Mithilfe der 3er-Regel konnen Sie Bilder spannender gestalten. Wie das
funktioniert, zeige ich Thnen in diesem Abschnitt.

1. Legen Sie zunichst eine neue Prisentation an, oder fiigen Sie eine neue
Folie ein. Laden Sie das Originalbild Hochzeitstorte.jpg! von der beilie-
genden DVD (iiber Einfiigen » Bilder » Grafik). Ziehen Sie das Bild mit-
hilfe der entsprechenden Marker auf, sodass es die volle Folienfldche
ausfiillt.

2. Um spiter den gewiinschten Bildausschnitt besser finden zu kénnen, le-
gen Sie als Hilfskonstrukt eine Tabelle in der Grofse 3x3 (drei Spalten,
drei Zeilen) tiber das Bild (indem Sie auf Einfiigen » Tabelle klicken).

1 Quelle: www.pixelio.de (Fotograf: Olga Meier-Sander)
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Ein Bild mithilfe der 3er-Regel verbessern

Bl 9= | madacs |
= : -
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Tabeile rafy t hat Fatasbum | F Hypetiind Ao Teutded I}

3. Klicken Sie die Tabelle am Rand an, und wihlen Sie iiber Tabellentools »
Entwurf » Tabellenformatvorlagen das Tabellenformat Keine Formatvorla-
ge, Tabellenraster aus.

Uberpriifen Ansicht Acrobat Entwurf Layout
e e e < &) SChattierung ~ & A -
E E B - [ rahmen|~ - 3m
S |~ Lein Rahmen -7 stiftfarbe -
matvorlagen H Alle Rahmenlinien 3 Rahmenlini
[ Eahmenlinien aufen
4 Rahmenlinisn innen

Rahmenlinie oben

Rahmenlinie unten

4. Andern Sie iiber Tabellentools » Entwurf » Rahmenlinien die Stiftfarbe
auf WeiB, Hintergrund 1 und die Stiftstarke auf 3 Pt, und klicken Sie dann
im Bereich Tabellenformatvorlagen auf Rahmen » Alle Rahmenlinien. Die
Tabelle sollte jetzt »durchsichtig« sein und weil3e Linien haben.
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5. Verindern Sie die Tabelle in Hohe und Breite (Tabellentools » Layout »
ZellengréRe), bis Sie den optimalen Bildausschnitt gefunden haben. Set-
zen Sie das zentrale Motiv — die Rose — spannend in Szene, indem Sie
einen der Kreuzungspunkte der Tabelle genau auf die Bliite legen.

6. Klicken Sie nun das Bild an, und wihlen Sie Bildtools » Format » Zuschnei-
den. Die runden Marker werden daraufhin rechteckig und schwarz. Kli-
cken Sie auf einen der schwarzen Marker, und verdndern Sie den Bild-
ausschnitt durch Ziehen mit gedriickter Maustaste. Schneiden Sie das
Bild genau auf die Tabelle zu.

E:-'".r.,u'.-..g‘_:_; oy = bt

add-Ins | Format o @

e '_J] Ebene mach varne = |- j_‘.|-I ‘;‘d 19,05 e *

- 24 Ebene nach hinten

Zuschneiden —
r '?_-'i',}Auswahlbereich Zh = o 24 m .
Anardnen Grfe
IR I A R B B S SR IR = I R RO I 1 N I Zuschneiden

[Cas Bild zuschneiden, um

-nemunSChte B




Ein Bild mithilfe der 3er-Regel verbessern

Hilfslinien nutzen

Falls Sie wahrend des Zuschneidens Probleme haben, sich an der
Tabelle zu orientieren, nutzen Sie die Hilfslinien (Sie blenden sie mit
+ ein). Verschieben Sie die Linien an die Tabelle, und be-
schneiden Sie das Bild genau bis zur Hilfslinie.

Loschen Sie die Tabelle
und ziehen Sie den Bild-
ausschnitt auf Folien-
grofe auf. Das Ergebnis
sieht dann aus, wie in
der nebenstehenden Ab-
bildung zu sehen.
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Helligkeit, Kontrast,

Funktionen der Bildbearbeitung

In diesem Abschnitt stelle ich Thnen Funktionen vor, die aus meiner Sicht
fiir die Bearbeitung von Bildern (in der PowerPoint-Sprache haufiger Grafi-
ken genannt) sehr wichtig sind. Zunéchst bekommen Sie jedoch eine kom-
plette Befehlsiibersicht.

Jedes Mal, wenn Sie ein Bild anklicken (markieren), erscheint ein zusatzli-
ches Menii: Bildtools, in dem eine Menge niitzlicher Funktionen zu finden
sind.

Rahmen definieren, Bildeffekte wie

Weichzeichner, Ein- Verschiedene
. g Schatten, 3D-Drehung
farbungen und Effekte vordefinierte
wie Kreidezeichnung o. A. Bildstile Bildlayout = SmartArt-Format fir Bilder
/ \ | |
Pld92-0 - B = Bildtools: (SR R
:‘ _37_»’_-_'77: Start Einfiagen Entwurf Uberginge Animationen! Bildschirmprasentation Uberpriifen Ansicht Add-Ins _Furmat_ & e
" & Knrfekturen' B’ S — N — gGrafikrahm“én' [y Ebene nach warne = |2+ E]“: 31 1805 an
- By Farbe - B | el A‘ —ed sl - < Bideffekte~ D Ebene nach hinten - 1] e "
Freistellen L ! 0 Zuschheiden = 254 qn *
_,_h;Kunstler\scheEffekte'dm* = %::Blldlayout' IEi}Auswahlberen:l’v Sh - o bof ul
\ Anpassen \ Bildformatworiagen » 4 Anordnen \GrﬁBe
\
Freistellen von Bilder komprimieren Tiefenebene GroBe und Zuschnitt
Personen, (GroRe der Prasentations- bestimmen; andern; Bildformen
Objekten usw. datei optimieren), Bilder Bilder auswahlen,
andern bzw. austauschen, ausrichten, z.B. Oval, Herz
Bild auf das Originalbild gruppieren
zurucksetzen und drehen,
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spiegeln usw.

Die erste hier vorgestellte Funktion (Bildtools » Format » Anpassen » Bild
zuriicksetzen — in PowerPoint 2007 heil3t der Befehl Grafik zuriicksetzen) ist
der kleine Bruder der bekannten und &duf3erst hilfreichen Funktion Riickgéan-
gig machen. Der Unterschied besteht darin, dass die Bildbearbeitung selbst
dann noch riickgéngig gemacht werden kann, wenn die PowerPoint-Datei
schon mehrmals gespeichert, geschlossen und geéffnet wurde. Mithilfe der
Funktion Bild zuriicksetzen wird das Bild also wieder in den Ausgangszu-
stand zuriickversetzt, also in den Zustand, in dem es beim ersten Mal in
PowerPoint eingefiigt wurde. Wenn das Bild danach eingefarbt, verzerrt,



Funktionen der Bildbearbeitung

gestaucht, gedreht oder verkleinert wurde, werden die Originalparameter
wiederhergestellt.

Wenn Sie die zum Befehl Bild zuriicksetzen gehorige [%g Bild zuricksetzen| ~|
Dropdown-Liste aufklappen, erscheint die Option, |4_ ..._ .
das Originalbild mitsamt seiner Originalgrof3e wie-
derherzustellen (Bild und GréRe zuriicksetzen, nur in
PowerPoint 2010). Bild zuriicksetzen hingegen 16scht alle Bildeffekte und
setzt Rahmen, Rahmenfarbe, Helligkeit, Kontrast etc. zuriick (die Grol3e
bleibt jedoch gleich).

‘m Bild zurticksetzen
g Bild und Gréke zuriicksetzen

= = 3

Um die Bildgrof3e iiberhaupt zu veridndern, ziehen o
15 Format @

Sie einfach mit gedriickter Maustaste einen der Bild- e ]
marker in die gewiinschte Richtung. Wenn Sie es sehr =, ISl

Zuschneiden :“ 254 cm o

genau nehmen, wihlen Sie Bildtools » Format » GréRe I_l
Gréne 8
(in PowerPoint 2007 in der Befehlsgruppe Schriftgrad = — -
zu finden) und geben dort die Breite oder Hohe des Die Breite der Farm oder des Bilds

andern,

Bildes in cm an. r =7

Mehr Details zur GroRe des Bildes, zu Drehung, Position usw. finden Sie,
wenn Sie den Dialogfeldstarter (den kleinen Pfeil unten rechts) in der Grup-
pe GroRe anklicken.

Um den Bildausschnitt eines Bildes zu verdndern, benutzen Sie die Funktion
Zuschneiden in der Befehlsgruppe GréRe. Sie erkennen den Zuschneide-Mo-
dus daran, dass die Marker des Bildes rechteckig und schwarz sind. Klicken
Sie einen Marker an, und verschieben Sie ihn mit gedriickter Maustaste.

Bild bleibt in OriginalgroRe bestehen

Solange keine Bildkomprimierung durchgefuihrt wird, bleibt das Bild
auch nach dem Zuschneiden in Originalgrof3e in der PowerPoint-
Datei erhalten! Die beschnittenen Teile werden quasi nur ausge-
blendet.

Dariiber hinaus lasst sich die Form des Bildes verdndern, wenn Sie Zuschnei-
den » Auf Form zuschneiden wihlen (in der Version 2007 findet sich der Be-
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fehl unter Bildformatvorlagen » Bildform). Normalerweise ist ein Bild recht-
eckig beschnitten; hier konnen Sie es in eine Ellipse oder eine andere Form
andern.

Sehr hilfreich ist auch die Moglichkeit, ein Bild unter Einhaltung eines
Seitenverhéltnisses zu beschneiden (im Dropdown-Menii heil3t der Befehl
entsprechend Seitenverhaltnis). Das spart viel Zeit. Wenn Sie beispielswei-
se einen quadratischen Ausschnitt aus einem Digitalfoto brauchen, stellen
Sie ein Verhéltnis von 1:1 ein. Das klassische Verhaltnis fiir Digitalbilder,
Monitore und Fernseher war bislang 4:3 (das &ndert sich jedoch gerade in
Richtung 16:9).
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Die Befehle Fiillbereich und Einpassen im gleichen Menii helfen Thnen au-
Rerdem, wenn Sie mit Seitenverhéltnissen arbeiten. Probieren Sie es aus,
indem Sie ein Bild anklicken, ein Verhiltnis von 1:1 einstellen und dann
Zuschneiden » Fiillbereich aufrufen. Testen Sie auch den Befehl Einpassen,
und schauen Sie sich den Unterschied an. Hier wird das Bild einfach in den
bestehenden Ausschnittsbereich eingepasst.
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Um ein Bild zu drehen (2D), kénnen Sie den griinen Marker oberhalb des
Bildes benutzen. Klicken Sie ihn an, und ziehen Sie damit das Bild mit ge-
driickter Maustaste nach links oder rechts.

Alternativ konnen Sie mit der Funktion Drehen (auf dem Meniiband in der
Befehlsgruppe Anordnen) arbeiten, was den Vorteil hat, dass Sie exakte
Gradzahlen eingeben konnen. Die gleichen Befehle finden Sie auch iiber
Start » Zeichnung. Mit Vertikal kippen oder Horizontal kippen spiegeln Sie das
Bild; mit dem Meniipunkt Weitere Drehungsoptionen lassen sich auch hier-
bei ganz genaue Gradwerte fiir die jeweilige Drehung einstellen. Probieren
Sie es einfach mal aus.

&y Ebene nach vorne = Austichten = = -
- i o _I"_ ! ot 2] Hohe:

& Ebene nach hinten = L] Gruppierer

; = -
Zusch?emen io4 Breite:

B4, Auswahlbereich [jk Drehen =
W |

Anordnel ep  pechtsdrenung 90 Grad -
II-(IS‘(-‘II-B'I‘,-IIIE.‘:‘.

Linksdrehung 90 Grad

= Wertikal Kippen
Ak Horizontal kippen

Weitere Drehungsoptionen...

Wenn Sie ein Bild rdumlich drehen méchten (3D), wahlen Sie Bildtools »
Format » Bildformatvorlagen » Bildeffekte. Hier finden Sie eine Reihe von
vordefinierten Drehungen und Perspektiven. Diese Funktion ist sehr niitz-
lich, wenn Sie einer Folie Tiefe verleihen moéchten. Wenn Sie dreidimensio-
nale Objekte und Anordnungen einsetzen, hat der Zuschauer den Eindruck,
er schaue in die Tiefe des Raumes. Die Folie wirkt dadurch interessanter
und spannender. Sie konnen die 3D-Drehung zum Beispiel sehr gut verwen-
den, wenn Sie eine Serie von Urlaubsbildern oder Software-Screenshots ge-
staffelt hintereinander auf einer Folie zeigen oder zwei Bilder raumlich ge-
geniiberstellen wollen. Weitere Einsatzgebiete zeige ich Thnen im Abschnitt
»Einen Bilderwiirfel aufbauen« ab Seite 150.
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Uber Weitere 3D-Einstellungen konnen Sie wie gehabt exakte, gradgenaue
Einstellungen vornehmen. Alternativ gelangen Sie zu den 3D-Einstellun-
gen, wenn Sie mit der rechten Maustaste auf das Bild klicken und aus dem
Kontextmenti Grafik formatieren » 3D-Drehung wéahlen.

Die Bearbeitung der Bildqualitat, z.B. in Bezug auf Helligkeit, Kontraste
oder Weichzeichnung (Unschérfe), erfolgt iiber den Auswahlbefehl Bild-
tools » Format » Anpassen » Korrekturen. Hier konnen Sie auBerdem das Bild
umférben oder mit kiinstlerischen Effekten versehen. Alternativ klicken Sie
mit der rechten Maustaste auf das Bild und wéhlen Grafik formatieren » Bild-
korrekturen aus dem Kontextmenii.
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Eine farbliche Verédnderung, namlich die Reduzierung auf einen Duo-Ton,
erzeugen Sie mit Bildtools » Format » Anpassen » Farbe (in PowerPoint 2007
heil3t der Befehl Neu Einfirben). Alternativ klicken Sie mit der rechten
Maustaste auf das Bild und rufen dann den Befehl Grafik formatieren » Bild-
farbe auf. Diese Funktion, die das Bild in nur zwei Farben darstellt, bietet
Ihnen einige Moglichkeiten:

® Sie konnen damit sehr leicht einen bestimmten Bildstil erzeugen.

® Eingeférbte Bilder oder ClipArts wirken eher aus einem Guss, wenn sie
mit dieser Farbefunktion behandelt wurden.

® Sie konnten alle Symbole in einer Prasentation einheitlich farben, um ei-
nen Wiedererkennungswert zu schaffen.

® Der Hintergrund einer Folie lésst sich ganz hell oder ganz dunkel darstel-
len, sodass der Text im Vordergrund gut zu erkennen ist.
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1) Weitere Varianten

g/ Transparente Farbe bestimmen

%— Eildfarboptionen...

BT

Ganz neu hinzugekommen ist in PowerPoint 2010 die Funktion Kiinstle-
rische Effekte. Sie lasst sich beispielsweise fiir folgende Félle nutzen:

® Definition eines Bildstils

® Gestaltung einer Titelfolie, die inspirierend ist und ein wenig wie ein Ge-
malde wirkt (mit der Option Markierung)

Skizzierung einer Produktidee (z.B. mit Bleistiftskizze) oder einer Bau-
skizze (mit Bleistift: Graustufen)

Hervorhebung eines Produkts mithilfe der metaphorischen Wirkung des
Leuchtens (Leuchten: diffus)

Hervorhebung der Konturen fiir einen modernen, auffilligen Effekt
(Leuchten: Rander)



Funktionen der Bildbearbeitung
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Wenn Sie im gleichen Menii unten den Befehl Optionen fiir Kunsteffekte
aufrufen (das geht auch {iber Grafik formatieren » Kiinstlerische Effekte im
Kontextmenti), konnen Sie weitere Einstellungen vornehmen. Ein weiterer
interessanter Effekt in der Dropdown-Liste ist z.B. Heller Bildschirm: Das
Bild wird in kleine Quadrate eingeteilt. Deren Grof3e lésst sich im gleichen
Dialogfenster iiber den Schieberegler bei RastergréRe verstellen.
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Wenn Sie nun ein Blld auf eine & Korrekturen = & Bilder komprimieren == |
bestimmte Art und Weise forma- | @™~ 8 Bild indem - |-
. . . . || kinstlerische Effekte - ‘E Bild zuriicksetzen ~
tiert haben und diesen Bildstil s
auf Thre gesamte Présentation an- | Sliederung | X || | Bid andem
. . ——— Zuei d Grafik hseln,
wenden wollen, kénnen Sie das Eimefats Sl b
.. . . . der_aktuellen Grafik erhalten
iiber die Funktion Bildtools » For- T bleiben.

mat » Anpassen » Bild dndern sehr

leicht tun (alternativ nutzen Sie den Befehl Bild andern im Kontextmenii).
So konnen Sie die Bilder austauschen, ohne sie jedes Mal neu mit den Effek-
ten versehen zu miissen.

Wenn Sie viele Bilder verwenden, [ weituren- T Tr—
wird die PowerPoint-Datei im- | %fabe- Egic andem el |
mer grofder und verbraucht damit = Kumnerisc:::zzt: PR

mehr Speicherplatz. Das macht Glisderung | X | | pitder komprimieren

auch den Versand per E-Mail nicht Eirgefitt G G
leichter. Eine Losung bietet hier O '

die Funktion Bilder komprimieren in der Gruppe Anpassen. Hier konnen Sie

die Auflosung der Bilder, also den dpi-Wert anpassen. Diese Komprimierung
ist fiir einzelne Bilder, aber auch fiir die gesamte Prasentation moglich. Im
folgenden Abschnitt zeige ich Thnen, wie Sie diese Funktion fiir Thre Présen-
tation gebrauchen.

Die DateigroBe minimieren

Im Folgenden lernen Sie, wie einfach die Minimierung der Dateigré3e von
PowerPoint sein kann.

1. Offnen Sie eine PowerPoint-Datei mit einem oder mehreren Bildern.
Klicken Sie das Bild an, dessen Dateigrofe Sie verkleinern wollen, und
waéhlen Sie Bildtools » Format » Anpassen » Bilder komprimieren. Das Dia-
logfenster Bild komprimieren erscheint (in PowerPoint 2007 erscheint
zuvor ein Dialogfenster, in dem Sie auf die Schaltfliche Optionen kli-
cken miissen).
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Freistellen von Bildern

’Bild komptimieren @"

Komprimierungsoptionen:
[¥] Mur fir disses Bild iibernehmen
Zugeschnittene Bildbereiche ldschen

Zielausgabe:
(70 Drucken (220 ppi): hervorragende Qualitét auf den meisten Druckern und Bildschirmen
1 Bildschirm {150 ppi): geeignet Fir Webseiten und Projektoren
(7 E-Mail (96 ppi): Minimieren der Dokumentgréfe Fir die Freigabe
@ Dokumentaufldsung verwenden

[ Ok ] I Abbrechen ]

2. Hier konnen Sie auswihlen, ob die Komprimierung nur fiir das aktuelle
oder fiir alle Bilder gelten soll. Wenn Sie das Hiakchen bei Nur fiir dieses
Bild Gibernehmen wegnehmen, werden alle Bilder in der Prisentation
komprimiert.

3. Die stirkste Komprimierung erhalten Sie, wenn Sie E-Mail (96 ppi) aus-
wahlen. Aber keine Sorge, Sie werden in der Prasentation keinen Unter-
schied in der Bildqualitdt bemerken. Das hangt damit zusammen, dass
die Monitorauflosung bei 72 ppi liegt, also noch geringer ist.

4. Klicken Sie dann auf OK. Alle Bilder der Prisentation werden kompri-
miert. Die Komprimierung kann ein paar Minuten dauern, je nachdem,
wie viele Bilder es sind.

dpi und ppi

Die Auflosung oder Punktdichte eines Bildes wird in dpi oder ppi an-
gegeben. Die Abkiirzung dpi steht fiir Dots per Inch (Punkte pro Zoll)
und wird vor allem im Bereich des Vierfarbdrucks verwendet; ppi ist
die Abktirzung fir Pixel per Inch (Pixel pro Zoll) und gilt fur den digi-
talen Bereich (bei der Bildschirmdarstellung).

Freistellen von Bildern

Sie kennen moglicherweise folgende Problematik: Sie haben ein Bild von
einer Person vor einem Gebdude oder im Park gemacht, wollen aber eigent-
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Kapitel 3 — Bilder pfiffig prasentieren

lich nur die Person und nicht den Hintergrund zeigen. Vielleicht mochten
Sie auch ein Logo, ein bestimmtes Produkt, ein Auto, ein Haus, eine Maschi-
ne oder ein anderes Objekt losgelost vom Hintergrund in Thre Prasentation
einbinden. Um nur das Hauptmotiv eines Bildes zeigen zu kénnen, muss
es freigestellt werden. Mit PowerPoint 2003 und 2007 gibt es dafiir zwei
Moglichkeiten, in der Version 2010 ist noch eine weitere hinzugekommen.
Manchmal ist es sogar sinnvoll, zwei Moglichkeiten zu kombinieren.

Ein Bild mit der Transparenzfunktion freistellen

Am einfachsten stellen Sie ein Bild iiber die Transparenzfunktion frei. Sie
hat allerdings den Nachteil, dass nur eine Farbe im Bild transparent, also
durchscheinend markiert werden kann. Die Funktion bietet sich deshalb an,
wenn der Hintergrund in einem Bild einfarbig ist, z. B. bei Logos oder Pack-
shots (Produktfotos). Als Beispiel wenden wir die Transparenzfunktion hier
auf ein Logo an.

1. Laden Sie das Bild Logo_freistellen.jpg von der beiliegenden DVD.

2. Damit man die Freistellung spéter besser erkennen kann, bauen wir
zunachst einen Schlagschatten ein. Klicken Sie dazu das Logo an, und
wéhlen Sie {iber Bildtools » Format » Bildformatvorlagen die Option
Schlagschattenrechteck aus.

Animationen Bildschirmprasentation Uberprifen Ansicht Add-Ins

L Grafikrahmen ~

I;I Ij' ji : ; ; v | = Bildeffekte =

= 52 Bildiayout -

Eildformatworlagen Pl
I

= ———————
1121 A0 Schlagschattenreckteck B E e D E e

3. Duplizieren Sie das Logo mit der Tastenkombination + (D], und
positionieren Sie das Duplikat rechts neben dem Original.
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Ein Bild mithilfe eines Pfades freistellen

4. Klicken Sie das zweite Logo an, und wihlen Sie Bildtools » Format » An-
passen » Farbe » Transparente Farbe bestimmen (in 2007 lautet der Pfad
Anpassen » Neu Einfarben » Transparente Farbe bestimmen). Der Cursor
verdndert sich — am Mauszeiger erscheint ein Stift.

5. Klicken Sie mit diesem Stift auf den weilen Hintergrund des Logos, um
diesen transparent zu machen. Sie kdnnen auch probeweise auf eine an-
dere Farbe klicken und sehen, was passiert.

Ohne Freistellung Mit Freistellung
@ ) @
a0 | !jﬂﬂ'!
Powerpqint Single User v 1.0 Pov_v-erPOint Single User V 1.0
Presentationmanager Presentationmanager

Ein Bild mithilfe eines Pfades freistellen

Die zweite Moglichkeit, das Freistellen mithilfe eines Pfades, 16st das Farb-
problem. Auf diese Weise konnen Sie nahezu jedes Motiv freistellen, z.B.
eine Person, eine Maschine, ein Haus, ein Spielzeug oder Ahnliches. Der
Trick besteht darin, die Kontur des Objekts mithilfe eines Pfades festzule-
gen. Diese Technik wird auch in Bildbearbeitungsprogrammen wie Adobe
Photoshop oder Core]DRAW genutzt.

1. Um eine Person auf einem Bild freizustellen, legen Sie zunichst eine
neue Folie mit dem Layout Leer an. Blenden Sie mit + die
Filihrungslinien aus, falls diese zu sehen sind, und entfernen Sie das Ras-
ter, indem Sie auf einem leeren Bereich der Folie die rechte Maustaste
driicken und Raster und Fiihrungslinien aus dem Kontextmenii wéhlen.
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Im Dialog Raster und Linien ent-  [Raster e Linien ===
fernen Sie dann das Hakchen bei ““é'f_ﬁ“*” 1
o
Objekte am Raster ausrichten. [ Objekke an anderen Objekten ausrichten
Rastereinstellungen
. . . . Abstand: 0,2 om
2. Fugen Sle daranhln das Blld [ Raster auf dem Bildschirm anzeigen

Frau_freistellen.jpg von der bei- | iisnsistelungen

[ zeichnungslinien auf dem Bildschirm anzeigen

llegenden DVD ein’ Oder laden [] Beim Awstichiten von Formen intelligents Fihrungslinisn anzeigen
Sie ﬁber Einfugen » Bilder » Gra- [&Is Standard festlegen ] [ o | [ Abbrechen

fik ein anderes Bild, dessen Mo-
tiv Sie freistellen wollen, in Ihre
Folie.

3. VergroRern Sie das Bild so weit, bis der freizustellende Teil in etwa der
GrofRe der Folie entspricht. Sollten Teile des Bildes iiber die Folie hin-
ausragen, verkleinern Sie das Bild mit der Funktion Zuschneiden. Es ist
sehr wichtig, dass Sie das komplette freizustellende Objekt sehen, ohne
scrollen zu miissen!

Bl ?- g &5 k- G |=
m St Finflgen Enbunarf Ubergfinge Ansioht And-Iny
1 @ Formetturen = K e [ ontianmen = Loene [ER
Uy Farbe + B |l il ol il - - Biliefieite
Freisteiien - .
W unstienisene Crrente - g - = 2 pignayout -

AREIER

] = 1%
(1 S

4. Der nichste Schritt ist, eine Form zu bauen, die die Kontur des Objekts
abbildet. Wahlen Sie dazu Start » Zeichnung » Formen » Linien » Frei-
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Ein Bild mithilfe eines Pfades freistellen

handform. Fahren Sie dann mit dem Mauszeiger an den Konturen des
Objekts entlang. Dazu klicken Sie auf eine Stelle der Kontur und setzen
so einen Punkt, dann bewegen Sie den Mauszeiger zur nichsten Stel-
le und setzen mit einem Klick wieder einen Punkt. Das machen Sie so
lange, bis das Objekt komplett umrundet ist. Sobald Sie wieder beim
Startpunkt sind, klicken Sie den Startpunkt an. Daraufhin wird die Fl&-
che automatisch geschlossen. Falls Sie den Startpunkt nicht anklicken
konnen oder sich der Pfad nicht schliefRt, driicken Sie (Esc ], und bre-
chen Sie damit den Vorgang ab. Weiter unten zeige ich Thnen, wie Sie
den Pfad nachtréglich noch schlieen kénnen.

5. Natiirlich lassen sich die Konturen nachtriglich noch korrigieren.
Zundchst dndern Sie tiber Start » Zeichnung » Fiilleffekt » Weitere Fiill-
effekte » Transparenz die Transparenz der Freihandform auf 50 %, damit
Sie das Motiv und die Konturen besser sehen. Klicken Sie dann mit der
rechten Maustaste auf die Freihandform, und wihlen Sie Punkte bear-
beiten aus dem Kontextmenii. Verschieben Sie die betreffenden Punkte,
indem Sie sie anklicken und mit gedriickter Maustaste an die richtige
Stelle ziehen.
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6. Wenn Sie einen Punkt mit der rechten Maustaste anklicken, erhalten
Sie weitere Optionen. Hier konnen Sie zum Beispiel angeben, ob es sich
um einen Ubergangs- oder um einen Eckpunkt handelt. Durch das An-
klicken wird die Kurve an dem entsprechenden Punkt verdndert. Wenn
Sie an dieser Stelle eine Rundung brauchen, stellen Sie Ubergangspunkt
ein; wenn Sie spitze Ecken oder Kanten haben wollen, wihlen Sie Eck-
punkt. Sie konnen Punkte auch glitten, wenn Thnen der Ubergang zu
stufig erscheint (mit dem Befehl Punkt glatten).

Arbeiten Sie genau

Je mehr Punkte Sie auf die Kontur des Motivs setzen, desto feiner
wird die Maske und desto hoher die Qualitat der Freistellung.

7. Nun schneiden Sie das Bild zu, und zwar so, dass der Zuschnitt genau an
die Kanten der Freihandform anst6f3t. PowerPoint 2010 zeigt das sehr
genau mithilfe der beweglichen Fithrungslinien an. Das Bild muss von
seiner Breite und Hohe her genauso grof3 sein wie die Form.

Bildtools
Ubergiange  Animatioren  Bildschi ntation 0 snsicht  Adddns | Format

z - .
Grafikrahmen = [y Ebene nach varme - |2 51675 om *

.‘ d d =) Bildeffekte - [Z4 Ebene nach hinten ~ @1
=0 Zuschnemen 3 17,26 an ©

2 Bildlayout - Sty Auswahlbereich Ik
Bildformatvorlagen Anordnen ~ Grane

0002000 P10 B G R D e Rt A B 41 112]

w4
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Ein Bild mithilfe eines Pfades freistellen

8. Schalten Sie dann den Zuschneiden-Modus
aus, indem Sie erneut auf den Befehl Zu-
schneiden oder einfach in den Hintergrund
und dann wieder auf das Bild klicken. Ver-
schieben Sie dann das Bild so, dass es mittig
auf der Folie liegt.

9. Um das Bild auf Threr Festplatte zu spei-
chern, klicken Sie es mit der rechten Maus-
taste an und wahlen Als Grafik speichern aus dem Kontextmenii. Geben
Sie der Datei einen passenden Namen. Wichtig: Merken Sie sich, wo
Sie den Ausschnitt speichern!

10. Klicken Sie die Freihandform mit der rechten Maustaste an, und wih-
len Sie Form formatieren aus dem Kontextmenii. Wechseln Sie dann
zum Bereich Fiillung » Bild- oder Texturfiillung. Wahlen Sie dort iiber
die Schaltflache Datei den Bildausschnitt aus, den Sie eben gespeichert
haben, und schlie3en Sie den Dialog.

e = =
Flllung Fullung
Linienfarbe ) Keine Fiillung
Linienart () Einfarbige Fillung
") Farbverlauf
Sehakien @ Bild- oder Texturfillung
Spiegelung () Musterfillung
Leuchten und weiche Kanten | | ) Folienhintergrundfiiiung
30-Format Texbur:
30-Drehung Einfligen aus:

i Dakei., 1 [;wischenablage] [ Cliphirt..

Bildkarrekturen
[7] Bild nebeneinander als Textur anardnen

BildFarbe Dehnungsoptionen

Kinstlerische Effekte Offsets:

Zuschneiden Links:

Grifie Oben: D°fo

Position

Textfeld Transparenz: U - [_3%
Albernativext Mit Form drehen
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11. Loschen Sie das Bild, z.B. mit der [Entf ]-Taste. Jetzt ist nur noch das
freigestellte Motiv, also die Frau auf der Folie zu sehen.

oo ‘ = B o=
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Uberginge  Animationen  Bildschirmprésentation  Uberprifen  Ansicht  Add-Ins Farmat Format | o @
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F &£ U 8§ abe 2%~ Aa- A~

Schriftart Zeichnung 3| Bearbeiten
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12. Nun kénnen Sie das freigestellte Motiv noch etwas verschénern. Ent-
fernen Sie beispielsweise iiber Start » Zeichnung » Formkontur » Kein
Rahmen (in PowerPoint 2007 heil’t es Keine Gliederung) die Umriss-
linie. Uber Start » Zeichnung » Formeffekte » Weiche Kanten kénnen Sie
aullerdem die Umrisskante weicher gestalten.

Sie haben nun eine Methode zum Freistellen kennengelernt, die sehr hdufig
gut funktioniert. In PowerPoint 2010 gibt es inzwischen jedoch eine neue
Freistellen-Funktion, die vieles erleichtert. Diese zeige ich Thnen im folgen-
den Abschnitt.

Die Freistellen-Funktion nutzen

In PowerPoint 2010 gibt es eine Funktion zum Freistellen, die in 80 % aller
Falle sehr gut funktioniert, denn mit ihr lassen sich gleich mehrere Farben



Die Freistellen-Funktion nutzen

im Bild transparent setzen. Die iibrigen Félle konnen Sie mithilfe eines Pfa-
des freistellen oder — wenn es ganz schwierig wird — iber »echte« Grafikpro-
gramme bearbeiten.

Uber Bildtools » Format » Anpassen » Freistellen finden Sie verschiedene Be-
fehle, mit denen Sie die Bildbereiche sehr leicht freistellen kénnen, indem
Sie den Hintergrund transparent setzen (zu entfernende Bereiche markie-
ren). Dariiber hinaus lasst sich noch genauer bestimmen, welche Bereiche
nicht ausgespart werden sollen (zu behaltende Bereiche markieren).

Ich zeige Thnen anhand eines Beispiels, worauf es dabei ankommt.

1. Legen Sie eine neue Folie mit dem Layout Leer an. Laden Sie die Datei
Stift-und-Papier.jpg von der beiliegenden DVD.

2. Rufen Sie dann den Befehl Bildtools » Format » Anpassen > Freistellen
auf.

IE“H ) - 15 _'r*-EE],!:

[rate| - Freistellen Bildschirmprdsentation Ansicht Format

[ =
¢ e @« @ v
Zu behaltende Zu entfernende  Markierung | Alle &nderungen Anderungen
Eereiche markieren Bereiche markieren  [&:chen WEreTen beibehalten
wWetfeinern schlielen
1~k = k4 ||12-|-|-|-1EI-|-|-|-8-|-|-|-E|-|-|-|-4-|-|-|-2-|-|-|-
1 T — _ :

g g

3. Im Bild erscheint ein Markierungsrahmen. Ziehen Sie ihn ganz auf.
PowerPoint erkennt die Konturen und farbt den Bereich, der entfernt
wird, pink ein.
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4. Wenn Sie die Markierung noch verindern wollen, klicken Sie im Menii-
band auf Freistellen » zu behaltende Bereiche markieren. Der Mauscursor
wird zu einem Stift. Klicken Sie damit in die Bereiche, die zum Objekt
gehoren und daher nicht freigestellt werden sollen. Diese Bereich wer-
den mit Pluszeichen markiert.

ElEH9-U 0 k-E- =

Freistellen Eildschirmprasentation Ansicht Format
& @ @8 v
Zu behaltende ZFu entfernende  Markierung | Alle Bnderungen Snderungen
!B___e__r_g_i_n:_['!_g_rllgr[c_ig_r_g_rj!Bereiche markieren  ldschen werwerfen beibehalten
‘Werfeinern Schlieken
(1 |§ |x ||12-I-|-|-1lJ-|-|-|-8-|-|-|-6-|-|-|-4-|-|-|-2-|-|-|-D‘

N

""4'"""6"""'8""'1

5. Wenn Sie einen Bereich filschlicherweise angeklickt haben, kénnen Sie
die Markierung entfernen. Klicken Sie dazu im Meniiband auf Markie-
rung I6schen oder auf Alle Anderungen verwerfen. Zum Schluss bestéti-
gen Sie alles mit Anderungen beibehalten. Daraufhin werden die ausge-
wahlten Bereiche freigestellt.

6. Falls die Kontur nicht optimal ist, nutzen Sie wie zuvor die Funktion
Bildtools » Format » Bildformatvorlagen » Bildeffekte » Weiche Kanten.

Sie haben inzwischen drei Moglichkeiten zum Freistellen von Motiven ken-
nengelernt. Die einfache Transparenzfunktion nutzen Sie am besten bei
einfarbigen Hintergriinden, die neue Freistellen-Funktion kénnen Sie im-
mer verwenden, und die Pfad-Freistellung hilft, wenn die anderen beiden
Methoden versagen.
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Texte auf Bildern platzieren

Texte auf Bildern platzieren

Der Begriff Absoften kommt aus der Werbesprache und bedeutet, ein Bild
verblassen zu lassen. Dadurch konnen bestimmte Informationen in den
Hintergrund treten, sind aber immer noch préasent. Die Palette der Anwen-
dungsmoglichkeiten ist sehr breit: Zum Beispiel konnen in einer Aufzihlung
die Texte und Bilder abgesoftet werden, die gerade nicht aktiv sind. An der
eigentlichen Aufzdhlung wird nichts verandert, aber die Zuschauer kénnen
immer sehen, an welcher Stelle der Prasentation sich der Sprecher befindet.

Ein weiterer wichtiger Anwendungsfall ist die Hervorhebung von Texten
auf einem Bild. Da Texte immer moglichst kontrastreich gestaltet werden
sollten, damit sie einfach zu lesen sind, kann man das Bild absoften und
dadurch die Texte stirken. Letzteren Fall stelle ich Thnen nun Schritt fiir
Schritt vor.

1. Legen Sie eine neue Folie mit dem Layout Leer an, und laden Sie ein
beliebiges Bild in die Folie, das auf deren volle Grof3e gebracht wer-
den kann (oder laden Sie die Datei Absoften.pptx von der beiliegenden
DVD).

2. Uber Start » Zeichnung » Formen » Textfeld legen Sie ein Textfeld iiber
das Bild. Schreiben Sie einen Text hinein, der zum Bild passt. Da das
Bild im Beispiel sehr dunkel ist, ist die schwarze Schrift sehr schlecht
lesbar.
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3. Sie haben jetzt zwei Moglichkeiten: Sie konnen das Bild iiber Bildtools »

Format » Anpassen » Farbe » Neu einfiarben so anpassen, dass der Kon-
trast von Text und Bild deutlicher
und der Text lesbarer wird. Sie kon-
nen das Bild aber auch einfach tiber
Bildtools » Format » Anpassen »
Korrekturen absoften (im gleichen
Menii gibt es auch den Befehl Opti-
onen fiir Bildkorrekturen, in dessen
Dialogfenster Sie manuelle Anpas-
sungen vornehmen kénnen). In un-
serem Beispiel haben wir den Kon-
trast verringert und die Helligkeit
erhoht.

1 s 4k
|

Ein Bilderpuzzle gestalten

Ein schoner Bildeffekt, der sich sehr gut als Sinnbild fiir Teile eines Ganzen
einsetzen lasst, ist das Puzzle.

Sie kdnnten zum Beispiel ein Belegschaftsfoto als Puzzle darstellen und da-
mit die Botschaft transportieren, dass jeder Mitarbeiter ein wichtiger Teil
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des Ganzen ist. Weitere Einsatzgebiete fiir eine solche Darstellung konn-
ten das Leistungsportfolio eines Unternehmens, die Bestandteile eines Pro-
dukts oder die Elemente eines Konzepts sein.

1. Offnen Sie die Prisentation Puzzle.pptx von der beiliegenden DVD, und
kopieren Sie die erste Folie mit den Puzzleteilen in eine neue Prisenta-
tion. Speichern Sie die neue Présentation unter einem passenden
Namen.

2. Zeichnen Sie ein Rechteck iiber die gesamte Folie (Start » Zeichnung »
Formen » Rechteck), und klicken Sie mit der rechten Maustaste darauf.
Im Kontextmenii wéhlen Sie Form formatieren » Fiillung » Keine Fiillung.

3. Dann legen Sie es in den Hintergrund (iiber Start » Zeichnung » Anord-
nen » In den Hintergrund).

o= vz, IR Tericntung - SNESE h
¥s [ Test ausrichten = AlLd o - T
TIn SmartArt konvertisren © v ok &nur‘(\nan

Absatz
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| vorlagen= ‘= Formeffeite = | Lg Markieren =

2 Objekte sortieren 2| Bearbeiten
[tz Al 40 8 & 7B 1§ g 32 101D B In den Vordergrund VA0 A1z
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4. Klicken Sie mit der rechten Maustaste neben die Folie, und wihlen Sie
Hintergrund formatieren. Wahlen Sie Fillung » Bild oder Texturfiillung,
und klicken Sie dann auf die Schaltflaiche Datei. Wahlen Sie das Bild
aus, das Sie in dem Puzzle darstellen wollen, und bestéitigen Sie Ihre
Auswahl mit Offnen. SchlieRen Sie den Dialog. Vielleicht sehen Sie das
ausgewahlte Bild schon im Hintergrund.

5. Markieren Sie alle Puzzleteile, indem Sie sie anklicken und dabei die
(Strg]-Taste gedriickt halten. Klicken Sie dann mit der rechten Maus-
taste auf den markierten Bereich. Aus dem Kontextmenii wéhlen Sie
Objekt formatieren und im darauffolgenden Dialog Fiillung » Folienhin-
tergrundfiillung. Wenn Sie dann auf SchlieBen klicken, sehen Sie IThr Bild
als Puzzle.

Dieser Puzzlestil eignet sich fiir viele Bereiche, und je nach Bildmotiv lassen
sich damit interessante Wirkungen erzielen.

Einen Bilderwiirfel aufbauen

Der Bilderwiirfel ist eine schone Methode, um buchstéblich verschiedene
Seiten eines Themas zu zeigen, wie z.B.:

® Vergangenheit, Gegenwart, Zukunft
® Umsatz, Gewinn, Prognose

® Wachstum, Markte, Branchen

® Vorteile, Nachteile, Fazit

Um in PowerPoint einen Bilderwiirfel mit einer 10°-Perspektive zu erstel-
len, gehen Sie wie folgt vor:

1. Legen Sie eine neue Folie mit Layout Leer an. Schalten Sie das Raster aus
(dazu klicken Sie mit der rechten Maustaste neben die Folie und 16schen
das Hékchen bei Raster und Fiihrungslinien » Objekte am Raster ausrich-
ten). Uber Start » Zeichnung » Formen » Rechteck zeichnen Sie ein Qua-



Einen Bilderwiirfel aufbauen

drat und geben eine Seitenldnge von 6 x 6 cm an (iiber Zeichentools »
Format » GroRRe).

2. Wihlen Sie dann iiber die rechte Maustaste den Befehl Form formatieren »
3D-Format, und geben Sie im Bereich Tiefe den Wert »6 cm« ein (auch
wenn er dort eigentlich in Punkt angegeben wird).

3. Dann klicken Sie links auf die Registerkarte 3D-Drehung. Wihlen Sie
iber den kleinen Pfeil am Feld Voreinstellungen die Option Perspektive
rechts (Stufe 1) aus. Darunter im Bereich Drehung geben Sie dann fiir X
den Wert »340°, fiir Y den Wert »10° und fiir Z den Wert »0°« ein.

i r
Grafik farmatieren
Filong 3D-Drehung
Linienfarbe
Yoreinstelungen: -
Linignart
Creh
Schatken renng )
Spiegelung 4 340° =
Leuchten und weiche Kanten ¥ |
30-Farmat z |o® B
i 3D-Drehung l A

Perspekkive: .4iS° I : {

Bildkorrekturen
Text

Bildfarbe [T] Flacher Text

Kinstlerische Effekke Objektposition
Zuschneiden Distanz vorn Boden: ot t :

Position
Textfeld

Alternativie:xt

4. Nun sehen Sie schon einen Wiirfel auf der Folie. Damit jede Seite des
Wiirfels ein Bild zeigen kann, miissen Sie das Seitenteil und das Oberteil
weiter bearbeiten. Duplizieren Sie also den Wiirfel, und klicken Sie mit
der rechten Maustaste auf das Duplikat. Im Kontextmenii wéhlen Sie
wieder Form formatieren » 3D-Format » Tiefe und setzen die Tiefe auf
den Wert »0 cm«.
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10.

Wechseln Sie zum Register 3D-Drehung, und geben Sie dort unter Dre-
hung fiir X den Wert »73,2%, fiir Y den Wert »9°« und fiir Z den Wert
»1°« ein. Verandern Sie nun noch die Hohe der Flache auf 5,75 cm, in-
dem Sie mit der rechten Maustaste darauf klicken, GroRe und Position
aus dem Kontextmenii wéhlen und diesen Wert im Feld H6he angeben.
Dann verschieben Sie die Form mit gedriickter Maustaste bzw. mithilfe
der Richtungstasten an die richtige Stelle an der linken Wiirfelseite.

Um auch die Oberseite anzupassen, duplizieren Sie wieder den Origi-
nalwiirfel. Reduzieren Sie die Tiefe des Duplikats auf den Wert »0 cm.
Geben Sie als Parameter fiir die Drehung folgende Werte ein: »283°
fiir die X-Achse, »290°« fiir die Y-Achse und »78,1°« fiir die Z-Achse.
Uber den Befehl GroRe und Position aus dem Kontextmenii setzen Sie
die Breite der Flache auf den Wert »5,74 cm«. Verschieben Sie auch
diese Flache an die entsprechende Stelle.

Um dem Wiirfel noch einen Schatten geben, duplizieren Sie das Ober-
teil, und klicken Sie mit der rechten Maustaste auf das Duplikat. Im
Kontextmenii wahlen Sie Form formatieren » Fiillung und setzen die
Fiillfarbe auf Grau (z. B. Schwarz, Text 1, heller 50%) mit einer Transpa-
renz von 50 %. Bestitigen Sie IThre Anderungen mit SchlieRen.

Wahlen Sie iiber Zeichentools » Format » Formenarten » Formeffekte die
Option Weiche Kanten » 50 Punkt aus. Ziehen Sie den Schatten etwas
grolder, verschieben Sie ihn an die richtige Stelle unter dem Wiirfel,
und legen Sie ihn in den Hintergrund (Zeichentools » Format » Anord-
nen » In den Hintergrund).

Wihlen Sie das Wiirfelobjekt aus, das Sie als Erstes auf der Folie an-
gelegt haben, und reduzieren Sie dessen Tiefe auf »0 cm« (indem Sie
mit der rechten Maustaste darauf klicken und Form formatieren » 3D-
Format » Tiefe wihlen).

Um nun ein Bild auf einer Flache einzufiigen, klicken Sie mit der rech-
ten Maustaste auf die entsprechende Flache und klicken {iber Form for-
matieren » Fiillung » Bild- oder Texturfiillung auf die Schaltflache Datei.



Einen Bilderwiirfel aufbauen

Suchen Sie sich das erste Bild aus, und fiigen Sie es mit einem Klick auf
Offnen ein. Verfahren Sie dann bei den anderen Flachen genauso.

11. Wenn Sie méchten, konnen Sie zu guter Letzt noch die Linienfarbe des
Wiirfels anpassen: Klicken Sie ihn mit der rechten Maustaste an, und
wéhlen Sie Form formatieren » Linienfarbe.

Zukunft

* E-Autos
* umweltschonend
* abgasfrei

* sehr leise

In der PowerPoint-Datei Bilderwiirfel. pptx auf der beiliegenden DVD finden
Sie verschiedene Wiirfel mit unterschiedlichen Perspektiven. Sie konnen sie
einfach in Thre Présentation iibernehmen und mit Ihren Bildern bestiicken.
Falls Thr Bild nicht die passenden Maf3e hat, benutzen Sie das Werkzeug
Bildtools » Format » Zuschneiden.
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Kapitel 4
Mehr Pep mit Grafikelementen

In diesem Kapitel soll es darum gehen, wie Sie mit Formen interessante Gra-
fikelemente erstellen und damit Thre Folien aufpeppen. Im Gegensatz zu
Bildern konnen grafische Elemente sehr gut an Vorgaben wie das Corporate
Design angepasst werden. Formen lassen sich skalieren (vergrof3ern/ver-
kleinern) und schnell in der Kontur verdndern. Sie bieten damit geniigend
Flexibilitit in der Gestaltung. Lassen Sie sich iiberraschen, und freuen Sie
sich auf die Beispiele und Anleitungen.

Da es hierbei vor allen Dingen ums Gestalten geht, enthilt dieses Kapitel
sehr viele Schritt-fiir-Schritt-Anleitungen zu unterschiedlichen Themen.
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Sie werden lernen, wie Sie mit Formen arbeiten. Wichtig ist dabei nattir-
lich zunéchst, wie Sie neue Formen erstellen und mit Formen »zeichnen«
konnen. Aullerdem zeige ich Thnen, wie Sie ClipArts und Vektorgrafiken
in Formen verwandeln und selbst Piktogramme bauen konnen. Alle diese
Grafikelemente eignen sich wunderbar dazu, Aussagen plakativ zu machen
oder z.B. Prozesse anschaulich darzustellen.

Vektorgrafiken

Vektorgrafiken sind einfache Computergrafiken, die nicht aus ein-
zelnen Pixeln aufgebaut sind, sondern mittels Kurven dargestellt
werden. Sie sind nicht durch eine bestimmte Auflésung in lhrer
GroRe begrenzt und kdnnen daher ohne Qualitatsverluste beliebig
skaliert werden.

Formen als Grundlage fiir Grafikelemente

Grafikelemente bestehen in erster Linie aus Formen und kdnnen beispiels-
weise Dreiecke, Vierecke, Prozessflusssymbole, 2D-Zeichnungen oder auch
3D-Figuren sein. Mit Formen konnen Sie Kugeln, Figuren oder Piktogram-
me »bauen« oder Autos und Eisenbahnen »zeichnen«. Formen kommen vor
allem in Verbindung mit Texten, Bildern und Prozess- oder Workflow-Dar-
stellungen zum Einsatz.

Ein Highlight in PowerPoint 2010 ist die Moglichkeit, Formen miteinander
zu kombinieren, d.h. Schnittmengen, Vereinigungen usw. darzustellen. (In
der Fachsprache wird dabei von booleschen Operationen gesprochen, falls
Sie diesen Begriff einmal horen sollten.)

Formen sind ein grundlegender Bestandteil von PowerPoint. Wenn Sie ler-
nen, damit zu arbeiten, erleichtern sie Thnen das Erstellen von Objekten und
die Gestaltung ganzer Folien und Prasentationen, und vor allem kénnen Sie
mit ihrer Hilfe eine individuelle Symbolik schaffen. Eine grof3e Auswahl an
Basisformen finden Sie iiber Start » Zeichnung » Formen (oder auch iiber
Einfiigen » lllustrationen » Formen).



Formen als Grundlage fiir Grafikelemente
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Das Seitenverhaltnis beibehalten

Als Einstiegsiibung zur Gestaltung mit Formen lernen Sie die grundlegende
Funktion Seitenverhaltnis beibehalten kennen. Wenn Sie eine Form einge-
fiigt haben und nachtréglich ihre GréRe verdndern wollen, halten Sie beim
Aufziehen die [ o ]-Taste gedriickt. So wird das Verhéltnis von Seitenlinge
und Seitenbreite beibehalten. Wenn Sie die Form also bei gedriickter o ]-
Taste breiter ziehen, wird auch die Hohe proportional verandert. Wenn Sie
eine neue Form anlegen und dabei die (o -Taste driicken, wird die Form
schon beim Aufziehen mit gleicher Héhe und Breite angelegt, was zu einem
Quadrat, einem Kreis oder Ahnlichem fiihrt. Zur Verdeutlichung dient die
folgende Anleitung:

1. Legen Sie eine neue Folie mit dem Folienlayout Leer an. Klicken Sie auf
Start » Zeichnung » Formen » Rechtecke, und wéhlen Sie Rechteck aus.

2. Wenn Sie die Form ausgewihlt haben, wird der Mauscursor zu einem
Kreuz. Ziehen Sie mit gedriickter Maustaste ein Rechteck auf der Folie
auf.

3. Klicken Sie irgendwo neben der Form auf die Folie, um das Einfiigen ab-
zuschliel3en. Nun klicken Sie die Form wieder an und ziehen sie mit ge-
driickter Maustaste an einem der Eckmarker grof3er. Driicken Sie dabei
die (o ]-Taste. Hohe und Breite werden gleich skaliert, d.h., das Recht-
eck wird proportional vergro3ert (und bleibt ein Rechteck).

4. Probieren Sie das Ganze beispielsweise mit einer Ellipse aus (Start »
Zeichnung » Formen » Standardformen » Ellipse). Mit gedriickter [ J-
Taste bleibt die Ellipse beim Vergrof3ern eine Ellipse; wenn Sie beim
Anlegen die (¢ ]-Taste driicken, wird die Form zum Kreis. Aus einem
Rechteck wird beim Anlegen mit gedriickter [« ]-Taste sofort ein Qua-
drat. Probieren Sie das ruhig auch mal mit anderen Formen aus.

Wenn Sie eine Form komplett austauschen, z.B. ein Rechteck durch einen
Kreis ersetzen wollen, konnen Sie das iiber Zeichentools » Format » Formen
einfligen » Form bearbeiten » Form dndern tun.
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Am haufigsten werden Formen in Kombination mit Text verwendet, z. B. bei
Workflow- oder Prozessdarstellungen. Um eine Form mit Text zu versehen,
legen Sie sie an, und tippen Sie einfach los. Bei nur einer Form wird automa-
tisch diese mit dem Text gefiillt.

Wenn Sie mehrere {ibereinanderliegende oder verschachtelte Formen ver-
wenden, klicken Sie die Form an, in die Sie etwas schreiben wollen, und
driicken Sie [F2]. Der Cursor blinkt dann in der jeweiligen Form, und Sie
kénnen mit dem Schreiben beginnen.

Um bereits vorhandenen Text innerhalb von Formen zu dndern, klicken Sie

einfach mit der Maus in den Text. Bei mehreren Formen arbeiten Sie auch
hier wieder mit der Taste [F2].
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Es gibt drei Moglichkeiten, den Text in einer Form zu formatieren:

1. Sie konnen die {iblichen Formatierungen der Befehlsgruppe Start »
Schriftart verwenden.

2. Indem Sie die Form mit der rechten Maustaste anklicken, rufen Sie im
Kontextmenii den Befehl Form formatieren auf und nehmen dort unter
Textfeld » Innerer Seitenrand entsprechende Einstellungen vor. Sie kon-
nen z.B. die Abstdnde des Textes zum Rand der Form verdandern.

3. Bei der letzten Moglichkeit markieren Sie den Text und gelangen iiber
die rechte Maustaste und den Kontextmeniibefehl Texteffekte formatie-
ren in den Dialog zum Bearbeiten des Textfeldes.

—
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Bilder in Formen

Wenn Sie die vorhergehenden Kapitel bereits gelesen haben, haben Sie
schon Moglichkeiten kennengelernt, Bilder zu beschneiden oder in Form
zu schneiden. Eine weitere Variante besteht darin, die Form mit einem Bild



Formen ausrichten

zu fiillen. Klicken Sie dazu mit der rechten
Maustaste auf die Form, und wéihlen Sie
im Kontextmenii den Befehl Form forma-
tieren (wenn Sie den Text angeklickt ha-
ben, heil3t der Befehl Grafik formatieren).

Im Dialogfenster fiigen Sie iiber Fiillung »
Bild- oder Texturfiillung und die Schaltfla-
che Datei ein Bild ein. Wenn Sie doch lieber

ein anderes Bild nehmen wiirden, konnen Sie
auf die gleiche Weise ein neues einfiigen.

Formen ausrichten

Die folgenden grundlegenden Funktionen werden Sie sehr haufig brau-
chen, wenn Sie viel mit Formen gestalten. Soll eine Folie ordentlich ausse-
hen, miissen z.B. die Abstdnde stimmen und die Elemente auf der gleichen
Hohe oder biindig ausgerichtet sein. PowerPoint unterstiitzt Sie dabei mit
Funktionen zum Ausrichten und Verteilen von Objekten.

1. Legen Sie auf einer Folie drei gleich groRe Rechtecke an, und verteilen
Sie sie beliebig auf der Folie.

2. Markieren Sie alle Rechtecke (indem Sie einen Markierungsrahmen da-
riiber aufziehen oder sie mit gedriickter [ ]-Taste nacheinander ankli-
cken).
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3.

Uber Start » Zeichnung » Anordnen » Objekte positionieren » Ausrichten
oder iiber Zeichentools » Format » Anordnen » Objekte positionieren »
Ausrichten finden Sie eine Auswahl an Ausrichtungen und Verteilungen.
Wihlen Sie in unserem Fall Oben ausrichten, dann werden alle Recht-
ecke an der Oberkante des obersten Rechtecks ausgerichtet (bei Unten
ausrichten entsprechend an der Unterkante des untersten Rechtecks auf
der Folie).
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Wenn Sie dann im Menii auf Horizontal verteilen klicken, werden die
Abstidnde der Rechtecke zueinander angepasst, sodass sie alle mit dem
gleichen Abstand nebeneinanderliegen. Mit Vertikal verteilen werden
die Formen so angeordnet, dass sie mit dem gleichen Abstand iiberei-
nanderliegen.



Ebenen

PowerPoint legt alle Elemente einer Folie, also jeden Text, jedes Bild, jede
Grafik, jede Gruppe etc., auf einer zugehérigen Ebene ab.

Ebene 3: Text

Das ist eine Glicksfolie.
Ebene 2: Bild

Das Gliick ist

Ebene 1:Text mit den Tiichtigen.

Folienmaster

Manchmal miissen die Ebenen verdndert werden, um zum Beispiel mehre-
re libereinanderliegende Bilder zu vertauschen. In den meisten Fallen wird
diese Funktion jedoch bei Formen gebraucht, z. B. wenn Sie ein Textfeld auf
eine farbige Form legen wollen.

Sie verdndern die Tiefenebene eines Objekts, indem Sie es anklicken und
dann Start » Zeichnung » Anordnen » Objekte sortieren wihlen (eine andere
Moglichkeit ist Zeichentools » Format » Anordnen). Es gibt vier Ebenenfunk-
tionen. Mit In den Hintergrund verschieben Sie das Objekt hinter alle ande-
ren Objekte der Folie, In den Vordergrund holt das Objekt vor alle anderen
Elemente auf der Folie. Mit Ebene nach vorne und Ebene nach hinten bringen
Sie das jeweilige Objekt genau auf die gewiinschte Ebene.
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Elemente gruppieren

Eine Gruppe ist eine Sammlung von Folienelementen, die zusammengefasst
ein neues Folienelement ergibt. Der Vorteil ist, dass auf diese Weise mehre-
re Elemente wie ein Einzelelement behandelt und leichter bearbeitet wer-
den konnen, zum Beispiel beim Skalieren. Gerade in der Arbeit mit Formen
ist diese Funktion sehr niitzlich.

1. Legen Sie eine Folie mit drei Rechtecken an. Markieren Sie die Formen,
und driicken Sie + (o] + (G]. Wie Sie sehen, sind die Rechtecke
nun nicht mehr einzeln markiert, sondern nur noch mit einem Rahmen
versehen. Sie wurden gruppiert. (Sie konnen auch eine Gruppe bilden,
indem Sie mit der rechten Maustaste auf den markierten Bereich klicken
und Gruppieren wahlen. Die dritte Moglichkeit ist Start » Zeichnung »
Anordnen » Objekte gruppieren.)

2. Wenn Sie nun an einem der neuen Eckmarker ziehen, verdandert sich die
Grof3e aller Rechtecke gleichzeitig.

3. Zum Auflésen der Gruppe driicken Sie + (o] + (H]. Auch diesen
Befehl erreichen Sie alternativ iiber die rechte Maustaste oder iiber Start »
Zeichnung » Anordnen » Objekte gruppieren » Gruppierung aufheben.



Formen kombinieren

Gruppierungen spielen in der Prasentationsgestaltung eine wichtige Rolle.
Merken Sie sich am besten die beiden Tastaturkiirzel oder — noch besser —
wenden Sie sie haufig an.

Formen kombinieren

Gerade wenn es darum geht, neue Formen fiir eine Prasentation zu schaf-
fen, ist die Funktion Kombinieren sehr viel wert. Sie ist neu in PowerPoint
2010 und beinhaltet vier verschiedene Befehle:

® Formenvereinigung: Mehrere Formen werden zu einer Form verschmol-
zen.

® Formenkombination: Mehrere Formen werden zu einer Form verschmol-
zen, wobei die Schnittmenge auf3en vor gelassen wird.

® Formenschnittmenge: Die Schnittmenge mehrerer Formen bleibt als Er-
gebnis bestehen.

® Formensubtraktion: Die erste Form bleibt abziiglich der Schnittmenge be-
stehen. Alle weiteren Formen werden geloscht.

Damit Sie diese Funktionen nutzen konnen, miissen Sie den Befehl Formen-
kombinationen in die Symbolleiste fiir den Schnellzugriff laden.

1. Offnen Sie dazu die PowerPoint-Optionen (Datei » Optionen » Symbol-
leiste fiir den Schnellzugriff). In der Dropdown-Liste Befehle auswahlen
wiéhlen Sie Alle Befehle aus.

2. In der daraufhin erscheinenden Liste su-

Pl 9 - ?.,'|£7_'*';E|'|:
chen Sie den Befehl Formen kombinieren - :__Q_J__ —

Star‘t; 'Q Formernwereinigung ]

und fiigen ihn iiber die Schaltflache Hin- @y |© Eomenkombinaton |
zufiigen der Leiste hinzu. SchlieBen Sie By B3~ |0: Formenschnittmenge a
die Optionen. Der Befehl Formen kombinie- Fnfugen o @ Formensubtraktion  F

ren mit seiner Auswahl an Funktionen er-
scheint dann in Threr Symbolleiste fiir den
Schnellzugriff.
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Die folgende Abbildung zeigt die Wirkung der Funktionen. Sie konnen For-
men nur dann kombinieren, wenn mindestens zwei Formen markiert sind.

Originalformen

N o

Vereinigung Kombination Schnittmenge Subtraktion

Zwei Seiten einer Medaille darstellen

Das Beispiel, das wir im Folgenden zusammen anlegen, eignet sich sehr gut
dazu, zwei Seiten einer Medaille zu zeigen oder zwei gegeniiberliegende
Pole zu verdeutlichen.

1. Legen Sie zunichst auf einer leeren Folie einen Kreis an. Dazu wihlen
Sie Start » Zeichnung » Formen » Ellipse und klicken dann einmal auf die
leere Folie. Duplizieren Sie den Kreis ([Strg] + (D)), und legen Sie bei-
de Kreise mithilfe der Ausrichtefunktionen exakt {ibereinander, indem
Sie sie markieren und Start » Zeichnung » Anordnen » Objekte positionie-
ren » Ausrichten » Oben ausrichten bzw. Linksbiindig wiahlen. Das miissen
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2.

3.

4.

Zwei Seiten einer Medaille darstellen

Sie deshalb tun, weil ein Kreis mit dem Rechteck verschmolzen wird,
wir aber in der Mitte noch einen Kreis zeigen wollen.

Zeichnen Sie dann ein Rechteck (Start » Zeichnung » Formen » Recht-
eck).

Verschieben Sie das Rechteck so iiber die beiden Kreise, dass beide For-
men einander {iberlappen.

Markieren Sie zuerst das Rechteck und danach mit gedriickter [Strg]-
Taste den oberen Kreis. Rufen Sie iiber die Schnellzugriffleiste die Funk-
tion Formen kombinieren » Formensubtraktion auf. Rechteck und Kreis
werden verbunden.

Markieren Sie das Rechteck bzw. das, was davon noch {iibrig geblieben
ist, und duplizieren Sie es mit + (D]J. Verschieben Sie es mithilfe
der Pfeiltaste auf der gleichen Hohe auf die andere Seite des Kreises.

Uber Start » Zeichnung » Anordnen » Objekte positionieren » Drehen »
Horizontal kippen spiegeln Sie das Rechteck und schieben es dann mit
der Pfeiltaste auch auf der rechten Seite an den Kreis heran.
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7. Verteilen Sie die drei Elemente gleichmiRig auf der Folie (Start » Zeich-
nung » Anordnen » Objekte positionieren » Ausrichten » Horizontal vertei-
len). Beschriften und formatieren Sie die Formen nach Wunsch.

Vorteile Nachteile

Natiirlich konnen Sie die Darstellung auch fiir andere Einsatzzwecke ver-
wenden, beispielsweise um ein Ungleichgewicht zu verdeutlichen. Bilden
Sie dazu einfach eine Gruppe aus allen Elementen, und drehen Sie anschlie-
Bend die Gruppe mithilfe der Drehmarker.

Formen punktgenau bearbeiten

Einige Formen lassen sich {iber eine genaue Punktbearbeitung erstellen
und nachbearbeiten. Diese Moglichkeit brauchen Sie zum Beispiel fiir das
Freistellen oder auch, um neue Formen zu kreieren. Ob sich eine Form auf
diese Weise nachbearbeiten lasst, erkennen Sie daran, dass Thnen im Kon-
textmenii der Form der Meniipunkt Punkte bearbeiten angeboten wird oder
dass Sie iiber Zeichentools » Format » Formen einfiigen » Form bearbeiten den
Befehl Punkte bearbeiten wihlen konnen.

Trick zur Punktbearbeitung in PowerPoint 2007

In PowerPoint 2010 funktioniert die Punktbearbeitung mit jeder
Form. In der Version 2007 hingegen gibt es Einschrankungen. Dabei
hilft ein Trick: Uber Zeichentools » Format » Formen einfiigen » Form
bearbeiten » In Freihandform konvertieren konnen Sie so gut wie je-
des Objekt fir die Punktebearbeitung vorbereiten. Wenn Sie diesen
Befehl gewahlt haben, sollte die Funktion zur Verfiigung stehen.



Formen extrahieren und weiterbearbeiten

Um eine Form punktgenau zu bearbeiten, gehen Sie folgendermaf3en vor:

1. Legen Sie eine Freihandform an, indem Sie Start » Zeichnung » Formen »
Freihandform wéhlen. Setzen Sie dann mit einem Mausklick den ersten
Punkt auf die Folie, bewegen Sie die Maus an eine andere Stelle, und
setzen Sie den néchsten Punkt usw., bis Sie wieder am Ausgangspunkt
angelangt sind. Wenn Sie ihn anklicken, schlie3t sich die Flache. Wenn
Sie das Erstellen der Freiflache (Freihandform) abbrechen wollen, drii-

cken Sie die [Esc]-Taste.

2. Klicken Sie mit der rechten Maustaste auf die Fliche und im Kontext-
menii auf Punkte bearbeiten, um sich alle Punkte anzeigen zu lassen.

3. Wenn Sie die Fliche noch -
= -3
verdndern mochten, konnen FreEE=EA-2-2-¢

Sie die einzelnen Punkte mit

. . Punkt hinzufilgen
gedriickter linker Maustaste Punict laschen
Ffad affnen

Ffad schliefien

verschieben. Wenn Sie mit
der rechten Maustaste auf

Ubergangspunkt
Punkt glatten

einen Punkt klicken, bieten
| _v"_ | Eckpunkt

sich Thnen noch mehr M&g-
lichkeiten. Mit Punkt glatten
wird die Kontur z.B. runder

Punktbearbeitung beenden

und damit harmonischer.

Sie miissen aber nicht selbst »malen«, sondern konnen auch vorgefertigte
Teile aus ClipArts verwenden, wie Sie nun sehen werden.

Formen extrahieren und weiterbearbeiten

Wenn Sie eine zu Threm Thema passende ClipArt-Grafik gefunden haben
und sie auf Ihrer Folie verwenden, wollen Sie sie vielleicht einfarben, ein
wenig ihre Kontur verdndern oder lediglich einen Teil der Grafik verwen-
den. Ublicherweise werden ClipArts als Bild eingefiigt und kénnen deshalb
nur eingeschrankt verandert werden.
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Mithilfe der hier vorgestellten Extraktions- bzw. Zerlegetechnik lassen sich
zum Beispiel ClipArts oder andere Vektorgrafiken (aus anderen Program-
men wie Corel DRAW) in PowerPoint weiterbearbeiten. Im Beispiel dieses
Abschnitts isolieren wir die Gliihbirne aus einem ClipArt, das einen Mann
mit Gliithbirne zeigt, damit wir sie spater allein verwenden konnen.

1. Wibhlen Sie Einfiigen » Bilder » ClipArt, und geben Sie »Gliihbirne« in das
Suchfeld auf der rechten Seite ein. Wenn Sie das hier gezeigte ClipArt-
Mainnchen mit Glithbirne nicht finden, konnen Sie die Prasentation in-
klusive Bild auch von der beiliegenden DVD laden (ClipArt_zerlegen.

™ I TR (8 = B @
st Biefopen  Enbeud  Oberginge Avslcht  AdiIng 5@
= Y — B 1ayou - el I = I i B v+ | 3 Sucnen
iy A 1 9 p= = EE 423y &,

1 — s uroseeen . 5 4—P - 4 2 - | B Erineen =
BTN 3 e ey | T A E S A A EEEE (B ESCUNZCardnan senpomit L Martieren -
jvardienabin.. 5 | Follun I SSchitan: At | Zichnung L Benrbelen |
: |: Jx: [ F X REREE | RO, K- O ECCL L LY CIRE: KRS K. RROO WAL T (R N LR | = - x

t =l = Suwhennachc E
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& [ Erosbrusss:
m Ausgewihite Modendateitypon =
é ) ¥ Officn conm-rhalte barickeichngen
s &
&
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& B
o - I
= - =
2 2 E
: 3 =
L — L YT ——
Klicken Sie, umn Mobizen hirgueufugen : 1D tirwnese 2um Suchen von Bidern
Folindvend | “larisa-Design™ o3 Deutsch eutschland) |'|j 2= g (== {1 P

2. Ziehen Sie das ClipArt per Drag & Drop auf die Folie, oder klicken Sie
es doppelt an, um es auf die Folie zu bringen. Dann klicken Sie mit der
rechten Maustaste darauf und wéhlen Gruppieren » Gruppierung aufhe-
ben. Wenn PowerPoint nachfragt, ob die Grafik umgewandelt werden
soll, bestétigen Sie mit Ja.
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Formen extrahieren und weiterbearbeiten

3. Fiihren Sie den gleichen Schritt noch einmal aus, erst dann sehen Sie
alle Einzelteile der Grafik. Um die Markierung zu entfernen, klicken Sie
irgendwo auf die freie Flache.

4. Nun konnen Sie einzelne Elemente verschieben, dndern oder 16schen.
Isolieren Sie alle Elemente, die zur Gliihbirne gehoren, indem Sie einen
Markierungsrahmen um sie ziehen und alles verschieben. Am besten
gruppieren Sie die Teile der Glithbirne (rechte Maustaste » Gruppieren),
damit nichts aus Versehen verrutscht.
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Teil der Grafik als neue Datei speichern

Wenn Sie mit dem isolierten Teil der Grafik weiterarbeiten méch-
ten und der Befehl Gruppierung aufheben nicht aktiv ist, klicken Sie
mit der rechten Maustaste auf die Grafik, und wahlen Sie Als Grafik
speichern aus dem Kontextmenu. Speichern Sie die Grafik im Format
.emf. Fugen Sie die Datei dann Uber Einfiigen » Bilder » Grafik wieder
in die Folie ein, und arbeiten Sie damit weiter.

2D-Figuren anlegen

Mithilfe von Formen lassen sich Figuren bauen, die Sie in Thren Prasentatio-
nen einsetzen konnen, um diese lebendiger und interessanter zu gestalten.
In diesem Abschnitt mochte ich Thnen zeigen, wie Sie an die Sache heran-
gehen konnen. Sie finden das komplette Beispiel, das Sie fiir IThre Zwecke
verdndern und erweitern konnen, auch auf der beiliegenden DVD (2D-
Figuren.pptx).

Die hier gezeigten Figuren lassen sich in vielen Prdsentationen zu unter-
schiedlichen Zwecken einsetzen, beispielsweise:

® zur Darstellung eines Workflows, z.B. von der Bestellannahme bis zur
Rechnungsstellung

¢ fiir die Funktionen im Unternehmen, z.B. Controlling, Telefonzentrale

® als Hinweis- oder Signalgeber z. B. mit einem Schild in der Hand: Ist eine
Sache okay? Geht der Gewinn nach oben? Wird ein Verlust prognosti-
ziert?

® als Kennzeichnung fiir das jeweilige Kapitel, z. B. Buchhaltung, Personal-
wesen oder Marketing

Die Basisfiguren sehen Sie in der folgenden Abbildung.



2D-Figuren anlegen

i

1. Blenden Sie mit + die Hilfslinien ein, und legen Sie zunéchst
eine Fithrungslinie im unteren Drittel der Folie an. Das ist die Grundli-
nie, auf der alle Figuren zu stehen kommen.

2. Um den Rumpf der ménnlichen Figur anzulegen, wihlen Sie Start »
Zeichnung » Formen » Flussdiagramm » Flussdiagramm: Verzégerung und
ziehen die Form auf einer leeren Folie auf. Grof3e und Position spielen

erst einmal keine Rolle.
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3.

Drehen Sie dann das Objekt iiber Zeichentools » Format » Anordnen »
Drehen » Linksdrehung 90°. Geben Sie in der Befehlsgruppe GroRe bei
Héhe »4 cm« und bei Breite »6 cm« ein.

Fiir den Kopf der Figur wihlen Sie Zeichentools » Format » Formen ein-
fiigen » Standardformen » Ellipse, und zeichnen Sie mit gedriickter (o |-
Taste einen Kreis. Geben Sie unter Zeichentools » Format » GréRe bei
Hohe und Breite jeweils »3 cm« ein.

Verschieben Sie den Kopf auf den Rumpf, markieren Sie dann Rumpf
und Kopf, und richten Sie den Kopf iiber Zeichentools » Format » Anord-
nen » Ausrichten » Horizontal zentrieren genau aus. Markieren Sie nun
nur den Kopf, und verschieben Sie ihn mit den Pfeiltasten bzw.
an die richtige Position.

. Nun wird die Ménnerfigur noch formatiert. Mar-

kieren Sie dazu Kopf und Rumpf, und erstellen
Sie eine Gruppe (mit + (o] + oder
iiber die rechte Maustaste mit dem Kontextmen{i-
befehl Gruppieren). Wihlen Sie iiber Zeichen-
tools » Format » Formenarten » Schnellformatvor-
lagen die Vorlage Intensiver Effekt — Aquamarin,
Akzent 5.

Um nun die Frauenfigur anzulegen, duplizie-
ren Sie die Minnerfigur ([Strg)+ (D)), und
verschieben Sie das Duplikat nach rechts. Lo-
sen Sie die Gruppe fiir die Frauenfigur auf (mit
+ (o] + (H] oder iiber die rechte Maustaste mit dem Kontext-
meniibefehl Gruppieren » Gruppierung aufheben).

Wir wollen den Rumpf der zweiten Figur verengen, um sie weiblich
aussehen zu lassen. Legen Sie dazu zunichst eine zweite horizontale
Fithrungslinie auf der Hohe der geplanten Taille an (indem Sie die erste
Linie mit gedriickter [Strg]-Taste und gedriickter Maustaste verschie-
ben).



9.

10.

2D-Figuren anlegen

Kurvenmarker

Klicken Sie nun einmal auf einen leeren Bereich der Folie, und markie-
ren Sie dann den Rumpf der Frauenfigur. Klicken Sie mit der rechten
Maustaste darauf, und wéhlen Sie Punkte bearbeiten aus dem Kontext-
menii. (In PowerPoint 2007 wandeln Sie den Rumpf iiber Zeichentools »
Format » Formen einfiigen » Form bearbeiten » In Freihandform konvertie-
ren in eine Freihandform um. Danach klicken Sie den Rumpf mit rechts
an und wéahlen Punkte bearbeiten aus dem Kontextmenii.)

Zoomen Sie jetzt an den Rumpf heran, damit Sie feiner arbeiten kon-
nen, und bearbeiten Sie die Punkte an der Taille, d.h., Sie ziehen die
Punkte mit gedriickter Maustaste zur Rumpfmitte. Orientieren Sie sich
dabei an der zweiten horizontalen Fiihrungslinie. Diese Bearbeitung
verlangt sehr viel Fingerspitzengefiihl; wenn der Punkt sich nicht da-
hin bewegt, wo Sie ihn haben wollen, nutzen Sie die Riickgangig-Funk-
tion (oder + (Z)), und setzen Sie neu an. Um die Kriimmung
der Aullenlinie zu verdndern, kénnen Sie die Kurvenmarker verwen-
den (sie erscheinen als diinne blaue Linien mit einem Marker am Ende,
wenn Sie einen der Bearbeitungspunkte anklicken). Wenn Sie fertig
sind, beenden Sie den Punktebearbeitungsmodus (indem Sie einfach
auf einen leeren Bereich der Folie klicken). Mit + (o] +
gruppieren Sie Kopf und Rumpf wieder.
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11. Zu guter Letzt legen Sie die Kinderfiguren an. Duplizieren Sie die Mén-
ner- und die Frauenfigur. Markieren Sie beide Figuren, und klicken Sie
mit der rechten Maustaste darauf. Im Kontextmenii wéhlen Sie GroRe
und Position.

12. Im Dialogfenster setzen Sie im Bereich Skalierung das Hikchen bei Sei-
tenverhaltnis sperren (in PowerPoint 2007 hei3t die Option Ansichts-
verhiltnis sperren). In das Feld H6he geben Sie »60 %« ein. Schliellen

Sie den Dialog.
= -
Farm farmatieren @
Fiillung Grake
Linienfarbe Andern der Gréfe und Drehen
Lirienart Hahe: 553? m 2 Breite:
Cge
Schatken Drehung: |0
SDIEQE|ung Skalierung r—aayan S———" r—aayyean
Hiihe: |B0%s 2| Breite: |B0%s

Leuchten und weiche Kanten =1
Seitenverhaltnis sperren

Sb-Format Relativ zur Criginalbildgrolbe
30-Drehung Optirnal Fiir Bildschirmprésent ation
Bildkorrekburen Auflasung 646 b3 4'8_0 - ..
Eildfarbe Criginalgréte

Kinstlerische Effekke Hhe: Brette:

Zuschngiden '_ .Z_urt:lcllfgeltzglj i

Grilke

Position

Textfeld

Alternativiext

13. Mit + (o] + (H] 16sen Sie die Gruppierung der beiden kleinen
Figuren. Klicken Sie dann den Rumpf der einen Figur an, und ziehen
Sie ihn schmaler. (Alternativ klicken Sie mit der rechten Maustaste auf
den Rumpf, und wihlen Sie Grée und Position » GroRBe » Skalierung.
Stellen Sie im Feld Breite z. B. den Wert »70 %« ein.) Daraufhin miissen
Sie Kopf und Rumpf jeweils wieder zentriert ausrichten. Zum Schluss
gruppieren Sie jeweils wieder beide Teile der Figuren.
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Damit haben Sie die Basisfiguren erstellt. Der nachste Schritt ist die Zuord-
nung von bestimmten Merkmalen, damit die Figuren eine Bedeutung be-

kommen und fiir spezielle Aussagen stehen kénnen: Beispielsweise konnen

Sie Accessoires wie Taschen oder Kommunikationsmittel, andere ClipArts

oder Symbole ergédnzen.

1.

Um z.B. Figuren mit Taschen zu erstellen, gehen Sie wie folgt vor: Fiir
den Koffer des Mannes zeichnen Sie ein abgerundetes Rechteck (Start »
Zeichnung » Formen » Rechtecke » Abgerundetes Rechteck) und einen
Halbbogen (Formen » Standardformen » Halbbogen). Passen Sie die Gro-
Ben entsprechend an, und verschieben Sie die Einzelteile an die richtige
Position.

Die Accessoires sollen in farbigem Kontrast zu den Figuren stehen.
Dennoch wahlen Sie zunéchst die gleiche Formatierung wie fiir die
Figuren: Start » Zeichnung » Schnellformatvorlagen » Intensiver Effekt
— Aquamarin, Akzent 5. (Alternativ nutzen Sie den gleichen Pfad wie
oben: Zeichentools » Format » Formenarten » Schnellformatvorlagen.)
AnschlieBend verdndern Sie die Farbe iiber Schnellformatvorlagen und
Andere Designfiillungen in Formatvorlage 6. Sie konnen natiirlich auch
Farben wahlen, die zu Threm Corporate Design passen. Fiir die Damen-
und Kindertasche gehen Sie genauso vor, verwenden aber eine andere
Grundform (Start » Zeichnung » Formen » Standardformen » Trapezoid).
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Um den Figuren andere Gegenstinde »in die Hand zu geben«, konnen Sie
ebenso gut ClipArts verwenden. Wenn Thnen ein Symbol fehlt und Sie es
nicht bauen wollen, laden Sie sich eine ClipArt-Grafik herunter (Einfiigen »
ClipArt) und wenden zur Formatierung wie gehabt die Schnellformatvorla-
gen darauf an.

Falls die heruntergela-
denen Bilder nicht ganz
Ihren Vorstellungen ent-
sprechen, zerlegen Sie sie
und entfernen storende
Bestandteile (siehe den
Abschnitt »Formen extra-
hieren und weiterbearbei-
ten« ab Seite 169). Das geht allerdings nur mit Vektorgrafiken, nicht aber
mit Bildern oder Bitmaps.

SchlieRlich konnen Sie die Figuren auch mit Symbolen versehen, z.B. fiir
Zustimmung, Ablehnung oder Tendenzen. Dazu ziehen Sie einen Kreis auf
und beschriften ihn (z.B. einfach reinschreiben); anschliefend nehmen
Sie die Schnellformatvorlagen wie oben beschrieben. Die Symbole aus der
PowerPoint-Datei 2D-Figuren.pptx auf
der beiliegenden DVD konnen Sie ganz
einfach austauschen. Duplizieren Sie
zuerst die Figur mit dem Symbol. Mar-
kieren Sie dann nur das Symbol, z.B.
den Haken, indem Sie darauf klicken
und + [A] driicken. Wihlen Sie
iiber Einfligen » Symbole » Symbol ein
anderes Symbol.

Mit diesen unbegrenzten Moglichkeiten konnen Sie Thre Figurensammlung
stetig erweitern. Am besten duplizieren Sie immer eine Folie mit Figuren
und verdndern diese dann. Damit bauen Sie sich eine eigene Bibliothek fiir
Ihre Prédsentationen auf. Um dann eine Figur zu nutzen, kopieren Sie sie

((strg] + (c]) und fiigen sie in die neue Présentation ein ([Strg] + (V]).



3D-Figuren bauen

3D-Figuren bauen

In sehr vielen Prasentationen geht es um Strategien, Taktiken und Maf3nah-
men. Eine Moglichkeit der Visualisierung solcher Themen sind Schachfigu-
ren. Sie lassen sich mithilfe der 3D-Funktionen von PowerPoint bauen.

il

Der grof3e Vorteil dieser individuellen Kreationen: Sie konnen Thre Samm-
lung verdndern und an spezielle Bediirfnisse anpassen, z. B. in Bezug auf die
Farbgebung. Solche Elemente lassen sich dariiber hinaus leicht animieren,
sodass Verdnderungen und verschiedene Zustédnde sehr gut gezeigt werden
konnen. Auf der beiliegenden DVD finden Sie alle Figuren in der Prédsenta-

tion 3D-Figuren.pptx.
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1. Wir fangen mit der leichtesten Figur an, dem Bauern. Um dessen 3D-
Basis zu bauen, legen Sie erst einmal eine leere Folie an und zeichnen
den ersten Kreis (indem Sie ihn {iber Start » Zeichnung » Formen » Ellipse
mit gedriickter | ¢ |-Taste aufziehen). Klicken Sie mit der rechten Maus-
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taste darauf, und wihlen Sie GroRe und Position aus dem Kontextmenti.
Im Dialogfenster geben Sie fiir Hohe und Breite jeweils »2,8 cm« an.

2. Wechseln Sie links im Dialog zum Bereich 3D-Drehung. (In PowerPoint
2007 miissen Sie den Dialog schlief3en, erneut mit der rechten Maus-
taste auf die Form klicken und aus dem Kontextmenii Form formatieren
wiéhlen.) Stellen Sie unter Drehung dann fiir Y den Wert »290°« ein.

3. Wechseln Sie nun wiederum in den Bereich 3D-Format, und wihlen Sie
unter Abschragung fiir Oben die Option Kreis aus. Setzen Sie dessen Brei-
te auf »3 pt« und die Héhe auf »20 pt«. Bestdtigen Sie Thre Angaben mit

SchlieRen.
Form formatieren =8~ @
Foking 3D-Format
Linienfarbe Abschragung
ini I Breite: 3PL, k=]
Linienart Oben: o ___ :
Schatten |3 Hghe: 20PL
Keine Abschriagung
Spiegelung Unten;

Leuchten und weiche Kanten

; Tiefe
3D-Format ! -

-arbe: Abschragung
30-Drehung Fa —|

Bildkorrekturen Kontur | | |
X ] i . J

Bildfarbe Earbe: ”

reis
Kinstlerische Effekte Oberflache I l
Zuschneiden
Material:
Griifie
Position _J

Textfeld kie

Albernativiest

4. Um den zweiten Baustein der Figur zu erstellen, duplizieren Sie den ers-
ten Kreis mit + (D], klicken Sie mit der rechten Maustaste dar-
auf, und wahlen Sie im Kontextmenii Form formatieren » 3D-Format »
Abschragung » Oben » Starke Abschragung. Fiir die Breite und Hohe ge-
ben Sie jeweils »12 pt« an. Unter Abschragung » Unten nehmen Sie Kreis
und geben als Parameter fiir Breite und Héhe jeweils »6 pt« an.
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5.

3D-Figuren bauen

‘Form formatieren B
Fiilung 3D-Format
Linierfarbe Abschragung

s Breite: 12 PE.
Linignark oben: E " e
Schatken e T 12Pt

; Ereite: & PE
Spiegelung Unten: I o= T
Hihe: &P,

Leuchten und weiche Kanten

Tiefe:
30-Farmat
30-Drehung Farbe: Tiefe: 0Pt
Bildkarrekturen kantlr
Bildfarbe Farbe: Gréife: ore. B
Kinstlerische Effekbe Oberflache
Zuschneiden

Material: Q’ * | Beleuchtung: g -

Grﬁﬁe pr— e/
Position inkel: |9 1

Alernativiest

Schliellen Sie das Dialogfenster Form formatieren, und verdndern Sie
mit der Maus oder mit den Pfeiltasten die Position des zweiten Kreises
so, dass er passend iiber dem ersten Kreis sitzt.

Nun duplizieren Sie den zweiten Kreis, indem Sie ihn markieren und
+ (D] driicken. Andern Sie seine GréRe auf dem bekannten Weg:
Fiir Breite und Hohe geben Sie jeweils »2,2 cm« an. Im Bereich 3D-For-
mat wéhlen Sie unter Abschragung » Oben die Option Kreis. Setzen Sie
Breite und Hoéhe auf »13 pt«. Fiir Abschragung » Unten wéhlen Sie die
Vorgabe Keine. Platzieren Sie den Kreis an der richtigen Stelle iiber den
beiden anderen.

Nun machen wir uns daran, den Rumpf der Figur, einen Zwischenring
und die Kugel als Kopf zu gestalten. Fiir den Rumpf duplizieren Sie den
dritten Kreis. Unter GroRe stellen Sie fiir Breite und Hohe jeweils »1,6
cm« ein. Unter Abschragung » Oben wihlen Sie Starke Abschragung mit
einer Breite von »6 pt« und einer Héhe von »40 pt«. Bei Abschragung »
Unten geben Sie Keine an. Verschieben Sie das Teil iiber die drei anderen
Bausteine.
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8.

10.

Dann ist der Zwischenring dran: Duplizieren Sie den Rumpf. Bei Ab-
schragung » Oben geben Sie Kreis an und versehen ihn mit einer Breite
von »20 pt« und einer Hohe von »6 pt«. Fiir Abschragung » Unten wéh-
len Sie ebenfalls Kreis und geben eine Breite von »20 pt« und eine Hohe
von »6 pt« an. Positionieren Sie auch diesen Ring entsprechend.

Zu guter Letzt setzen Sie der Figur die Kugel auf. Wieder duplizieren
Sie zunidchst den Zwischenring. Fiir Abschragung » Oben wéhlen Sie
dann Kreis und geben bei Breite und bei Hohe »20 pt« an. Auch unter
Abschréagung » Unten wihlen Sie Kreis, mit einer Breite und einer Hohe
von jeweils »20 pt«. Verschieben Sie die Kugel iiber die anderen Teile.

Nun fehlen noch einige Abschlussarbeiten. Markieren Sie alle Elemen-
te der Figur und richten Sie sie iiber Start » Zeichnung » Anordnen » Ob-
jekte positionieren » Ausrichten » Horizontal zentrieren mittig aus. Dann
gruppieren Sie alle Elemente ([Strg]+ (¢ ]+ (G]), um sie anschlie-
Rend einzufiarben (rechte Maustaste » Form formatieren). Wihlen Sie
fiir die Fiillung wie auch fiir die Linienfarbe (fiir die Kontur der Form)
den gleichen Farbton, z.B. Weil3 bzw. Grau (fiir helle Figuren) oder
Schwarz (fiir dunkle Figuren).

Sie haben nun das Prinzip gesehen, wie die Figuren aufgebaut werden. Ver-
suchen Sie, die iibrigen Figuren selbststdndig aufzubauen. Dennoch mochte
ich Thnen ein paar Tipps zu Konig, Dame und Springer nicht vorenthalten.

Nachdem Sie einen Kreis gezeichnet haben, denken Sie daran, ihn wie eben
beschrieben zu drehen (indem Sie Form formatieren » 3D-Drehung » Dre-
hung wahlen und im Feld Y den Wert »290°« angeben).

® Konig: Das Kreuz fiir die »Krone« zeichnen Sie iiber Start » Zeichnung »
Formen » Standardformen » Zierrahmen. Nutzen Sie den Ziehmarker (die
kleine gelbe Raute), um die Form selbst schmaler zu machen. Um das
Kreuz perspektivisch zu zeigen, wahlen Sie Form formatieren » 3D-Dre-
hung » Voreinstellungen » Parallel » Von der Achse 1 nach rechts. (Eventu-
ell miissen Sie die Perspektive noch iiber die Werte der X- und Z-Achse
nachjustieren.) Bei 3D-Format » Abschragung wéhlen Sie fiir Oben und



3D-Figuren bauen

Unten jeweils die Option Kreis und geben als Parameter bei Breite und
Hohe jeweils »3 pt« an.

Dame: Fiir die Abschriagung des zweithochsten Elements der Dame
zeichnen Sie einen Kreis und wihlen 3D-Format » Abschragung » Oben »
Weiche Abrundung mit einer Breite von »20 pt« und einer Hohe von »6 pt«.
Fiir Abschragung » Unten » Starke Abschragung geben Sie eine Breite von
»8 pt« und eine Hohe von »20 pt« an. Die Halbkugel ganz oben auf der
Figur konnen Sie mit folgenden Parametern bauen: Unter 3D-Format »
Abschragung » Oben wihlen Sie Kreis und geben fiir Breite und Hohe je-
weils »12 pt« an.

Springer: Den Kopf des Springers erstellen Sie am einfachsten, indem
Sie iiber Einfiigen » ClipArt als Suchbegriff »Schach« eingeben (gegebe-
nenfalls auch iiber Office-Online). Dort suchen Sie sich ein passendes
Pferdebild aus und »zerlegen« die ClipArt-Grafik so, dass Sie den Pferde-
kopf weiterverwenden konnen (siehe Abschnitt »Formen extrahieren
und weiterbearbeiten« ab Seite 169). Gehen Sie dann weiter vor wie bei
dem Kreuz auf der Konigsfigur.
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Eine 3D-Kugel gestalten

Ich zeige Thnen in diesem Abschnitt, wie man eine schone 3D-Kugel gestal-
tet, denn sie eignet sich fiir viele Einsatzgebiete, z.B. als Aufzdhlungszei-
chen, in Phasendiagrammen, fiir Schaubilder und Infografiken.

Implementierung

@ Konzeption

2 o

e Soll-Ist-Analyse

1. Legen Sie eine leere Folie an, und ziehen Sie iiber Start » Zeichnung »
Formen » Ellipse mit gedriickter [ o |-Taste einen Kreis auf. Uber das Kon-
textmeni (rechte Maustaste) wahlen Sie Groe und Position und tippen
bei Breite und H6he jeweils »4 cm« ein. Im Bereich Linienfarbe wiahlen
Sie Keine Linie.

2. Im gleichen Dialogfenster im Bereich 3D-Format setzen Sie folgende Pa-
rameter: Bei Abschragung » Oben wihlen Sie Kreis und geben fiir Breite
und Hohe jeweils »2 cm« an. (Geben Sie den Wert tatsichlich in cm an;
er wird dann automatisch in Punkt umgerechnet.) Fiir Abschragung »
Unten nehmen Sie ebenfalls die Option Kreis mit einer Breite und Hohe
von jeweils »2 cm.

3. Weiter unten im Bereich 3D-Format finden Sie Moglichkeiten, die Ober-
flaichenstruktur zu verdndern und die »Beleuchtung« (Lichteffekte und
Schatten) anzupassen. Bestétigen Sie Ihre Eingaben mit Schliefen. Zum
Schluss wihlen Sie iiber Start » Zeichnung » Formeffekte » Schatten »
Perspektive » Perspektivisch diagonal oben rechts, um noch mehr Raum-
lichkeit zu schaffen.
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Piktogramme erstellen

Versuchen Sie noch weitere Ideen mithilfe von Kugeln darzustellen, z.B.
Krafteverhaltnisse oder Starken und Schwéchen.

Piktogramme erstellen

Piktogramme sind grafische Symbole, die Sie sehr gut einsetzen kénnen,
um Threm Publikum eine Orientierung zu ermoglichen. Denken Sie bei-
spielsweise an einen Elektromarkt und seine Werbeprospekte. Die Eigen-
schaften der einzelnen Geréte sind hdufig mit Piktogrammen kombiniert,
z.B. die Umdrehungszahl bei Bohrmaschinen, der Prozessortakt von Com-
putern oder auch die Garantiedauer. Je haufiger Sie diese Symbole sehen,
desto schneller und sicherer konnen Sie die Eigenschaften einordnen. Die
Piktogramme machen es uns also unter anderem leicht, einer Sache einen
Wert zuzuordnen.

Sie werten mit Piktogrammen nicht nur die Prisentation optisch auf, son-
dern helfen dem Zuschauer auch, ihre Inhalte schneller zu verstehen. Auf
der beiliegenden DVD finden Sie mehr als 100 Piktogramme fiir unter-
schiedlichste Einsatzzwecke (Piktogramme.pptx).

Die hier vorgestellten Piktogramme bestehen aus der Piktogrammbasis, z.B.
einem Rahmen und einer farbigen Grundfldche, und dem Symbol selbst. Sie
konnen die auf der DVD mitgelieferten Piktogramme einfach verandern, in-
dem Sie zunéchst die Gruppierung l6sen (iiber Start » Zeichnung » Anordnen »
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Objekte gruppieren » Gruppierung aufheben oder mit + (o] + (H]))und
dann die griine gegen eine andere Farbbasis austauschen. Sie konnen die Pik-
togrammauswahl auch erweitern, indem Sie sich zusatzliche Symbole einfii-
gen bzw. erstellen.

Aufbau der Piktogramme

-

Uber
* Webdings
* Wingdings
* ClipArts
* Formen

alternative || i
Basis

Um ein Symbol aus einer Schriftart einzufiigen, legen Sie ein Textfeld an
(Einfliigen » Text » Textfeld), und fiigen Sie dann iiber Einfiigen » Symbole »
Symbol ein Symbol Ihrer Wahl ein. Vergrof3ern Sie tiber Start » Schriftart
die SchriftgroRe, und setzen Sie die Schriftfarbe auf WeiR, Hintergrund 1.
Platzieren Sie das Textfeld mittig iiber der Basis und gruppieren Sie beide.

Basis erstellen

Eine Anleitung dazu, wie Sie sich eine neue Piktogrammbasis er-
stellen, finden Sie ebenfalls auf der beiliegenden DVD in der Datei
Piktogramme.pptx.

Was immer Sie an den Piktogrammen verandern — vergessen Sie

nicht, hinterher wieder alle Teile zu gruppieren ([Strg] + (¢ ]+ (G]).

Das erspart Ihnen unnétiges Verschieben von Elementen.



Kapitel 5

Tabellen, Diagramme und Schau-
bilder intelligent konzipieren

Je nach Einsatzgebiet, zum Beispiel bei einer Vertriebskonferenz, bei einem
offentlichen Vortrag, bei einem Fachvortrag oder einem internen Meeting,
werden Zahlen, Daten und Fakten in einer Prasentation verwendet. Dieses
Kapitel soll Ihnen Konzepte, Ideen und Anregungen liefern, wie Sie die Dar-
stellung mithilfe von Tabellen, Diagrammen und Schaubildern interessan-
ter aufbereiten kdnnen.
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Sie werden lernen, welche grundlegenden Konzepte es gibt, um Zahlen, Da-
ten, Fakten darzustellen. Sie werden SmartArts individuell anpassen und
Ideen kennenlernen, die das SmartArt-Konzept erweitern. Diagramme las-
sen sich mit einfachen Mittel in Abhédngigkeit natiirlich von der Zielgruppe
interessanter und spannender gestalten. Tabellen konnen Sie durch Einbin-
dung von Grafiken aufwerten und damit den Empfingern der Prédsentatio-
nen ein einpragsameres Bild der Tabelle liefern. Sie lernen, wie Sie anstelle
von trockenen Zahlen und Daten Schaubilder und Infografiken erstellen.

Darstellungskonzepte

Meistens stellen wir Zahlen als reine Tabellen oder als einfache Linien-,
Balken-, Sdulen- oder Kreisdiagramme dar. Wenn die Daten (auch die Zah-
len selbst) komplexer oder umfangreicher werden, wenn eine einpréagsame
oder wenn eine schnell verstidndliche Darstellung gesucht wird, ist es haufig
sinnvoll, nach anderen Darstellungsvarianten zu suchen. In diesem Zusam-
menhang wird dann auch von Infografiken oder Schaubildern gesprochen.

In diesem Kapitel geht es also um grundlegende Darstellungskonzepte, die
Ihnen dabei helfen, Thre Daten schnell interessanter aufzubereiten. Auch
diese Konzepte lassen sich nattirlich individuell erweitern und anpassen.

Konzepte und Beispiele

Fir einen Sachverhalt gibt es immer verschiedene Darstellungs-
moglichkeiten. Dem einen gefallt eine Darstellung auf Anhieb, dem
anderen nicht. Probieren Sie daher aus, was am besten zur konkre-
ten Aufgabenstellung und zu Ihrer Zielgruppe passt. Verandern Sie
die folgenden Ideen dann ruhig nach lhren Vorstellungen.

SmartArt-Grafiken und auch das SmartArt-Konzept dahinter sind eine gute
Moglichkeit, um Daten aufzubereiten. Das Thema wurde schon einmal in
Kapitel 2, »Text spannender gestalten«, angesprochen, als es darum ging,
Text mithilfe von SmartArt-Grafiken interessanter zu gestalten. Da Power-



Darstellungskonzepte

Point die Grafiken von Haus aus mitbringt, spart es eine Menge Zeit, sie
auch fiir die Darstellung von Zahlen, Daten und Fakten zu nutzen. Die Ein-
satzgebiete konnten dabei etwa folgende sein:

® Kennzahlensysteme

® Verteilungen, z.B. Ressourcenplan, Umsatz- und Gewinnverteilung

® Zuordnungen wie Firmenstrukturen oder Stellenhierarchien

e Strukturen, z.B. Anteile an einem Fond oder Inhaltsstoffe eines Produkts

e Abliufe und Prozessfliisse, wie etwa Arbeitsschritte beim Ausfiillen eines
Formulars oder Regeln fiir die Bearbeitung eines Vorgangs

® Zusammenhinge und Abhéngigkeiten, z.B. der Kreislauf des Wassers in
der Natur oder der Zusammenhang von Widerstand, Strom und Span-
nung

Die néchsten beiden Abbildungen

zeigen zwei Beispiele. Das erste Gesamt m
Bild ist ein Umsatziiberblick, der ! 1

i ' s
mithilfe der SmartArt-Grafik Hori- 9,6 Mio. € AT

. . I_I_l I_I_I
zontale Hierarchie gestaltet wurde st Bl i B brsiics B vicd s

.. - Produkte 7,1Mio. € [l 2,5 Mio. € 0,8 Mio. €
(der Meniipfad lautet Einfiigen »

lllustrationen » SmartArt » Hierar-
chie).

Das zweite Beispiel zeigt eine Grafik zur Produktionsleistung, die mit der
SmartArt-Grafik Geschachteltes Ziel erstellt wurde (zu finden {iber Einfiigen »
lllustrationen » SmartArt » Beziehung).

Unternehmen Musteralpha — Alle Standorte

Sparte 1
1251

| Tochterunternehmen Musterbeta

Sparte 2 il Produkt1

232t 11t Abteﬂung Mustergamma

Produkt 2 Maschine 1 Maschine 2 Maschine 3
Sparte 3 S 05t o0&t 04t

7,1t

189



Kapitel 5 —Tabellen, Diagramme und Schaubilder

Eine SmartArt-Grafik verwenden

In diesem Abschnitt erarbeiten wir den Umsatziiberblick aus dem vorheri-
gen Abschnitt, der mithilfe der SmartArt-Grafik Beschriftete Hierarchie (in
PowerPoint 2007 heifl3t sie Horizontale Hierarchie) gestaltet wurde.

1. Legen Sie eine neue Folie mit dem Layout Titel und Inhalt an. Geben Sie
als Titel »Umsatziiberblick« ein. Klicken Sie dann auf das Symbol Smart-
Art-Grafik einfiigen in der Mitte der Folie, und wéhlen Sie im Dialogfens-
ter Hierarchie » Beschriftete Hierarchie aus.

STANAR. Crafi suswahlen %)

I alle

5= Liste

=22 Prozess n
5 o _ = B8 ——= -

X
i
>

0
0
0
E
E
e
L

E] Beziehung I_’= -'f:- — = E\ EI
Matriz = a2 :ﬂ {=]
S Pyramide =
a e — Beschriftete Hierarchie
E Grafik - Hiermit. zeigen Sie hierarchische 4

Beziehungen von oben nach unten an,
und zwar hierarchisch gruppiert, Betont

-

die Uberschrift oder Text der Ebene 1.
Die erste Textzeile der Ebene 1 wird in
der Form am Anfang der Hieratrchie

2rmsnsink oed slle feckFalaandan

I O I [ Abbrechen ]

2. Das SmartArt wird eingefiigt, und links daneben er-
scheint ein Textfenster. Hier{iber konnen Sie die Tex-
te sehr einfach dndern. Wenn Sie es nicht brauchen,
schlieRen Sie es. Uber die kleinen Pfeile links an der
Grafik konnen Sie das Fenster jederzeit wieder aus-
klappen. Geben Sie die entsprechenden Texte ein.
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Arbeit mit dem Textfenster

Mit (o] + fligen Sie einem Hierarchieelement im Textfenster
weitere Zeilen hinzu.

Fir ein neues Hierarchieelement driicken Sie im Textfenster einfach
die [« ]-Taste.

Wenn Sie auf eine Gliederungsebene (Aufzahlungsebene) tiefer
wollen, nutzen Sie die [%5_]-Taste; wenn Sie eine Gliederungsebene
héher wollen, driicken Sie die [ ¢ J-Taste und die (5, ]-Taste.

Um im Textfenster etwas zu l6schen, nutzen Sie entweder die

[+« ]- (Riicktaste) oder die [Entf ]-Taste.

Anstatt das Textfenster zu verwenden, kénnen Sie Anderungen natiir-
lich auch direkt in den Feldern der Grafik vornehmen.

[FL2 0 A0 e e B B e e 2 e O e 2 e e e e e g e A 42 ]
: Umsatztberblick
~ Geben Sie hier Ihren Text ein 53
= [12,8 Mio. €
= Produktgruppe &
9,6 Mo, £
» Produkt 1 Gesamt
7,1Mi0, €
* Produkt 2 |
25Mo. & " Bereich
* Produktgruppe B |
3,2 Mio. €
* Produkt 3
2,4 Mio, £ Produkte
* Produkt 4
0,8 Mio, €
* Gesamt
* Bereich
* Produkte
T —
Beschriftete Hierarchie...

= A hinzuzuftgen

3. Wenn Sie eher grafisch arbeiten, kénnen Sie die Anzahl der Elemente
im SmartArt iiber Form hinzufiigen sowohl horizontal als auch vertikal
erh6hen. Um neue Formen in die Hierarchie einzufiigen, gibt es eine
eigene Befehlsgruppe SmartArt-Tools » Entwurf » Grafik erstellen.
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m stat Lifugen  Enteut  Uberginge  Ammstionen  Bikdichamprisentition  Ube
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o

Gesamt

4. Nun kiimmern wir uns um die gestalterischen Aspekte. Im Normalfall
sind die Texte der SmartArt-Grafik entweder zu klein oder zu grof3.
Markieren Sie daher alle Eintrage bis auf die Beschriftung der breiten
Balken. Am besten klicken Sie ein Element an, halten die [ ¢ ]-Taste ge-
driickt und markieren das nichste Element, oder Sie 6ffnen die Textbox
und markieren alle Textzeilen, deren Textgrof3e gedndert werden soll.

Passen Sie iiber Start » Schriftart die Schriftgrofe an. Stellen Sie in die-
sem Fall 18 Punkt ein.

n Stwt Linfagen: it Uberginge It T
i et ntenest (10 <A A B ww [ g & A
ln’u‘] dar =) R Puricisntiin | S P4 D121 e O | & 2 e
irfugen

=
Heue i 2 E 8 Fermen Anardnen SchneRfermat
F foiee “SAbichnitt FArusdafi-por A- EEIER I 7 b i et @~ | Iy
s 3 Ziennuing i fea

Cj = [x | CIFTE0 [ XIETET, BTIIET STETaE: SREITAT GrTrerE T ETors CICTIrE: S

B
B |
| i ] s .
| 1 wﬁmﬁuﬂmmrmﬁ = UmSﬂtZUhEI’bIICk
! . e [28MOE 2]
* PrOCLKIHETN A
A6Mo €
'?nu.:
s Gesamt
25Mo, &
* POCUKIGRENe B
32Mo € Bereich
= Prockt 3
24M0.6

« Procuke
Nt Produkte

Ansicht  Addking Entwurt  Format

Zwiichenabla Fosan Setriftar
[

CTT CIErEIK OOTTOrE [ EETE

* Gosant
= Boreich
* Procude i

| Beschiillete Hierarchie..

5. Markieren Sie dann die Balkenbeschriftung (Gesamt, Bereich, Produk-
te), und stellen Sie eine Schriftgréfse von 28 Punkt ein. Da der Umbruch
bei Produktgruppe A und Produktgruppe B nun nicht mehr korrekt ist,
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Eine SmartArt-Grafik verwenden

miissen Sie die Boxen breiter ziehen. Markieren Sie dazu die erste der
beiden Boxen mit einem einfachen Mausklick. Die zweite Box markieren
Sie danach, indem Sie sie mit gedriickter o ]-Taste anklicken. Visieren
Sie beim Klicken am besten den Rand der Box an. Ziehen Sie beide Bo-
xen mithilfe eines der Marker breiter, die sich rechts bzw. links an der
Box befinden.

(11200 130 1 B B A R D B B A 132 ]

Gehen Sie hier Ihren Text ein 52

. 128me Umsatztberblick

. Pmdu‘ktgruppe!—\
9,6 M
® Produkt 1
7iME
* Produkt 2
2,5 M€
* ProduktgruppeB
3,2
* Produkt 2

2,4 ME P &
* Produkt 4 Produkte €

0,6Me

Gesamt

* Gesamt

* Bereich
* Produkte

Beschriftete Hierarchie...

| —

6. Zum Schluss kénnen Sie iiber SmartArt-Tools » Entwurf » SmartArt-For-
matvorlagen noch die farbliche Ausgestaltung je nach Geschmack ver-

B H9 GG kB |+ =
Start  Einfiigen  Entwurf  Uberginge i Bildschirmprisentation  Uberprifen  Ansicht  Addns | Entwurf | Format
L Ferm hinzufigen ~ 4 Haher stufen * a :""- Beste Suchergebnisse fiir Dokument |~ E B
5 Aufzihlungszeichen hinzufugen = Tiefer stufen 3 = hd i = AT
o ! Layout | Farben Ll L | Grafik  Korvertieren
[ Textbereich & von rechts nach links 53,7 | sndern v | shdem v | !"“! - it b ebeet 5
Grafik erstellen | Layouts | | Zuricksetzen |

VA2 0 A0 R I EREENRIRNE CREERE V3]

T S K T KRy R )|
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Erweiterte SmartArt-Konzepte

SmartArt-Grafiken werden den Grundanforderungen fiir die Darstellung
von Zahlen, Daten und Fakten meistens gerecht. Manchmal ist es aber ab-
wechslungsreicher und auch sinnvoll, von den in PowerPoint vorhandenen
SmartArt-Konzepten abzuweichen und andere Darstellungsweisen einzu-
setzen. Im Folgenden finden Sie einige Ideen und Méglichkeiten, die Sie fiir
Ihre Zwecke verwenden, anpassen und erweitern konnen. Laden Sie dazu
die Prasentation Konzepte.pptx von der beiliegenden DVD, und kopieren Sie
sich die Muster, die Sie einsetzen wollen, in Ihre Priasentation. Wenn Sie die
Gruppierung eines Musters auflosen, konnen Sie noch feinere Verdnderun-
gen vornehmen.

Mit Ebenen arbeiten

Mithilfe unterschiedlicher Ebenen lassen sich Zusammenhinge, Hierar-
chiestufen, Verteilungen usw. relativ leicht darstellen.

— =

_1____________/

Anstatt verschiedene Zahlen, z. B. Umsitze, einfach in einer Tabelle aufzu-
fithren, kann man sie mit wenigen Handgriffen anschaulich darstellen, in-
dem man sie je nach Grolde auf verschiedenen Ebenen anordnet. So lassen
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Mit Ebenen arbeiten

sie sich leichter miteinander vergleichen. In der obigen Abbildung bzw. auf
der Folie sehen Sie neun Darstellungsmoglichkeiten. Wenn Sie eine ver-
wenden moéchten, kopieren Sie sie einfach auf eine neue Folie, und arbeiten
Sie dann damit weiter.

Plattformen — Umsatz
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Im Folgenden werden wir gemeinsam eine Grafik erstellen, die das Konzept
der Ebenen verfolgt.

1. Offnen Sie die Datei Konzepte.pptx von der
beiliegenden DVD, und kopieren Sie die ge-
stapelten runden Flichen. Fiigen Sie die Fla-
chen in eine neue Prisentation ein, auf einer
Folie mit dem Layout Nur Titel. Geben Sie in
das Titelfeld den Text »3 Zielebenen« ein.

2. Markieren Sie das Objekt (alle drei Flichen), und wihlen Sie Start »
Zeichnung » Formeffekte » Voreinstellung » Voreinstellung 10 aus. Wah-
len Sie iiber Start » Zeichnung » Fiilleffekt als Fiillfarbe eine Farbe aus,
die Thnen geféllt. Losen Sie die Gruppierung vollstdndig auf (indem Sie

zweimal + (o] + [H] driicken).
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3. Damit Sie wissen, wie grof3 die kleinste Fli-
che mindestens sein muss, schreiben Sie
den Text »Hauptziel« in ein Textfeld (Start »
Zeichnung » Formen » Textfeld). Achtung:
Den Text nicht in die Form schreiben, denn
sonst miissen Sie ihn gegebenenfalls kom-
pliziert nachbearbeiten, damit er gut wirkt!
Nehmen Sie als Textfarbe eine Farbe, die im Kontrast zur Fliche, z.B.
zu Weil3, steht. Fetten Sie die Schrift, und wéhlen Sie als Schriftgrofe
z.B. 32 Punkt. Formatieren Sie den Text schlieRlich iiber Zeichentools »
Format » WordArt-Formate » Texteffekte » Spiegelung » Enge Spiegelung,
mit Beriihrung.

_ | Hauptziel |

4. Verschieben Sie nun die Flachen (die oberste zusammen mit dem Text-
feld) in eine versetzte Position. Ziehen Sie die einzelnen Flachen gro-
Rer, sodass eine Steigerung sichtbar ist.

5. Duplizieren Sie nun das Textfeld »Hauptziel« zweimal ([Strg] + [D)).
Verschieben Sie die Textkopien auf die beiden freien Flachen, und &n-
dern Sie den Inhalt in »Feinziele« bzw. »Grobziele«. Fertig ist die neue
Darstellung mit einer erweiterten SmartArt-Grafik.
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Integrierte Darstellungskonzepte

Hauptziei

Feinziele

Grobziele

Integrierte Darstellungskonzepte

Das Konzept der integrierten Darstellung dient dazu, Teile eines Ganzen zu
zeigen. Wie der Name vermuten lasst, wird dabei ein einzelnes Teil oder
grafisches Element in ein grof3eres Element integriert. Die folgende Abbil-
dung zeigt Thnen einige Ideen, beispielsweise einen Karteikasten (in der
Mitte ganz rechts). Die Karteikarte ist Teil des Karteikastens, also als Ele-

ment in den Kasten integriert.

wiiil
Y

A

00 | 00000
23k
00’ 80000
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Als Beispiel sei hier eine Grafik zur Produktzusammensetzung angefiihrt.
Die klassische Darstellung wire vielleicht ein Balken- oder ein Tortendia-
gramm, doch anschaulicher wird es, wenn Sie eine integrierte Darstellung
wahlen. Dies sorgt fiir bessere Einpragsamkeit bei Zuschauern und wirkt
insgesamt interessanter.

Produktzusammensetzung

A 0,9% Argon

78% Stickstoff

‘)

Die Bestandteile eines Finanzplans darstellen

Im Folgenden zeige ich Thnen, wie Sie Teile eines Finanzplans darstellen
konnen. Das Beispiel dient nur zu Ubungszwecken und zeigt eine verein-
fachte Aufteilung der in einem Finanzplan enthaltenen Teilpléane.

1. Offnen Sie die Datei Konzepte.pptx von der beiliegenden DVD, und ko-
pieren Sie den dargestellten Ordner. Fiigen Sie ihn in eine neue Prasen-
tation ein, auf einer Folie mit dem Layout Nur Titel. Geben Sie als Titel
»Unser Finanzplan besteht aus ...« ein.



2.

6.

Unser Finanzplan besteht aus ...

VergroRRern Sie den Facherordner um ca. 60 % (mithilfe der Marker oder
indem Sie {iber das Kontextmenii und Gr6Be und Position » Skalierung in
die Felder Hohe und Breite jeweils »160 %« eingeben).

Waihlen Sie als Fiillfarbe einen schwachen
Gelbton (Start» Zeichnung» Fiilleffekt » Weitere
Fiillfarben) und fiir die Linien einen hellgrauen
Farbton (Start » Zeichnung » Formkontur » WeiB,
Hintergrund 1, dunkler 15%). Heben Sie dann
die Gruppierung auf ([Strg]+ (o] + (H]).
Markieren Sie das mittlere Blatt, und setzen Sie dessen Fiillfarbe auf
WeiB, Hintergrund 1.

Ziehen Sie das weil3e Blatt aus dem Ordner und nach rechts auf die Fo-
lie. Klicken Sie das Blatt an, und schreiben Sie »1/3 Umsatzplan« da-
rauf. Klicken Sie mit der rechten Maustaste auf das Blatt, und wahlen Sie
Form formatieren » Textfeld » Textlayout » Vertikale Ausrichtung » Oben.
Setzen Sie iiber Start » Schriftart noch die Schriftgrof3e auf 20 Punkt.

Uber Einfiigen » Tabelle fiigen Sie eine 4x4 Felder grof3e Tabelle ein. Um
die Tabelle zu formatieren, markieren Sie sie und wihlen Tabellentools »
Entwurf » Tabellenformatvorlagen » Keine Formatvorlage, kein Raster.

Waéhlen Sie nun tber Tabellentools » Entwurf » Rahmenlinien zeichnen »
Stiftfarbe die Farbe WeiR, Hintergrund 1, dunkler 15% aus. Dann stellen
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Sie liber Tabellentools » Entwurf » Tabellenformatvorlagen » Rahmen die
Option Alle Rahmenlinien ein.

7. Verkleinern Sie die Tabelle iiber die Ziehpunkte so, dass sie auf das Blatt
passt. Sollte die Hohe nicht passen, markieren Sie alle Zellen der Tabel-
le, und reduzieren Sie die Schriftgrofie.

8. Da eine Tabelle nicht gruppiert
werden kann, dies jedoch die
weitere Arbeit sehr erleichtern
wiirde, zeige ich Thnen einen 343 Umsatpian
kleinen Trick. Klicken Sie mit
der rechten Maustaste auf den
Rahmen der Tabelle, und legen
Sie sie als .png- oder .jpg-Datei
ab (Mentibefehl Als Grafik spei-
chern). Uber Einfligen » Grafik laden Sie dann diese Datei wieder in Ihre

Unser Finanzplan besteht aus ...

Prasentation und tauschen sie mit der Tabelle aus.

9. Duplizieren Sie daraufhin das Ficherblatt und die eingefiigte Grafik
zweimal ([Strg] + (D)), und schreiben Sie auf das eine Blatt »1/3 Li-
quiditdtsplan« und auf das andere »1/3 Investitionsplan«. Gruppieren

Sie die Texte und Blitter jeweils (mit + (o] + [G)).

Unser Finanzplan besteht aus ...

1/3 Investitionsplan

1/3 Liquiditatsplan

1/3 Umsatzplan
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Diagrammbasierte Konzepte

10. Verteilen Sie die Blitter nun auf der Folie, wie in der nichsten Abbil-
dung gezeigt. Sie konnen ihre Anordnung leicht &ndern, indem Sie sie
iiber Start » Zeichnung » Anordnen in den Vordergrund, in den Hinter-
grund usw. verschieben.

11. Beschriften Sie zum Schluss den Ordner mit dem Text »Finanzplanc,
und formatieren Sie ihn mithilfe der Formatvorlagen (Zeichentools »
Format » WordArt-Formate).

Unser Finanzplan besteht aus ...

1/3 Investitionsplan
1/3 Liquiditatsplan
1/3 Umsatzplan

Diagrammbasierte Konzepte

Die Klassiker wie Sédulen-, Balken-, Linien- und Kreisdiagramm sind Ih-
nen bekannt. In vielen Zusammenhingen werden die Diagramme in ihrer
Grundform verwendet, d.h., wie von PowerPoint vorgegeben. Die meisten
Ersteller passen die Diagramme dann noch beziiglich Gré3e, Farbe und Cor-
porate Design an. Die Darstellung wirkt daher sehr sachlich, akademisch
und faktenbasiert. Die Zielgruppe dieser Darstellungen sind in der Regel
»Zahlenmenschen« wie Controller, Wirtschaftspriifer und andere, denen es
leicht féllt, Zahlen und Diagramme zu erfassen und zu behalten.
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Die Praxis zeigt auch, dass die Darstellung von Zahlen und Daten haufig mit
der Branche und der Art der Présentation, z. B. Bilanzpressekonferenzen ei-
ner Bank, Mathematik-Vorlesungen an einer Universitidt oder Verkaufsver-
anstaltungen eines Konsumgiiterherstellers, zusammenhéngt.

Dasbedeutet fiir einen Teil der Prasentationen, dass die sachliche Optik voll-
kommen ausreicht. Andere Zielgruppen wiederum, die »Nicht-Zahlenmen-
schen«, brauchen Gedichtnisanker, um sich Zahlen und Daten besser mer-
ken zu kénnen. Fiir sie miissen die Diagramme visuell attraktiver oder auch
»emotionaler« gestaltet werden. Neben der besseren Merkbarkeit steigt die
Aufmerksamkeit, und es kommt mehr Abwechslung in die Prasentation.

Die folgenden Anregungen werden Ihnen helfen, attraktivere Diagramme
zu gestalten.

Diagramme mit Bild

Die einfachste Form, ein Diagramm lebendiger zu gestalten, ist das Hinzu-
fligen eines passenden Bildes. Das Bild sollte natiirlich Bezug zum Inhalt
des Diagramms haben.

LWl
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A

B
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L1 il

' A B C D

Die Tabelle zeigt einige Beispiele fiir Diagramme mit Bild, die Sie als Anre-
gungen fiir eigene Kreationen betrachten kénnen.

b8 Bl Lt

» = 0 o

D

Diagrammthema Bildidee

Umsatz eines bestimmten
Produkts, z.B. Apfel

Abbildung des jeweiligen Produkts

Marktanteil des Unternehmens Logo des Unternehmens




Diagramme mit Bild

Diagrammthema Bildidee

Produktionsleistung eines Stand- | Signifikantes Gebaude des Stand-
orts orts

Distribution (Verteilung) eines Produkt oder Gebiet
Produkts Uber ein Gebiet

Anteil eines bestimmten Rohstoffs | Abbildung des Rohstoffs oder
am Gesamtprodukt chemische Formel

Vergleich verschiedener Produkte | Korb oder Einkaufswagen mit den
Produkten

Wir haben im Verlauf dieses Buches schon diverse Beispiele dafiir gesehen,
wie man Daten mit Bildern kombinieren kann. Die folgende Abbildung zeigt
ein weiteres Diagramm, das mit einem passenden Bild aufgefrischt wurde.

Ausgehen

Faulenzen

ort treiben

Lesen
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Von Piktogrammen uberlagerte Diagramme

Eine weitere Moglichkeit, Diagramme attraktiver zu gestalten, ist die Uber-
lagerung mit Piktogrammen. Ebenso wie Bilder sollten sie natiirlich im
Zusammenhang mit den Inhalten stehen. Piktogramme haben jedoch den
Vorteil, dass sie — dezent eingesetzt — auch in sachlichen Prasentationen ak-
zeptiert werden und die Folie attraktiver machen.

Aullerdem konnen Piktogramme sehr gut iiber Diagramme gelegt werden,
ohne dass sie die Information verdecken. Achten Sie dabei darauf, dass Sie
eine geeignete Position fiir das Piktogramm finden, z. B. unten links oder un-
ten rechts auf dem Diagramm, und dass es nicht zu viel vom Diagramm ab-
deckt. Am sinnvollsten sind ein- oder zweifarbige Piktogramme, damit der Zu-
schauer nicht zu sehr abgelenkt wird. Schauen Sie sich dazu die Beispiele an.

A B G D

» ®»m a ©

DIE WELT IM FOKUS

Weltbevolkerung Weltwirtschafts- Weltexporte
leistung

= Schwellenlander = Industrielander Quslis: IWF 2008
Larstsliung smavicon
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Ein Diagramm mit Piktogrammen iiberlagern

Die folgende Tabelle enthilt einige Beispiele fiir Diagramme, die durch Pik-
togramme {iberlagert werden.

Diagrammthema Idee fiir ein Piktogramm

Umsatz weltweit Erdkugel, kleine Weltkarte

Wachstum Zickzack, aufwarts verlaufende Kurve, Pflanze,
Keimling, gecffnete Hande mit Keimling, krab-
belndes Kind

Gewinn Wahrungszeichen, Prozentzeichen, Stapel von

Miunzen oder Geldscheinen

Marktposition Siegertreppchen, mehrere Kreise, Kugeln, Sportler,
Schach, Brettspiel

Verteilung Asymmetrischer Stern, Netz mit Knoten, Pfeile in
verschiedene Richtungen

Ein Diagramm mit Piktogrammen uberlagern

In diesem Abschnitt zeige ich Thnen, wie Sie ganz einfach ein Diagramm mit
Piktogrammiiberlagerung erstellen. Als Datenbasis dienen uns dabei Ver-
kaufszahlen von Apfeln.

1. Offnen Sie eine Folie mit dem Layout Titel und Inhalt, und klicken Sie auf
Einfligen » Illustrationen » Diagramm » Balken » Gruppierte Balken.

2. In der Datentabelle, die daraufhin erscheint, verkleinern Sie den Wer-
tebereich, indem Sie alle bis auf eine Datenreihe 16schen. Geben Sie als
Kategorien »Ost«, »West«, »Nord«, »Siid« und fiir die Datenreihe »Abver-
kauf in Mio. €« ein. Schlieen Sie dann die Tabelle.

3. Uber Diagrammtools » Entwurf » Diagrammlayouts versehen Sie das Dia-
gramm mit Layout 2. Loschen Sie die Legende (Diagrammtools » Layout »
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4.

206

Beschriftungen » Legende » Keine), und formatieren Sie das Diagramm
(Diagrammtools » Entwurf » Diagrammformatvorlagen » Formatvorla-
ge 29).

Abverkauf Apfelin Mio. €

Siid 45

Fiir dieses Beispiel eignet sich naturgemal$ ein Apfel-Piktogramm. Sol-
che Symbole kénnen Sie beispielsweise {iber ClipArts oder aus Schriften
einfligen. Hier suchen wir das Bild iiber Start » Einfiigen » ClipArt aus.
Geben Sie in das Suchfeld »Apfel« ein, und wihlen Sie eine geeignete
Grafik aus. Ziehen Sie das ClipArt auf die Folie, und platzieren Sie es auf
den Balken.

Uber Bildtools » Format » Anpassen konnen Sie das Piktogramm, falls
notwendig, farblich anpassen. Hier heben wir es au3erdem durch einen
Schatten vom Diagramm ab. Uber Bildtools » Format » Bildformatvor-
lagen » Bildeffekte » Schatten » AuBen wahlen Sie also Offset diagonal
unten links aus. Anschlief3end klicken Sie im selben Dialog ganz unten
auf Weitere Schatten. Setzen Sie den Wert im Feld Abstand so weit nach
oben, bis Thnen der Abstand des Schattens zum Apfel zusagt.

Abverkauf Apfelin Mio. €

sud

Nerd

West

Ost



Diagramme mit Tiefenebenen

Diagramme mit Tiefenebenen

Diagramme sind in PowerPoint aus unterschiedlichen Ebe-

nen aufgebaut, z.B. einer Hintergrundebene mit einem

Bild, dariiber einer Balkengrafik und im Vordergrund ei- :

nem halbtransparenten Logo. Die Balken im Diagramm 'I" I
konnen auch halbtransparent sein, damit mehr vom Hin- "
tergrund zu sehen ist. Das Spannende an der Darstellung L
sind die iibereinander gelagerten transparenten Flichen

(Layer-Technik; von engl. layer = Schicht) — damit werden
zusétzliche Informationsebenen moglich.

Im Folgenden zeige ich Thnen einige Beispiele fiir Diagram-

me mit Tiefenebenen. Man kann z.B. ein zum Thema pas- I % I
sendes Bild als Hintergrundebene mit reduzierter Farbe | _I__ =
einfiigen. Im Beispiel, einem Diagramm zur Entwicklung A B C D
der sozialversicherungspflichtigen Beschiftigung, liegen

dariiber die Saulen, die halbtransparent den Hintergrund zeigen und einen

Schatten haben, um sich besser abzuheben. Im Vordergrund sehen Sie das
halbtransparente Logo.

Mio. Beschaftigte,
Stichtag 31. Marz

2004 2005 2006 2007 2008 2009

Quelle: BA Niirnberg
Darstellung: smavicon
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Der Hintergrund lasst sich jedoch auch mit einem abgedunkelten Bild dar-
stellen, dariiber das halbtransparente Logo und davor die Balken, die das
Hintergrundmotiv wieder aufgreifen.

Mio. Beschaftigte,
Stichtag 31. Marz

>
ik
A ?-..

2004 2005 2006 2007 2008 2009

Quelle: BA Niirnberg
Darstellung: smavicon

Ein Diagramm mit Tiefenebenen erstellen (1)

In diesem Abschnitt legen wir Schritt fiir Schritt ein Exemplar eines Dia-
gramms mit Tiefenebenen an.

1. Legen Sie zunichst eine Folie mit dem Layout Nur Titel an, und wihlen
Sie dann Einfligen » lllustrationen » Diagramm » Sdulen » Gruppierte Sau-
len. Geben Sie die Werte in die Excel-Tabelle ein, wie in der Abbildung
zu sehen, und reduzieren Sie die Anzahl der Siulen, indem Sie z.B.
Spalten 16schen und/oder den Diagrammauswahlbereich verkleinern.
Schliel3en Sie Excel.

2. Andern Sie das Diagrammlayout iiber Diagrammtools » Entwurf » Dia-
grammlayouts in Layout 2. Um den Diagrammtitel, die Legende usw. zu



Ein Diagramm mit Tiefenebenen erstellen (1)

entfernen, gehen Sie in die Befehlsgruppe Diagrammtools » Layout » Be-
schriftungen, und wéhlen Sie erst unter Diagrammtitel die Option Keine
und dann unter Legende ebenfalls Keine.

Ziehen Sie nun das Diagramm breiter. Klicken Sie in das Diagramm, und
markieren Sie alle Sdulen (ein Klick auf die erste Sdule geniigt). Mit der
rechten Maustaste und dem Kontextmeniipunkt Datenreihen formatie-
ren » Reihenoptionen verringern Sie die Abstandsbreite auf »50 %«, denn
breitere Sdulen wirken optisch interessanter als sehr schmale.

2010 2011 2012 2013 2014 2015

Um die Siulen zu formatieren, rufen Sie das Kontextmenii der Zeich-
nungsflache auf. Wenn Sie den Mauszeiger auf dem Diagramm positio-
nieren und kurz warten, erscheint die Bezeichnung des Elements, iiber
dem die Maus gerade steht. Sie konnen das aber auch iiber Diagramm-
tools » Layout » Aktuelle Auswahl herausfinden. Klicken Sie also mit
rechts auf die Zeichnungsflache, und fiigen Sie dann iiber Zeichnungs-
flache formatieren » Fiillung » Bild- oder Texturfiillung und die Schaltfla-
che Datei das Bild Frachtschiff.jpg* von der beiliegenden DVD ein. Mar-
kieren Sie dann die Sdulen, und wihlen Sie {iber die rechte Maustaste
aus dem Kontextmenii Datenreihen formatieren » Fiillung » Einfarbige
Fiillung. Suchen Sie sich eine passende Farbe aus. Aullerdem stellen Sie
die Transparenz auf »50 %«.

1 Quelle: www.pigs.de (Urheber: hecht1969, »Frachtschiff«, CC-Lizenz (BY 2.0)).
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2010 2011 2012 2013 2014 2015

GrolRe des Motivs

Um eine moglichst gute Wirkung zu erzielen, sollten Sie ein Motiv
wahlen, dessen Breite und Hohe zum Diagramm passt. Beschneiden
Sie das Bild gegebenenfalls, damit es genau liber die gesamte An-
zahl an Saulen oder Balken passt.

Ein Diagramm mit Tiefenebenen erstellen (2)

In diesem Abschnitt zeige ich Thnen eine weitere Méglichkeit, ein Diagramm
mit Tiefenebenen anzulegen.

1. Legen Sie eine Kopie der Folie aus dem vorigen Beispiel an. Klicken
Sie mit der rechten Maustaste auf das Diagramm, und wahlen Sie Als
Grafik speichern aus dem Kontextmenii. Verwenden Sie als Dateiformat
Windows-Metadatei *wmf, und merken Sie sich den Speicherort. Dann
entfernen Sie das urspriingliche Diagramm von der Folie, indem Sie es
markieren und driicken.
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Ein Diagramm mit Tiefenebenen erstellen (2)

2. Um das Hintergrundbild zu bearbeiten, laden Sie zuniichst das gespei-
cherte Diagramm auf die Folie (Einfiigen » Bilder » Grafik). Uber Start »
Zeichnung » Anordnen » Objekte gruppieren » Gruppierung aufheben 16-
sen Sie die Grafik auf. Wenn Sie den Befehl ausfiihren, werden Sie ge-
fragt, ob die Grafik zu einem Microsoft-Office-Zeichnungsobjekt veran-
dert werden soll. Bestdtigen Sie mit Ja.

3. Rufen Sie den Befehl Gruppierung aufheben noch einmal auf. Dann 16-
schen Sie die tiberfliissigen Farbflaichen mit . Beschneiden Sie das
Hintergrundbild so, dass es oben, links und rechts biindig mit den Sau-
len ist (Bildtools » Format » GréRe » Zuschneiden). Klicken Sie mit der
rechten Maustaste auf das Bild, und wihlen Sie Als Grafik speichern aus
dem Kontextmenii. Speichern Sie das Hintergrundbild als .png-Datei.

Zuschneiden

Damit Sie genauer zuschneiden konnen, klicken Sie mit der rechten
Maustaste auf den Folienhintergrund, und wahlen Sie Raster und
Fiihrungslinien aus dem Kontextmenu. Entfernen Sie das Hakchen
bei Objekte am Raster ausrichten.

e

m i Enfugen  Enteuil  Ubegange  Anmatonen  Bilschuimprisenaton

-
:L' Plassem 3

o}
| [Duschnsien| 3 15as o o

2010 2011 2012 2013 2014 2015
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4. Klicken Sie die Sdulen an. Diese wurden durch die Speicherung als
.wmf-Datei in ein Bild gewandelt. Uber die rechte Maustaste und Grafik
formatieren » Fiillung » Bild- oder Texturfiillung und die Schaltflache Da-
tei wihlen Sie das eben gespeicherte Hintergrundbild (die .png-Datei)
aus.

5. Formatieren Sie die Saulen nun iiber Bildtools » Format » Anpassen » Far-
be » Neu einfirben in einer hellen Variante. Dann driicken Sie so lange
die (%5, ]-Taste, bis Sie das Hintergrundbild markiert haben, und wéh-
len dafiir bei Neu einfarben eine dunkle Farbvorlage. Natiirlich kénnen
Sie auch den Hintergrund hell und die Siulen dunkel gestalten. Zum

Schluss gruppieren Sie alle Elemente (mit + (o] + (6)), damit
Sie einfacher damit weiterarbeiten kdnnen.

= 45

2010 2011 2012 2013 2014 2015

Diagramme mit bildhaften Werten

Eine sehr beliebte und verbreitete Art der Informationsdarstellung ist die
Darstellung von Diagrammen mit bildlichen bzw. piktogrammaé&hnlichen
Werten. Diese Variante eignet sich immer dann, wenn es um konkrete Pro-
dukte oder um (Dienst-)Leistungen geht. Die Abbildung zeigt einige Mog-
lichkeiten.



Diagramme mit bildhaften Werten

Dabei lassen sich manche Symbole/Bilder sehr gut stapeln, d. h. {ibereinan-
der- oder auch nebeneinanderlegen, und andere wiederum konnen leicht
gestreckt (eigentlich verzerrt) werden. Ob Sie die Bilder stapeln oder stre-
cken, kénnen Sie im Diagramm einstellen (Datenreihen formatieren » Fiil-
lung). In der Regel eignet sich das Strecken besonders dann, wenn die Wer-
te nicht stark voneinander abweichen oder jeder Wert ein anderes Bild hat.
Stapeln lassen sich alle Bilder.

Im Folgenden zeige ich Thnen
Moglichkeiten, wie Sie bild- o HHHIRERERERER ALY
hafte Werte einsetzen konnen.
Im ersten Bild geht es um die sant PHRERRERRRRERRERRRRRRERRRRRRRERRERRETS
Anzahl neuer Seminarteilneh- 2 am. ppeeeeeeeeeeettttsssstssee
mer, daher sind die Balken mit

. e o . 1. Qril. 4
einem stilisierten Maéannchen WAL

gefiillt. Die Grol3e der Figur ist 0 10 20 30 40 50
so gewdhlt, dass ihre Anzahl

tatsdchlich auch den Werten auf der x-Achse entspricht, z.B. zeigen zehn
Mannchen wirklich zehn Teilnehmer an. Sie kénnen aber auch grof3ere Bil-

der nehmen und diese nur symbolisch verwenden.
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Um eine Grafik zur Umsatzver-
teilung spannender zu gestal-
ten, kann man das Produkt,
um das es geht, als Symbol fiir

den Wert benutzen. Die neben-
el stehenden Beispiele zeigen die

0 . v : Umsatzentwicklung von Kiirbis-
1. Qrtl. 2. Qrtl. 3. Qrtl. 4. artl.

20
80
70
60 -
50

40
30

sen zu Halloween und die Ent-
wicklung des Weinverkaufs in
Flaschen.

4500

Im Gegensatz zu den vorheri-
3400 3500 . s
s gen Beispielen wird im folgen-
den S&ulendiagramm nicht in
):| jeder Sédule mit dem gleichen
il Symbol gearbeitet, sondern mit

=
=

unterschiedlichen Bildern fiir
die einzelnen Rubriken. Das
Diagramm wirkt dadurch insge-
samt interessanter.

2005 2006 2007 2008

Wie Sie solche Folien erstellen, zeige ich Thnen Schritt fiir Schritt in den
néchsten Abschnitten.

NAFFEECENUSS IN DEUTSICRILAND

Kaffee — Das Getrank Nr. 1 in Deutschland

Getrankekonsum pro Kopf und Jahr

1621
1001
a0 791
|
Kaffee Bier Mineral- Erfrischungs- Milch
wasser getrinke
Quelle: Ifo 1998

Darstellung: smavicon
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Eine Liniengrafik mit bildhaften Datenpunkten gestalten

Eine Liniengrafik mit bildhaften Datenpunkten
gestalten

Liniengrafiken gibt es wie Sand am Meer. Wenn sie in einem Zusammen-
hang gezeigt werden, der nicht hochste Seriositat verlangt, lohnt es sich,
Datenpunkte bildhaft zu gestalten. Die Optik hebt die Grafik aus der Masse
hervor und bleibt womdéglich besser in Erinnerung als viele andere.

1. Erstellen Sie eine Folie im Layout Titel und Inhalt, und klicken Sie dann
auf Einfiigen » lllustrationen » Diagramm. Wahlen Sie Linie » Linie mit
Datenpunkten aus. In der Datentabelle, die sich sodann 6ffnet, verklei-
nern Sie den Wertebereich, indem Sie zwei Datenreihen 16schen. Fiir
die Kategorien tippen Sie »1980«, »1990«, »2000« und »2010« und fiir
die Datenreihe »Verkaufte Apfel in Mrd.« ein. SchlieBen Sie dann das
Diagramm.

2. Andern Sie das Diagrammlayout — falls es nicht standardmiRig bei Ih-
nen eingestellt ist — iiber Diagrammtools » Entwurf » Diagrammlayouts in
Layout 1, und 16schen Sie die Legende des Diagramms (Diagrammtools »
Layout » Beschriftungen » Legende » Keine).

Verkaufte Apfelin Mrd.

" ~ _—
35 \ /

13 \ /
25 ~N—

Achsentitel

1,5

0,5

1980 1990 2000 2010
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3. Statt der einfachen Datenpunkte sollen hier Bildchen von Apfeln ein-
gefligt werden. Prinzipiell kénnen Sie alles als Datenpunkte einfiigen:
Schriftsymbole, ClipArts, Bilder usw. Beachten Sie bei Schriftsymbolen,
dass es manchmal besser ist, die Schrift als Grafik zu speichern (rechte
Maustaste » Als Grafik speichern) und dann wieder einzufiigen (Einfiigen »
lllustrationen » Grafik) — z.B. wenn Sie Speicherplatz sparen wollen oder
die Schriftart sich nicht passend ins Diagramm einfiigen I&sst.

BildgroRe festlegen

Legen Sie die GroRRe des Symbols fest, bevor Sie es in das Diagramm
einfligen, denn dann sehen Sie schon, wie es aussehen wird, und
Sie sparen sich die Formatierung des Symbols liber die Datenreihen-
optionen.

4. Uber Einfiigen » Bilder » ClipArt fiigen Sie nun ein geeignetes Bild eines
Apfels in die Folie ein (dazu geben Sie »Apfel« in das Suchfeld ein und
haken auch Office.com-Inhalte beriicksichtigen an). Wenn Sie auf das
passende Bild klicken, wird es auf der Folie platziert. Passen Sie dann
erst einmal seine Grof3e an.

5. Zum Einfiigen des Symbols in das Diagramm markieren Sie es und drii-
cken + [C]. Klicken Sie dann in das Diagramm, und wihlen Sie
alle Datenpunkte aus (ein einfacher Klick auf die Linie geniigt). Fiigen

Sie den Apfel mit + (V] ein.
Verkaufte Apfel in Mrd.
4.5

3.5

2,5

Achsentitel

1,5
0,5

1980 1990 2000 2010
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Eine Balkengrafik mit bildhaften Werten erstellen

Das folgende Beispiel basiert auf den gleichen Werten wie das vorherige,
aber diesmal erstellen wir daraus ein Balkendiagramm.

1.

Legen Sie eine Kopie der Liniengrafik aus dem vorherigen Beispiel an.
Benennen Sie die Kopie um, und arbeiten Sie damit weiter.

. Zunéachst dndern Sie das Diagramm iiber Diagrammtools » Entwurf» Typ »

Diagrammtyp dndern » Balken in ein einfaches Balkendiagramm (Gruppier-
te Balken).

. Normalerweise bleibt das Symbol erhalten und sieht dann oft sehr breit

aus. Falls es verschwunden ist, gehen Sie genauso vor wie eben beim
Einfiigen in die Liniengrafik: Markieren Sie das Symbol, kopieren Sie
es mit + [CJ, klicken Sie einen Balken an, und fiigen Sie das Bild
mit + [v] wieder ein. Alternativ kénnen Sie auch mit der rechten
Maustaste auf die Balken im Diagramm klicken und dann iiber Daten-
reihen formatieren » Fiillung » Bild- oder Texturfiillung » Datei ein Bild
auswéhlen (Sie miissen es aber zuvor gespeichert haben).

. Um den Symbolen eine passende Grofse zu geben, markieren Sie alle

Balken. Klicken Sie dann mit der rechten Maustaste auf den markier-
ten Bereich, und wéhlen Sie Datenreihen formatieren » Reihenoptionen.
Uber den Schieberegler unter Abstandsbreite kénnen Sie die GroRe der
Symbole verdndern.

. Nun sind die Apfel aber immer noch zu breit. Klicken Sie deshalb wieder

mit der rechten Maustaste auf die markierten Balken, wéhlen Sie Da-
tenreihen formatieren » Fiillung, und aktivieren Sie unten im Dialog nun
die Option Stapeln (statt Strecken). Sie kdnnen hier angeben, wie viele
Symbole (Bilder) pro Einheit (x-Achse) erscheinen sollen, z.B. 1 Apfel
pro Einheit oder 1 Apfel fiir 10 Einheiten usw. (Stapeln und teilen mit).
Probieren Sie einfach mal verschiedene Werte aus.
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Verkaufte Apfel in Mrd.

2010 |
2000
1990 |

1980 |

Eine Saulengrafik mit bildhaften Werten anlegen

Nachdem Sie sowohl ein Linien- als auch ein Balkendiagramm erstellt ha-
ben, kommt nun die Saulengrafik an die Reihe. Als Beispiel dient hier das
Diagramm zum Weinverkauf, das wir bereits weiter oben gesehen haben.

1. Kopieren Sie das Balkendiagramm, und wihlen Sie dann Diagramm-
tools » Entwurf » Typ » Diagrammtyp dndern » Sdule » Gruppierte Saulen.
In der Excel-Tabelle 16schen Sie zwei Datenreihen und geben die in der
Abbildung zu sehenden Werte und Beschriftungen ein. Andern Sie iiber
Diagrammtools » Entwurf » Diagrammlayouts den Layouttyp in Layout 2,
und l16schen Sie die Legende.

Entwicklung des Weinverkaufs in Flaschen

4500
3400 3500
! I I
2005 2006 2007 2008



Diagramme mit 3D-Objekten

2. Uber Einfiigen » Bilder » ClipArt suchen Sie eine Bild einer Weinflasche
und ziehen sie auf die Folie. Anschlie3end markieren Sie die Flasche
und fiigen sie in die Sdulen ein ([Strg] + (€] und + [v]). Stan-
dardmaif3ig sollte fiir die Fiillung Strecken eingestellt sein. Falls nicht,
dndern Sie die Einstellung {iber das Kontextmenii und Datenreihen for-
matieren » Fiillung.

3. Klicken Sie dann noch mit der rechten Maustaste auf die Saulen, und
verandern Sie die Gro3e der Symbole (Datenreihen formatieren » Rei-
henoptionen » Abstandsbreite).

Entwicklung des Weinverkaufs in Flaschen

Diagramme mit 3D-Objekten

Bislang habe ich Thnen nur Diagramme gezeigt, die zweidimensional sind.
Sie haben den Vorteil, dass Falschwahrnehmungen und -interpretationen
leichter ausgeschlossen werden kdnnen. Im 3D-Bereich hingegen kommt es
aufgrund der verdnderten Perspektive haufig zu Verzerrungen und falschen
Interpretationen. Auch der Informationsgehalt nimmt im Grunde nicht zu,
wenn man von einer zweidimensionalen Darstellung auf 3D umstellt. Den-
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noch konnen 3D-Diagramme sehr

spannend und innovativ wirken, wenn

man sie richtig einsetzt. Wir nehmen hier die typischen, bereits in Power-

Point vorhandenen 3D-Diagramme als Basis und versehen sie sozusagen
mit Sahneh&ubchen, ndmlich mit 3D-Objekten.

litl

N SNV

& B

Wertpapiere

Die néchsten Abbildungen zeigen
Beispiele fiir Diagramme mit 3D-
Objekten. Zunichst ein Beispiel
aus der Finanzbranche: Laut die-
sem Kreisdiagramm werden -ca.
75% des Sparanteils auf verschie-
dene Kapitalanlagen verteilt, die
hier bildlich dargestellt werden.
Die Spiegelung auf der Oberfléche
unterstreicht die Wertigkeit der
Kapitalanlagen.

Pflaume
10%

Avocado
11%

Erdbeere
24%

55%

Verteilung gemessen am Gesamtumsatz
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Das zweite Beispiel stammt aus
dem Handel. Der Zuschauer er-
kennt auf den ersten Blick die vier
Obstsorten mit ihrem jeweiligen
Anteil am Gesamtumsatz. Der
Schatten der 3D-Objekte auf den
Kreissegmenten unterstreicht die
dreidimensionale Wirkung. In der
Regel wird eine solche Darstellung
besser behalten als ohne 3D-Ob-
jekte.

Melone



Ein Kreisdiagramm mit 3D-Objekten anlegen

Ein Kreisdiagramm mit 3D-Objekten anlegen

In diesem Abschnitt erstellen wir ein Kreisdiagramm mit 3D-Objekten fiir
die Immobilienbranche.

1. Legen Sie zuerst eine neue Folie mit einem leeren Layout an, und er-
stellen Sie iiber Einfiigen » Illustrationen » Diagramm » Kreis » 3D-Kreis
ein Kreisdiagramm. In die Excel-Tabelle fiigen Sie den Titel »Hauser in
Deutschland, die beiden Kategorien »Umweltfreundliche« und »Ande-
re« mit den Werten »35 %<« und »65 %« ein. Loschen Sie die iibrigen Zei-
len, und schlief3en Sie Excel.

2. Andern Sie iiber Diagrammtools » Entwurf » Diagrammlayouts das Lay-
out auf Layout 1 (wenn es nicht schon ausgewdahlt ist). Wéhlen Sie im
Bereich Diagrammformatvorlagen die Formatvorlage 29 aus.

Anderungen an 3D-Objekten

Wenn Sie Uber Schnellformatvorlagen Veranderungen an 3D-Ele-
menten vornehmen, wird die 3D-Darstellung auf 2D zuriickgesetzt,
denn die Schnellformatvorlagen sind nur fur 2D ausgelegt.

3. Klicken Sie eine der Beschriftungen im 3D-Kreis an, und ziehen Sie
sie mit gedriickter Maustaste auf3erhalb des Kreises. Wiederholen Sie
den Vorgang fiir die zweite Beschriftung. Passen Sie die Schriftgrofsen
an: mindestens 24 Punkt fiir die Kreisbeschriftung und mindestens 24
Punkt fiir den Titel.

Héauser in Deutschland

4. Klicken Sie die Kreissegmente an, und

Umwelt-
freundliche
35%_

klicken Sie dann mit der rechten Maus-
taste auf das grollere Kreissegment, um
nur dieses zu markieren, denn wir wol-
len jedes Segment unterschiedlich ein-
farben. Uber Datenreihen formatieren »

Fiillung wéhlen Sie einen Rot- oder Oran-
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geton als Fiillfarbe aus. Wiederholen Sie diesen Schritt fiir das kleinere
Segment, wahlen Sie hierfiir aber ein Griin als Fiillung.

5. In den gingigen Bilderarchiven im Internet finden sich eine Menge
3D-Objekte. Auf der beiliegenden DVD finden Sie die beiden Hauser,
Griines_Haus.png und Rotes_Haus.png, die hier verwendet werden. La-
den Sie die Grafiken auf die Folie, und platzieren Sie sie iber dem 3D-
Kreis an der passenden Stelle.

6. Fiir die plastische Wirkung brauchen wir noch einen Schatten. Die ein-
fachste Moglichkeit ist, die Hauser zu markieren und {iber Start » Zeich-
nung » Formeffekte » Schatten » Perspektive » Perspektivisch diagonal

Hauser in Deutechiand oben links einen Schatten zu erzeugen. Wenn

Umwelt- Thnen die Schattenwirkung so nicht gefillt,
ﬁeug";l/:fh\e konnen Sie den Schatten durch Markieren
der Hauser verdndern (rechte Maustaste »

Grafik formatieren » Schatten). Sie konnen

~dere  beispielsweise Schattenfarbe, Transparenz,
Winkel oder auch den Abstand zum Haus

verandern.

Die Perspektive anpassen

Fir eine genaue Perspektive sind die passenden 3D-Objekte und
sehr viel Feinarbeit notwendig. Wenn Sie 3D-Objekte mit einem
unpassenden Perspektivwinkel haben, versuchen Sie zunachst, die
3D-Drehung des 3D-Kreises anzupassen (dazu klicken Sie mit der
rechten Maustaste auf das Diagramm und wahlen 3D-Drehung aus
dem Kontextmen).

Ebenso konnen Sie die 3D-Objekte selbst ein wenig nachjustieren
(ebenfalls Uber Grafik formatieren » 3D-Drehung). In den meisten
Fallen kommen Sie damit schon sehr gut voran. Wenn man es, wie
z.B. im Bereich der Architektur, wirklich hundertprozentig genau
braucht, kann man sich die 3D-Objekte sogar individuell anfertigen
lassen, z.B. von einer Prasentationsagentur.
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Diagramme mit Themenaspekt

Diagramme mit Themenaspekt

Jedes Diagramm entstammt einem bestimmten Themengebiet. Wird dieses
Themengebiet in einem oder mehreren Aspekten aufgegriffen und in einen
gestalterischen Zusammenhang mit den Zahlen gebracht, lassen sich {iber-
aus interessante Diagramme erstellen. Es geht nicht mehr nur darum, ein
einzelnes Bild oder Symbol zu finden, das zum Thema passt, sondern das
Thema wird praktisch zur Grundlage der Darstellung, zu einem integrier-
ten Gestaltungsrahmen.

Dem ersten Beispiel liegt das Thema Werbeumsatze zugrunde. Die hier ein-
gesetzten Motive sind hédufig Werbeplakate, Litfal3sdulen oder Preisschil-
der. Dabei wird die Liniengrafik zum integrativen Bestandteil des Bildes.

10 JAHRE Werbe- lnvestltlonen
WERBUNG

2003 2005 2008 2009 = 2010 |

Die Diagrammbalken der néchsten Abbildung werden als Stromkabel dar-
gestellt. Die Piktogramme unterstiitzen das Bildhafte, und mit der Gliihbir-
ne im Hintergrund wird das Thema dariiber hinaus auf subtile Weise emo-
tionalisiert.
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In der Tabelle finden Sie weitere Anregungen.

Diagrammthema

Thema (Beispiel)

Produktionszahlen ausgelieferter
Flugzeugtypen

Segmentierter Hangar,
Flughafen mit verschiedenen Flug-
zeugtypen

Wettbewerbsanalyse von Baby-
nahrung

Segmentierte Babyflasche,
Supermarktregal mit Babynahrung

Anzahl der Fernsehzuschauer im
Verlauf einer Show (auf Minuten-
basis)

Fernseher, auf dem eine Linien-
grafik zu sehen ist,
Couch, bei der die Riuicklehne die
Liniengrafik bildet




Ein Wasserfalldiagramm anlegen

Ein Wasserfalldiagramm anlegen

Wenn es um Auswertungen geht, z. B. einer Bilanz, einer betriebswirtschaft-
lichen Aufstellung, eines Kostenplans oder eines Projekts, bieten sich Was-
serfalldiagramme an. Anhand einer solchen Grafik kann dann sehr schnell
erkannt werden, wo noch Handlungsbedarf besteht.

6%

Umsatz Dienst- Rohstoffe  Personal- Raum- Gemein- Gewinn
leister kosten kosten kosten

Im Folgenden zeige ich Thnen Schritt fiir Schritt, wie Sie ein solches Was-
serfalldiagramm anlegen. In unserem Beispiel geht es um die Bilanz eines
Unternehmens.

1. Legen Sie eine neue Folie mit dem Layout Titel und Inhalt an. Geben Sie
im Titelfeld den Text »Wasserfalldiagramm« ein, und klicken Sie auf
das Symbol Diagramm einfiigen in der Mitte der Folie. Im Dialogfenster
wahlen Sie Saulen » Gestapelte Saulen aus (in dieser Darstellung werden
die Saulen sozusagen zweigeteilt). Loschen Sie die dritte Datenreihe in
der Excel-Tabelle, und verkleinern Sie den Diagrammdatenbereich. Ge-
ben Sie als Kategorien die Begriffe »Umsatz«, »Dienstleister«, »Rohstof-
fe« usw. ein, wie in der Abbildung zu sehen.

2. Geben Sie in Datenreihe 1 fiir Umsatz den Wert »100 %« ein. Die iibri-
gen Felder dieser Spalte fiillen wir im néchsten Schritt mithilfe einer
Formel. Machen Sie daher mit den Eintragen fiir die Spalte Datenrei-
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he 2 weiter: Tragen Sie fiir Dienstleister den Wert »25 %«, fiir Rohstoffe
»10 %« usw. ein.

3. Klicken Sie danach in die Zelle Dienstleister/Datenreihe 1. Geben Sie das
Zeichen »=« und dann »B2-C3« ein, und driicken Sie [« ]. Mit dieser
Formel wird automatisch der passende Wert und damit die Sdulenho-
he errechnet. Klicken Sie auf diese Zelle, kopieren Sie die Formel mit
+ (], markieren Sie die letzten Zellen der Spalte unterhalb, und
driicken Sie + [v]. So wird die Formel ebenfalls in den iibrigen
Zellen der Spalte Datenreihe 1 hinterlegt. Schlief3en Sie Excel.

B =
Datenieihe | Datemeihe 2
e |

Wasserfalldiagramm

s 25%|
a5 104

La0%

s 15%|
100t

1 B [
== [
Bl : 3 WDatenreihe 2
e | i I ' moatanraihe 1
S N
& U R &

a3 74

L3
o

Zizhen sie zum Andem der GréNle des Dlagrammdatenberelchs die unters rechte Ecke des Bereichs.

§

&
&
o

Klicken iz, um Kiotizan hirmLzuftigen

Fanelvons | Asumoeoy | G Gamm mammun | EERE s EFERTE e

4. Um nun das Diagramm zu formatieren, wechseln Sie zu Diagrammtools »
Entwurf » Diagrammlayouts, und wéhlen Sie Layout 2. Loschen Sie den
Titel des Diagramms und seine Legende, indem Sie bei Diagrammtools »
Layout » Beschriftungen » Diagrammtitel und bei Diagrammtools » Layout »
Beschriftungen » Legende jeweils die Option Keine wéhlen.

5. Klicken Sie in die Séule Umsatz, und geben Sie dann bei Diagrammtools »

Layout » Beschriftungen » Datenbeschriftungen die Option Keine an, damit
die Saule keinen Wert anzeigt.
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6.

Ein Wasserfalldiagramm anlegen

Mit einem Rechtsklick auf den unteren Teil der {ibrigen Saulen, z.B.
Dienstleister, gelangen Sie in das Kontextmenii Datenreihen formatieren »
Flillung. Markieren Sie hier die Option Keine Fiillung, sodass die untere
Séulenreihe im Diagramm verschwindet. Leider ist jetzt auch die Farbe
der Sdule Umsatz verschwunden, daher klicken Sie wieder mit rechts da-
rauf, und wéhlen Sie {iber Datenreihen formatieren » Fiillung eine Farbe
aus. Falls sich die Reihen nicht mehr markieren lassen, konnen Sie die
Datenreihe auch tiber Diagrammtools » Layout » Aktuelle Auswahl und die
Dropdown-Liste Diagrammelemente auswéhlen.

l
6% |
% S & N N N &
3 e o‘& NG <& Eg &
& & & & & o B
N & & A & &5 cd
& & & N &
Q a Q:\‘, R~ (-Dlz.

Passen Sie die Farbe der Datenreihe 2 {iber die rechte Maustaste und
Datenreihen formatieren » Fiillung Ihren Wiinsche an. Klicken Sie dann
mit der rechten Maustaste auf die Sdule Umsatz, und wihlen Sie Daten-
reihen formatieren » Reihenoptionen » Abstandsbreite. Stellen Sie hier
»75 %« oder einen kleineren Wert ein.

Sicherlich ist Thnen auch aufgefallen, dass die Texte unseres Beispiels
diagonal angeordnet sind. Dies konnen Sie in der Datentabelle {iber Dia-
grammtools » Entwurf » Daten » Daten bearbeiten dndern. Brechen Sie
die Texte einfach an der passenden Stelle um, indem Sie einen Binde-
strich (-) eingeben und die Spalte dann schmaler ziehen. Wenn Sie das
in jeder Tabellenbeschriftung gemacht haben, verdndert sich auch die
Achsenbeschriftung entsprechend.
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9. Um den Wert »6 %« in der Sdule Gewinn besser lesbar zu machen, ist
es sinnvoll, ihn nach oben zu verschieben. Klicken Sie zunéchst die Da-
tenreihe an und dann den Datenwert. Sie konnen den Wert nun ein-
fach mit der Maus verschieben.

10. Wenn Sie auflerdem Linien zwischen den Sdulen zeichnen wollen, um
deren Anteile an der Umsatzsiule deutlicher zu machen, miissen Sie
das leider von Hand tun (Start » Zeichnung » Formen » Linie). Wenn Sie
eine Linie in der richtigen Lange erstellt haben, duplizieren Sie sie ein-
fach und verschieben sie an die passende Stelle. Zum Schluss markieren
Sie das gesamte Diagramm und legen es in den Hintergrund (Start »
Zeichnung » Anordnen), damit die Linien im Vordergrund liegen und so-
mit angezeigt werden.

Wasserfalldiagramme zu bauen kann viel Zeit kosten. Als Tipp kann ich
Thnen mitgeben, dass es auch Software gibt, mit der Sie diese Diagramme
schnell und einfach erstellen konnen, z. B. Think-Cell. Aufgrund des Preises
lohnt sich diese Software aber wirklich nur, wenn Sie viele Diagramme an-
legen.

Entscheidungstabellen

Entscheidungstabellen begegnen uns in vielen Prasentationen, bei denen
eine Grundlage fiir eine Bewertung geschaffen werden soll, z.B. in Projekt-
prasentationen, Wettbewerbsanalysen oder Risikoabschatzungen.

Die folgenden Ideen konnen fiir Gegeniiberstellungen von Produkten,
Dienstleistungen, Mitbewerbern, Projekten u. a. genutzt werden.

Als Basis verwende ich ein Beispiel, bei dem drei Produkte miteinander ver-
glichen werden. Dem gegeniiber stehen sechs Auswahlkriterien, z. B. Funk-
tionsumfang, Modularitit oder Stabilitdt. Bewertet werden diese auf einer
Skala von 1 bis 4. In der Zeile Fazit wird die durchschnittliche Wertung an-
gegeben. Das Beispiel soll Thnen lediglich zeigen, welche Moéglichkeiten es



Entscheidungstabellen

fiir Entscheidungstabellen gibt. (Wie Sie diese Basis erstellen, zeige ich Ih-
nen genau im Abschnitt »Eine Entscheidungstabelle anlegen« ab Seite 232.)

In der ersten Variante wurden die Punkte wie bei einem Ampelsystem far-
big gekennzeichnet, was es einfacher macht, die Bewertung zu erfassen.
So kann man z. B. auf einen Blick sehen, dass das Produkt 2 nur eine grii-
ne Wertung hat (die Produkte 1 und 3 dagegen jeweils zwei). Noch etwas
lesbarer ist die Darstellung mit schwarzen Wertungspunkten auf farbigen
Spalten.

Funktionsumfang oo 00
Modularitat o000 ()
Stabilitat

Design oo oo 000
Schulungsangebot oo 000

Serviceumfang oo o0

Funktionsumfang
Modularitat
Stabilitat

Design
Schulungsangebot

Serviceumfang
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In der folgenden Version wurde anstelle des Wertungspunktes ein Bild ein-
gefiigt, in diesem Fall ein sechszackiger Stern mit Farbverlauf. Sie konnen

aber z.B. auch Symbole (Schriftzeichen) einsetzen.

Funktionsumfang
Modularitat
Stabilitat

Design
Schulungsangehot

Serviceumfang

B Bis ety
¥ R R e 1w - 2
B SIS B
 ae Qe te te te
elelelele ¥ Loty
BRI BB e

In der néchsten Abbildung wird fiir die Bewertung ein klassischer Balken
eingesetzt. Der Trick in dieser PowerPoint-Umsetzung ist der, dass fiir je-
des Produkt ein eigenes Balkendiagramm iiber die Tabelle gelegt wird und
somit sehr schnell Anderungen und Korrekturen durchgefiihrt werden kon-
nen. AuBerdem lasst sich die Tabelle sehr leicht erweitern bzw. verkleinern.

| Produktl | Produkt2 | Produkt3

Funktionsumfang
Modularitat
Stabilitat

Design
Schulungsangebot
Serviceumfang

Fazit

- =i
— — s
31 2,1 2,8



Entscheidungstabellen

Ausgehend von den Balken konnen Sie dariiber hinaus andere passende
Symbole einsetzen (indem Sie mit rechts auf den Balken klicken und {iber
Datenreihen formatieren » Fiillung die Option Stapeln aktivieren).

Funktionsumfang Povants | gt SN
Modularitat WHRRE W ==
Stabilitat e e ST e S
Design g Srisviovls oty
Schulungsangebot e e e e e e
Serviceumfang dotiosty Tl Criavisiy
Fazit 3,1 2,1 2,8

Im letzten Beispiel werden anstelle der Balken Linien mit Datenpunkten
verwendet. Liniengrafiken eignen sich auch fiir Darstellungen von Stérken/
Schwachen-Profilen.

| Produkt1 | Produkt2 ‘ Produkt3

Funktionsumfang ;

Modularitat D § '
Stabilitat

Design

Schulungsangebot '
Serviceumfang
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Eine Entscheidungstabelle anlegen

In diesem Abschnitt erstellen wir die Basis fiir eine Entscheidungstabelle

und nennen diese Tabelle Basistabelle, weil wir sie fiir die ndchsten Anlei-

tungen immer wieder brauchen werden.

1.

Legen Sie eine neue Folie mit dem Layout Titel und Inhalt an. Klicken Sie
auf das Symbol Tabelle einfiigen in der Folienmitte. Fiir Spaltenanzahl
geben Sie »13« und fiir Zeilenanzahl den Wert »8« ein.

. Markieren Sie die Spalten 2 bis 13, und geben Sie iiber Tabellentools »

Layout » ZellengroRe fiir Breite den Wert »1 cm« ein. Markieren Sie dann
die Spalte 1, und geben Sie hierfiir im Feld Breite »10 cm« ein. Markie-
ren Sie nun die Spalten 2 bis 5 in der ersten Zeile, und verbinden Sie die
Zellen {iber Tabellentools » Layout » Zusammenfiihren » Zellen verbinden.
Wiederholen Sie diesen Schritt fiir die Spalten 6 bis 9 und 10 bis 13
der ersten Zeile sowie fiir die Spalten 2 bis 5, 6 bis 9 und 10 bis 13 der
letzten Zeile.

. Fiillen Sie nun die Felder der Tabelle mit Text, wie in der Abbildung zu

sehen. Fiir die Wertungspunkte klicken Sie in die entsprechende Zelle
und fiigen iiber Einfligen » Symbole » Symbol einen Punkt ein. Wahlen
Sie dazu im Feld Schriftart die Schrift Wingdings aus. Wenn es schnell
gehen soll, geben Sie im Feld Zeichencode »108« ein. Kopieren Sie das
Zeichen in der Zelle ([Strg] + [C], markieren Sie die Zellen, in die das
Symbol noch eingefiigt werden soll, und driicken Sie + (v].

. Nun formatieren wir die Tabelle. Klicken Sie dazu auf ihren Rahmen.

Uber Start » Schriftart stellen Sie die passende Schriftgroe ein, z.B. 24
Punkt. Wenn Thnen die Symbole zu groR sind, markieren Sie die ent-
sprechenden Zellen und verkleinern ihre Schriftgrofe. Indem Sie die
gesamten Zellen und nicht nur einzelne Symbole anpassen, vermeiden
Sie Fehler bei Anderungen und Korrekturen in der Tabelle.



Balken in einer Entscheidungstabelle einsetzen

5. Die erste Zeile hat automatisch eine Farbe bekommen. Ubertragen Sie
sie mit dem Pinsel (Format libertragen) auf die letzte Zeile, oder stellen
Sie tiber Start » Zeichnung » Fiilleffekt eine Farbe ein.

6. Um Kriterien (Spalte 1) und Produkt 1 (Spalten 2 bis 5) deutlicher ab-
zugrenzen, wird die senkrechte Trennlinie dicker formatiert. Markieren
Sie dazu die zweite Spalte, stellen Sie bei Tabellentools » Entwurf » Rah-
menlinien zeichnen eine Stiftstarke von »2% pt« ein. Bei Stiftfarbe wéh-
len Sie Weif, Hintergrund 1. Dann aktivieren Sie {iber Tabellentools » Ent-
wurf » Tabellenformatvorlagen » Rahmen die Option Rahmenlinie links.
Wiederholen Sie den Vorgang fiir die Spalten 6 und 10. Fiir die letzte
Zeile wihlen Sie Tabellentools » Entwurf » Tabellenformatvorlagen » Rah-
men » Rahmenlinie oben.

Funktionsumfang

Modularitat e o 0 0 o P
Stabilitat o o o e o 0 e o o
Design L) o o 0 0 0

Schulungsangebot

Serviceumfang

Balken in einer Entscheidungstabelle einsetzen

Dieser Abschnitt enthélt eine Anleitung dazu, wie Sie eine Entscheidungs-
tabelle im klassischen Balkendesign anlegen, wie Sie sie im Abschnitt »Ent-
scheidungstabellen« ab Seite 228 bereits als Beispiel gesehen haben.
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Kapitel 5 —Tabellen, Diagramme und Schaubilder

1. Legen Sie eine leere Folie i

an. Uber Einfiigen » lllus- = Datenreihe 1
trationen » Diagramm » Serviceumfang  EEG—
Balken » Gruppierte Balken Schulungsangebot _

Design  EG——

legen Sie ein einfaches Bal-
Stabilitat I

kendiagramm an. In der Modularitst  ———
Datentabelle 1dschen Sie Funktionsumfang  —— [ |
die Datenreihen 3 und 4. 0 1 2 ER 5

Erweitern Sie die Tabelle

um zwei Zeilen, sodass Sie sechs Zeilen fiir die Kriterien zur Verfiigung
haben. Geben Sie den Text fiir die Kategorien und den zugehorigen
Wert fiir die Datenreihe ein, wie in der Abbildung zu sehen.

2. Im Moment sind die Kriterien von unten nach oben angeordnet. Mar-
kieren Sie daher das Diagramm, und klicken Sie auf Diagrammtools »
Layout » Achsen » Achsen » Vertikale Primdrachse » Achse von rechts nach
links anzeigen. Danach sollte das Kriterium Funktionsumfang an obers-
ter Stelle stehen.

W Datenreihe 1

Funktionsumfang
Modularitat
Stabilitat

Design
Schulungsangebot

Serviceumfang

3. Fiir die Darstellung in der Entscheidungstabelle brauchen wir keine Be-
schriftungen wie Titel oder Legenden und auch keine Achsen. Gehen
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Eine Liniengrafik als Bild einfiigen

Sie im Menii Diagrammtools » Layout die Befehlsgruppen Beschriftun-
gen, Achsen und Hintergrund durch, und wéhlen Sie jeweils die Option
Keine, bis nur noch die Balken zu sehen sind.

4. Offnen Sie eine Kopie der Folie mit der Basis-Entscheidungstabelle, und
kopieren Sie das Balkendiagramm auf die Entscheidungstabelle. Ver-
kleinern Sie das Balkendiagramm in Breite und Hohe, sodass es genau
in die dafiir vorgesehenen Spalten passt. Orientieren Sie sich zunéachst
an den Wertungspunkten, und loschen Sie diese erst anschlie3end.

5. Uber Diagrammtools » Entwurf » Diagrammformatvorlagen wihlen Sie
nun noch ein passendes Design aus, z.B. Formatvorlage 32.

6. Markieren Sie das Balkendiagramm, und duplizieren Sie es zweimal,
damit wir die Bewertung fiir die anderen beiden Produkte erstellen
konnen. Platzieren Sie die Balkendiagramme in der zugehorigen Spalte,
und verdndern Sie anschliefend die Zahlen in der Excel-Tabelle (Dia-
grammtools » Entwurf » Daten » Daten bearbeiten).

Produkt1 | Produkt2 | Produkt3
Funktionsumfang
Modularitat
Stabilitat
Design

Schulungsangebot

Serviceumfang

[
:llllll

Fazit 2,8

Eine Liniengrafik als Bild einfligen

Zu guter Letzt zeige ich Thnen noch die Erstellung von Entscheidungstabel-
len mit Linien und Wertepunkten. Auch dieses Beispiel haben Sie schon im
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Produkt1 | Produkt2 | Produkt3

Funktionsumfang

Modularitat

e
Stabilitat
Design
Schulungsangebot (
L ] L ]

Serviceumfang

it 12128

Abschnitt »Entscheidungstabellen« ab
Seite 228 gesehen. Auf den ersten Blick
sieht die Darstellung recht einfach aus,
weil sie den Anschein erweckt, dass es
dafiir eine Diagrammfunktion gibt. Lei-
der nein — wir miissen uns hier mit einem
Trick behelfen. Es gibt zwei Moglichkei-
ten: Entweder erstellen Sie separat ein

Liniendiagramm und fiigen es als Bild in die Tabelle ein, oder Sie legen die
Datenpunkte und Linien manuell an.

In diesem Abschnitt zeige ich Thnen zunéichst, wie Sie ein Liniendiagramm

anlegen und dann als Bild einfiigen konnen.

1. Zunichst erstellen Sie ein Balkendiagramm, wie schon in der vorheri-
gen Anleitung gezeigt, oder verwenden das oben angelegte Beispiel mit
den Balken als Grundlage, indem Sie es duplizieren. Zur Vereinfachung
dieses neuen Beispiels dndern Sie in der Excel-Tabelle des Balkendia-
gramms von Produkt 1 den Wert beim Parameter Stabilitdt auf »1«.

2. Dann markieren Sie das Diagramm und 4ndern den Diagrammtyp: Dia-
grammtools » Entwurf » Typ » Diagrammtyp dndern » Linie » Linie mit
Datenpunkten. Passen Sie die Darstellung der Punkte an, indem Sie
z.B. anstelle einer Raute einen Kreis einsetzen (dazu klicken Sie mit
der rechten Maustaste auf einen Datenpunkt im Diagramm und wéhlen
iiber Datenreihen formatieren » Markierungsoptionen » Integriert » Typ

ein Symbol aus).
3. Wenn das Liniendia-
gramm fertig ist, fiigen
Sie eine Kopie IThrer Ba-
sistabelle als neue Folie
ein. Achten Sie dabei
darauf, dass bei Produkt
1 und dem Parameter
Stabilitdt nur ein Punkt
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Eine Liniengrafik als Bild einfiigen

zu sehen ist. Zeichnen Sie darauf ein Rechteck ein, wie in der Abbildung
gezeigt (Start » Zeichnung » Formen » Rechtecke » Rechteck). Es dient als
Vorlage fiir die Grofde der Liniengrafik. Die Ecken sollten genau in der
Mitte der dulieren Kreissymbole sitzen.

Kopieren Sie dann das Rechteck und das
Liniendiagramm gemeinsam auf eine Folie
(dazu legen Sie am besten eine neue leere
Folie an). Drehen Sie das Rechteck mithil-
fe des griinen Drehmarkers um 90° Grad
(oder Kklicken Sie es mit der rechten Maus-
taste an, wihlen Sie GréRe und Position »
GroRe, und geben Sie im Feld Drehung den
Wert »90° ein). Verdndern Sie die Grolse des Liniendiagramms, sodass
die dullersten Punkte auf dem Rand des Rechtecks zu liegen kommen.

Da die Liniengrafik so nicht gedreht werden kann, miissen wir einen
kleinen Umweg machen. Klicken Sie dazu mit der rechten Maustaste auf
die Liniengrafik, und speichern Sie sie {iber Als Grafik speichern als .png-
Datei ab. Dann fiigen Sie dieses Bild iiber Einfiigen » Bilder » Grafik auf
der Folie mit der Tabelle und der Balkengrafik ein. Drehen Sie es um 90
Grad, und verschieben Sie es an die passende Position in der Entschei-
dungstabelle.

Funktionsumfang
Modularitat
Stabilitat

Design
Schulungsangebot

Serviceumfang
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Eine Liniengrafik manuell anlegen

Die zweite Moglichkeit, eine Entscheidungstabelle mit einer Liniengrafik zu
versehen, ist zwar etwas aufwendiger, dafiir aber auch flexibler. Die Linien
und die Verbindungen zu den Datenpunkten werden manuell erstellt und
miteinander verbunden.

1. Offnen Sie zunichst eine Kopie der Basistabelle-Prisentation bzw. ko-
pieren Sie die Basistabellen-Folie in Ihre Prisentation. Fiigen Sie bei
Produkt 1 einen Kreis als Datenwert ein. Dafiir wéhlen Sie Start » Zeich-
nung » Formen » Standardformen » Ellipse und ziehen die Form mit ge-
driickter o -Taste auf. Duplizieren Sie den Kreis ([Strg]+ [D]), und
verkleinern Sie das Duplikat so weit, bis es nahezu nur noch ein Punkt ist.

2. Markieren Sie die beiden Kreise, und richten Sie sie iiber Start » Zeich-
nung » Anordnen » Objekte positionieren » Ausrichten » Vertikal zentrie-
ren und Horizontal zentrieren so aus, dass sie genau iibereinanderliegen.

Gruppieren Sie sie mit + + (a).

Zoom

Wenn Sie die Kreise markieren und sie dann uber die Zoomfunktion
vergrofiern, kdnnen Sie leichter und genauer damit arbeiten.

3. Duplizieren Sie die beiden Kreise fiinfmal
(fiir jedes Kriterium), und positionieren Sie
sie am besten senkrecht untereinander. Dann
heben Sie die Gruppierung erst einmal wieder
auf ([Strg) + (o] + [H)). Zeichnen Sie iiber
Start » Zeichnung » Formen » Linien » Linie
Verbindungen zwischen den Kreisen. Verbin-
den Sie dabei den Endpunkt einer Linie immer
mit dem kleinen Kreis. Das ist wichtig, sonst
lassen sich die Kreise spéter nicht richtig ver-

schieben.



Eine Liniengrafik manuell anlegen

4. Nachdem alle kleinen Kreise durch Linien verbunden sind, markieren
Sie alle grof3en Kreise und ziehen sie iiber Start » Zeichnung » Anord-
nen » Objekte sortieren in den Vordergrund. Gruppieren Sie immer
einen grof3en Kreis mit seinem kleinen Kreis. Dann gruppieren Sie all
diese gruppierten Kreise und alle Linien zu einem einzigen Objekt.

Gruppierung

Arbeiten Sie von nun an immer mit dieser Gruppierung zu einem
Objekt, denn sonst kann es passieren, dass die Linienverbindungen
aufgelost werden und Sie wieder von vorne beginnen mussen.

5. Uber Start » Zeichnung » Schnellformatvorlagen wiihlen Sie eine passen-
de grafische Ausgestaltung, z. B. Intensiver Effekt — Orange, Akzent 6.

6. Zum Schluss duplizieren Sie den Linienkérper (das gruppierte Objekt)
und verschieben die Kopie fiir die spatere Nutzung an den Rand der Fo-
lie. Losen Sie die Gruppierung des Originals auf ([Strg] + (o] + (H)).
Verschieben Sie nun die einzelnen Datenpunkte an die entsprechende
Stelle im Wertebereich fiir das Produkt 1. Fiir die weiteren Produkte du-
plizieren Sie jeweils eine Kopie, 16sen die Gruppierung und verfahren

(——C—C—<—<

wie fiir Produkt 1 bereits beschrieben.

[ brodukt | Produkt2 | Produt3

Funktionsumfang

Modularitat
Stabilitat

Design

Schulungsangebot Y/
w

Serviceumfang
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Kapitel 6 — Zeitstrahl und Abldufe gekonnt visualisieren

Kapitel 6

Zeitstrahl und Ablaufe
gekonnt visualisieren

Unternehmensprasentationen enthalten haufig eine Beschreibung der His-
torie, Projektprédsentationen zeigen Meilensteine und Projektablaufe, oder
Marketingprasentationen enthalten Termine und Abl&ufe fiir Aktionen. Ne-
ben diesen Beispielen gibt es eine ganze Reihe von Foliensétzen, die Zeit-
abfolgen, nichste Schritte oder auch Workflows zeigen. In diesem Kapitel
finden Sie Anregungen zu diesen Themen. Sie lernen, wie Sie Zeitstrahlen
und Ablédufe spannender und interessanter visualisieren.
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Kapitel 6 — Zeitstrahl und Ablaufe gekonnt visualisieren
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Sie werden lernen, welche wichtigen grundlegenden Konzepte und Ideen es
gibt, um Zeitstrahlen und Ablaufe darzustellen, und wie Sie sie interessant
gestalten konnen. Sie werden erfahren, wie Sie die verschiedenen Funktio-
nen in PowerPoint kombinieren, um ansprechende Konzepte umzusetzen.

Konzepte fiir Zeitstrahlen

Der Zeitstrahl stellt einen Ablauf dar und basiert gewohnlich auf einer zeit-
metrischen Basis, z. B. Jahrzehnte, Jahre, Monate, Wochen, Tage, Stunden
oder Sekunden. Mit seiner Hilfe werden beispielsweise Historien, Umsatz-
entwicklungen, Projektphasen, Entwicklungsschritte oder Roadmaps dar-
gestellt.

Im Gegensatz dazu wird der Begriff Ablauf fiir aufeinander aufbauende
oder parallel ablaufende Vorgidnge ohne exakte zeitliche Aufschliisselung
benutzt. Zu dieser Kategorie gehéren zum Beispiel Flussdiagramme (Flow-
charts) fiir Prozess- und Programmbeschreibungen in der Informatik, Pro-
zessbeschreibungen in der Organisationsentwicklung und Workflows wie
Bestell-, Liefer- oder Messvorgénge.

Die folgende Abbildung zeigt sechs Basiskonzepte, auf denen Zeitstrahlen
aufgebaut werden kénnen:

® Horizontaler (waagerechter) Zeitstrahl: Der Zeitstrahl ist in der
Grundanlage waagerecht aufgebaut und verlduft in der Regel von links
nach rechts. Alternativ kann er auch von rechts nach links laufen oder
leicht aufsteigen. Typische Beispiele sind historische Entwicklungen mit
Jahreszahlen.

e Vertikaler (senkrechter) Zeitstrahl: Der Zeitstrahl ist in der Grundan-
lage senkrecht aufgebaut und verlauft in der Regel von unten nach oben
(alternativ von oben nach unten). Er kann auch leicht nach links oder
rechts gekippt sein. Ein Beispiel ist hier wieder die Darstellung einer Ent-
wicklung mit Jahreszahlen.



Konzepte fiir Zeitstrahlen

® Bidirektionaler Zeitstrahl (mit zwei Zeitachsen): Bei diesem Typ gibt
es eine waagerechte und eine senkrechte Zeitachse. In der horizontalen
Achse sind dann zum Beispiel Jahreszahlen und in der vertikalen Monate
eingetragen.

® Flachenzeitstrahl: Die Zeitentwicklung wird anhand von einzelnen seit-
lich aneinandergereihten Flachen dargestellt. Ein Beispiel: Der Zeitraum
— sagen wir die Jahreszahl — wird an die jeweilige Flache geschrieben,
und in der Flache werden Informationen, Bilder usw. gezeigt, die zu dem
jeweiligen Jahr passen.

® Aufbauender Zeitstrahl: Ahnlich wie beim Flichenzeitstrahl werden
die Fldachen {ibereinandergestapelt und seitlich versetzt. Hiermit wird
die Darstellung einer Entwicklung noch deutlicher, denn die aufbauende
bzw. aufsteigende Darstellung wird in der westlichen Kultur stets positiv
bewertet.

® 3D-Zeitstrahl: Der Zeitstrahl wird rdumlich dargestellt. Zum Beispiel
gibt es einen Pfeil auf der Folie, der von oben rechts nach unten links ver-
lauft. Am Pfeilbeginn geht es mit alten Jahreszahlen los, und nach vorne
hin werden die Jahreszahlen aktueller. Um die 3D-Wirkung zu unterstiit-
zen, werden altere Jahreszahlen (also die oben rechts) kleiner geschrie-
ben als die aktuellen.
Damit wird eine grofdere
Relevanz der jiingeren E‘:‘:‘:ﬁ>
Daten gegeniiber den al-

ERENE

teren vermittelt.

Alle diese Zeitstrahlkonzep- H

te konnen natiirlich auch | '

miteinander verkniipft wer-

den, wenn noétig. Ich stelle

Ihnen diese Moglichkeiten S
im Folgenden ausfiihrlich SSE

vor und zeige Thnen zudem
einige Beispiele.
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Kapitel 6 — Zeitstrahl und Ablaufe gekonnt visuali

Da Vinel
1452-1518

Die Entscheidung, welches Konzept Sie verwenden, héngt von der Aufga-
benstellung und dem Gesamtkonzept der Prdsentation ab. Die folgenden
Beispiele geben Thnen Aufschluss iiber die verschiedenen Einsatzmoglich-
keiten. Wie in der Liste oben beginnen wir mit den horizontalen bzw. waa-
gerechten Zeitstrahlen.

Der horizontale Zeitstrahl wird am hédufigsten eingesetzt und ist daher so-
zusagen der Archetyp eines Zeitstrahls, der sich prinzipiell fiir alle Zusam-
menhénge eignet.

Die folgenden Beispiele sind Variationen des klassischen Zeitstrahls: Sie
sind immer noch horizontal aufgebaut und ihre Stationen beschriftet, aber
wir haben sie mit passenden Bildern aufgepeppt.

Beriihmte Kiinstl .
ertimee fnstier Automobil vs. Unterhaltung

114901576 —
Velazquez van Gogh *
Modell-

15991660 1853-1830 500-P5- CW-Wert

l Design- | Relaunch WModel| i

Raffasl
1483-1520
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| Pionier studie

1920 1940 1950 1

m
153§-rTD® l Q -E Q

Rembrandt
1606-1696 Radio Farb-TV Videorekorder

Daneben gibt es das Konzept des vertikalen bzw. senkrechten Zeitstrahls,
bei dem die Entwicklung von unten nach oben oder von oben nach unten
dargestellt wird. Im Gegensatz zum horizontalen Zeitstrahl kénnen hier
aufgrund der geringeren Hohe der Folie weniger metrische Daten, also Jah-
reszahlen etc. eingesetzt werden, dafiir aber mehr Inhalt. Wenn Ihr Schwer-
punkt mehr auf Inhalten liegt, wére diese Darstellung geeignet.

Die nichsten Beispiele sind Varianten dieses senkrechten Zeitstrahls, jeweils
mit passenden Bildern oder durch eine farbige Gestaltung mit Hintergrund
aufgewertet, die zudem auch die Lesbarkeit fordert, weil die Chronologie
der einzelnen Zeitpunkte leicht zu erkennen ist.



Konzepte fiir Zeitstrahlen

mcklung der Region Firmenentwicklung Eggle

Ausnutzung zur
Energiegewinnung

Industrialisierung
der Region

Josef Lindemann,
Firmengriinder

o

Der néchste Typus ist der bidirektionale Zeitstrahl. Dabei geht es darum,
Zeitraume oder Daten zu verschachteln. Beispielsweise wird eine Achse fiir
grolde Zeitraume wie Jahre, Jahrzehnte oder Jahrhunderte verwendet und
die andere fiir die darin eingeschlossenen Zeitrdume, also Tage, Monate
usw.

Die folgende Folie zeigt einen solchen zweidimensionalen Zeitstrahl: Die
waagerechte Achse enthilt die Entwicklung in Jahrzehnten, und zu jedem
Jahrzehnt gehort noch einmal eine senkrechte Achse, die auf die Gescheh-
nisse der einzelnen Jahre eingeht. So kdnnen Sie viele Informationen auf
einer Folie unterbringen, ohne dass es uniibersichtlich wird und iiberladen
wirkt. Auch fiir eine Abfolge von Folien, die sich dann z.B. jeweils mit den
einzelnen Dekaden (Jahrzehnten) befassen, eignet sich dieser Typ sehr gut.

Marktentwicklung
Verkauf  Marketing  Qualitit Service Networking
LN
L
1970 1980 1990 2000 2010

1981 Marketing wird zum essentiellen Bestandteil
des Unternehmens

‘_ﬂf‘ 1995 Eréffnung des Marketing-Instituts
e o

2008 Expansion durch konsequentes
strategisches Marketing
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Kapitel 6 — Zeitstrahl und Ablaufe gekonnt visualisieren

Das vierte Zeitstrahlkonzept ist der Flachenzeitstrahl, der die Achsenbe-
schriftung quasi ablost. Der Flachenzeitstrahl zeigt eher isolierte Ereignisse
als eine Entwicklung an — nach dem Motto »hier ist mal etwas passiert und

da auch noch«. Dennoch kann diese Form des Zeitstrahls auch fiir Entwick-
lungen eingesetzt werden, wie das Beispiel weiter unten zeigt.

Das erste Beispiel ist ein Fldchenzeitstrahl mit abgerundeten Flachen, der
einzelne Stationen der Entwicklung des Funktelefons zeigt.

Entwicklung des Funktelefons

Der Relaunch-Plan in der zweiten Abbildung enthilt drei Zeitflachen und
zwei waagerechte Zeitphasen. Das bietet die Moglichkeit, zwei Projekte im
Zeitablauf zu vergleichen; au3erdem werden Pufferzeiten vor und nach den
Projektabschnitten angedeutet.

Relaunch-Plan

Zeitplan

Marketing I I.
Vertrieb l l I
I I Zeit

Start Vertrieb Start Einfuhrung
1.07.2011 1.10.2011

Operativer
Einsatz

Phase 2
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Konzepte fiir Zeitstrahlen

Der aufbauende Zeitstrahl wird {iblicherweise fiir Schritt-fiir-Schritt-Ent-
wicklungen verwendet und dhnelt dem senkrechten Zeitstrahl, wobei bei El
Letzterem immer ein Pfeil zu sehen ist, hier jedoch nicht. Er kann dariiber

hinaus fiir alle Zeitabldufe verwendet werden und suggeriert eine positive
Entwicklung.

Die zeitliche Entwicklung kann im aufbauenden Zeitstrahl — trotz des Na-
mens — sowohl von unten nach oben als auch umgekehrt dargestellt werden.

Historie
REkEN Grundung der HHXX AG

Meilensteine

gEeEkY Einfohrung LVX

2010
2008
2005

Presentation-Booster auf Basis der Neurowissenschaften

kEei=Ed Einfuhrung CES

Einfihrung von Zooming-Prasentationen in D/A/CH =
hEel=leR Einfahrung System ABC

Einfihrung des 1999 entwickelten Folienmanagers fir PPT

gEEiEEER A ufbau des Service Centers in Petersburg

2002 /[ Multilingual-Présentationen (bis zu 4 Sprachen synchron)

ool Finfuhrung des Softwarestandards JCX
2001

Entwicklungvon Wide-Screen-Prisentationen
2005 \euentwickiung von MuSave

2Lolof:8 Grundung des Service Centers In Paris

2000 Jf Entwicklungvon 3D-Stereo-Prasentationen

1999 [/ Entwicklungder Preview-Funktion fir PowerPoint

ploh[el Ubernahme von SUPER Inc. in den USA

Die letzte Gruppe von Zeitstrahlen, die ich hier vorstellen mochte, sind die
3D-Zeitstrahlen, die vor allem dann eingesetzt werden, wenn man innova- /
tiv, modern wirken will oder wenn die Relevanz einer bestimmten aktuellen S=SS
Information im Vordergrund stehen soll.

Im ersten Beispiel kommt der 3D-

2371 +
Zeitstrahl »aus der Tiefe des Rau- * neueste Entwicklung der Sternenflotten-Ingenieure
» modernstes Raumschiff seiner Zeit

* Kommando: Captain Lisa Cupload

mes«. Dabei wird die Dreidimen-
sionalitdt durch die Perspektive
und vor allem durch die Achsenbe-
schriftung erreicht. Die zweite Ab-
bildung zeigt einen kurvigen Zeit-
strahl, der von hinten nach vorne
verlduft und mit einem Schatten
versehen wurde, sodass er radum-
lich wirkt.
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Entwicklung der Flusslandschaften

* Befestigungen
* Damme
+ Begradigungen

+ Schleusen

+ Wasserdamme
+ Dampfschifffahrt + Mihlen
* Personenverkehr

* Wasserkraft

+ Umweltauswirkung
+ Klarbetriebe

Phasen einer Entwicklung darstellen

In diesem Abschnitt erstellen wir einen Entwicklungsphasen-Zeitstrahl, der
an den Produktlebenszyklus im Bereich der Betriebswirtschaftslehre ange-
lehnt ist. Die blaue Fldache an dem Zeitstrahl deutet die Umsatz- oder Ab-
satzkurve des Produkts oder der Firma an.

1. Legen Sie eine neue Folie (mit
dem Layout Leer) an. Als Ent-
wurfsvorlage konnen Sie fiir

Entwicklung

dieses Beispiel die Vorlage Hy-

perion verwenden (Entwurf »

Design). Uber Start » Zeich- = (i >
nung » Formen » Linien » Pfeil

ziehen Sie dann mit gedriick-

ter (o ]-Taste einen waage-

rechten Pfeil iiber die Folie.
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Phasen einer Entwicklung darstellen

2. Fiigen Sie dann iiber Start » Zeichnung » Formen » Rechtecke » Abge-

rundetes Rechteck ein Rechteck ein, in das Sie nachher den Text schrei-
ben. Geben Sie die erste Jahreszahl ein: »1980«. Passen Sie nun Schrift,
Schriftgrofe und die Grof3e des Rechtecks nach Thren Vorstellungen an.
Die Rundungen des Rechtecks konnen Sie iiber den Ziehmarker (die
kleine gelbe Raute) verdndern.

Duplizieren Sie das Rechteck dreimal, und dndern Sie die Jahreszahl.
Platzieren Sie das erste Rechteck auf dem Pfeilanfang und das letzte
Rechteck auf der Pfeilspitze. Markieren Sie alle Rechtecke, und richten
Sie sie iiber Start » Zeichnung » Anordnen » Objekte positionieren » Aus-
richten » Horizontal verteilen passend aus. Dann markieren Sie zusitz-
lich den Pfeil und klicken im gleichen Menii auf Vertikal zentrieren.

Formen verschonern

Wenn Sie die Rechtecke gestalten wollen, kdnnen Sie das besonders
schnell Gber Start » Zeichnung » Schnellformatvorlagen tun.

Um nun die Wachstumskurve darzustel- | e
len, zeichnen Sie ein Dreieck, wie es in der
folgenden Abbildung zu sehen ist (Start »
Zeichnung » Formen » Standardformen »
Rechtwinkliges Dreieck).

Entwicklung

Spiegeln Sie das Dreieck mit Anordnen »
Drehen » Horizontal kippen.

Entwicklung
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6.

Verschieben Sie die obere Ecke
des Dreiecks iiber den Wert
»2000« auf der Achse. Dafiir
miissen Sie zunichst mit der
rechten Maustaste auf die
Form klicken und Punkte bear-
beiten aus dem Kontextmenii
wahlen. (In PowerPoint 2007
miissen Sie das Dreieck erst in eine Freihandform umwandeln: Zeichen-

Entwicklung

tools » Format » Formen einfiigen » Form bearbeiten » In Freihandform
konvertieren. Im gleichen Menii kénnen Sie dann die einzelnen Punkte
des Dreiecks tiber Punkte bearbeiten verandern.)

Klicken Sie dann mit der rech-
ten Maustaste auf einen der
Punkte, und wéhlen Sie Punkt
glatten aus dem Kontextmenti.

Dadurch wird das Dreieck ab- M
gerundet.

Legen Sie das abgerundete Dreieck in den Hintergrund (Start » Zeichnung »

| Entwicklung

Anordnen » Objekte sortieren » In den Hintergrund), und erginzen Sie zum
Schluss die iibrigen Texte, z.B. »Griindung« und »Wachstumsphase«, wie
oben beschrieben (Start » Zeichnung » Formen » Rechtecke » Abgerundetes
Rechteck).

Entwicklung

Reife-
Wachstums- phase Modifikations-
phase phase

Grindung
1980




Einen dynamischen Zeitstrahl anlegen

Einen dynamischen Zeitstrahl anlegen

In diesem Abschnitt zeige ich Thnen, wie Sie einen Zeitstrahl anlegen, des-
sen Grundlage ein Pfeil ist. So stellen Sie die Entwicklung sehr plakativ dar
und verleihen Thren Informationen Dynamik.

1. Legen Sie zunéchst eine neue Folie (mit dem Layout Leer) an. Uber Start »
Zeichnung » Formen » Standardformen » Parallelogramm fiigen Sie ein
kleines Parallelogramm ein (ziehen Sie es auf der Folie auf).

m Start | Einfiigen  Entwurf  Ubsrging=  Animationen  Bildschimprasentation  Uberprifen  Ansicht  Acrobat

= [ Layout + - e m It (] B= 22 Faliefekt
|_] A A | R lj Ll—j—) S y & Farmlantur

LB EFY By zuriicksetzen 2
Einfugen Heue F £ U 8§ abe 2V~ As A

Formen Anm(lnen Schnellfarmat-
Foliew = Abschnitt - varlagen

=} Formeffekte

Zwischenablage & Falien Schriftart IZuIetzl verwendete Formen | LN
O VI e T e S e T e e ey [ A== RS > e N T P B0 A ey

[T
| Linien
NNNTLL R WRAD %
Rechtecke
EHREaEEREEE
Standardformen

Bo ANIACOGOOO®®

@6bugri-2Zom
L0 )4 2

Blockpfeile

ARG RTHLER ST
€ dvnmnpD » HE
T

Formefformen

[F=x==g

Flussdiagramm
O0<codOdldeoay
CUORRE E ¢ AVED
Qoo

Sterne und Banner

LI ADEERRER
kA ) T 1 QI 0

e e S G S S S B SN T

2. Als Nichstes kippen Sie das Parallelogramm (Start » Zeichnung » @ ,Q\
Anordnen » Objekte positionieren » Drehen » Horizontal kippen) und (Lﬁ/
verdndern mit der gelben Raute seine Grof3e und Neigung, wie in \ {{
der Abbildung zu sehen. Drehen Sie dann das Parallelogramm mit- VJ
hilfe des griilnen Markers, sodass es wie der obere Schenkel einer
Pfeilspitze positioniert ist.
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3.

Genauer ausrichten

Wenn die Form sich nicht so ausrichten lasst, wie Sie sie gerne hat-
ten, und immer wieder in eine bestimmte Position »zurtickspringtc,
schalten Sie das Raster aus oder benutzen die [Strg]-Taste fiir die
Feinjustierung.

Ziehen Sie dann ein weiteres Parallelogramm auf _ -

< B
der Folie auf, und kippen Sie es erneut, diesmal ver- K"*--.\H .
tikal (Start » Zeichnung » Anordnen » Objekte posi- Oji /"
tionieren » Drehen » Vertikal kippen), und drehen :"—. / /.f i
bzw. verschieben Sie das zweite Parallelogramm so, \ £/ &
dass die beiden zusammen eine Pfeilspitze ergeben. 5

Die beiden Formen konnen sich dabei {iberlappen.

Fiir den Rumpf des Pfeils ziehen Sie ein Trapezoid auf (Start » Zeichnung »
Formen » Standardformen » Trapezoid), wie es die linke Abbildung zeigt.

Drehen Sie das Element am griinen Marker so weit, dass seine breite
Seite die Pfeilspitze iiberlagert. Strecken und stauchen Sie den Rumpf,
damit ein Pfeil entsteht und geniigend Platz fiir die Beschriftung vor-
handen ist.

< B
~ S
~— e
~ -
. S
T —7
e Y
e J/
__,__,/ /
e f
o ———— Y
= _— y
e il . / /
" — ,.-"r Y
e — y s
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/______’— _— — L
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Q':_/-"' -
-
B _— -
L
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. Um den Pfeil zu gestalten, markieren Sie alle drei Objekte, und wéhlen

Sie Start » Zeichnung » Formkontur » Kein Rahmen. Gruppieren Sie dann
alle Teile des Pfeils ([Strg] + + (GJ, und passen Sie iiber Start »



Einen dynamischen Zeitstrahl anlegen

Zeichnung » Fiilleffekt die Farbe an. Wihlen Sie einen passenden Schat-
ten (Start » Zeichnung » Formeffekte » Schatten » Weitere Schatten), und
passen Sie ihn an, z. B. indem Sie einfach mal die Werte bei Weichzeich-
nen oder Abstand verdndern.

Fiir die Beschriftung innerhalb des Pfeils nutzen Sie entweder einzel-
ne Textboxen (Start » Zeichnung » Formen » Standardformen » Textfeld)
oder geben den Text direkt in die Form ein. Wenn Sie sich fiir einzelne
Textboxen entscheiden, erstellen Sie sie erst alle nebeneinander, mar-
kieren Sie sie, und drehen Sie sie, indem Sie {iber die rechte Maustaste »
GroRe und Position » GroRe einen Gradwert im Feld Drehung angeben.
Die dullere Beschriftung erstellen Sie dann mithilfe einzelner Textbo-
xen und gestrichelter Linien. Erstellen Sie einfach eine Textbox und eine
Linie (Start » Zeichnung » Formkontur » Striche), und duplizieren Sie sie.

Zum Abschluss fiigen Sie fiir eine bessere Lesbarkeit noch einen Hin-
tergrund ein. Dazu verwenden Sie einfach ein Rechteck, das Sie farben
und iiber Start » Zeichnen » Anordnen in den Hintergrund legen.

i Marktreife

iPilotphase

Einfihrung

ETestphase
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Konzepte fiir Ablaufe

Ahnlich wie bei den Zeitstrahlen ist auch das Spektrum fiir die Gestaltung
von Abliufen sehr breit. Die folgende Ubersicht zeigt sechs verschiedene
Grundtypen:

® klassische Ablaufe (Workflows, Flowcharts)
e Zyklen

® Abldufe mit Hintergrundmotiv

® Ablédufe mit Bildelementen

e illustrative Abldufe

® Ablédufe ohne Prozesspfeile (Flachenablaufe)

Ahnlich wie im vorherigen Abschnitt stelle ich Ihnen die einzelnen Typen im
Folgenden néher vor und zeige Ihnen das eine oder andere Beispiel.

Q.Q. O
OO

Sl

Teile der hier vorgestellten Ablaufe, namlich eine Auswahl von Prozess- und
Zyklusdarstellungen, lassen sich in PowerPoint mithilfe von SmartArts ge-
stalten (Einfiigen » lllustrationen » SmartArt).

254



3 Grafik o..o.. —
¥ —

= e

iean - = [- |

el @

Konzepte fiir Ablaufe

Einfache Blockliste

Hiermit zeigen Sie nicht sequenzelle oder
gruppierte Informationsbiocke an. Dabei
werden der horizontale und der vertkale
Bereich zum Anzeigen van Formen
maximeert,

Coc ) ()

Klassische Ablaufe, wie sie in PowerPoint zu finden sind, werden beispiels-
weise fiir Programmablaufe von Software oder fiir Arbeitsabldufe in Unter-
nehmen (Workflow) eingesetzt. Im Folgenden sehen Sie einige Beispiele

aus diesen Bereichen.

Die Flowchart-Symbole, die Sie in der Abbildung sehen und die die einzel-
nen Stationen des Ablaufs reprisentieren, finden Sie unter Start » Zeich-

nung » Formen » Flussdiagramm.

Anfangs- oder Endzeichen eines Prozesses

Rechenschrittoder Verarbeitungs-
funktion eines Prozesses

Input- oder Output-Operation

Entscheidungen und Verzweigungen

Verbindungsstelle, Verbindung zwischen
zwei Abschnitten/Prozessen

Speicher, Harddisc usw.

Anzeige

Verbindungzu weiteren
Seiten (Off-Page Connector)
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Das erste der folgenden Beispiele zeigt
ein Flowchart (Flussdiagramm), wie es
z.B. in der Softwareentwicklung oder
in einer Prozessbeschreibung verwen-
det wird. Die Folie kommt mit wenigen
Effekten daher, und die Formatierung
ist lediglich {iber die Schnellformatvor-
lagen erfolgt.

¥
Nein
Das folgende Beispiel zeigt eine Ar- '_$

beitsanweisung. Durch die weif3en Fla- 2

chen wirkt die Folie sehr sachlich. Der
s

eingefiigte Schatten riickt die Flow-
chart-Symbole in den Vordergrund.

Solldie
Prasentation
animiertsein?

Auf»Nach Auf »Beim
Varheriger« Klicken«
einstellen einstellen

Prasentation
erstellen

Um einen Ablauf so zu gestalten, als wire er gerade frisch entwickelt wor-
den, eignet sich eine Folie im handschriftlichen Look.
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Solldie
Prisentation
anlralert selin?,

Ja

AufrNach Aufrieim
Vorherioer« Klickens
elnstellen elnstellen

? _J

Prisentotion
erstellen

Das néchste Beispiel zeigt ein Flussdiagramm, das noch mal mit verschiede-
nen Phasen hinterlegt ist.

Kontakt-
anfrage

Verkauf Einfach?

Komplexe Rechnungs-
Produktion stellung
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Durch Farben lassen sich bestimmte Teile des Ablaufs herausheben, werten
oder auch Aufgabentrdgern zuordnen. Die néchste Folie zeigt ein solches
Beispiel, bei dem die Farben bestimmten Personen zugeordnet sind.

Beschwerde

¢

Experten-
Schlichtung * Entscheidung

AN

—— Fall abgeschlossen

Der néchste Typ von Abldufen, den ich hier vorstellen will, sind die Zyklen.
Sie sind dadurch gekennzeichnet, dass ein Ablauf eine Schleife bildet, die
endlos wiederholt werden kann. Das bedeutet: Wenn das Ende erreicht ist,
kann es wieder von vorne losgehen. Dariiber hinaus kann ein Kreislauf et-
was Abgeschlossenes bzw. eine Einheit symbolisieren.

Das erste Beispiel zeigt den Ablauf einer Pizzalieferung, der als Zyklus mit
gebogenen Pfeilen dargestellt wird. Die Gestaltung des Kreises und der Seg-
mente erinnert dariiber hinaus selbst an eine Pizza.
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Pizzalieferung

Lieferung
annehmen

Man kann dem Zyklus auch einen 3D-Look verpassen, was der Folie Tiefe
gibt und sie interessanter macht. Pfeile oder Textfelder werden durch die
plastische Wirkung jeweils besonders deutlich hervorgehoben.

Visionen

e —
Opcation

-~

f b

Strategie Mission

Ny
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Nachricht Empfanger
schreiben eingeben

Betreff notieren

Die dritte Variante von Abldufen sind solche mit einem Hintergrundmotiv.
In diesen Féllen kann der Hintergrund entweder die Botschaft der Folie un-
terstiitzen oder dient gleichzeitig dazu, den Ablauf visuell zu verorten.

Als Hintergrundmotiv fiir das erste Beispiel wurde eine Textur verwendet,
die wie eine Schultafel wirkt. Die Schriftart, z.B. Bradley Hand ITC, und
die gezeichneten Verbindungen sollen den personlichen, handschriftlichen
Charakter unterstreichen.

welches Haustierpasstzu thnen ?

Sind Siett

P

ja—

T Ry

! 1
Herrchen  Diewer
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Im zweiten Beispiel richtet sich die Darstellung des Ablaufs nach dem Hin-
tergrundmotiv. Die Steine werden als Orientierungspunkte fiir die einzel-
nen Stationen verwendet.

1.
Standpunkt
finden

3.

" Y Sicher
Erfolgreich ankommen

sein

Natiirlich lassen sich Bilder nicht nur als Hintergrund fiir Abldufe, sondern
auch als Einzelelemente verwenden. Das bedeutet, dass ein Bild den Kno-
tenpunkt zwischen zwei Pfeilen darstellt.

Die Bildhaftigkeit der Stationen erleichtert es, den Ablauf besser zu ver-
stehen. Sie konnen dies natiirlich noch durch Pfeile unterstiitzen. Figuren
und Symbole machen es dem Zuschauer leicht, sich in der Darstellung des
Prozessablaufs zurechtzufinden. In diesem Stil kann man viele Themen auf
lockere und unterhaltsame Art présentieren.

Auf der néchsten Folie sehen Sie an den Knotenpunkten Bilder, die das The-
ma noch bildhaft verstérken.
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Full-Service-Archivierung

Scannen

Digitalbelege L 1LEmp

UMTS
Digitalbilder |(:@) tmmp q /
- ~

Das zweite Beispiel zeigt einen klaren linearen Ablauf von links nach rechts.
Hin und wieder, z.B. in den Bereichen Verkauf, Marketing oder Logistik,

Archiv-
system

stellt man mit einem solchen Ablauf dar, dass parallel gearbeitet wird. Die
Piktogramme iiber dem Flussdiagramm zeigen die Funktionstréger, und die
Bilder unter dem Flussdiagramm stehen fiir die zugehorigen Ressourcen
wie Computer, Datenspeicher oder LKW.

Kunden- Verkaufund | Produktions-
beratung Marketing planung

. "
e & -~ 2 a ® !‘
6 s fBO° £ oV

Herstellung Logistik Buchhaltung

| BN B | BN B -
.—».—- .—r.—b.—l{ ’—r.—e.—r’ ’—r.—t.
‘m-w TR Cm-m
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Konzepte fiir Ablaufe

Das néchste Beispiel zeigt einen Ablauf ganz ein-
fach anhand von Bildern und ist damit natiirlich
sehr plakativ.

Wie wir schon vorher gesehen haben, wirken
handschriftlich gestaltete Abldufe sympathisch
und aktuell. Bei Abldufen mit Bildelementen
konnen Sie auch mit gezeichneten Bildern arbei-
ten und so einen sehr lockeren Stil zeigen, der
dem Zuschauer suggeriert, dass der Ablauf ganz
einfach ist. Bilder wirken kindlich, und deshalb
assoziieren wir sie mit Einfachheit.

Aste und

Wasser gelangt
in die Kanalisation

Aste und Blatter werden in
Biosilos zu Diinge- =
mittel verarbeitet

Alle tbrigen
Schadstoffe
werden entfernt

Blatter werden
herausgefischt

Planung

Entwicklung

Verbesserung

Sandfanganlagen
ziehen grofiere Partikel
auf'den Boden des Tanks

Wasser lauft
durch ein Becken
mit Steinen

Chemikalien reinigen
schlammiges Wasser:

Chemikalien
setzen Sauerstoff
frei und reinigen
das Wasser

Sauberes
Wasser
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Einen Schritt weiter in diese Richtung gehen Sie mit sogenannten illustra-
tiven Ablaufen. Dabei ist der Prozess in die Gesamtdarstellung eingebettet
und nicht mehr auf den ersten Blick als Prozess erkennbar. Der Prozess
erscheint also beildufig, die Gesamtdarstellung steht im Vordergrund. Sie
konnen solche Ablaufe nutzen, um noch interessantere, spannendere Folien
zu bauen.

Im ersten Beispiel sind die einzelnen Schritte des Ablaufs einfach entlang
einem Bild der Anlage angeordnet, um die es geht. Auch das zweite Beispiel
lebt von seiner plakativen Darstellung. Man erkennt sehr schnell, worum
es geht, und der Ablauf selbst erschlief3t sich anhand der Pfeile. Im letzten
Beispiel wird die Thematik schon allein dadurch deutlich, dass der digitale
Datenstrom durch Nullen und Einsen dargestellt wird.

Leistungsablauf (Anlagenbau)

. ™~
Service

‘“\//Architektur

v - -
- 7 \/Logistik
\4&&55-

—
Beraten | -

automation
\//F:ozess-

technik

3
Realisieren |

Planen

264



Konzepte fiir Ablaufe

Kraftwerk Wérme-

- tauscher
b, ‘
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I 010111101010101000EEESEEay
FPge 110100010101010 BHBEEEE"

,‘A
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Der letzte Ablauftyp, den ich Ihnen hier zeigen mochte, sind Ablédufe, die
ganz ohne eigentliche Prozesspfeile funktionieren. Der Ablauf ergibt sich
aus der Logik der Darstellung oder durch einzelne Elemente wie den einge-
kerbten Richtungspfeil in PowerPoint.

Das folgende Beispiel stammt von meiner Présentationsagentur smavicon
und nutzt pfeilartige Textfelder (Start » Zeichnung » Formen » Blockpfeile »
Eingekerbter Richtungspfeil) sowie eine Nummerierung dazu, um eine
Chronologie zu verdeutlichen. Dariiber hinaus wird hier die gewohnte Lese-
richtung von links nach rechts eingehalten, was dem Verstdndnis ebenfalls
dient.

4M1VAVIC0N /
Vorgehen

Analyse Konzeption . Umsetzung
L Zielsetzung € Inhalt und ¢ prasentations-
Gestaltung \ und Foliendesign
@ -
= Zielgruppe @ . ! \
= Didaktik . @ Textgestaltung,
@ Lektorat

Einsatzgebiete

(z.B. Messe, Vertrieb) g

= Dramaturgie

© Bildgestaltung
(Recherche)

. 4 Audio, Video und
2D-/3D-Animation

e

¢ Rhetorik und
Dialektik

technische und &rtliche
Voraussetzungen

e Wahrnehmungs-
psychologie

©  Wirtschaftlichkeit von

Pradsentationsldsungen -4 Programmierung

In der Folie zur Markteinfiihrung ist der Ablauf durch einen Weg gekenn-
zeichnet. Allein durch das Wort Start und die Leserichtung von links nach
rechts wird deutlich, wie der Prozess verlduft. Im letzten Beispiel geben die
iiberlappenden und sich verkleinernden Rechtecke den Prozessfluss vor.



Konzepte fiir Abldufe

Von der Idee zur Markteinfiihrung

Start Akzeptanz-

check

Modell

Konkretisie-
Idee rung

Landerubergreifende Patentierung

- Lizenz- .
Prufung auf : zulassungs- ~ Lizenz-
rm:;sram ,  Marketing Vertahren vergabe
lichkeif
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Einen Ablauf bildhaft mit Figuren darstellen

In diesem Abschnitt geht es darum, einen Ablauf mit Figuren zu veran-
schaulichen.

Arbeitsablauf

Problemanalyse Losungsentwicklung Qualitatskontrolle Auslieferung

1. Legen Sie eine neue Folie (mit dem Layout Nur Titel) an. Schreiben Sie
»Arbeitsablauf« in das Titeltextfeld.

2. Auf der DVD finden Sie die Datei Figur.pptx. Offnen Sie die Datei, mar-
kieren Sie die Figuren, die Sie fiir Ihre Prasentation brauchen, und ko-
pieren Sie sie auf Ihre erste Folie.

3. Platzieren Sie die Figuren nebeneinander. Damit die Figuren auf einer
Hohe stehen, blenden Sie die Hilfslinien ein ([A1t] + [F9)), und orien-
tieren Sie sich daran. Gleichen Sie die Absténde so aus, dass gut Pfeile
dazwischenpassen.

4. Fiigen Sie iiber Start » Zeichnung » Formen » Blockpfeile » Pfeil nach
rechts einen Blockpfeil ein. Versehen Sie ihn mit einer passenden Far-
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Einen Ablauf bildhaft mit Figuren darstellen

be und einer Kontur (Start » Zeichnung » Fiilleffekt bzw. Formkontur).
Duplizieren Sie den Pfeil zweimal ([Strg] + [D]), und verteilen Sie die
neu entstandenen Pfeile zwischen den Méannchen. Richten Sie die Pfeile
aneinander aus, indem Sie sie markieren und zum Beispiel Start » Zeich-
nung » Anordnen » Objekte positionieren » Ausrichten » Vertikal zentrie-
ren wiahlen.

Zeichnen Sie nun iiber Start » Zeichnung » Formen » Linien » Kurve eine
Kurve zwischen den ersten beiden Figuren. Beginnen Sie sie mit dem
ersten Mausklick iiber der ersten Figur, lassen Sie dann die Maustaste
los, und setzen Sie auf halber Strecke zur zweiten Figur den néchsten
Punkt (hoher als den ersten). Lassen Sie wieder die Maustaste los, und
setzen Sie den letzten Punkt der Kurve mit einem Klick iiber der zweiten
Figur. Sie beenden das Zeichnen, indem Sie die [ Esc]-Taste driicken.

Formatieren Sie die Kurve tiber Start » Zeichnung » Formkontur mit fol-
genden Parametern: Als Farbe wéhlen Sie Orange, fiir Starke den Wert
»3 pt«, bei Striche wihlen Sie Viereckiger Punkt und fiir Pfeile geben Sie
Pfeilart 5 an.

Genauere Bearbeitung

Wenn Sie die Kurve mit der rechten Maustaste anklicken und Punkte
bearbeiten wahlen, konnen Sie die gesetzten Punkte noch einmal
verandern. Damit Sie die Punkte genauer bearbeiten kénnen, nut-
zen Sie die Zoom-Funktion, um sie zu vergrof3ern.

Duplizieren Sie nun die Kurve mehrmals, um auch die anderen Figu-
ren damit zu verbinden. Klicken Sie mit der rechten Maustaste auf eine
Kurve, und wihlen Sie Punkte bearbeiten aus dem Kontextmenii, um sie
anzupassen. Versehen Sie nun die Figuren mit Texten, wie im Beispiel
zu sehen.

Diese Art der Darstellung lasst sich fiir viele Themen nutzen, weil Sie sehr
variabel ist. Das gilt auch fiir den Ablauf im folgenden Abschnitt.
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Einen Ablauf mit Pendellinie erstellen

In diesem Abschnitt zeige ich Thnen, wie Sie schnell und einfach Bilder als
Ablauf in einer flacher werdenden Wellenbewegung positionieren. Das Ab-
flachen lenkt dabei den Fokus auf den Auftrag.

Strukturierte Auftragsgewinnung

Erstanruf

Nachfassen

Auftrag
erhalten

Angebot
senden

Unterlagen
senden

1. Legen Sie eine neue Folie (mit dem Layout Nur Titel) an. Schreiben Sie
»Strukturierte Auftragsgewinnung« in die Uberschrift.

2. Uber Start » Zeichnung » Formen » Blockpfeile » Pfeil nach rechts fiigen
Sie dann einen Blockpfeil ein. Passen Sie ihn in seiner Grof3e und Farbe
an. Um den Farbverlauf einzustellen, den man in der Abbildung sieht,
wéhlen Sie Start » Zeichnung » Fiilleffekt » Farbverlauf » Helle Varianten »
Linear links.
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3. Wenn der Pfeil fertig ist, zeichnen Sie iiber Start » Zeichnung » Formen »
Linien » Kurve eine passende Kurve wie in der Abbildung. Setzen Sie fol-
gende Parameter fiir die Linie: Start » Zeichnung » Formkontur » Starke »
6 Pt. und Start » Zeichnung » Formkontur » Striche » Viereckiger Punkt.

Strukturierte Auftragsgewinnung

4. Dann suchen Sie sich {iber Start » Einfiigen » Bilder » ClipArt ein Handy-
Bild aus (geben Sie dafiir »Handy« oder »Mobiltelefon« als Suchbegriff
ein). Alternativ nutzen Sie die Fotos aus der Datei Strukturierte_Auf-
tragsgewinnung.pptx von der beiliegenden DVD. Ziehen Sie das Bild per
Drag & Drop auf die Folie.

Bessere Ergebnisse

Bessere Suchergebnisse erhalten Sie, wenn Sie im Suchfenster das
Hakchen bei Office.com-Inhalte beriicksichtigen gesetzt haben.

5. Falls das Bild sehr groR ist, verkleinern Sie es entsprechend, oder éndern
Sie die Zoom-Einstellungen mit dem Schieberegler (Slider) ganz unten
rechts auf dem Bildschirm. Beschneiden Sie das Bild dann quadratisch,
indem Sie Bildtools » Format » GréRBe » Zuschneiden » Seitenverhéltnis »
Quadrat » 1:1 wiahlen.
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6. Dann stellen Sie bei Bildtools »

Format » Bildformatvorlagen Strukturierte Auftragsgewinnung
die Option Abgeschragtes Oval,
schwarz ein. Verkleinern Sie
das ovale Bild, und setzen Sie
es an den Beginn der Linie.
Passen Sie bei Bedarf die Farbe
und die Stiarke der Kontur an
(Bildtools » Format » Bildfor-
matvorlagen » Grafikrahmen).

7. Fiigen Sie an den Wendepunkten der Linie weitere Bilder ein (Start »
Einfugen » ClipArt). Passende Suchbegriffe sind zum Beispiel »Brief«
oder »Unterschrift«. Uber Einfiigen » Text » Textfeld erstellen Sie die Tex-
te und platzieren sie je nachdem iiber oder unter den Bildern.
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Kapitel 7

Effekte und Animationen sinnvoll
einsetzen

Der grofdte Vorteil von Multimedia-Préisentationen gegeniiber klassischen
Medien wie Flipchart, Overhead-Projektion oder Tafel besteht darin, dass
Sie eine Vielzahl von Animationen und Effekten wéhrend Threr Prasenta-
tion einsetzen konnen. Leider wurde in den letzten Jahren auf3erordentlich
héufig Gebrauch von dieser Moglichkeit gemacht, sodass sich Animationen
und Effekte inzwischen in vielen Priasentationen verbieten. In diesem Kapi-
tel zeige ich Thnen, was Sie an Animationen einsetzen »diirfen«, womit Thre
Prasentation noch professionell und nicht wie »Spielerei« wirkt.
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Sie werden lernen, welche Animationsarten und -effekte unterschieden
werden und wann der Einsatz von Animationen sinnvoll ist (Animations-
regeln). Dariiber hinaus erfahren Sie, wie Sie dezente Animationseffekte
professionell einsetzen und wie Sie mit interessanten Animationen Infor-
mationen hervorheben kénnen.

Grundlagen der Animationstechnik

In diesem Abschnitt geht es darum, warum es sinnvoll ist, in einer Présenta-
tion Animationen und Effekte einzusetzen. Wenn hier von Animationen die
Rede ist, geht es um die Funktionen Ubergénge und Animationen in Power-
Point. Der Begriff Effekt wiederum ist in PowerPoint den Ubergingen und
Animationen untergeordnet und bezeichnet zum Beispiel einen Einzeleffekt
wie Verblassen. Im Text selbst werden die Begriffe nicht scharf getrennt;
wenn ich also von Effekt spreche, sind damit auch Animationen gemeint.

* Aufmerksam-

——— keit erregen !
e Interesse
zeigen 1 schaffen

1 Vorgéi nge
und Ablaufe
erklaren

Spannung
erzeugen

Wie die Abbildung zeigt, gibt es einige gute Griinde fiir Referenten, Anima-
tionen einzusetzen:

¢ Aufmerksamkeit erregen: In vielen Fillen geht es darum, Bewegung
in die Folie zu bringen und damit die Aufmerksamkeit des Betrachters



Grundlagen der Animationstechnik

zu gewinnen. Die Bandbreite der Effekte ist sehr vielfaltig, was auch be-
deutet, dass man hier sehr viele Fehler machen kann. Dies vermeiden Sie
unter anderem dadurch, dass Sie das Einsatzgebiet und Thre Zielgruppe
genau kennen. So ist es z. B. wenig sinnvoll, in einer Prasentation fiir eine
Bilanzpressekonferenz Texte in die Folie »fliegen« zu lassen — auf einer
Messe hingegen kann so etwas eine gute Wirkung haben.

® Interesse schaffen: Menschen, die z. B. an einem Messestand vorbeige-
hen, reagieren in erster Linie auf pfiffige Animationen oder tolle Effekte.
Es geht darum, Interesse fiir Thr Thema zu wecken.

* Emotionen wecken: Damit eine Information oder Botschaft beim Pub-
likum »hédngenbleibt«, miissen Sie Emotionen wecken. Stellen Sie sich
z.B. vor, Sie lassen auf Ihrer Folie einen Ballon, der das Thema Freiheit
symbolisieren soll, tatsdchlich nach oben schweben. So etwas wirkt we-
sentlich eindringlicher als ein Standbild.

® Spannung erzeugen: Wenn Sie Elemente auf der Folie »verstecken
und im Laufe der Prasentation langsam aufdecken, entsteht Spannung.
Die Zuschauer werden neugierig und wollen wissen, was als Néchstes
kommt. Wichtig ist hierbei, dass die Gesamtdarstellung nicht vollstdndig
erahnt werden kann, um den Uberraschungseffekt nicht zu zerstoren.

® Fokus lenken: Beleuchten Sie im wahrsten Sinne immer die Stelle der
Présentation, an der Sie sich gerade befinden. Wenn Sie z.B. einzelne
Elemente einer Maschinenanlage vorstellen wollen, konnen Sie dafiir
sehr gut einen Hervorhebungseffekt einsetzen, der das jeweils beschrie-
bene Detail deutlich vom Rest der Maschine abhebt.

® Vorgidnge/Ablédufe erkldren: Ein Vorgang oder Ablauf wird normaler-
weise am besten verstanden, wenn Sie ihn langsam entwickeln. Das gilt
vor allem fiir komplexe Schaubilder. Die Aufmerksamkeit des Zuschauers
ist sehr stark auf den Referenten gerichtet, und der Zuschauer muss sich
nicht in den Ablauf »einlesen«, sondern bekommt ihn Schritt fiir Schritt
erklart.

® Verborgene Details zeigen: Mithilfe von Animationen kénnen Sie Ein-
zelteile einer Abbildung, die zunéchst nicht sichtbar sind, nach und nach
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einblenden, d.h., im Gegensatz zum Punkt »Spannung erzeugen« geht
es hierbei nicht um das bewusste »Verstecken« von Elementen, sondern
darum, Informationen gezielt »aufzudecken«. Diese Animation bietet
sich an, wenn Sie etwas vom Allgemeinen ausgehend hin zum Speziel-
len erkléren. Zeigen Sie beispielsweise einen Motorblock von aul3en, und
blenden Sie alle Teile bis auf den Zylinder aus (bzw. stellen Sie sie »ausge-
graut« dar), oder stellen Sie einen Projektplan in der Ubersicht dar, und
vertiefen Sie sich dann in die Details der einzelnen Schritte.

Sie sehen, der Einsatz von Animationen und Effekten ist im entsprechenden
Zusammenhang durchaus sinnvoll. In einer Situation, die emotional sein
darf und Interesse wecken soll, konnen Animationen sehr effektvoll sein
und Sie konnen sie ausufernd einsetzen; in sachlichen, eher rational ge-
pragten Prédsentationen sollten Animationen hingegen zuriickhaltend und
nur zur Lenkung des Zuschauerfokus verwendet werden.

Regeln fiir den Einsatz von Animationen

Im Folgenden stelle ich Thnen vier Regeln vor, die Ihnen helfen sollen, die
Qualitat Threr Animationen und die Sinnhaftigkeit ihres Einsatzes zu iiber-
priifen:

1. Einsatz und Menge von Animationen richten sich immer nach dem In-
halt der jeweiligen Prasentation (»Animation follows Content«). Dazu
zwei Beispiele: Sie fiigen auf einer Folie eine Rakete als Sinnbild dafiir
ein, dass Thr neues Konzept wie eine Rakete ziinden wird. Da Sie Dyna-
mik demonstrieren und Thre Zuschauer vermutlich von Threr Idee {iber-
zeugen wollen, diirfen Sie die Rakete ruhig animieren, sie also z.B. aus
der Folie «fliegen« lassen. In einem anderen Zusammenhang wére eine
solche Animation eher unangebracht. Wenn Sie beispielsweise einen
Vortrag zum Umgang mit Qualitétsrichtlinien halten, sollten Sie den
Text nicht zum Fliegen animieren, denn es bietet sich weder thematisch
an noch wollen Sie der Prasentation etwas Emotionales oder Lustiges
verleihen.
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Regeln fiir den Einsatz von Animationen

Regeln fiir Animationen

Q teilen die Informations-
menge ein (20-5ek.-Regel)

Q ... unterstiitzen Abldaufe
Q .. geben die Leserichtung vor

@ .. richten sich nach dem Inhalt
(»Animation follows Content«)

Animationen...

In der westlichen Welt verldauft die Leserichtung von links oben nach
rechts unten. Da wir darauf konditioniert sind, sollten Sie auch bei Fo-
lien diese Leserichtung weitestgehend einhalten. Wenn Sie Prasenta-
tionen vor internationalem Publikum halten, vor allem in Asien oder
der arabischen Welt, oder wenn grafische Elemente wie eine Pyrami-
dendarstellung, Radialdiagramme oder Ahnliches im Einsatz sind, ist es
sinnvoll, mithilfe von Animationen die Leserichtung fiir den Zuschauer
vorzugeben.

Auch im Zusammenhang mit Abldufen ist der Einsatz von Animationen
héufig angebracht. Steht der Ablauf in einem sachlichen Zusammen-
hang, sollten Sie nur Animationseffekte wie z. B. Verblassen, Erscheinen
oder Wischen verwenden. Gibt es einen emotionalen Kontext, konnen
auch dynamischere, abwechslungsreiche und iiberraschende Effekte
eingesetzt werden.

Eine wichtige Regel fiir Folien im Allgemeinen besagt, dass der Zu-
schauer die aktuelle Information innerhalb von 20 Sekunden gelesen
bzw. verstanden haben sollte (vgl. den Abschnitt »Sinnvolle Textgestal-
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tung« ab Seite 69). Je kiirzer dieser Zeitraum jedoch ist, desto besser.
Der Einsatz von Animationen kann dabei helfen, die Menge an Infor-
mationen zu begrenzen, indem Sie z.B. Aufzdhlungspunkte nicht auf
einmal zeigen, sondern nacheinander einblenden.

Sie haben die wichtigsten Regeln fiir Animationen kennengelernt und kon-
nen damit Ihre Prasentationen mit sinnvollen Animationen ausstatten.

Animationsarten

Angelehnt an die klassischen Animationsarten, wie sie in »echten« Anima-
tionsprogrammen seit Jahrzehnten vorhanden sind, finden wir in Power-
Point drei verschiedene Kategorien von Animationen:

® 2D-Animationen: Diese unterteile ich hier noch einmal in einfache Ani-
mationen (Standardanimationen) und kombinierte Animationen (mehre-
re Animationen, die parallel ablaufen).

® Pfadanimationen: Ein oder mehrere Folienelemente werden entlang ei-
ner Strecke animiert, z. B. um die Fahrt eines Autos entlang einer Strale
oder den Sinkflug eines Blattes darzustellen.

* Blenden: Diese »flieRenden«, geschmeidigen Ubergénge sind hinling-
lich aus Videofilmen und Videoschnittprogrammen bekannt. In Power-
Point handelt es sich dabei um die sogenannten Folieniibergénge (Menii
Uberginge).

Natiirlich kénnen alle Animationsarten und -effekte auch miteinander kom-
biniert werden, woraus sich eine Menge interessanter Gestaltungsmoglich-
keiten ergibt.

Eine weitere wichtige Animationsart, nimlich die 3D-Animationen, ist lei-
der derzeit nicht in PowerPoint enthalten. 3D bedeutet in diesem Zusam-
menhang z.B., dass ein Element umflogen wird (Kameraflug) oder ein Logo
um eine Kugel fliegt. Wie Sie solche 3D-Animationen dennoch behelfsma-
Rig herstellen konnen, zeige ich Thnen im Abschnitt »Die Welt umkreisen«
ab Seite 321.
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Animationen in PowerPoint

Unter dem Meniipunkt Animationen versammelt PowerPoint eine Reihe
von Effekten, die sogenannten Animationseffekte. Die zuvor genannten ein-
fachen und kombinierten Animationen werden in PowerPoint daher noch
einmal in drei grundlegende Animationseffekte untergliedert.

® Eingangseffekte (Eingang)
® Hervorhebungseffekte (Betont)

® Ausgangseffekte (Ausgang)

Alle drei Kategorien werden dabei den Eigenschaften Einfach, Dezent, Klas-
sisch und Spektakuldr zugeordnet, wie in der folgenden Abbildung zu sehen.
Die Blenden bzw. Folieniibergdnge sind in PowerPoint unter dem Menii-
punkt Ubergénge zu finden. Mit ihnen konnen Sie in Verbindung mit Ani-
mationseffekten interessante Ergebnisse erzielen.

Drehen Rigsenrad Farderl

Folieniibergdnge I

le:um Transparent  Objektfart

Kombinierte
Animationen

Einfache
Animationen

Eingangs- Hervorhebungs- Ausgangs- 3
Dynamischer

Pfadanimationen

1
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Um Eingangs-, Hervorhebungs- und Ausgangseffekte zu unterscheiden,
stellen Sie sich eine Biihne vor. Der Moment, in dem der Schauspieler die
Biihne betritt, ist der Eingangseffekt, d. h., es geht um die initiale Wirkung:
Rennt oder schwebt er z. B. hinein, springt oder kriecht er?

Wenn er (zusammen mit mehreren anderen Schauspielern) auf der Biihne
ist, geht es um den Hervorhebungseffekt. Tritt er hervor, um sich bemerkbar
zu machen, wird er lauter, benutzt er irgendwelche Hilfsmittel oder verén-
dert er sein Kostliim, um aufzufallen? Am Ende des Stiickes kommt der Ab-
gang (der Ausgangseffekt) — auch der kann mit grofem Getdse stattfinden
oder z.B. besonders dramatisch oder lustig sein.

Pfadanimationen und Folieniibergénge konnen unabhingig von diesen Ef-
fekten genutzt werden, man kann sie aber auch sehr gut mit ihnen kombi-
nieren.

Im Folgenden stelle ich Thnen die zentralen Effekte und ihre Optionen ge-
nauer vor.

1. Legen Sie eine neue Folie mit dem Layout Leer an, und fiigen Sie ein
Rechteck ein (Start » Zeichnung » Formen » Rechteck).

2. Markieren Sie das Rechteck, und fiigen Sie iiber Animationen » Anima-
tion » Wischen den ersten Animationseffekt ein. Schauen Sie sich den
Effekt iiber die Funktion Vorschau (Animation » Vorschau » Vorschau) an.
Zusatzlich konnen Sie den Animationsbereich einblenden (Animationen »
Erweiterte Animation » Animationsbereich).

Animationsbereich

In PowerPoint 2007 und 2003 lasst sich der Animationsbereich nicht
abschalten, d. h.,, er ist standardmaRig vorhanden und enthalt die
gesamten Animationsfunktionen. Der groRte Teil der Animations-
steuerung ist in 2010 nach oben in das Menliband gewandert.

Zum Anpassen von Animationseffekten gibt es eine Reihe von Méglichkei-
ten im Meniiband auf der Registerkarte Animationen. Sie kdnnen z.B. an-
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geben, wann die Animation beginnen soll (Animationen » Anzeigedauer »
Verzogerung) oder wie lange sie dauert bzw. wie schnell sie ablauft (Anima-
tionen » Anzeigedauer » Dauer).

el Ubeginge | Anmatenen | Bidschmprsentation

Sie konnen eine Animation aber auch auf Knopfdruck — oder vielmehr »auf
Mausklick« — starten (iiber Animationen » Anzeigedauer » Start » Beim KIi-
cken), sie zusammen mit weiteren Effekten beginnen lassen (Mit Vorheri-
gen) oder die Effekte der Reihe nach hintereinander einsetzen (Nach Vorhe-
rigen). Dazu ein Beispiel: Sie wollen, dass das Rechteck eingeblendet wird
und sich anschliefend dreht. Dazu markieren Sie das Rechteck und wéhlen
als Eingangseffekt Animationen » Animation » Eingangseffekte » Verblassen.
Uber die Option Animationen » Anzeigedauer » Start » Nach Vorherigen star-
tet die Animation, wenn Sie die Folie im Prasentationsmodus anschauen.

Als zweiten Animationseffekt wollen wir das Rechteck drehen lassen. Klicken
Sie es an, und wihlen Sie Animationen » Erweiterte Animation » Animation
hinzufiigen » Eingang » Drehen. Setzen Sie Animationen » Anzeigedauer »
Start auf Nach Vorherigen, und schauen Sie sich die Vorschau an (Funktion
Vorschau oder alternativ Wiedergabe im Animationsbereich).

Wenn Sie Animationen » Erweiterte Animation » Animationsbereich einge-
blendet haben, sehen Sie auch die Reihenfolge der Animationen und kon-
nen sie dndern und weitere Effektoptionen einstellen (klicken Sie dazu mit
der rechten Maustaste auf einen Effekt im Animationsbereich).
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Mehrere Animationseffekte fiir ein Element

Es ist wichtig, ob Sie gerade einen Effekt andern (also ersetzen) oder
ihn Gber den Befehl Animationseffekte hinzufiigen mit einem wei-
teren Effekt kombinieren. Wenn Sie von vorneherein darauf achten,
in welchem »Modus« Sie sich befinden, ersparen Sie sich doppelte
Arbeiten.

Ein anderes Beispiel ist Folgendes: Sie wollen, dass ein Auto von links nach
rechts in die Folie fahrt, und gleichzeitig sollen sich seine Reifen drehen.
Fiir das Einfahren des Autos nutzen Sie eine Pfadanimation (Animationen »
Animation » Pfadanimationen » Linien) und lassen mithilfe der Angabe Ani-
mationen » Anzeigedauer » Start » Mit Vorherigen gleichzeitig die Reifen
uber den Effekt Animationen » Animation » Betont » Rotieren rotieren. (Das
war jetzt der Schnelldurchgang. Falls Sie Animationseinsteiger sind und das
zu wenig Information sein sollte, arbeiten Sie zum Beispiel den Abschnitt
»Eine Kugel als Zugpferd einsetzen« ab Seite 316 durch. Danach bekommen
Sie das mit dem Auto locker hin.)

Uber die Befehlsgruppe Animation » Effektoptionen kénnen Sie dariiber hin-
aus z.B. die Richtung eines Animationseffekts einstellen. Nutzen Sie fiir Thr
Rechteck einfach mal den Effekt Eingang » Wischen, und schauen Sie sich
die Effektoptionen an.

Uber Animationseffekte hinzufiigen kénnen Sie ein Element mit weiteren Ef-
fekten versehen. Falls Sie einfach den Effekt &ndern, ohne diese Funktion zu
verwenden, wird der aktuelle Effekt ausgetauscht.

Mit Animation ilibertragen haben Sie ab PowerPoint 2010 die Moglichkeit,
einen oder mehrere Effekte, die einem Folienelement zugeordnet wurden,
mit allen Optionen auf andere Folienelemente zu {ibertragen. Diese Funk-
tion ist sehr niitzlich, denn vor allem bei komplexen kombinierten Anima-
tionen miissen Sie dann nicht jedes Mal alle Einstellungen neu vornehmen.

Weitere sehr wichtige Optionen fiir Pfadanimationen finden Sie, wenn Sie
im Animationsbereich doppelt auf einen Effekt klicken (oder mit der rech-
ten Maustaste und dem Kontextmentipunkt Effektoptionen). Laden Sie dazu
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am besten die Beispieldatei Auto_Pfadanimation-Gleiten.pptx von der bei-
liegenden DVD, und schauen Sie sich dort die Einstellungen an. Blenden
Sie vorher den Animationsbereich ein. Sie konnen hier zum Beispiel einstel-
len, ob die Pfade mit verschoben werden, wenn Sie ein Objekt verschieben
(Gesperrt), oder nicht (Nicht gesperrt). Mit Gleiten Start oder Gleiten Ende
konnen Sie z.B. die Geschwindigkeit einstellen, mit der ein Objekt am Pfad
»entlanglaufte«.

Rechts B
ekt | Anzeigedauer | Textanimation|
Einstellungen
Pfad: Richt gesperrt b : ‘jE].
Gleiten Start: B, 0 sek. =
Gleiten Ende: ' J 156k, -
Springen Ende: 0 0 sek, =]

[ Automatisch umkehren

Erweiterungen
Sound: [Ohne Sound] @
Mach Animation: Micht abblenden E

lex anemierer

Ein Beispiel fiir diese Einstel-

lung sehen Sie in der folgen- Iy -
den Abbildung. Das Auto star- © '
tet langsam und beschleunigt Geschwindigkeit Iiaitanstart Gleiten Ende

kontinuierlich auf eine Hochst-

geschwindigkeit, die dann ge-

halten wird. Uber Gleiten Start Zedt
wird eingestellt, wie viele Se-

kunden der Anlauf dauern soll.

Gleiten Ende bedeutet analog dazu eine kontinuierliche Abnahme der Ge-
schwindigkeit bzw. eine Entschleunigung.

v
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Eine dezente Textanimation anlegen

Nun beginnen wir mit dem praktischen Teil dieses Kapitels. Zundchst moch-

te ich Thnen zeigen, wie Sie eine dezente Textanimation anlegen, deren Vor-

teil darin besteht, dass sie vom Zuschauer nur unbewusst wahrgenommen

wird. Zu den dezenten Animationen gehoren zum Beispiel die Animations-

effekte Erscheinen, Verblassen und Wischen.

1.

Offnen Sie eine Prisentation, die eine Textfolie enthilt (z.B. die Bei-
spieldatei Dezente-Textanimationen.pptx von der beiliegenden DVD).
Die Folie sollte auch Absétze haben, die in der Listenebene (frither »Glie-
derungsebene«) erhoht sind. Sie finden die Listenebenen iiber Start »
Absatz » Listenebene erh6hen bzw. Start » Absatz » Listenebene verrin-
gern. (Im Beispiel dieses Abschnitts stehen die Textzeilen »Erscheinenc,
»Verblassen« und »Wischen« in der zweiten Listenebene bzw. auf der
zweiten Gliederungsebene.)

Um den Text zu animieren, klicken Sie das Textfeld an, und wéhlen Sie
Animationen » Animation » Eingang » Wischen. Falls Sie den Effekt nicht
finden, klicken Sie im gleichen Menii auf Weitere Eingangseffekte, und
suchen Sie sie im Dialogfenster. Unter Animationen » Animation » Ef-
fektoptionen wéhlen Sie dann Richtung » Von links. Bei Animationen »
Anzeigedauer » Dauer stellen Sie den Wert »00,25« (fiir 1/4 Sekunde)
ein. Testen Sie die Animation iiber Animationen » Vorschau » Vorschau.
Sie werden feststellen, dass ein Aufzdhlungspunkt der ersten Gliede-
rungsebene nach dem anderen

angezeigt wird. = &z;
art: Beim Klicken = Animation neu anordnen

Schalten Sie liber Animationen » > EEEE

Erweiterte Animation » Anima- | e

tionsbereich den Animationsbe- [ — -

reich ein. Dort konnen Sie mit ei-

nem Doppelklick auf die jeweilige l; L o ]

Animation noch weitere Anpas-

sungen vornehmen.




Eine dezente Textanimation anlegen

4. Doppelklicken Sie also auf den  (Tyiihen ERr=
Animationseintrag. Sie befinden

|EFFekl: IAnzeigedauer Texkanimation |

sich nun im Dialogfenster Wi-

. Text gruppieren: |Bei 2, Abschnittsebene ]
schen. Wechseln Sie dort auf den = ArRR [=]

Automatisch Als einzelnes Objekk i
[ autgmatisch alle absatze auf einmal 4

angefigte FolBei 1, Abschnittsebene

Reiter Textanimation, und dndern

Sie bei Text gruppieren den Ein- Bei'2, Abschnittsebens
. grupp . B i mgekeiy Bei 3. Abschnittsebene
trag auf »Bei 2. Abschnittsebenex. Bei 4. Abschnittsebene

Bei 5. Abschnitksebene

Testen Sie erneut die Animation
tiber die Schaltfliche Vorschau
auf dem Meniiband. Jetzt sollte [
auch die zweite Gliederungsebe-
ne einzeln eingeblendet werden.

0k ] [ abbrechen

Anstelle des Animationseffekts Wischen konnen Sie auch Verblassen oder
Erscheinen verwenden.

Dezente Textanimationen

* dezente Textanimationen sind A
vom Zuschauer nur unbewusst v
werden

* dazu gehoéren zum Beispiel
— Erscheinen
— Verblassen
— Wischen

* Uber Animationsbereich » Effek
sich tiefere Gliederungsebenen
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Ein Element durch Framing hervorheben

Mit dem Begriff Framing bezeichnet man eine Methode der Hervorhebung,
bei der ein Rahmen (etwa eine Rechteck oder ein Kreis) jeweils einen oder
mehrere Bereiche auf der Folie hervorhebt.

Framing kann sehr gut in Kombination mit einer Animation eingesetzt wer-
den. Im Folgenden zeige ich Thnen zwei Varianten: einmal einen Rahmen,
der sich iiber die Animation aufbaut, und danach einen pfeilexpandieren-
den Rahmen, mit dem es so aussieht, als ob ein Pfeilsymbol den Rahmen
grof3 zieht.

1. Fiir einen aufbauenden Rahmen legen Sie zunéchst eine leere Folie an.
Fiigen Sie tiber Einfligen » Bilder » Grafik oder Einfiigen » Bilder » Clip-
Art eine Landkarte ein. (Alternativ konnen Sie auch die PowerPoint-
Préasentation Hervorhebung_Framing.pptx mit der Landkarte von der
beiliegenden DVD laden.) Zeichnen Sie {iber Einfiigen » Illustrationen »
Formen » Rechtecke » Rechteck einen Rahmen auf einem Bereich der Kar-
te, den Sie hervorheben wollen. Entfernen Sie {iber Start » Zeichnung »
Fiilleffekt » Keine Fiillung die Farbe. Stattdessen geben Sie der Kontur des
Rechtecks tiber Start » Zeichnung » Formkontur eine Farbe, die in Kont-
rast zum Hintergrund steht. Die Karte ist fliederfarben, also nehmen Sie
z.B. Orange fiir den Rahmen.




Ein Element durch Framing hervorheben

2. Klicken Sie dieses Rechteck dann an, und wihlen Sie Animationen » Ani-
mation » Eingang » Rad aus. Wenn Sie den Effekt nicht finden, klicken
Sie im gleichen Menii auf Weitere Eingangseffekte, und suchen Sie den
Effekt dort.

3. Unter Animationen » Animation » Effektoptionen wihlen Sie 1 Speiche.
Dann passen Sie {iber Animationen » Anzeigedauer die Werte fiir Start,
Dauer usw. an Thre Bediirfnisse an.

Um statt des aufbauenden Rahmens einen pfeilexpandierenden Rahmen an-
zulegen, gehen Sie folgendermalf3en vor:

1. Nehmen Sie das vorherige Beispiel als Grundlage, und 16schen Sie zu-
nichst die Animation am Rechteck. Dazu blenden Sie den Animations-
bereich ein (iiber Animationen » Erweiterte Animation), markieren den
jeweiligen Effekt im Animationsbereich und driicken die “Taste.

2. Als neuen Effekt fiir den rechteckigen Rahmen wihlen Sie Animationen »
Animation » Weitere Eingangseffekte » Klassisch » Zoom einfach. Unter
Effektoptionen stellen Sie In ein. Geben Sie fiir Animationen » Anzeige-
dauer » Start die Option Nach Vorherigen an, und stellen Sie bei Anima-
tionen » Anzeigedauer » Dauer den Wert »02,00« ein.
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3.

Fiir den Pfeil am Rahmen wéhlen Sie dann Einfiigen » Illustrationen »
Formen » Standardformen » Halber Rahmen. Bevor Sie mit dem Forma-
tieren und Positionieren beginnen, klicken Sie mit der rechten Maus-
taste auf den Folienhintergrund, und deaktivieren Sie {iber den Befehl
Raster und Fiihrungslinien die Option Objekte am Raster ausrichten.

Als Néachstes suchen Sie sich tiber Start » Zeichnung » Fiilleffekt eine Far-
be als Kontrast zum Hintergrund aus (aber eine andere als die Rahmen-
farbe, also z.B. Dunkelblau). Drehen und verschieben Sie den »halbier-
ten« Rahmen, sodass seine Spitze nach oben rechts weist. Zoomen Sie
das Objekt heran, und passen Sie iiber die Marker die Dicke der Kanten
des halben Rahmens an die Dicke des gesamten Rahmens an.

Nun kommt das eigentlich Spannende: Wir animieren den Pfeil. Wahlen
Sie dazu Animationen » Animation » Weitere Animationspfade » Linien
und Kurven » Diagonal nach oben rechts. Unter Anzeigedauer » Start stel-
len Sie Mit Vorherigen und bei Anzeigedauer » Dauer den Wert »02,00«
ein. Achten Sie darauf, dass diese Animation nach der Rahmenanimati-
on kommt (Anzeigedauer » Animation neu anordnen » Spater).

Doppelklicken Sie im Animationsbereich auf die Pfeilanimation. Unter
Pfad wéhlen Sie die Option Gesperrt, und fiir Gleiten Start und Gleiten
Ende geben Sie jeweils den Wert »0 sek.« ein.



7.

9.

Nachdem Sie den Dialog geschlossen haben, klicken Sie den Pfad in der
Mitte an und verschieben ihn mit den Pfeiltasten. Das Ende des Pfades
(erkennbar am kleinen roten Dreieck) muss so platziert werden, dass
der animierte Pfeil »am Ende seines Weges« auf der Rahmenkante zu
liegen kommt. Um das zu testen, nutzen Sie den Befehl Wiedergabe im
Animationsbereich. Es kann sein, dass hier ein paar Versuche notig sind,
bis es klappt. Lassen Sie sich auch nicht von der Animation des Recht-
ecks irritieren — beachten Sie sie hierbei einfach nicht.

Sobald der Pfeil richtig mit der Kante abschliel3t, befassen Sie sich mit
dem Anfang des Pfades. Klicken Sie dazu auf das kleine griine Dreieck,
und verschieben Sie es mit der Maus so lange, bis die Animation des
Pfeils synchron mit dem Zoom des Rechtecks verlauft.

»

Animationshereich - X

1} f Rechteck 3 )
| " Halber Rahmen 7 [_| E“

“mn 4

Da der Pfad gesperrt ist, wird er beim Verschieben des Rahmens nicht
mit verschoben. Verschieben Sie nun den dunkelblauen Pfeil an den An-
fang des Pfades, so als wiirde er von dort starten. Die Verschiebung ist
notwendig, weil man ansonsten den Rahmen fiir einen Bruchteil einer
Sekunde an der Endposition im Prasentationsmodus sehen wiirde. Falls
Sie das nicht stort, konnen Sie den Rahmen auch dort belassen, wo er ist.

Ein Element durch Framing hervorheben
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10. Zum Schluss kénnen Sie den Pfeil noch mit einem weiteren interes-
santen Effekt versehen. Wahlen Sie dazu Animationen » Erweiterte
Animation » Animation hinzufiigen » Weitere Hervorhebungseffekte »
Spektakuldr » Blinken. Damit der Effekt als Erstes in der gesamten Ani-
mationsreihenfolge erscheint, verschieben Sie den Effekt iiber Anima-

tion neu anordnen » Friither an die ers-

te Stelle der Chronologie. Stellen Sie
dann bei Animationen » Anzeigedauer »

Start die Option Nach Vorherigen ein,

und geben Sie im Feld Anzeigedauer »

Dauer den Wert »00,50« an. Die Einstel-

lung Nach Vorherigen ist notwendig, da-

mit der Effekt beim Aufrufen der Folie
automatisch startet. Falls Sie den Effekt
lieber mit einem Klick starten mochten,
stellen Sie Anzeigedauer » Start » Beim
Klicken ein.

11. Dann doppelklicken Sie im Animationsbereich auf den Effekt. In den
Optionen fiir den Effekt Blinken wahlen Sie schlieSlich den Reiter
Anzeigedauer und geben dort im Feld Wiederholen den Wert »3« ein.

Im néchsten Abschnitt stelle ich Thnen eine andere Variante der Hervor-
hebung anhand einer Landkarte vor.

Bereiche zur Hervorhebung einfarben

In diesem Abschnitt geht es darum, einen bestimmten Bereich auf der Folie
anders einzufirben, um ihn hervorzuheben.

1. Legen Sie eine leere Folie mit dem Layout Leer an. Fiigen Sie iiber Ein-
fugen » Bilder » Grafik oder Einfiigen » Bilder » ClipArt eine Landkarte
ein. (Alternativ konnen Sie auch die PowerPoint-Prasentation Hervorhe-
bung_Framing.pptx mit der Landkarte von der beiliegenden DVD laden).



2.

Duplizieren Sie die Landkarte mit + [b]. Markieren Sie beide
Karten, und richten Sie sie deckungsgleich aus (Start » Zeichnung » An-
ordnen > Objekte positionieren » Ausrichten » Linksbiindig und Oben aus-
richten).

Markieren Sie dann nur die oben liegende Karte, und schneiden Sie den
Ausschnitt aus, den Sie hervorheben wollen (Bildtools » Format » Gro-
Be » Zuschneiden). Stellen Sie ihn frei (Bildtools » Format » Anpassen »
Freistellen). Erstellen Sie zur Sicherheit eine Kopie des freigestellten Motivs
(eventuell auch von der gesamten Folie). Farben Sie den Ausschnitt {iber
Bildtools » Format » Anpassen » Farbe » Neu einfarben bzw. Weitere Varianten
in einer Kontrastfarbe. Wenn Thnen das freigestellte Ergebnis nicht gefallt,
konnen Sie auch die Methode »Freistellen mit Pfad« verwenden (siehe dazu
Kapitel 3, »Bilder pfiffig prasentierenc).

Zum Schluss animieren Sie den Ausschnitt. Klicken Sie ihn an, und wéh-
len Sie Animationen » Animation » Eingang » Wischen. Fiir Animationen »
Animation » Effektoptionen verwenden Sie Von unten.

Animierte Farbung

Diese Farbanimation lasst sich z.B. auch sehr gut fiir Tabellen oder
Diagramme verwenden.

Bereiche zur Hervorhebung einfarben
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Einen Bereich mit einer Lupe hervorheben

Dieser Abschnitt behandelt das Zooming. Dabei wird ein Bereich eines Bil-
des, einer Tabelle, eines Diagramms oder einer anderen Darstellung vergro-
Rert, um ihn hervorzuheben. In diesem Abschnitt simulieren wir die Ver-
grollerung durch eine Lupe.

1.

Legen Sie eine leere Folie an. Fiigen Sie iiber Einfligen » Bilder » Grafik
oder Einfligen » Bilder » ClipArt eine Landkarte ein. (Alternativ kdnnen
Sie auch die PowerPoint-Présentation Hervorhebung_Framing.pptx mit
der Landkarte von der beiliegenden DVD laden.) Duplizieren Sie die

Landkarte mit + (D].

Markieren Sie beide Karten, und richten Sie sie deckungsgleich aus
(Start » Zeichnung » Anordnen » Objekte positionieren » Ausrichten »
Linksbiindig und Oben ausrichten). Markieren Sie dann nur die oben lie-
gende Karte, und wéhlen Sie Bildtools » Format » Bildformatvorlagen »
Abgeschrigtes Oval, schwarz. Uber Bildtools » Format » GroRe » Zuschnei-
den verkleinern Sie das Bild auf den Ausschnitt, den Sie spéter hervor-
heben wollen.

. Mit Bildtools » Format » Bildformatvorlagen » Bildeffekte » Schatten »

Weitere Schatten konnen Sie den Ausschnitt weiter gestalten. Hier habe
ich z.B. Voreinstellungen » AuBen » Offset unten diagonal rechts gewé&hlt
und bei Abstand den Wert »22« eingestellt. Uberpriifen Sie den Schatten
im Zusammenhang mit der Animation.

Um den Ausschnitt schlieflich zu animieren, klicken Sie ihn an und
wéhlen Animationen » Animation » Eingang » Erscheinen, damit der Aus-
schnitt nicht sofort beim Aufruf der Folie zu sehen ist. Uber Animationen
» Erweiterte Animation » Animation hinzufiigen » Weitere Hervorhebungs-
effekte » Betont » VergroRern/Verkleinern stellen Sie den Zoom fiir den
Ausschnitt ein. Wéhlen Sie dann Animationen » Anzeigedauer » Start »
Nach Vorherigen, und geben Sie im Feld Anzeigedauer » Dauer den Wert
»02,00« ein. Im Animationsbereich konnen Sie mit Doppelklick auf den
Eintrag noch weitere Einstellungen vornehmen (Effektoptionen), z.B.



Einen Agendapunkt hervorheben

wie grofd gezoomt wird (Effekt » Einstellung » Schriftgrad) oder ob der
Zoom langsam starten soll (Gleiten Start).

Einen Agendapunkt hervorheben

Dieser Abschnitt zeigt Thnen, wie Sie eine Agenda animieren, die aus fiinf
Themen besteht und bei der immer ein Thema hervorgehoben werden soll.

1. Laden Sie fiir diese Ubung die Datei Agendapunkt.pptx von der beilie-
genden DVD.

2. Markieren Sie die SmartArt-Grafik, und wahlen Sie Animationen » Ani-
mation » Betont » Transparent aus. Bei Animationen » Animation » Ef-
fektoptionen » Sequenz nutzen Sie die Option Nacheinander und stellen
dann Animationen » Anzeigedauer » Start mit Vorherigen ein.

3. Schalten Sie den Animationsbereich iiber Animationen » Erweiterte Ani-
mation » Animationsbereich ein. Doppelklicken Sie auf den Eintrag, um
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den Dialog mit den Effektoptionen zu 6ffnen. Wechseln Sie dort auf den
Reiter Anzeigedauer, und wahlen Sie im Feld Dauer die Option Bis zum
nachsten Klick aus.

4. Klappen Sie dannim Animationsbereich die  bpimstionsereich v X
Animation tiber einen Klick auf den kleinen
Doppelpfeil links unter dem Eintrag auf,

. . | Dﬁ Inhaltsplatzhal,.. | E“
sodass alle Elemente einzeln zu sehen sind. Sy Ihalsplatzhel >
Damit nur der erste Eintrag schon zu sehen %4 Inhaltsplatzhal, . [ >
ist, wenn die Folie aufgerufen wird, 16schen T Inhalesplatzhl... [

. . R . . g Inhalesplatzhal, . [ >

Sie die '('ersten drei Eintrage mit der - A Ihotsplteha,. [

Taste. Uber den kleinen Doppelpfeil klap- 14 Inhaltsplatzhal.. [

pen Sie die Liste wieder zu. Ty Inhalbsplatzhal.. [ >

ih Inhaltsplatzhal... [ »

5. Klicken Sie die SmartArt-Grafik an. Uber iy Inhalesplatenal . [

. . . . . . ih Inhalsplatzhal... [ >

Animationen » Erweiterte Animation » Ani- fiy haksplatzhal,. [
mation hinzufiigen » Betont » Transparent A

fligen Sie eine weitere Animation hinzu.
Setzen Sie das Feld Animationen » Anzeigedauer » Start wieder auf Mit
Vorherigen, klappen Sie im Animationsbereich die Einzelanimationen
iiber den kleinen Doppelpfeil aus, und 16schen Sie den vierten, fiinften
und sechsten Eintrag. Klicken Sie dann den ersten Eintrag in dieser Ab-
teilung mit der rechten Maustaste an, und wihlen Sie Bei Klicken begin-
nen aus dem Kontextmenii. Klappen Sie die Liste wieder zu.

6. Erstellen Sie eine dritte, vierte und fiinfte Animation, indem Sie analog
zur zweiten verfahren. Allerdings 16schen Sie bei der dritten Animation
die Eintrage sieben, acht und neun, bei der vierten Animation die Ein-
trage zehn, elf und zwolf und bei der fiinften Animation die letzten drei
Eintréage.

Diese Animation konnen Sie natiirlich auch fiir beliebige andere Themen
verwenden. Zum Beispiel konnen Sie flinf Bestandteile einer Strategie vor-
stellen oder fiinf Highlights eines Produkts.
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Zitatstellen mit einem Textmarker-Effekt hervorheben

sl

-

o253
5

Einleitung |Global Menschen | Finanzen | Ausblick

Zitatstellen mit einem Textmarker-Effekt
hervorheben

In diesem Abschnitt zeige ich Thnen, wie Sie einen Textmarker animieren,
der Textstellen auf der Folie mit einem Leuchtbalken markiert.

1.

Legen Sie eine Folie mit dem Layout Titel und Inhalt an. Fiigen Sie einen
(Blind-)Text ein, oder laden Sie gleich die Prasentation Hervorhebung_
Zitat.pptx von der beiliegenden DVD.

. Fiigen Sie dann iiber Einfiigen » Illustrationen » Formen » Sterne und Ban-

ner » Doppelte Welle eine ebensolche Form ein, und legen Sie sie iiber
den Teil des Textes, der markiert werden soll. Wahlen Sie bei Start »
Zeichnung » Fiilleffekt bzw. Formkontur die passende Farbe fiir den Mar-
ker, hier also jeweils Gelb.

. Duplizieren Sie die erste Welle ([Strg] + [D]) gegebenenfalls, und plat-

zieren Sie sie an weiteren zu markierenden Stellen. Passen Sie die Grof3e
der Welle der jeweiligen Textstelle an. Markieren Sie abschlieend alle
Wellen, und legen Sie sie in den Hintergrund (entweder {iber Start »
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5.

Zeichnung » Anordnen » Objekte sortieren » In den Hintergrund oder in-
dem Sie sie mit der rechten Maustaste anklicken und In den Hintergrund
aus dem Kontextmenii wihlen).

Nun bauen Sie sich einen Textmarker, wie in der folgenden Abbildung
zu sehen. Wenn Sie keine Zeit haben, finden Sie den fertigen Textmar-
ker auch in der bereits genannten Datei Hervorhebung_Zitat.pptx. Ein
Tipp: Das Flussdiagramm, das die Spitze des Markers darstellt, kénnen
Sie verandern, indem Sie mit der rechten Maustaste darauf klicken und
Punkte bearbeiten aus dem Menii wahlen. Gruppieren Sie nach der Be-

arbeitung die Teile des Textmarkers ([Strg] + (o] + (G]).

Filleffekt: Gelb, /
Trapezoid Formeffekte:
Abschragung ¥
Kreis
Trapezoid,

und gestaucht Weiche Abrundung

Flussdiagramm:

8 . Fulleffekt: Schwarz,
vertikal gekippt Formeffekte:
(Anordnung» Drehen) Abschragung b

Fllleffekt: Gelb,

manuell angelegt Formeffekte:
und Puhkte nach- Leuchten » Weitere
bearbeitet Leuchtfarben » Gelb

Platzieren Sie dann den Textmarker am Anfang der ersten Welle, und
drehen Sie ihn, sodass er in ca. 45 Grad zum Text steht (ganz genau
gelingt dies iiber Zeichentools » Format » Anordnen » Drehen » Weitere
Drehungsoptionen).



Zitatstellen mit einem Textmarker-Effekt hervorheben

6. Zunichst animieren wir nur die Wellen und schieben anschlieRend die
Textmarker-Animationen dazwischen. Markieren Sie also alle (1) Wel-
len, und wéhlen Sie Animationen » Animation » Wischen. Bei Animatio-
nen » Animation » Effektoptionen stellen Sie unter Richtung die Option
Von links ein. Fiir Anzeigedauer » Start geben Sie Mit Vorherigen an und
bei Anzeigedauer » Dauer den Wert »01,00«.

Um den Textmarker zu animieren, klicken Sie ihn an und wahlen tiber

Animationen » Erweiterte Animation » Animation hinzufiigen nacheinan-
der folgende Effekte aus und passen die entsprechenden Parameter an:

® Eingang » Verblassen, wobei Sie fiir Anzeigedauer » Dauer den Wert

»00,25« einstellen

® Weitere Animationspfade » Linien und Kurven » Rechts; hier machen

Sie die gleichen Angaben wie bei den Wellen, geben also bei Anzeige-
dauer » Dauer den Wert »01,00« ein und bei Anzeigedauer » Start die
Option Mit Vorherigen

® Beenden » Verblassen mit dem Wert »00,25« bei Anzeigedauer » Dauer

und mit der Option Nach Vorherigen bei Anzeigedauer » Start

Schalten Sie den Animationsbereich ein (Animationen » Erweiterte Ani-

mation » Animationsbereich), und verdndern Sie die Reihenfolge der

Elemente (Animationen » Anzeigedauer » Animationen neu anordnen)

wie folgt:
1.
2.
3.
4.

Textmarker mit Eingang » Verblassen
Doppelte Welle mit Wischen
Textmarker mit Pfadanimation » Rechts

Textmarker mit Beenden » Verblassen

Testen Sie die Animation mit der Schaltfliche Wiedergabe im Anima-
tionsbereich. Mit gro3er Wahrscheinlichkeit werden Sie feststellen, dass
der Pfad von der Linge her noch nicht hundertprozentig passt. Klicken
Sie auf das Ende des Pfades (das rote Dreieck), und verschieben Sie es
mit gedriickter [ o ]-Taste, bis es aussieht, als wiirde der Textmarker den
Text tatséchlich gelb markieren.

297



Kapitel 7 — Effekte und Animationen sinnvoll einsetzen

10. Fiir die nichsten Textmarker-Animationen gehen Sie dhnlich vor, mit
ein paar kleineren Anderungen:

® Bei Weitere Animationspfade » Linien und Kurven » Rechts setzen Sie
die gleiche Zeit ein wie bei den Wellen (also Anzeigedauer » Dauer
»01,00« und Anzeigedauer » Start » Beim Klicken). Verschieben Sie
den Animationspfad direkt an die Stelle, an der der Textmarker lau-
fen soll. Dazu klicken Sie einfach auf den Pfadkorper und verschie-
ben den Pfad mit gedriickter Maustaste. Die Feinjustierung nehmen
Sie spéter vor.

® Den Textmarker blenden Sie jeweils iiber den Effekt Eingang » Ver-
blassen mit Anzeigedauer » Dauer » »00,25« und Anzeigedauer »
Start » Mit Vorherigen ein.

® Das Ausblenden erzielen Sie iiber den Effekt Beenden » Verblassen
mit Anzeigedauer » Dauer » »00,25« und Anzeigedauer » Start » Nach
Vorherigen.

11. Die Reihenfolge der Effekte miissen Sie dieses Mal folgendermaf3en
anpassen:

1. Textmarker mit Pfadanimation » Rechts
2. Textmarker mit Eingang » Verblassen

3. Doppelte Welle mit Wischen

4. Textmarker mit Beenden » Verblassen

12. Wie vorher miissen Sie noch den Pfad so genau ausrichten, dass es
wirkt, als wiirde der Textmarker den Text just in dem Moment markie-
ren. Fiir die iibrigen Textmarker-Animationen gehen Sie analog zum
zweiten Textmarker vor.

Wenn Sie alles richtig gemacht haben, gleitet der Textmarker iiber die Mar-
kierungen, und es sieht aus, als wiirde er den Text farbig anstreichen.
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Textzeilen fokussieren

Zitat

,Mit eit per Definition geschlagen,
dennoch nicht unsichtbar, prasentiere ich mich
als unbeachtetes und ungeliebtes Stiefkind
zeitgenaossischer Literatur. Meine Bestimmung
liegt — wie ich selbst —in engen Grenzen und ist
rein platzhalterischer Natur.”

Textzeilen fokussieren

Der Vortragende mochte den Fokus normalerweise auf die Textzeile legen,
iiber die er gerade spricht. Mit einem Fokusbalken wird das auf interessante
Art und Weise unterstiitzt. In diesem Abschnitt lernen Sie am Beispiel einer
Agenda den Fokusbalken kennen und erfahren, wie Sie ihn animieren.

1. Legen Sie zunichst eine Folie mit dem Layout Titel und Inhalt an. Fiigen
Sie mehrere Aufzdhlungspunkte ein (oder laden Sie die entsprechen-
de Prasentation Hervorhebung_Fokusbalken.pptx von der beiliegenden
DVD). Um die Ubung méglichst einfach zu halten, sollte es sich jeweils
um nur eine Zeile Text mit einer ausreichenden Schriftgré3e handeln.
Zeichnen Sie iiber Einfiigen » lllustrationen » Formen » Rechtecke ein
Rechteck, das die erste Textzeile genau abdeckt, und formatieren Sie
es nach Threm Geschmack (z.B. iiber Start » Zeichnung » Fiilleffekte,
Formkontur oder Formeffekte). Das Rechteck bzw. der Balken sollte sich
einerseits vom Hintergrund und andererseits vom Text abheben. Legen
Sie dann das Rechteck hinter den Text (Start » Zeichnung » Anordnen »
Objekte sortieren » Ebene nach hinten).
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2. Bevor Sie den Balken animieren, miissen Sie noch einige Einstellungen
vornehmen:

1. Klicken Sie mit der rechten Maustaste auferhalb der Folie, wihlen
Sie Raster und Fiihrungslinien, und 16schen Sie das Hikchen bei Ob-
jekte am Raster ausrichten.

2. Mit + blenden Sie die Fithrungslinien (Hilfslinien) ein.
Ziehen Sie die horizontale Fithrungslinie genau auf die Mitte der
zweiten Zeile, weil wir dort den Balken platzieren wollen und das
durch die Fiihrungslinie sehr viel einfacher wird.

3. Blenden Sie den Animationsbereich ein (Animationen » Erweiterte
Animation » Animationsbereich).

Fiihrungslinien verschieben

Um die Fihrungslinien moglichst leicht verschieben zu kénnen, kli-
cken Sie sie am besten irgendwo auRerhalb der Folie an.

3. Markieren Sie den Balken, und wihlen Sie Animationen » Animation » Er-
scheinen. Markieren Sie den Balken erneut, und rufen Sie Animationen »
Erweiterte Animation » Animation hinzufiigen » Animationspfade » Linien
auf. Setzen Sie den Wert im Feld Anzeigedauer » Dauer auf »00,50«, und
bei Anzeigedauer » Start wihlen Sie Beim Klicken.

4. Verindern Sie die Linge des Pfades, indem Sie auf seine Spitze klicken
und ihn mit gedriickter Maustaste so verkiirzen, dass die Spitze bei der
horizontalen Fiihrungslinie »einrastet«. Testen Sie die Verdnderungen
iiber die Schaltflache Wiedergabe im Animationsbereich.

5. Duplizieren Sie nun die horizontale Fithrungslinie. Mit der Maus und
gedriickter -Taste ziehen Sie die bestehende Linie nach unten. Sie
erkennen den Vorgang der Duplizierung daran, dass ein kleines Pluszei-
chen am Mauscursor erscheint. Wenn Sie die Maus loslassen, haben Sie
eine zweite Linie. Verschieben Sie sie in die Mitte der dritten Zeile.



6.

Textzeilen fokussieren

Klicken Sie unseren Balken erneut an, und fiigen Sie iiber Animationen »
Erweiterte Animation » Animation hinzufiigen » Animationspfade » Linie
einen zweiten Pfad ein. Setzen Sie das Feld Dauer auf den Wert »00,50«.
Verschieben Sie den Anfang des neuen Pfades mit gedriickter Maustaste
an das Ende des ersten Pfades — meistens docken die Pfade von selbst
aneinander an. Verkiirzen Sie das Ende des zweiten Pfades bis zur Hohe
der dritten Zeile bzw. bis zur zweiten horizontalen Fithrungslinie.

= | ®Prasentationsziele einfeich erreichen
--wVorgehern ---s-tr-u-k-t-urie-rt---alive-n-de (v i s w2 v ol

: gi e-sicher eifisetzaqy -

= Zielgruppe wirkungsvoll ébegeistern

=10 wichtige Wirkungsveé‘stérker einsetzen

Verfahren Sie fiir die {ibrigen Zeilen genauso wie beim zweiten Pfad.

Schalten Sie jetzt die Fiihrungslinien ab ([A1t] + (F9]), und klicken Sie
den Text am Textrahmen an. Wéhlen Sie Animationen » Animation » Ein-
gang » Verblassen. Stellen Sie die folgenden Parameter ein bzw. behal-
ten Sie die Standardeinstellung bei:

® Animationen » Animation » Effektoptionen » Nach Absatz
® Anzeigedauer » Start » Nach Vorherigen

® Anzeigedauer » Dauer » »00,25«

Doppelklicken Sie im Animationsbereich

auf den Inhaltsplatzhalter. Im Dialogfens- I % _Inhaksplatzhal... [

=]l

ter fiir die Effektoptionen suchen Sie sich o

auf dem Reiter Effekt bei Nach Animation
einen Farbton aus, der etwas heller ist als
die Schrift. Wenn die Schrift z. B. schwarz
ist, wihlen Sie hier einen Grauton.
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10. Um die Reihenfolge der Elemente an- [aumstiansbecics - %
zupassen, klappen Sie den Inhalts-
platzhalter im Animationsbereich aus, 1D Rechizcks [
. . . . D ¥ Prasentationsz... []
indem Sie auf den kleinen Doppelpfeil 20 | Recwecks [
links darunter klicken. 9 vorgshen st [

33 | Rechecks |

D # Konzeptionun... [

11. Verschieben Sie den ersten Effekt, der 49 | Redhiecks [
. . . O ¥ Zelgruppewi... ||
beim Inhaltsplatzhalter eingetragen ist 54 | Rechescks [

D W 10wichtige wi.., [
643 | Rechtecks O
ten Eintrag fiir den Balken. Den zweiten © # Praktiche v, [

. ‘B | Rechteck |
Eintrag des Inhaltsplatzhalters (Vorge- 579 @ :xpe:tan:mm i
hen strukturiert ...) schieben Sie direkt &
unter den zweiten Eintrag des Balkens

sshunden v| < [0] 2 0 4 o

usw. (Slehe Abbildung). 4| Rethenfolge dndern |8

(Prasentationsziele ...), unter den ers-

12. Zum Schluss testen Sie Ihre Animationen iiber die Schaltfliche Wie-
dergabe. Falls die Animation IThnen noch nicht hundertprozentig genau
erscheint, passen Sie gegebenenfalls ihre Geschwindigkeit an, oder
platzieren Sie die Pfade praziser.

Agenda

Prasentations-Workshop fur Profis

= Prasentationsziele einfach erreichen
mVorgehen strukturiert anwenden
= Konzeption und Dramaturgie sicher einsetzen

mZielgruppe wirkungsvoll begeistern

=10 wichtige Wirkungsverstarker einsetzen
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Diagrammsaulen einzeln animieren

Diagrammsaulen einzeln animieren

Gerade Diagramme lassen sich sehr gut animieren. Das hat zum Beispiel
den Vorteil, dass man gezielt eine Saule auf Mausklick erscheinen lassen
kann. In dieser Anleitung geht es darum, ein Sdulendiagramm auf einfa-
che Art und Weise zu animieren. Offnen Sie eine Prisentation mit einem
Sdulendiagramm (z.B. die Datei Sdulendiagramm_animieren.pptx von der
beiliegenden DVD), oder legen Sie ein neues Sdulendiagramm an.

1. Markieren Sie das Diagramm, und wihlen Sie Animationen » Anima-
tion » Eingang » Wischen. Fiir den Fall, dass Sie den Effekt nicht finden,
wéhlen Sie im gleichen Menii den Eintrag Weitere Eingangseffekte, und
suchen Sie dort danach. Bei Animationen » Animation » Effektoptionen
verwenden Sie Richtung » Von unten und Sequenz » Nach Kategorie.

2. Wenn Sie sich die Animation anschauen, werden Sie feststellen, dass
auch die Legende auf einen Klick hin erscheint. Viele Referenten méch-
ten jedoch lieber gleich die Legende sehen und dann per Klick nur die
einzelnen Sdulen einblenden. Schalten Sie dafiir iiber Animationen »
Erweiterte Animation » Animationsbereich den Animationsbereich ein.
Dort klappen Sie die einzelnen Eintrédge iiber den kleinen Doppelpfeil
nach unten auf, sodass alle
Eintrdge zu sehen sind. Kli-
cken Sie den ersten Eintrag
an, und stellen Sie Animatio-
nen » Anzeigedauer » Start » ot
Nach Vorherigen ein. Testen
Sie die Prasentation {iber
Bildschirmprasentation » Bild-
schirmprasentation starten »

Von Beginn an — die Legende H
wird automatisch eingeblen-
det und die Séaulen per Klick.

Kategorie 1 Kategorie 2 Kategorie 3 Kategoried
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Die Stiicke eines Tortendiagramms animieren

In diesem Abschnitt geht es darum, ein Tortendiagramm radial zu animie-
ren. Sie konnen sich das so vorstellen: Auf dem Tisch steht eine leere runde
Kuchenplatte, und nun stellt jemand Tortenstiick fiir Tortenstiick auf die
Platte.

1.

Offnen Sie eine Prisentation mit einem Tortendiagramm (z.B. Torten-
diagramm_animieren.pptx von der beiliegenden DVD), oder legen Sie
ein neues Tortendiagramm an.

Klicken Sie das Diagramm an, und wihlen Sie Animationen » Animation »
Eingang » Rad aus. Unter Animationen » Animation » Effektoptionen wihlen
Sie fiir Speichen die Option 1 Speiche und bei Sequenz die Angabe Als ein-
zelnes Objekt.

Wenn Sie sich die Animation in der Vorschau (Animation » Vorschau »
Vorschau) genau anschauen, sehen Sie, dass der Mittelpunkt der Rad-
Animation nicht exakt in der Mitte des Diagramms liegt. Um dieses Pro-
blem zu beheben, gibt es mehrere Losungsansatze.

Die eine Moglichkeit ist folgende: Sie duplizieren das Diagramm
((strg] + (D]) und schieben das Duplikat erst einmal auf die Seite. Lo-
schen Sie im Original-Tortendiagramm die Legende und alle Elemente,
die auf3erhalb der Torte liegen, z. B. die Beschriftungen. Um ein Element
zu 16schen, markieren Sie es und driicken die Entf]-Taste, oder Sie
stellen Diagrammtools » Beschriftungen » Legende » Keine ein. Die Torte
ist jetzt grofder, was vollkommen in Ordnung ist.

Nehmen Sie nun das Duplikat, und vergrofSern Sie das gesamte Dia-
gramm so weit, bis beide Torten in etwa gleich grof3 sind. Animieren Sie
das Klon-Diagramm iiber Animationen » Animation » Eingang » Verblas-
sen. Bei Animationen » Anzeigedauer » Start stellen Sie Nach Vorherigen
ein. Legen Sie das Klon-Diagramm abschliefend in den Hintergrund,
z.B. iiber Start » Zeichnung » Anordnen » Objekte sortieren » In den Hin-



Tabellenspalten einzeln einblenden

tergrund. Testen Sie die Animation iiber die Vorschau, und korrigieren
Sie sie notigenfalls.

5. Die andere Méglichkeit wire diese: Sie legen eine weile Fliche iiber
das gesamte Diagramm (Start » Zeichnung » Formen und anschliefend
Start » Zeichnung » Fiilleffekt » Weil, Hintergrund 1), schieben die Mit-
telpunkte dieser Flache und des Tortendiagramms iibereinander (dafiir
stellen Sie am besten die Transparenz der Flache auf 50 % ein) und fiigen
iiber Animationen » Animation » Beenden den Effekt Rad mit Speichen »
1 Speiche ein. Testen Sie die Wirkung einfach iiber die Vorschaufunk-
tion (Animationen » Vorschau » Vorschau). Diese Variante funktioniert
sehr gut, allerdings konnen Sie das Diagramm so nicht ausdrucken.
Dazu miissten Sie dann die Folie duplizieren und die weil3e Flache wie-
der entfernen. Diese Variante finden Sie auf der beiliegenden DVD in
der Datei Tortendiagramm_animieren.pptx.

m 1. Quartal ™2 Quartal ™ 3.Quartal ™4, Quartal

Tabellenspalten einzeln einblenden

Eine Tabelle Spalte fiir Spalte einzublenden, sieht auf den ersten Blick sehr
leicht aus. Allerdings gibt es dafiir in PowerPoint keinen Befehl. Die Anima-
tion der Tabelle funktioniert nur iiber Umwege. Es gibt verschiedene Mog-
lichkeiten, die ich Thnen im Folgenden vorstelle:
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1. Sie legen fiir jede Spalte eine eigene Tabelle an und animieren jede Ta-
belle einzeln. Hierbei ist exaktes Arbeiten sehr wichtig, andernfalls sieht
die Animation unausgeglichen aus. Dariiber hinaus kénnen Anderungen
sehr aufwendig werden, wenn sich Spalten- oder Zeilenbreiten dndern.

2. Sie losen die Gruppierung einer Tabelle (indem Sie sie mit der rechten
Maustaste anklicken und Gruppierung auflésen aus dem Kontextmenii
wahlen — diesen Schritt miissen Sie zweimal hintereinander tun) und
gruppieren die einzelnen Spalten neu. Anschlielend animieren Sie jede
neue Gruppe. Auch hierbei ist exaktes Arbeiten &uflerst wichtig, und der
Aufwand fiir Anderungen ist leider noch héher als bei Variante 1.

3. Jede Spalte wird mit einer weil3en Flache iiberlagert, die dann iiber Ani-
mationen » Animation » Beenden » Wischen die jeweilige Tabellenspalte
freigibt. Dies ist eine sehr einfache und elegante Losung. Fiir Anderun-
gen miissen Sie die Flachen ausblenden (indem Sie iiber Start » bearbei-
ten » Markieren » Auswahlbereich auf das Augensymbol klicken). Um die
Folie ausdrucken zu kénnen, miissen Sie ein Duplikat anlegen, bei dem
Sie die weif3en Flachen entfernen.

4. Die letzte Moglichkeit, die ich in diesem Abschnitt auch detailliert vor-
stellen moéchte, funktioniert wie Variante 3, nur dass die weilsen Fla-
chen aufSerhalb der Folie liegen und erst beim Starten der Folie iiber
die Tabelle gelegt werden. Die Tabelle kann sehr einfach gedndert und
gedruckt werden. Allerdings ldsst sich das Einblenden der Flache beim
Folienstart nur mit einem Trick realisieren. Die Flachen werden mithilfe
einer Pfadanimation iiber die Tabelle gelegt, und die Geschwindigkeit
wird auf den kleinsten Wert gesetzt, ndmlich 0,01 Sekunden.

Neben diesen vier hauptsichlich genutzten Varianten gibt es noch weite-
re Moglichkeiten, angefangen bei trickreichen Pfadanimationen bis hin zu
programmierten Losungen (mit Visual Basic for Applications, VBA).

In diesem Abschnitt zeige ich Thnen eine Anleitung fiir Variante 4, da Sie auf
diese Weise Ihre Fahigkeiten im Umgang mit Animationen weiter ausbauen.
Auch alle iibrigen Varianten finden Sie auf der beiliegenden DVD.
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1.

Tabellenspalten einzeln einblenden

Offnen Sie zunichst die Folie mit der Tabelle (Beispieldatei Hervorhe-
bung_Tabelle.pptx). Mit Einfliigen » Illustrationen » Formen » Rechtecke »
Rechteck zeichnen Sie einen Kasten iiber die erste Spalte. Wéhlen Sie
Start » Zeichnung » Fiilleffekt » Designfarben » WeiR3, Hintergrund 1 und
als Start » Zeichnung » Formkontur » Kein Rahmen.

. Passen Sie das Rechteck genau an die Spalte an, duplizieren Sie es, und

legen Sie die Duplikate jeweils iiber die anderen Spalten. Richten Sie die
Flachen genau passend aus, z.B. iiber Start » Zeichnung » Anordnen »
Objekte positionieren » Ausrichten » Oben ausrichten. Jetzt sollten alle
Spalten sauber durch Késten abgedeckt sein.

Markieren Sie die drei Rechtecke, und wihlen Sie Animationen » Anima-
tion » Beenden » Wischen aus (Achtung: Nicht verwechseln mit Eingang »
Wischen!). Bei Animationen » Animation » Effektoptionen wéhlen Sie Rich-
tung » Von unten. Unter Animationen » Anzeigedauer » Start stellen Sie
Beim Klicken ein. Schalten Sie den Animationsbereich ein (Animationen »
Erweiterte Animation » Animationsbereich). Priifen Sie {iber die Vorschau
(Animation » Vorschau » Vorschau), ob die Animation gut aussieht, und
korrigieren Sie sie gegebenenfalls.

Raster ausschalten

Sie sollten immer das Raster ausgeschaltet lassen, andernfalls las-
sen die Formen sich nicht genau positionieren. Klicken Sie dazu mit
der rechten Maustaste auf den Hintergrund der Folie, und wahlen
Sie Raster und Fiihrungslinien aus dem Kontextmeni. Im Dialogfens-
ter [6schen Sie den Haken bei Objekte am Raster ausrichten.

Klicken Sie den ersten Kasten an, und wihlen Sie Animationen » Erweiter-
te Animation » Animation hinzufiigen » Weitere Animationspfade » Linien
und Kurven » Rechts. Schalten Sie mit + die Fiihrungslinien
ein. Verschieben Sie eine horizontale und eine vertikale Fiihrungslinie
zum Anfangspunkt des Animationspfads. Verschieben Sie nun den Ani-
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5.

mationspfad so, dass das Pfadende auf dem Kreuzungspunkt der Fiih-
rungslinien liegt.

Wettbewerbsanalyse
Unter den Top 3 nur ein echter M

1 2

Klicken Sie im Animationsbereich doppelt auf den Eintrag fiir die Pfad-
animation, und verdndern Sie im Dialogfenster auf dem Reiter Effekt die
Einstellungen wie folgt:

® Pfad » Gesperrt
® Gleiten Start: »0 sek.«
® Gleiten Ende: »0 sek.«

SchlieSen Sie den Dialog, aber lassen Sie den Eintrag fiir die Pfadani-
mation markiert. Bei Animationen » Anzeigedauer » Start stellen Sie Mit
Vorherigen ein und bei Dauer den Wert »00,01«. Riicken Sie den Pfad-
animationseintrag auf die erste Position im Animationsbereich (Anima-
tionen » Anzeigedauer » Animation neu anordnen » Friiher).

Ziehen Sie jetzt den Kasten nach links auf3erhalb der Folie. Achtung:
Der Pfad darf sich nicht mitbewegen! Wenn Sie jetzt mit der Taste
den Bildschirmprasentationsmodus wahlen, sollte sofort die weille
Flache iiber der Spalte liegen. Wenn Sie dann im Bildschirmprésenta-
tionsmodus irgendwo mit der Maustaste klicken, sollte die Flache ver-
schwinden.



Tabellenzeilen einzeln einblenden

8. Verfahren Sie mit den anderen Késten genauso wie mit dem ersten. Da-
bei spielt es keine Rolle, aus welcher Richtung der Pfad kommt (auch
wenn von oben nicht so sinnvoll ist). Legen Sie die Pfadanimation je-
weils auch wieder an die erste Position.!

Wettbewerbsanalyse

Unter den Top 3 nur ein echter Mitbewerber, andere nur »me too-

Tropfheimer AG Im Bereich Rost und Stahl
sehr gut aufgestellt,

Fun-da-Mental GmbH

X21 Orbiter KG

Tabellenzeilen einzeln einblenden

Im vorhergehenden Abschnitt haben Sie gelernt, welche Moglichkeiten es
gibt, um Tabellen spaltenweise einzublenden. Diese lassen sich auch auf
eine Animation {ibertragen, die Zeile fiir Zeile verl4uft. In dieser Ubung stel-
le ich Thnen allerdings eine andere Moglichkeit vor, die Sie natiirlich auch
genauso fiir das spaltenweise Einblenden verwenden kénnen.

1 Der Begriff me too (engl.: »ich auch«) stammt aus der Marketingbranche und bedeutet
so viel wie »nachahmen«. Wenn ein Hersteller beispielsweise eine neuartige Kaffee-
pad-Maschine auf den Markt bringt und andere Firmen dieses (erfolgreiche) Konzept
aufgreifen, bezeichnet man die Folgeprodukte dann als »me too«.
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1.

Offnen Sie die Folie mit der Tabelle von der beiliegenden DVD (Hervor-
hebung_Tabelle.pptx). Zeichnen Sie ein Rechteck {iber die gesamte Ta-
belle (Einfiigen » Illustrationen » Formen » Rechtecke » Rechteck). Wahlen
Sie als Start » Zeichnung » Fiilleffekt » Weif3, Hintergrund 1 und Start »
Zeichnung » Formkontur » Kein Rahmen. Passen Sie das Rechteck genau
an die Gro3e der Tabelle an.

Markieren Sie die Flache, und wihlen Sie Animationen » Animation »
Animationspfade » Linien aus. Dann stellen Sie Animationen » Animation »
Effektoptionen » Richtung » Nach unten ein. Schalten Sie zur besseren Uber-
sicht den Animationsbereich ein (Animationen » Erweiterte Animation »
Animationsbereich). Priifen Sie iiber die Vorschau (mit der Schaltflache
Wiedergabe), wie sich die Animation verhélt. Die weil3e Flache, die tiber der
Tabelle liegt, sollte sich nun ein Stiick nach unten bewegen und die erste
Zeile der Tabelle freigeben. Zum Nachjustieren legen Sie am besten eine
senkrechte Fiihrungslinie an den Pfad an und verkiirzen oder verlin-
gern sie, indem Sie das Pfadende mit gedriickter Maustaste verschieben.

Klicken Sie die weifde Flache an, und fiigen Sie

iiber Animationen » Erweiterte Animation » Ani- "
mation hinzufligen » Animationspfade » Linien ¥
eine weitere Animation hinzu. Ziehen Sie den

Pfad nach unten, indem Sie auf seinen »Rumpfe | &

klicken, und zwar so, dass sein Anfang auf das
Ende des vorhergehenden Pfads trifft. Im Nor-
malfall legen sich Pfadanfang und Pfadende qua-
si von selbst nahtlos aneinander.

4. Verkiirzen oder verlingern Sie den zweiten Pfad, indem Sie das Pfad-

ende mit der Maus verschieben. Kontrollieren Sie die Animation iiber
die Vorschau, und justieren Sie gegebenenfalls nach. Daraufhin fiigen
Sie fiir jede weitere Zeile eine Pfadanimation hinzu, wie soeben be-
schrieben.



5.

Tabellenzeilen einzeln einblenden

Waagerechte Hilfslinien

Damit Sie sich besser orientieren konnen, ist es sinnvoll, auch waage-
rechte Hilfslinien am Pfadanfang und am Pfadende zu platzieren. Ge-
rade beim Justieren sparen Sie damit viel Zeit.

Wie schon im vorherigen Abschnitt, »Tabellenspalten einzeln einblen-
den« ab Seite 305, erwahnt, diirfen die weilsen Rechtecke zum Bearbei-
ten der Tabelle oder zum Ausdrucken nicht auf der Folie zu sehen sein.
Fligen Sie also eine weitere Pfadanimation hinzu, und verschieben Sie
den Pfad nach oben, sodass sein Ende gleich am Anfang des ersten Pfads
sitzt.

Offnen Sie den Animationsbereich, und verschieben Sie den Eintrag
fir diesen neuen Pfad an die erste Stelle der Liste (Animationen »
Anzeigedauer » Animation » Neu anordnen » Friiher). Bei Animationen »
Anzeigedauer » Start stellen Sie Mit Vorherigen ein und bei Dauer den
Wert »00,01«.

Klicken Sie die weif3e Flache an. Nun sind alle Effekteintrige im Anima-
tionsbereich markiert. Klicken Sie mit der rechten Maustaste auf einen
der Eintrage, und wéhlen Sie Effektoptionen aus dem Kontextmenii. Sie
gelangen zur Registerkarte Effekt. Dort &ndern Sie die Einstellungen wie
folgt und schlieRen danach den Dialog:

® Pfad » Gesperrt
® Gleiten Start: »0 sek.«
® Gleiten Ende: »0 sek.«

Schieben Sie die Fldche aulRerhalb der Folie, und testen Sie die Anima-
tion in der Vorschau (Animation » Vorschau » Vorschau) oder iiber die
Schaltflaiche Wiedergabe. Falls die Animation zu langsam lauft, verin-
dern Sie die Zeitangabe iiber Animationen » Anzeigedauer » Dauer.

3N



Kapitel 7 — Effekte und Animationen sinnvoll einsetzen

312

Wettbewerbsanalyse

Unter den Top 3 nur ein echter Mitbewerber, andere nur »me too-«

Tropfheimer AG Im Bereich Rost und Stahl Schwacher Service
sehr gut aufgestellt,
besonders bei Stahlaugen

Fun-da-Mental GmbH Besseres Preis-Leistunes- Schlechte Lieferfahickeit

Ein SmartArt schrittweise animieren

Nachdem Sie nun schon verschiedene Moglichkeiten der Animation ken-
nengelernt haben, zeige ich Thnen in diesem Abschnitt, wie Sie auch Smart-
Arts zum Leben erwecken kénnen.

1. Laden Sie die Prisentation SmartArt_animieren.pptx von der beiliegen-
den DVD, oder erstellen Sie selbst eine SmartArt mit dem Layout Alter-
nierender Fluss ({iber Einfiigen » Illustrationen » SmartArt » Prozess).

2. Markieren Sie die SmartArt-Grafik, und wihlen Sie Animationen » Ani-
mation » Eingang » Wischen aus. Bei Animationen » Animation » Effekt-
optionen » Richtung wéhlen Sie Von oben und bei Animationen » Anima-
tion » Effektoptionen » Sequenz die Option Nacheinander aus. Schalten
Sie den Animationsbereich ein (Animationen » Erweiterte Animation »
Animationsbereich), und klappen Sie die Effekteintrdge iiber den Kklei-
nen Doppelpfeil aus.

3. Verindern Sie die Einzeleintrige im Animationsbereich wie folgt:

® Fiir den zweiten Effekteintrag, »Inhaltsplatzhalter: Wissen speichernc,
stellen Sie Animationen » Anzeigedauer » Start » Nach Vorherigen ein.



Ein SmartArt schrittweise animieren

® Fiir den dritten Eintrag, »Inhaltsplatzhalter: Form 31«, wéhlen Sie Ef-
fektoptionen » Richtung » Von links.

® Fiir den vierten Eintrag, »Inhaltsplatzhalter: Stufe 2«, stellen Sie Ef-
fektoptionen » Richtung » Von unten und Start » Nach Vorherigen ein.

® Auch fiir den fiinften Eintrag, »Inhaltsplatzhalter: Erklaren konnen,
stellen Sie Effektoptionen » Richtung » Von unten und Start » Nach Vor-
herigen ein.

® Beim sechsten Eintrag, »Inhaltsplatzhalter: Gebogener Pfeil 32«,
wiahlen Sie Effektoptionen » Richtung » Von links.

® Fiir den siebten Eintrag, »Inhaltsplatzhalter: Stufe 3«, geben Sie
Start » Nach Vorherigen an.

® Fiir den achten und letzten Eintrag, »Inhaltsplatzhalter: Anwenden
diirfen, stellen Sie ebenfalls Start » Nach Vorherigen ein.

Ein Hinweis noch: Die Reihenfolge der Einzeleintrage lasst sich bei Smart-
Arts nicht anpassen!

Sie haben mit dieser Ubung gesehen, wie Sie SmartArt-Grafiken geschickt
animieren konnen. Wenn Sie Lust haben, probieren Sie das doch einfach
mal mit anderen SmartArt-Grafiken aus.

Stufe 2

* erklaren
kénnen

* Wissen
speichern

Stufe 1
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Einen rasanten Titeleffekt anlegen

Der hier beschriebene Titeleffekt baut sich sehr schnell auf (unter 1,5 Se-
kunden) und lasst sich daher optimal fiir ausgewéahlte Folien verwenden,

z.B. fiir Kapitel- oder Highlight-Folien.

1.

Laden Sie die Préasentation Titeleffekt.pptx von der beiliegenden DVD,
oder bauen Sie die benétigten Elemente selbst:

® ein Rechteck mit linearem Farbverlauf, wobei die Enden jeweils auf
100% Transparenz eingestellt sind und das Rechteck die gesamte Fo-
lienbreite umfasst

® ecinen Kreis mit radialem Farbverlauf, dessen Durchmesser der Hohe
des Rechtecks entsprechen sollte

® cin Textfeld mit Text

Das Textfeld muss {iber der Kugel (dem Kreis) und die Kugel wiederum
tiber der Flache (dem Rechteck) liegen.

. Fiir eine bessere Ubersicht schalten Sie den Animationsbereich ein

(Animationen » Erweiterte Animation » Animationsbereich). Aullerdem
blenden Sie die Fiihrungslinien ein ([A1t] + (F9]). Wihlen Sie fiir das
Rechteck Animationen » Animation » Animationspfade » Linien aus. Un-
ter Animationen » Animation » Effektoptionen verwenden Sie fiir Rich-
tung die Angabe Rechts. Bei Animationen » Anzeigedauer » Start stellen
Sie Mit Vorherigen ein, und im Feld Dauer geben Sie den Wert »00,75«
an. Verschieben Sie eine waagerechte Fiihrungslinie genau auf den Ani-
mationspfad und eine senkrechte genau auf seinen Anfang.

|
I |

} oo Titeleffekt - “} T

.

“

3. Verschieben Sie dann den Animationspfad nach links (klicken Sie dazu

am besten auf seinen Rumpf), sodass das Ende des Pfades auf dem Kreu-
zungspunkt der Fithrungslinien liegt. Zoomen Sie die Folie kleiner (mit



Einen rasanten Titeleffekt anlegen

dem Zoom-Schieber unten rechts auf dem Bildschirm). Klicken Sie den
Pfadanfang an, und ziehen Sie ihn auflerhalb der Folie, und zwar so
weit, bis er ca. die halbe Folienbreite aulserhalb der Folie erreicht hat.

Zoomen Sie wieder auf normale Foliengrol3e. Duplizieren Sie eine der
senkrechten Fiihrungslinien (indem Sie mit gedriickter [Strg]-Taste an
der Linie ziehen), und legen Sie sie auf der Mitte der Kugel ab.

Klicken Sie das Rechteck an, und machen Sie es »unsichtbar«, indem
Sie es liber Start » Bearbeiten » Markieren » Auswahlbereich auswéhlen
und rechts in der Leiste Auswahl und Sichtbarkeit auf das Augensymbol
klicken.

Klicken Sie die Kugel an, und wéhlen Sie Animationen » Animation » Ani-
mationspfade » Linien aus. Bei Effektoptionen verwenden Sie Richtung »
Links. Fiir Animationen » Anzeigedauer » Start stellen Sie Mit Vorherigen
ein, und fiir Dauer geben Sie »00,75« an.

Verschieben Sie den Pfad nach rechts, sodass das Pfadende auf dem
Kreuzungspunkt der Fithrungslinien endet, die iiber der Kugel liegen.

b

= I _ ........ T ‘It‘ﬁl‘ﬁffek{) EE

Ziehen Sie den Pfadanfang nach rechts auerhalb der Folie (etwa eine
halbe Kugelbreite).

4 Titeleffekt b
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10.

Klicken Sie den Text an, und wéihlen Sie Animationen » Animation »
Eingang » Verblassen aus. Bei Animationen » Anzeigedauer » Start stel-
len Sie Nach Vorherigen ein und bei Dauer den Wert »00,75«.

Machen Sie zum Schluss das Rechteck wieder sichtbar (iiber die glei-
che Schaltfldche in der Leiste Auswahl und Sichtbarkeit, die aber dies-
mal kein Auge mehr zeigt), und testen Sie die Animation {iber die Re-
gisterkarte Bildschirmprésentation.

Titeleffekt

Eine Kugel als Zugpferd einsetzen

In dieser Ubung erstellen wir eine animierte Kugel, die den Titeltext sozu-
sagen durch das Bild zieht. Dieser Effekt eignet sich besonders, wenn ein
Konzept oder ein Produkt vorgestellt wird, das bald anlaufen oder auf den
Markt gebracht werden soll. Um das »ins Rollen bringen«, also die Bewe-
gung und den 3D-Eindruck zu verstérken, lassen wir den Schatten der Ku-
gel mit der Animation schweben.

1.

Laden Sie die Prasentation Zugpferd_Kugel.pptx von der beiliegenden
DVD, oder bauen Sie selbst die folgenden Elemente:

® cin Textfeld mit Text

® einen Kreis mit 3D-Optik (siehe z.B. den Abschnitt »Eine 3D-Kugel
gestalten« ab Seite 184), ein ClipArt oder ein Foto von einer Kugel

® einen Schatten, der zur Kugel passt (z. B. indem Sie eine Ellipse zeich-
nen, sie mit einer dunkelgrauen Fiillung versehen und ihre Rander
uber Formeffekte » Weiche Kanten unscharf machen)



2.

Eine Kugel als Zugpferd einsetzen

Schalten Sie zunichst den Animations-

bereich ein (Animationen » Erweiterte Die Sache ins Rollen bringen

Animation » Animationsbereich), und las-

sen Sie sich die Fiihrungslinien anzeigen Re|aunchunse,esmp_pmdumo }

([A1t] + [F9]). Fiigen Sie eine waagerech-

te Fithrungslinie fiir die Kugel und eine fiir

die Schattenellipse ein, indem Sie mit gedriickter [Strg]-Taste und ge-
driickter Maustaste an einer der vorhandenen Fiihrungslinien ziehen.
Die senkrechte Fithrungslinie sollte auf der Mitte der Textbox liegen.

Markieren Sie alle drei Elemente (Text, Kugel und Schatten), und schie-
ben Sie sie nach links auf3erhalb der Folie. Achten Sie darauf, dass sie
auf den waagerechten Fithrungslinien stehen bleiben.

Die Sache ins Rolle

Klicken Sie nur den Text an und wihlen Sie Animationen » Animation
» Animationspfade » Linien aus. Unter Effektoptionen verwenden Sie
Richtung » Rechts. Bei Animationen » Anzeigedauer » Dauer stellen Sie
vorlaufig den Wert »03,25« ein. Ziehen Sie das Pfadende bis zur senk-
rechten Fiihrungslinie.

Markieren Sie beide Elemente (Kugel und Schatten), und wéhlen Sie
auch hier wieder Animationen » Animation » Animationspfade » Linien.
Bei Animationen » Anzeigedauer » Start stellen Sie Mit Vorherigen ein
und bei Dauer den Wert »04,00«. Ziehen Sie das Pfadende der Kugel und
das Pfadende des Schattens nach rechts auf3erhalb der Folie. Achten Sie
darauf, dass Sie sich dabei auf der Fiihrungslinie bewegen. Aullerdem
miissen Kugel und Schatten sich auch aullerhalb der Folie befinden,
wenn die Pfadanimation beendet ist, d.h., beide geben nur ein kurzes
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Gastspiel auf der Folie. Sie starten also links auf3erhalb der Folie und
enden rechts ebenfalls aul3erhalb der Folie.

Die Sache ins ERoIIen bringen

:
EREp e bl

Klicken Sie nun nur die Kugel an, und fiigen Sie iiber Animationen » Er-
weiterte Animation » Animation hinzufiigen » Betont » Rotieren eine wei-

¥ ¥

tere Animation hinzu. Unter Animationen » Anzeigedauer » Start stellen
Sie Mit Vorherigen ein und bei Dauer den Wert »04,00«.

Markieren Sie die drei Eintrédge im Animationsbereich, die Pfadanima-
tionen enthalten. Klicken Sie mit der rechten Maustaste auf einen dieser
Eintrage, und setzen Sie iiber Effektoptionen » Effekt die Einstellungen
flir Gleiten Start und Gleiten Ende jeweils auf »0 sek.«. Testen Sie die Ani-
mation iiber Bildschirmprasentation » Bildschirmprasentation starten »
Von aktueller Folie (oder mit (o] + (F5)). Priifen Sie dort also, ob die
Kugel rollt, der Schatten richtig mitlauft und der Text nahezu immer
den gleichen Abstand zur Kugel halt. Falls nicht, verkiirzen oder verlan-
gern Sie den Zeitraum im Feld Dauer.

Die Sache ins Rollen bringen

unseres Top-Produkts




Einen Nachrichtenticker simulieren

Einen Nachrichtenticker simulieren

Vermutlich kennen Sie Tickertexte aus dem Fernsehen, wenn die aktuellen
Meldungen als Text unten durchs Bild laufen. Einen solchen Effekt kénnen
Sie mit PowerPoint auch fiir Ihre Priasentation erstellen.

1. Legen Sie eine neue Folie (mit einem Layout Threr Wahl) an. Fiigen Sie
unten auf der Folie ein rotes Rechteck ein (Einfligen » Illustrationen »
Rechtecke » Rechteck). Legen Sie ein Textfeld an, und schreiben Sie Ih-
ren Tickertext dort hinein. Die Zeile sollte ruhig weit {iber den rechten
Folienrand hinausgehen.

Das ist ein Tickertext. Hier kénnten neueste Nachrichten und ar

2. Zoomen Sie die Folie kleiner, sodass moglichst der komplette Text auf
Threm Bildschirm zu sehen ist. Daraufhin ziehen Sie das Textfeld mit
gedriickter [ o ]-Taste und gedriickter Maustaste nach rechts auRerhalb
der Folie, bis der komplette Text auBerhalb liegt.

Umschalt-Taste beim Verschieben

Wenn Sie beim Verschieben von Elementen die [ o ]-Taste gedriickt
halten, erzeugt dies ein nicht sichtbares Raster, das eine genaue Be-
wegung der Elemente auf den Flihrungslinien sowie ihre Justierung
ermoglicht.

3. Wihlen Sie dann Animationen » Animation » Animationspfade » Linien.
Bei Effektoptionen » Richtung verwenden Sie Links. Ziehen Sie das Pfa-
dende mit gedriickter [ ]-Taste so weit nach links, dass es auferhalb
der Folie endet. Wie weit Sie das Ende hinausziehen miissen, hingt von
der Breite Thres Textfeldes ab. Der Abstand zum Folienrand sollte die
Halfte der Textbreite betragen.
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Tickerschnell-53ek proFolienbreite
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4. Die Geschwindigkeit, mit der der Tickertext iiber die Folie laufen soll-
te, hdngt von verschiedenen Faktoren ab: Wie relevant ist der Text fiir
die Zuschauer, wie leicht liest sich Thr Text, wie wichtig ist er? Wenn
ein Wort z. B. vom rechten Folienrand bis zum linken Folienrand 8 Se-
kunden braucht, haben wir eine Geschwindigkeit von 8 Sekunden/Fo-
lienbreite. Schnelle Leser schaffen 5 Sekunden/Folienbreite, der durch-
schnittliche Leser braucht ca. 10 Sekunden/Folienbreite.

5. Inunserem Beispiel brauchen wir zwei Folienbreiten, um den gesamten
Text anzuzeigen. Wenn wir uns fiir die Geschwindigkeit von 8 Sekun-
den/Folienbreite entscheiden, brauchen wir folglich 2 X 8 Sekunden,
also 16 Sekunden. Geben Sie also bei Animationen » Anzeigedauer »
Dauer den Wert »16,00« ein. Testen Sie die Animation in der Vorschau
(Animationen » Vorschau » Vorschau) oder im Prisentationsmodus
([2] + [F5)). Wenn Thnen der Tickertext zu langsam vorkommt, pro-
bieren Sie mal einen Wert von 5 Sekunden pro Folienbreite. In unserem
Beispiel wiirden wir dann also bei Dauer den Wert »10,00« eingeben.

Wir haben jetzt einen Tickertext fiir eine Folie erstellt. Wenn Sie auf meh-
reren Folien einen Ticker laufen lassen wollen, miissen Sie auf jeder Folie
einen neuen Text eingeben. Falls der Ticker jedoch durchgéngig sein soll,
brauchen Sie eine VBA-Programmierung (Visual Basic for Applications)
oder spezielle Zusatzsoftware, sogenannte Digital-Signage-Softwarel6sun-
gen (suchen Sie einfach bei Google nach »Digital Signage Software«).
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Die Welt umkreisen

Ticker

in Tickertext. Hier konnten neueste Nachrichten und andere |

Die Welt umkreisen

In der letzten Ubung dieses Kapitels erstellen wir einen »Pseudo-3D-Effekt,
in dem ein Logo um eine Erdkugel »fliegt«. Das Logo bewegt sich aber nicht
wirklich in 3D, sondern wir kombinieren 2D-Effekte miteinander, wodurch
ein dreidimensionaler Effekt praktisch vorgetdauscht wird.

Hierbei ist allerdings anzumerken, dass Microsoft den fiir diese Animatio-
nen wichtigen Animationsbefehl Drehen in PowerPoint 2010 so verdndert
hat, dass man diesen Effekt nicht damit erstellen, aber 4&ndern und abspie-
len kann. Die Animation selbst muss mit der Version 2007 oder 2003 erstellt
werden. Da diese Animation in meinen Seminaren aber auf grofSes Interesse
stof3t, habe ich sie mit in dieses Buch aufgenommen.

1. Laden Sie die Prisentation Umkreisung_Logo.pptx von der beiliegenden
DVD. Klicken Sie das Logo mit der rechten Maustaste an, und rufen Sie
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den Befehl Bild &ndern im Kontextmenii auf. Laden Sie dann Ihr eigenes
Logo oder ein anderes Bild in die Folie. Mit (& ] + konnen Sie sich
anschliel3end die Animation anschauen.

2. Wenn Sie moéchten, dass das Logo die Welt mehrmals umkreist, dupli-
zieren Sie die Folie so oft, wie Sie das Logo kreisen lassen wollen, und
lassen Sie so die eine Umkreisung mehrmals hintereinander ablaufen.
(Im DVD-Beispiel aus der Prasentation Umkreisung_Kuh.pptx habe ich
es so gemacht. Die Zeit fiir den Folieniibergang habe ich fiir jede Folie
unter Uberginge » Anzeigedauer » Nichste Folie » Nach auf den Wert
»00:01,00« gesetzt.) Schauen Sie sich den Effekt mit (¢ ] + an.

Welt-Umkreisung
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Kapitel 8

Video- und Audiodateien
richtig einbinden

Mit den neuen Moglichkeiten, die PowerPoint 2010 bietet, um Film und Ton
einzubinden, eroffnen sich — verglichen mit fritheren Versionen — durchaus
interessante Perspektiven. Die Einbindung ist grundséitzlich vereinfacht
worden, und es werden nun mehr Dateiformate akzeptiert. Dariiber hinaus
konnen Videos direkt im Programm »gestaltet«, d. h. in Lange, Form, Farbe
und Layout verdndert oder mit Text und Grafiken {iberlagert werden.
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Mit diesem Kapitel werden Sie lernen, welche Moglichkeiten es gibt, Videos
gestalterisch aufzupeppen, beispielsweise mit grafischen Effekten. Sie wer-
den sehen, wie Sie Videos und Audiodateien bearbeiten kénnen, und da-
riiber hinaus erfahren Sie, worauf Sie beim Einbinden solcher Dateien zu
achten haben und wie Sie Videos und Audiodateien komprimieren kénnen.

Basisfunktionen Video

In PowerPoint 2010 konnen Video- und Audiodateien nun in die Présenta-
tion eingebettet statt wie in den Vorgédngerversionen als externe Dateien
verkniipft werden. Das bringt viele Vorteile: Wenn Sie die Prasentation bei-
spielsweise weitergeben wollen, miissen Sie die Video- und/oder Soundda-
teien nicht mehr separat mitliefern (und konnen sie so natiirlich auch nicht
vergessen).

Kompatibilitat

In PowerPoint 2010 eingebettete Videos laufen auch unter der
Version 2007. Sogar in PowerPoint 2003 lassen sie sich verwenden,
aber nur, wenn sie verkntipft wurden.

Auch in der Version 2010 konnen Sie deshalb Videos und Sound wei-
terhin lediglich verknipfen, indem Sie beim Einfligen die entspre-
chende Einstellung wahlen. Das hat generell den Vorteil, dass Ihre
Prasentation weniger Speicherplatz braucht. Beachten Sie dazu die
Hinweise im Abschnitt »Voraussetzungen fiir die Integration von
Video- und Audiodateien« ab Seite 328.

Beim Einfiigen eines Videos in eine Prisentation iiber Einfiigen » Medien »
Video bieten sich Ihnen vier verschiedene Moglichkeiten:

e Uber den Befehl Video aus Datei konnen Sie Videos von Threr Festplatte
einfiigen, d. h., das Video wird in die Prasentation eingebettet und kann
mit allen von PowerPoint zur Verfiigung gestellten Videobearbeitungsbe-
fehlen gestaltet werden.



Basisfunktionen Video

® Mit der Option Video aus Datei > Einfiigen » Verkniipfung mit Datei ver-
kniipfen Sie Videos, die auf Ihrer Festplatte liegen, mit Threr Prédsenta-
tion. So verbraucht die Prasentation weniger Speicherplatz, allerdings
miissen Sie immer daran denken, die verkniipften Dateien mitzuschicken
oder beim Vortrag dabeizuhaben. Auch mit dieser Variante stehen Thnen
alle Gestaltungsmoglichkeiten offen.

® Mit Moglichkeit 3, Video von Website, verkniipfen Sie Videos aus dem
Internet (von einer Website) mit Threr Prasentation. Dazu gehen Sie in
Threm Internetbrowser auf die entsprechende Seite, suchen dort den
sogenannten Einbettungscode und kopieren ([Strg]+ [C]) ihn in das
in PowerPoint angezeigte Feld ([Strg] + [V]). Der Clip bleibt dabei im
Internet, d.h., Sie brauchen wihrend des Vortrags eine Internetverbin-
dung, und Sie konnen keinerlei Gestaltung am Video vornehmen. Wenn
Sie das Video bearbeiten mochten, miissen Sie es auf Ihre Festplatte ko-
pieren. Priifen Sie vorher jedoch die rechtliche Lage! Nicht jedes Video
darf verwendet oder bearbeitet werden.

® Die letzte Variante ist ClipArt-Video. Dabei binden Sie ein Video aus dem
ClipArt-Archiv in Thre Prasentation ein. Hier haben Sie die gleichen Mog-
lichkeiten zur Gestaltung wie bei einem Bild.

Wie Bilder lassen sich nun auch Videos gestalten. Sie konnen sie beispiels-
weise mit Bildrahmen und Effekten versehen, sie in neue Formen einpassen,
dafiir eine 3D-Drehung gestalten oder sie sogar neu einfdrben. Sobald Sie
ein Video angeklickt haben, erscheint die Meniileiste Videotools » Format,
iiber die Sie sdmtliche Einstellungen vornehmen kénnen.

Rahmen, Kanten, Ausschnitt (Form)
Wiedergabe im Eigenes Rahmen- und Effekte einstellen, z.B. Schatten,
Bearbeitungsmodus motiv verwenden rdumliche 3D-Drehung

@976 0 k-E-|=

Start Einfugen Entwurf Ubergénge Animationen Bildschirmprdsentation Uberprifen Ansicht dd-Ins | Format | ‘WWiedergabe

5o @ I= e _ = R L’(?V\deoform - Ly Ebene nach
PN Wl B e = = om o : i
Wiedergabe Korrekturen Farbe Posterrahmen Entweirf Q d Q J ‘ ‘ g : ngdenrahmen Bl Ebene nach
- - - Turicksetzen = T e Wideoeffekte ~ %Auswahlhel
“arschau / ‘ Anpassen A Wideoeffekte - 7
Helligkeit Video Video in Grund- Ebene des
und Kontrast einfarben stellung bringen Videos verdndern

anpassen
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Unter Videotools » Wiedergabe kdnnen Sie dariiber hinaus die Abspieleigen-
schaften des Videos verdndern. Dazu zdhlen Funktionen wie Video kiirzen,
Ausblenden und Endloswiedergabe.

Sprungmarken sind
Zeitmarkierungen im
Video, die bestimmte

Aktionen zulassen, Lautstarke  Video im Vollbildmodus laufen
z.B. das Einblenden des Videos lassen, d.h., alle Formatangaben  Im Loop
eines Textes anpassen werden ignoriert abspielen

®Blld*®-\0 @ k- E-|= Fideotools

Start Einfligen Entwurf Uberginge Animationen ildschirmprasentatjdn Uberpriifen Ansicht Add-Ins Format I ‘Wiedergabe |

b .:.# ! Q@V Ausblendedauer ‘ﬁﬂ H tart: Automatisch =, ErdiGTieHETgatE
. . q‘ﬂEmb\Eﬂden: 00,00 5| L Wiedergabe im Vollbildmodus
Werierushs Sﬁ;uzrl\‘%nga;ﬁe ”!,‘,'Qf,::';‘ :J?;; Efﬂﬂ.ush\enden: 00,00 z lauts'tarke Aushlenden, wenn keine Wiedergabe etfolgt Wl bl e L
‘arschau Sprungmarken 4 Bearbeiten Lﬁ Wideogptionen
! \
Video verkiirzen, ein- Video nur dann zeigen, Automatisch  Nach der
blenden (Fade-In) und wenn es abgespielt wird, oder beim Wiedergabe
ausblenden (Fade-Out) d.h., zeitlich davor und Klick auf das  wieder an
danach erscheint nur Video starten den Anfang
das hinter dem Video des Videos
liegende Motiv springen

Wie bereits erwahnt, konnen Sie mit PowerPoint 2010 Texte, Formen, Bilder
usw. {iber das Video legen und das Ganze sogar zeitlich gesteuert ablaufen
lassen. Sie konnen also beispielsweise einstellen, dass nach einer Sekunde
Film der Titel als Text erscheinen soll. Das eroffnet natiirlich eine Vielzahl
an Gestaltungsmoglichkeiten. Im Abschnitt »Einen Videoclip mit Text und
Grafik iiberlagern« ab Seite 334 finden Sie dazu eine Ubung.

Basisfunktionen Audio

Im Hinblick auf die Funktionalitdt und den Aufbau der Meniis unterschei-
den sich die Einstellungsmoglichkeiten fiir Audiodateien nur geringfiigig
von denen fiir Videos. Im Folgenden nenne ich nur die wichtigsten Unter-
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schiede. Wenn Sie Audiodateien einfiigen, haben Sie iiber Einfiigen » Medi-

en » Audio drei Wahlmoglichkeiten:

e Uber Audio aus Datei fiigen Sie Audiodateien entweder direkt ein oder
verkniipfen sie (analog zu den Videos).

e Uber ClipArt-Audio konnen Sie kurze Audioclips aus dem ClipArt-Archiv

einfiigen.

o Uber Audioaufnahme konnen Sie direkt aus PowerPoint heraus eine Auf-

nahme mit dem Mikrofon machen.

Im Gegensatz zu einem Video kann
eine Audiodatei iiber mehrere Foli-
en hinweg abgespielt werden. Dazu
wahlen Sie iiber Audiotools » Wie-
dergabe » Audiooptionen » Start »
Folieniibergreifende Wiedergabe aus.
Die Anzahl der Folien konnen Sie ein-
stellen, indem Sie den Animations-
bereich einblenden (Animationen »
Erweiterte Animation » Animationsbe-
reich), dort doppelt auf den Eintrag
der Audiodatei klicken (Effektoptio-
nen) und die Anzahl der Folien an-
passen (iiber Bei Wiedergabe beenden
und Nach).

Komprimierung

‘Wiedergabe Audio

Effekt | anzeigedauer | Audineinstellungen

‘Wiedergabe starten
@ Yon Beginn an
() Yon letzter Position

(71 Ab Zeit: | sekunden

‘Wiedergabe beenden
() Beimn Klicken
() Mach aktueller Folie
@ Mach: |§ LE—‘ Folien

Erweiterungen
Sound: [Chne Sound]
Mach der Animation: | Micht abblenden

Texk animigren:

Agerung awischen Buchstaben

&

R

(

Ok

] [ Abbrechen

Um die Dateigrof3e einer Prasentation zu verringern (was vor allem fiir die
Weitergabe wichtig ist), lassen sich Video- und Audiodateien, die innerhalb
von PowerPoint gespeichert sind, komprimieren. Leider minimieren Sie da-
durch auch deren Qualitét. In der Praxis gilt es daher, einen Kompromiss
zu finden bzw. sich zu iiberlegen, wofiir die Prisentation eingesetzt wer-
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den soll. Wenn Sie die gleiche Prasentation fiir verschiedene Zwecke ver-
wenden, legen Sie am besten mehrere Varianten der Prasentation ab. Die
Komprimierungsfunktion finden Sie unter Datei » Informationen » Medien
komprimieren. Wenn Videos oder Sounddateien ruckeln oder Sie die Pra-
sentationsdatei verschicken wollen, sollten Sie sie komprimieren. Dabei ste-
hen Ihnen drei verschiedene Stufen zur Verfiigung, die sich jeweils auch auf
die Qualitét der Prasentation auswirken (siehe Abbildung).

MediengrdBe und -leistung

Sparen Sie Platz auf dern Datentrager, und werbessern sei die
Wiedergabeleistung, indern Sie Thre Mediendateien kamprimieren, Die
Medienqualitét kann durch Komprimierung beeintrichtigtwerden,

karnprimieren =

Die Mediendateien in dieser Prasentation hean_spruchen 0,05 ME.

Prisentationsqualitat tistung
| “{,‘ Vit Sparen Sie Platz, beiweitgehender Bewahrung der Audio- und
“ideoqualitat,

Internetqualitat

Die Qualitat ist mit Medien wergleichbar, die Ober das Internet ereti und dndern,
gestreamt werden,

.

Geringe Qualitat
“erwehden Sie dieses Format, wwenn nur eingeschrankt Platz
werflighar ist, ebwa beim Senden von Prasentationen per E-Mail.

£

musst, dass sie Folgendes

Voraussetzungen fiir die Integration von
Video- und Audiodateien

Wichtige Voraussetzungen, um Videos oder Ton in PowerPoint einzubetten,
sind das richtige Videoformat und der passende Video-Codec. Das Videofor-
mat ist die Klassifizierung eines Clips, also z.B. .mpeg oder .mov. Fiir jedes
Videoformat gibt es verschiedene Video-Codecs. Sie konnen sich das wie
eine Art Garage vorstellen: Sie brauchen zunéchst mal einen Schliissel, um
die Garage aufzuschlief3en (Videoformat). Wenn Sie das Auto dann fahren
wollen, brauchen Sie einen weiteren Schliissel, ndmlich den Autoschliissel
(Video-Codec).
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Voraussetzungen

Video-Codec

Codec ist ein Kunstwort, das aus Coder (Kodierer) und Decoder (Deko-
dierer) zusammengesetzt ist. Mit diesem Verfahren werden Daten
oder Signale digital kodiert und dekodiert, und da ein Film sehr viel
Speicherplatz benotigt, werden die Videoclips beim Kodieren ubli-
cherweise auch komprimiert.

Damit ein Video tiberhaupt auf Threm Computer lauft, brauchen Sie einen
sogenannten Treiber, der auch vom Video-Codec abhingt. Bei Betriebssyste-
men wie Windows oder Mac sind standardmaf3ig schon etliche Codecs vor-
installiert. Je neuer Ihr Betriebssystem ist, desto mehr Treiber sind instal-
liert. Aus diesem Grund ist es moglich, beispielsweise ein Video, das Sie mit
Threr Digitalkamera gedreht haben, auf Threm Computer abzuspielen. Falls
das mal nicht funktionieren sollte, lesen Sie in der Beschreibung zur Ka-
mera nach, welches Format (welcher Codec) verwendet wird, und suchen
Sie sich den passenden Treiber (einen aktuellen Player) aus dem Internet.
PowerPoint 2010 spielt die in der Tabelle aufgefiihrten Videoformate ab.

Videoformat Dateiendung

Windows Media Video ASF, ASX, WPL, WM, WMX, WMD, WMZ,
DVR-MS

Audio Video Interleave AVI

QuickTime Movie MOV

MP4 Video MP4, M4V, MP4V, 3GP, 3GPP, 3G2, 3GP2

Movie File MPEG, MPG, MPE, M1V, M2V, MOD,

MPV2, MP2V, MPA

MPEG-2 TS Video M2TS, M2T, MTS, TS, TTS

Windows Media Video File WMV, WVX

Adobe Flash Medium SWF
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Wenn Sie ein Video in PowerPoint einbetten oder verkniipfen méchten, sind
folgende Schritte notwendig:

1. Fiigen Sie zunéchst einfach die Videodatei in PowerPoint ein (Einfligen »
Medien » Video » Video aus Datei oder Video von Webseite oder ClipArt-
Video), und priifen Sie, ob der Clip im Prisentationsmodus ([ F5]) funk-
tioniert.

2. Falls nicht, schauen Sie sich das Videoformat an (klicken Sie im Win-
dows Explorer mit der rechten Maustaste auf die Datei und dann auf
Eigenschaften). Wenn es sich zum Beispiel um QuickTime Movie oder
Adobe Flash Medium handelt, ist auf jeden Fall ein aktueller Player
(Treiber) notwendig, der aus dem Internet geladen werden kann. Falls
es ein anderes Format ist, starten Sie den Windows Media Player, laden
Sie zunéchst die Videodatei, und versuchen Sie, den Clip abzuspielen.

3. Wenn der Clip auch im Windows Media Player nicht abgespielt werden
kann, fehlt ein passender Treiber, der nachgeladen werden muss:

® Im Normalfall fragt Sie der Media Player, ob er den entsprechenden
Treiber, der den Video-Codec enthilt, aus dem Internet laden soll.
Bestétigen Sie die Anforderung (vorausgesetzt, Sie haben gerade Zu-
gang zum Internet).

¢ Wenn Thnen kein Treiber fiir den Video-Codec angeboten wird, kon-
nen Sie sich tiber die rechte Maustaste und den Kontextmeniipunkt
Eigenschaften den Video-Codec anzeigen lassen, den entsprechenden
Treiber zu diesem Video-Codec im Internet suchen und ihn manuell
installieren. Als Beispiele fiir diesen Fall seien hier die Formate DivX
oder vidX genannt.

Folgende Hinweise miissen Sie beachten, wenn Videos lediglich verkniipft
wurden, so wie in den dlteren Versionen von PowerPoint:

® Die Prasentation und die zugehorigen Videodateien miissen im selben
Ordner liegen, ansonsten kann es vorkommen, dass PowerPoint die Ver-
kniipfung nicht findet. Das passiert vor allem dann, wenn die Présenta-
tion auf einen anderen Computer iibertragen wurde.
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® Legen Sie die Préisentation und die Videos nicht auf den Desktop. Ver-
kniipfen Sie auch Videos, die auf einem Desktop liegen, nicht mit Power-
Point, denn der Desktop enthalt einen benutzerspezifischen Pfad, der in
PowerPoint gespeichert wird. Wenn die Prasentation mit dem verkniipf-
ten Video dann auf einem anderen PC abgespielt werden soll, miisste
dort auch Thr benutzerspezifischer Pfad vorhanden sein, was in der Regel
nicht der Fall ist. Daher ist es besser, Sie suchen sich immer einen Ordner
auf Threr Festplatte aus.

® Friiher gab es hiufig Probleme, wenn Pfadname und Videoname zusam-
men mehr als 128 Zeichen hatten, weil PowerPoint den Namen einfach
bei 128 Zeichen »abgeschnitten« hat. Mit der neuen Version taucht das
Problem nicht mehr auf. Dennoch ist es gut, wenn der Pfad recht kurz
gehalten wird, denn das bedeutet mehr Ubersicht und unter Umstiinden
auch eine kiirzere Ladezeit.

Genau wie im Bereich der Videos hat Microsoft auch die Anzahl der Au-
dioformate erhéht. So kénnen nun beispielsweise auch Formate wie .mp3
in PowerPoint eingebunden und bearbeitet werden. Audiodateien kénnen
genauso wie Videos eingebettet oder optional auch verkniipft werden.
Praktisch ist auch, dass jetzt Audiodateien ein- und ausgeblendet werden
koénnen, denn gerade wenn ein Musikstiick iiber mehrere Folien lauft, horte
der Ton vorher oft zu abrupt auf. Mit dem Ausblenden kann die Lautstarke
sanft heruntergefahren werden. Ebenso wie bei Videos lassen sich Sprung-
marken definieren. (Eine Sprungmarke setzt man an einem Punkt in dem
Musikstiick, an dem etwas passieren, zum Beispiel ein Bild eingeblendet
werden soll.)

Audiodateien (Yadts;*.adt*aac;*.aif* aifc* aiff; " aw* snd* mid* midi;*. rmi* mp3* mp2 X m3u* mda wav* wma* wag™ asf)
ADTS Audio (% adts*adt.aac)

AIFF audio file (aiff) (*.aifi*.aifc;*.aiff)

AU audio file (au) (*.au™snd)

MIDI file {ridi) {*.mid;* midi;*.rmi)

MP3 audio file (mp3) *mp3;*mp2*m3u)

P4 Audio (*.mda)

Windows audio file fwav) (*wav)

Windows Media Audio file (wrma) (*wima*wax)
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Fiir den Umgang mit Audiodateien in PowerPoint gelten die gleichen Re-
geln und Voraussetzungen wie bei den Videoclips. Falls Sie lange Musikstii-
cke verwenden, kann die SpeichergroRe der Prasentation sehr grof3 wer-
den. Nutzen Sie daher am besten die Medienkomprimierungsfunktion von
PowerPoint. Falls das nicht ausreichen sollte, denken Sie dariiber nach, die
Musikstiicke jeweils zu kiirzen.

Beispiele fiir die Verwendung von Videos

Die folgenden Beispiele sollen Thnen einen Einblick in die Gestaltungsmog-
lichkeiten von und mit Videos geben. Videos lassen sich im Raum drehen,
mit Bildern iiberlagern, kreisrund ausschneiden u. v. m. Sie finden die meis-
ten Funktionen dazu im Videoformatierungsmenii (Videotools » Format).
Die Beispiele dieses Abschnitts finden Sie auf der beiliegenden DVD. Ei-
nige Videoclips sind Apple QuickTime Movies. Bitte installieren Sie dazu
einen aktuellen QuickTime-Player (Sie konnen einfach bei Google nach
»QuickTime Player« suchen). Fiir die Beispiele brauchen Sie lediglich den
Player; die {ibrigen im Download enthaltenen Programme wie iTunes usw.
sind nicht notwendig.

Als erstes Beispiel sehen Sie einen Wiirfel mit
drei sichtbaren Seiten, auf denen jeweils ein
Video lauft. Dazu wurden die Videos oben und
rechts perspektivisch im Raum gedreht (Video-
tools » Format » Videoeffekte » Videoeffekte »
3D-Drehung).

Die nichsten beiden Beispiele zeigen ein auf-
geschlagenes Buch, auf dessen Seite ein Video
l4duft. Im ersten Beispiel ist das Video ohne Vi-
deoeffekte eingebettet worden. Zuséatzlich wur-
de ein Blockpfeil {iber das Video gelegt. Der Blockpfeil kann zum Beispiel
auf einen bestimmten Bereich des Videos hinweisen.



Beispiele fiir die Verwendung von Videos

Videos in Bichern:

zurzeitnoch selten

mit zunehmender
Digitalisierungwerden
Inhalte noch multimedialer
ideal flir

+ Emotionalisierung

+ Erkldrungenund

+ \Vorgidnge

Fazit: Das ist ein Video
+ Prasentationen missen

sich den neuen Ideen

und Techniken anpassen

Im zweiten Buchbeispiel ist das Video perspektivisch der Buchseite ange-
passt, dhnlich wie schon beim Videowiirfel gesehen. Auflerdem wurde die
Videoform in ein abgerundetes Viereck verandert (Videotools » Format »
Videoeffekte » Videoform » Abgerundetes Viereck).

Dasisteln Video ™"

333



Kapitel 8 — Video- und Audiodateien richtig einbinden

. Kooperation im Fokus

334

Auf der nichsten Folie sehen Sie ein Fernrohr!, auf dem man
sieht, was sich in weiter Ferne abspielt. Die Form des Videos
wurde in einen Kreisausschnitt gebracht (Videotools » For-
mat » Videoeffekte » Videoform » Ellipse).

Zum Schluss dieses Abschnitts méchte ich noch einmal auf
die Méglichkeit der Uberlagerung eines Videos mit Text, For-
men oder Bildern hinweisen. Hieraus lassen sich unzihlige
Ideen entwickeln, z.B.:

® einen Texthinweis zu einem Haus einblenden

¢ mit einem Blockpfeil auf ein Objekt im Video hinweisen
® Videos mit Untertiteln versehen

® eine Person mit einem Spotlight hervorheben

® {iber einem Video von einer sich drehenden Weltkugel Bilder von Wahr-
zeichen verschiedener Lander einblenden

Die Animationseffekte in PowerPoint erlauben interessante Interaktionen,
die Thnen ein Video so einfach nicht bieten kann. Stellen Sie sich als Beispiel
Folgendes vor: Sie lassen ein eingebettetes Video endlos laufen, und auf ei-
nen Mausklick blenden Sie jeweils einen Pfeil und einen Text ein oder auch
wieder aus. Auf die Zuschauer wirkt so etwas sehr spannend.

Einen Videoclip mit Text und Grafik tiberlagern

Die héaufigsten Bearbeitungen, die an Videoclips vorgenommen werden,
sind die Uberlagerung durch Text und die Hervorhebung eines Teils des Vi-
deos. Dazu wurde bislang (in élteren Versionen als PowerPoint 2010) im-
mer ein Videoschnittprogramm benétigt. In der folgenden Ubung zeige ich
Thnen, wie Sie Text iiber einen Videoclip einblenden und Teile des Videos
hervorheben.

1 Quelle: http://de.wikipedia.org/wiki/Datei:Fernrohr_Zeilgalerie_Frankfurt-untilted.jpg


http://de.wikipedia.org/wiki/Datei:Fernrohr_Zeilgalerie_Frankfurt-untilted.jpg

1.

Einen Videoclip mit Text und Grafik iiberlagern

Legen Sie eine neue Folie an (fiir diese Ubung reicht ein leeres Layout).
Laden Sie tiber Einfiigen » Medien » Video » Video aus Datei den Video-
clip Elefantenkuh_Elsa.mov von der beiliegenden DVD. Vergrof3ern Sie
das Video um ca. 50% (Videotools » Format » GroRe). Gestalten Sie das
Video mit Videotools » Format » Videoeffekte » Intensiv » Monitor, grau.
Verschieben Sie das Video auf der Folie ein wenig nach rechts. Uber Ani-
mationen » Anzeigedauer » Start legen Sie Nach Vorherigen fest.

Animationen Bildschirmprasentation Uberpriifen Ansicht Acrobat Farmat Wiedergabe

subtil || [P videaform &
o e o ol o e [ B R oo o
Moderat —_—
SEEEFFEEL PR
S = ) e
- e = = |

Uber Einfiigen » lllustrationen » Formen » Standardformen » Ellipse zeich-
nen Sie mit gedriickter [ ¢ ]-Taste einen Kreis iiber das Video — ungefihr
da, wo sich die meisten Elefanten befinden. Entfernen Sie die Fiillfarbe
(Start » Zeichnung » Fiilleffekt » Keine Fullung), und farben Sie die Form-
kontur gelb (Start » Zeichnung » Formkontur » Gelb).
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3.

Fiigen Sie iiber den Elefanten ein Textfeld ein (Einfiigen » Text » Text-
feld), und schreiben Sie »Elefantenkuh Elsa« hinein. Passen Sie gegebe-
nenfalls die Schrift in Art, GroRe und Stil an das Video an. Da das Video
im Beispiel rdumlich dargestellt ist, sieht es besser aus, wenn Sie auch
den Text drehen. Klicken Sie mit der rechten Maustaste auf das Video,
und wiahlen Sie Video formatieren » 3D-Drehung aus dem Kontextmenii.
Notieren Sie die Parameter fiir die 3D-Drehung. Im Beispiel steht bei
Drehung X der Wert »20°% und bei Drehung Perspektive der Wert »55°«.
Setzen Sie dann fiir das Textfeld »Elefantenkuh Elsa« die gleichen Pa-
rameter ein, indem Sie mit der rechten Maustaste darauf klicken und
Form formatieren » 3D-Drehung aus dem Kontextmenii wéahlen. Wahlen
Sie jedoch zunéchst bei Voreinstellungen » Perspektive die Option Pers-
pektive vorn aus, und dndern Sie dann die Parameter fiir Drehung X und
Drehung Perspektive. Nehmen Sie dann die gleichen Einstellungen auch
fiir den Kreis vor.

Video abspielen

Sie konnen das Video (als Vorschau) abspielen, indem Sie die Tasten-

kombination + [P] driicken.

Fiir die anderen Animationen sind noch einige vorbereitende Arbeiten
notig. Wir wollen festlegen, wann Kreis und Text erscheinen sollen.
Wenn Sie mit der Maus auf das Video zeigen, erscheint das Wiederga-
bemenii. Klicken Sie dann auf das dreieckige Symbol fiir Wiedergabe/
Pause. Lassen Sie das Video vorlaufen, ungefihr bis zum Zeitpunkt
00:03,13. Wenn Sie das Video zu weit abgespielt haben, konnen Sie es
entweder iiber die Schaltflache Riickwarts zuriickspulen oder direkt auf
die entsprechende Stelle im Zeitbalken klicken.



Einen Videoclip mit Text und Grafik iiberlagern

Schrittweise
Wiedergabe/Pause vor/zuriick Zeitangabe

\/ A f -}I» o0zl 343 .

|

Zeitbalken mit der Moglichkeit, Lautstarkeeinstellung
mit der Maus direkt auf einen fur diesen Clip
Zeitpunkt zu klicken

Wenn Sie den gewiinschten Zeitpunkt erreicht haben, setzen Sie {iber
Videotools » Wiedergabe » Sprungmarken » Sprungmarke hinzufiigen
eine Sprungmarke. Sprungmarken sind bestimmte Stellen im zeitlichen
Ablauf des Videos, an denen eine Aktion ausgelost wird, zum Beispiel
das Einblenden eines Bildes. Die Sprungmarke wird im Zeitbalken als
kleiner Kreis angezeigt. An dieser Stelle werden spéater der Kreis und der
Text erscheinen. Lassen Sie den Videoclip bis etwa 00:08,00 weiterlau-
fen, und setzen Sie dort eine weitere Sprungmarke, an der die einge-
blendeten Objekte wieder ausgeblendet werden.

Spielen Sie das Video ab, und stoppen Sie es an der ersten Sprungmar-
ke. Alternativ klicken Sie mit der Maus direkt auf die Sprungmarke. Fii-
gen Sie einen Kreis und den Text »Elefantenkuh Elsa« in die Folie ein.
Platzieren Sie den Kreis und den Text, wie in der Abbildung zu sehen,
also genau auf das Video: Der Text befindet sich im oberen Drittel des
Videos, und den Kreis legen Sie genau auf eine der Elefantenkiihe.

> o <> o013 W
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10.

1.

Markieren Sie den Text, und wihlen Sie Animationen » Animation »
Eingang » Verblassen. Fiir Animationen » Anzeigedauer » Dauer stellen
Sie den Wert »00,25« ein. Da die Animation an der ersten Sprungmar-
ke beginnen soll, wahlen Sie bei Animationen » Erweiterte Animation »
Trigger » Bei Sprungmarke die Option Textmarke 1.

Fiir das Ausblenden des Textes verwenden Sie Animationen » Erweiter-
te Animation » Animation hinzufiigen » Beenden » Verblassen. Stellen
Sie bei Animationen » Anzeigedauer » Dauer wieder den Wert »00,25«
ein. Bei Animationen » Erweiterte Animation » Trigger » Bei Sprungmarke
wahlen Sie dieses Mal Textmarke 2. Testen Sie die gesamte Animation
iiber die Vorschau. Bei Fehlern konnen Sie auch den Animations-
bereich einblenden und dort korrigieren.

Wir mochten, dass der Kreis immer die Elefantenkuh Elsa hervorhebt.
Daher brauchen wird neben dem Ein- und Ausblenden auch eine Pfad-
animation. Gehen Sie fiir das Einblenden zunéchst so vor wie beim
Text. Setzen Sie allerdings fiir Animationen » Anzeigedauer » Start die
Option Mit Vorherigen ein, denn der Kreis soll zeitgleich mit dem Text
erscheinen.

Um jetzt die Pfadanimation hinzuzufiigen, wihlen Sie Animationen
> Erweiterte Animation » Animation hinzufiigen » Animationspfade »
Linien. Bei Animationen » Animation » Effektoptionen wihlen Sie fiir
Richtung die Option Rechts. Unter Animationen » Anzeigedauer » Start
nehmen Sie Mit Vorherigen, und bei Animationen » Erweiterte Anima-
tion » Trigger » Bei Sprungmarke geben Sie Textmarke 1 an.

Die Dauer der Pfadanimation kdnnen Sie ganz einfach berechnen, in-
dem Sie die Differenz zwischen der zweiten und der ersten Sprung-
marke nutzen: in unserem Beispiel also 8 Sekunden minus 3,13
Sekunden = 4,87 Sekunden. Dieser Wert muss bei Animationen » An-
zeigedauer » Dauer eingegeben werden. Der Einfachheit halber kon-
nen Sie auch den Wert »4,75« angeben.



Eine attraktive Diashow mit Musik anlegen

12. Schalten Sie den Animationsbereich ein (Animationen » Erweiterte Ani-
mation » Animationsbereich). Markieren Sie den Eintrag fiir die Pfad-
animation, und 6ffnen Sie iiber die rechte Maustaste die Effektopti-
onen. Andern Sie im Dialogfenster die Werte in den Feldern Gleiten
Start und Gleiten Ende jeweils auf »0 sek.«.

13. Markieren Sie jetzt wieder das Video auf der
Folie, und klicken Sie die zweite Sprungmarke
an (oder lassen Sie das Video abspielen, und
stoppen Sie es an genau dieser Stelle). Blen-
den Sie iiber + die Fiihrungslinien
ein, und verschieben Sie eine waagerechte und
eine senkrechte Fiihrungslinie so, dass ihr Kreu- : :
zungspunkt mitten auf der Elefantenkuh liegt. > —S=aPT )

14. Verschieben Sie nun noch das Pfadende auf den Kreuzungspunkt, da-
mit sich der Kreis nur bis zu diesem Punkt bewegt. Testen Sie den ge-
samten Ablauf im Bildschirmprisentationsmodus [F5], und nehmen
Sie gegebenenfalls Korrekturen vor.

Sie haben mit dieser Ubung gesehen, was mit den Videofunktionen von
PowerPoint mdglich ist. Frither sind solche Ergebnisse nur mit Video-
programmen moglich gewesen, heute funktioniert das innerhalb von
PowerPoint und bietet Thnen damit mehr Flexibilitdt und Gestaltungsmog-
lichkeiten.

Eine attraktive Diashow mit Musik anlegen

PowerPoint bietet eine Komfortfunktion zum schnellen und einfachen Er-
stellen von Fotoalben und Diashows: Fotoalbum. Damit kénnen Sie im
Handumdrehen Thre digitalen Fotos in einer interessanten Prisentation
aufbereiten. Wie Sie das anstellen, zeige ich Thnen in diesem Abschnitt.
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1.

Kopieren Sie zundchst am besten alle digitalen oder eingescannten Bil-
der, die Sie in die Diashow aufnehmen wollen, in einen Ordner. Das ist
zwar technisch nicht unbedingt erforderlich, aber Sie sparen so eine
Menge Zeit.

BildgroRe

Achten Sie darauf, dass die Bilder in einer Mindestauflosung von
1.024 x 768 Pixeln vorliegen, andernfalls leidet die Qualitat der Dar-
stellung. Falls Sie beabsichtigen, vor groRerem Publikum zu prasen-
tieren, und die Projektoren hohere Aufldsungen ermoglichen (z.B.
1.600 x 1.200 Pixel), sollten Sie entsprechend die Pixelwerte lhrer
Bilder erhohen.

Offnen Sie PowerPoint, und rufen Sie den Befehl Einfiigen » Bilder » Fo-
toalbum » Neues Fotoalbum auf. Es erscheint ein Dialog, in dem Sie die
Bilder einlesen konnen. Wahlen Sie iiber den Knopf Datei/Datentrager
die gewlinschten Bilder aus, und laden Sie sie ein. Nachdem PowerPoint
sie eingelesen hat, konnen Sie ihre Reihenfolge verdndern und festlegen
(liber die Pfeiltasten unterhalb der Box Bilder im Album). Bei Bedarf fiigen
Sie auch noch Textfolien ein (iiber die Schaltfliche Neues Textfenster).

Wie Sie in der Abbildung sehen, kdnnen Sie jedes Bild auf3erdem drehen
und in Helligkeit und Kontrast anpassen. Lassen Sie im Bereich Album-
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layout das Bildlayout bei An Folie anpassen. Wenn Sie die verschiedenen
Mbglichkeiten des Bildlayouts testen wollen, kénnen Sie die Ubung mit
einem anderen Bildlayout wiederholen.

Reihenfolge dndern Ausgewdbhlte Bilder
‘Fetealbum \ B Vorschau
Bilder auswahlen e
Bild einfigen aus: Bilde_[ im Alburn: Vorschau:
) o Desert
Textfolie elnfugen Text einfigen: Hydrangeas
— Jellyfish
Bildoptionen:
Wenn ein Design //7_Beschriftung unterhalb aller Bilder
ausgewéihlt iSt, 7] Blle SchwarzweiBbider B||d k_orreki_:ur—
kann festgelegt | mdglichkeiten
werden, ob direkt BE ORI Tl [ wie Drehen
unter den Bildern Albulayout Kontrast,
i ; e Helligkeit
Text platziert wird. | guuou: gl aAE ] ¥ T
F #: |Rechteck 2 .
[ Themes i4\AngIes.thx | =
Erstel\en;
Das Bild wird an die Auswabhl eines Die Gestaltung eines Fotoalbum als neue
FoliengroRe angepasst Masterlayouts bzw. Bildes kann Gber die Prasentation erstellen
oder mehrere Bilder eines Foliendesigns Fensterform angepasst
kommen auf eine Folie. werden.

4. Klicken Sie auf Erstellen, dann wird eine neue PowerPoint-Prasentation
erstellt, unabhéngig davon, wie viele andere Présentationen Sie gerade
geoffnet haben.

5. Weil im Feld Bildlayout die Option An Folie anpassen eingestellt war, wer-
den jetzt alle Bilder in FoliengréRRe dargestellt, d.h., wenn ein Bild zu
klein ist, wird es automatisch grof3er skaliert und umgekehrt. Das spart
Thnen eine Menge Zeit — gerade wenn Sie an Digitalfotos mit sehr hohen
Auflésungen denken, die meistens sehr viel grof3er als die Folie sind.

6. Damit die Bilder weich iiberblendet werden, kénnen Sie auch hier mit
Effekten arbeiten, z.B. Verblassen. Wechseln Sie dazu in die Foliensor-
tierung (Ansicht » Prasentationsansichten » Foliensortierung), und ord-
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nen Sie den einzelnen Folien anschlieRend iiber die Registerkarte Uber-
ginge Uberblendungen zu, z. B. Verblassen, Form oder Ahnliches.

Markieren Sie dann alle Folien, und setzen Sie unter Ubergénge » Anzei-
gedauer » Nachste Folie das Feld Nach auf den Wert »00:04,00«. Wech-
seln Sie anschlielSend wieder in die Standardansicht (Ansicht » Prasen-
tationsansichten » Normal). Nun ist die eigentliche Diashow fertig.

Wenn Sie moéchten, konnen Sie auf einzelnen Folien auch noch Text
oder Formen hinzufiigen (siehe dazu den vorherigen Abschnitt). Stellen
Sie sich z. B. vor, Sie erstellen eine Diashow zu IThrem letzten Urlaub. Sie
konnten beispielsweise die Namen von Stadten, Platzen, Personen usw.
oder Stichworter zu bestimmten Erlebnissen einfiigen. Wenn Sie etwas
besonders auffillig darstellen wollen, konnen Sie eine Hervorhebung
nutzen, z. B. einen Pfeil einzeichnen. (Wie Sie wissen, gibt es auch hier-
bei zahlreiche Méglichkeiten zur Animation; siehe Kapitel 7, »Effekte
und Animationen sinnvoll einsetzen.)

Hier steht Onkel Erwin.
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9. Eine andere Méglichkeit ist, die Diashow mit Musik zu unterlegen. Be-
schaffen Sie sich dazu zunéchst ein Musikstiick in digitaler Form, z.B.
als.mp3- oder.wav-Datei. Zum Einfiigen rufen Sie Einfiigen » Medien »
Audio » Audio aus Datei auf und laden das Stiick in Thre Présentation.
Wenn das Audiosymbol auf der Folie erscheint, verschieben Sie es auf
den Randbereich und nehmen folgende Einstellungen vor:

® Damit das Musikstiick auch iiber mehrere Folien zu horen ist, wih-
len Sie Audiotools » Wiedergabe » Audiooptionen » Start » Folieniiber-
greifende Wiedergabe.

® Um das Symbol wihrend der Diashow unsichtbar zu machen, wah-
len Sie Audiotools » Wiedergabe » Audiooptionen » Bei Prasentatio-
nen ausblenden.

10. Dariiber hinauskénnen Sie  [icergabe Audio
dle Anzahl der FOhen exakt Effekt | anzeigedauer I Audioeinstellungen
einstellen, bei denen Mu- Wiedergabe starken
sik zu horen sein soll. Das o n
ist beispiel . itzlich () Yon letzter Position
ist beispielsweise niitzlich, 85k T seuncen
wenn Sie mehrere Musik- Wiedergabe besnden
stliicke anspielen wollen. (€ Beim Klicken

(71 Mach akbueller Folie

Zum Beispiel kénnten Sie @i [ i

es in Threr Urlaubs-Dia-

Erweiterungen

show auf den ersten zehn Sound: [ohne sound]

Folien eher geméchlich an- Mach der Animation: | Micht abblendan |E|
gehen lassen und auf den : |
folgenden Folien immer
poppiger werden. Blenden —— T
Sie dazu den Animations-
bereich ein (Animationen »
Erweiterte Animation » Animationsbereich), und klicken Sie den Audio-
eintrag mit der rechten Maustaste an. Im Dialogfenster konnen Sie auf
dem Reiter Effekt im Bereich Wiedergabe beenden die exakte Anzahl
von Folien in das Feld Nach eingeben.
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11. Um schlieBlich das Musikstiick sanft ein- und auszublenden, wie Sie
es z.B. aus dem Radio kennen, nutzen Sie die Funktion zum Ein- und
Ausblenden von Audiodateien (Audiotools » Wiedergabe » Bearbeiten »
Ausblendedauer).

Sie haben gesehen, wie schnell eine Diashow erstellt ist. Es spricht also
nichts dagegen, wenn Sie bei Ihrer nichsten Firmenfeier ein paar Digitalfo-
tos machen und diese zum Ende der Feier mit interessanten Ubergingen auf
einem Bildschirm oder einer Leinwand abspielen.
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Kapitel 9

PowerPoint-Dateien geschickt
weiterverwenden

PowerPoint bietet eine Reihe von Moglichkeiten, eine Prédsentation auf
externen Datentrigern, iiber das Internet und in anderen Formaten wei-
terzugeben oder auch zu verarbeiten. Daraus ergeben sich Vorteile wie
der leichtere und schnellere »Transport« durch kleinere DateigrofRen, die
Unveranderbarkeit des Inhalts oder eine praktischere Handhabung und
Weiterbearbeitung.
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In diesem Kapitel zeige ich Thnen, wie Sie PowerPoint-Prasentationen im
Web einfach speichern, wie Sie sie in eine PDF, ein Video oder eine Word-
Datei konvertieren oder sie live im Internet vortragen.

Die Prasentation im Internet speichern

Eine Vielzahl an Optionen, um PowerPoint-Présentationen zu versenden
oder zu verarbeiten, finden Sie in PowerPoint 2010 unter dem Befehl Datei »
Speichern und Senden. Einige Befehle zum Speichern oder Konvertieren fin-
den Sie auch iiber den Befehl Speichern unter (zum Beispiel konnen Sie hier
auch eine PowerPoint-Datei in ein Video umwandeln). Die interessantesten
und neuesten Moglichkeiten stelle ich Thnen in diesem und den folgenden

Abschnitten vor.

%’ -8 @ k- [= Wenn Sie zum Beispiel Ihre Prisenta-
e e fmwet | Semner AR %% tion anderen Personen iiber das Internet
z:alc:am s Speichem undSenden zum Anschauen und zum Download zur
B5 Sffnen ‘F’é Per E-Mail senden % Verfiigung stellen oder sie dort lediglich
<Al @ 1 e als Backup nutzen wollen, bietet sich die
rformationen & Funktion Im Web speichern an. Um etwas
o L Stererrtspechem im Web zu speichern, brauchen Sie zum
Neu T@  sisscrimarssenttion oberragen Beispiel Online-Festplatten, wie sie ver-
PE B folien verafentichen schiedene Anbieter im Internet vermieten

(dazu einfach mal bei Google den Such-

send Dateitypen . X .
_ i begriff »Online-Festplatte« eingeben).
Hilfe M Dateityp dndern . . . . .
3 e Alternativ konnen Sie sich auch tiber On-
H -lns = =t
& Gptonen B EEES el line-Dienste wie GMX oder 1und1 Online-
£ Beenden 18] video rsteten Speicherplatz besorgen. Auflerdem bietet
Lo i mmatieedientiinis Microsoft selbst eine kostenfreie Moglich-
L >, werpacken . . . . . .
keit, ndmlich die sogenannte Live-ID. Sie
.__I‘l ahdzettel erstellen b . : : : :
[g) Fondeetelerstel miissen sich dazu lediglich bei Microsoft

registrieren. Die Live-ID ist ebenfalls emp-
fehlenswert, wenn Sie Thre Priasentationen auch live im Internet vorfithren
wollen. Doch dazu spater mehr.
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PowerPoint bietet Thnen bei der Funktion Im Web speichern auch einen Link
an, mit dem Sie sich anmelden bzw. registrieren konnen. Andernfalls miis-
sen Sie PowerPoint an der Stelle mitteilen, auf welchen Online-Speicher-
platz Sie speichern wollen.

Falls Sie diese Funktion in PowerPoint aus welchem Grund auch immer
nicht nutzen wollen, kénnen Sie iiber Synchronisationsprogramme, die in
Windows 7 enthalten sind, zum Beispiel das Programm »Sync, oder iiber
externe Programme wie »PureSync« von JumpingBytes einen Abgleich mit
der Online-Festplatte durchfiihren. Nach meiner Erfahrung ist es immer
gut, eine Sicherung der aktuellen Prasentation an einem anderen Ort zu ha-
ben. Das Internet hat den Vorteil, dass von jedem Ort aus darauf zugegriffen
werden kann.

Die Bildschirmprasentation live tibertragen

Mit der Funktion Bildschirmprasentation ilibertragen wird Ihr Laptop zum
Live-Ubertragungsgerit, d.h. wihrend Sie Thre Prisentation vorfiihren,
wird diese in Echtzeit iiber einen speziellen Service ins Internet gestellt.
Den Link zu dem Service und Threm Vortrag geben Sie an Interessierte wei-
ter, die Ihren Vortrag auf diese Weise verfolgen konnen, ohne anwesend zu
sein.

Damit Sie den Service im Internet nutzen kénnen, miissen Sie dafiir regis-
triert sein, zum Beispiel bei Microsoft Live (siehe vorheriger Abschnitt). Die
Funktion setzt voraus, dass Sie wahrend Ihres Vortrags online sind. Stellen
Sie also vorher in jedem Fall sicher, dass die Verbindung stabil ist.

Die Prasentation als PDF speichern

Das PDF-Format von Adobe hat den Vorteil, dass Ihre Priasentationen auf
allen Computern gleich aussehen, egal ob Sie einen PC, einen Mac oder ei-
nen Linux-Rechner verwenden. Die Priasentation kann nicht mehr einfach
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so gedndert werden, und Sie konnen sie iiberall auf Webseiten ablegen und
mit einem kostenfreien PDF-Reader lesen und ausdrucken. Auf3erdem ist
sie leicht per E-Mail zu versenden.

Allerdings liegt einer der Hauptnachteile von PDF-Dateien darin, dass Ef-
fekte und Animationen nicht mit konvertiert werden. Aber vielleicht 4ndert
sich das auch noch in einer der nachsten Versionen.

Um Thre Prasentation also in eine PDF zu verwandeln, wihlen Sie Datei »
Speichern und Senden » Dateitypen » PDF/XPS-Dokument erstellen » PDF/
XPS-Dokument erstellen. PowerPoint bietet Thnen zwei Speichergréfen zur
Auswahl:

® Standard (Onlineveréffentlichung und Drucken): Diese Option bedeutet
eine groldere DateigrofSe, dafiir aber auch mehr Qualitat. Dieses Format
sollten Sie wihlen, wenn Sie die Priasentation auch drucken wollen.

® MinimalgroRe (Onlinever6ffentlichung): Diese Variante ist sehr gut geeig-
net, wenn Sie die Priasentation per Mail versenden oder zum Anschauen
auf eine Website stellen wollen.

“Optionen o ]
Beseach
[P] Al FOF oder WPSvertie] @ s ) piduelleFole  AuswsHl
OQ 7 » Eibliothd Bedgruppenonertiets Frasentaticn | | t
Fole(n) Vo 1 - o | =
Organisieren » Heue|
WerBifentichungsoptionen
] MicrosoftPowerPoint|  Was veréfentichen:
Er— | rlenposets: s -] (0@
W Favoritan | Fobereshmen Reberfolgs: (@) Horonka %%
I Desktop [ susgeblendets Foben enschielien vertial —
B Dovwnleads = il o
45| Tuletrt besucht Nicht druckbars Informationsn einschiiefien
7 pokumentsigenschaftan
B Desktop ¥i Dolaxy s fur
5 Biblintheken POf-Optionan
& Bilder I50 19005-1-hompatibal (PCFJA)
T T TR ¥ Text abs Blmap speichom, wenn Schriftarten nicht engebettet werden konnen
& Eigene Dokumed | Abbrechen J

Dateiname  Prasentation] pdf

Dateityp: | PDF (el -

(] Datei nach dem Optimieren fie @ 5
Verdffenthchen &ffnen {

= Ordner ausklenden Tools = | Meroffentlichen ] | Abbrechen |




Uber die Schaltfliche Optionen konnen Sie weitere Einstellungen vorneh-
men. So haben Sie z. B. die Moglichkeit, nur die aktuelle Folie auszuwéhlen
oder aber die gesamte Prasentation mit sechs Folien pro Seite auszugeben
(wenn Sie bei Was veroffentlichen die Option Handzettel auswéhlen).

Alle Folien Threr Prasentation werden statisch iibernommen, d.h., Anima-
tionen, Uberginge usw. werden entfernt. Achten Sie deshalb darauf, dass
Thre Folien auch ohne die Animationen alle wichtigen Informationen ent-
halten. Um das zu testen, konnen Sie die Animationen mithilfe der folgen-
den Einstellung ausblenden: Bildschirmprasentation » Bildschirmprasenta-
tion einrichten » Optionen anzeigen » Prasentation ohne Animation. Stellen
Sie diese Einstellung aber am besten direkt nach dem Test wieder zuriick.

Animationen

Falls Sie dennoch Animationen und Ubergange in Ihrer Prasentation
haben mochten, nutzen Sie PDF-Converter von Drittanbietern, z. B.
Adobe Acrobat und PDF-Converter Professional, oder Dienstleistungs-
services wie AnPFiFF (Animierte PowerPoint-Folien im PDF-Format).

Eine Prasentation als Video ausgeben

Im Gegensatz zur PDF/XPS-Erstellung werden bei der Ausgabe als Video
samtliche Animationen, Uberginge, Videodateien, Sounds, Kommen-
taraufzeichnungen und sogar die Stiftmarkierungen mit umgewandelt, die
der Referent wiahrend des Prasentationmodus vorgenommen hat. Das End-
format ist eine .wmv-Datei. Die Vorteile eines solchen Videos liegen auf der
Hand:

® Die Prasentation ist vor Verdnderungen geschiitzt.

® Das ausgegebene Video kann von allen angeschaut werden, unabhéngig
davon, ob die richtige PowerPoint-Version bzw. das Programm {iberhaupt
installiert ist.

® Der Videoclip kann weiterverarbeitet werden, z. B. in anderen Videoclips.
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Nach einem Klick auf Datei » Speichern und Senden » Video erstellen kdnnen
Sie zwischen verschiedenen Einstellungen wihlen, die sich zum einen auf
die Qualitiit des Videos beziehen und zum anderen die Ubernahme von ge-
sprochenen Kommentaren und Anzeigedauern betreffen.

Es stehen drei verschiedene Qualitétsstufen zur Verfiigung:

® Computer- und HD-Anzeigen: Mit dieser Option erzielen Sie die grote
Auflésung (920 x 720 Pixel). Diese Videos sind damit fiir HD-Fernseher
und Computermonitore geeignet.

® Internet und DVD: Diese Einstellung ist fiir das Hochladen ins Web und
zum Brennen auf DVD geeignet. Es handelt sich um die mittlere Auflo-
sung: 640 x 480 Pixel.

® Tragbare Gerate: Mit der letzten Option erstellen Sie eine Videodatei, die
fiir Smartphones, Handys, Organizer, tragbare Videospieler usw. passend
ist. Diese niedrigste Auflosung betrégt 320 x 240 Pixel.

Bitte beriicksichtigen Sie bei der Auswahl der Qualitat vor allem die Schrift-
grofRe, die Sie verwendet haben. Es ist nicht sinnvoll, eine 12-Punkt-Schrift
bei einer GroRe von 320 x 240 Pixel darzustellen! Eine gute Schriftgrofe fiir
die Videowandlung liegt bei 24 Punkt.

Natiirlich kénnen Sie mit PowerPoint auch Thre Préasentation vertonen und
z.B. gesprochene Kommentare einfiigen. Wenn Sie also ein Mikrofon an-
schliefen oder eines in Ihren Laptop integriert ist, sprechen Sie im Présen-
tationsmodus einfach Ihren Text zu den Folien ein (Bildschirmprasentation »
Einrichten » Bildschirmprasentation aufzeichnen). Fiir die Aufzeichnung ha-
ben Sie zwei Moglichkeiten:

1. von Beginn der Prasentation an

2. ab der aktuellen Folie, was sehr praktisch ist, da Sie dadurch kleinere
Sequenzen besprechen kdnnen

Mit beiden Varianten werden der Ton, die Dauer von Mausklick zu Maus-
klick sowie die Anzeigedauer der Animationen und Folieniibergdnge in der
Préasentation gespeichert. (Wobei die eingestellte Dauer fiir Animationen
und Folieniibergénge sowieso in der PowerPoint-Datei gespeichert ist.)



Die gesamte Prasentation auf CD

Wenn Sie die Prasentation als Video ausgeben wollen, haben Sie schliel8lich
die Moglichkeit, gesprochene Kommentare und gespeicherte Zeitabldufe
mit in das Video zu iibernehmen, was z.B. den Vorteil hat, dass der Zeitab-
lauf genau Thren Vorstellungen entspricht.

Falls Sie die Option Aufgezeichnete Zeitabldufe und Kommentare verwenden
nicht ausgewahlt haben, konnen Sie einer Folie pauschal eine Standzeit zu-
weisen, z.B. 5 Sekunden. Das ist notwendig, weil die Mausklicks bei einem
Video ja entfallen und irgendwann einmal die néchste Folie im Video kom-
men soll.

\E“I‘n‘ 0 @ k- =5 ‘.._—_,,—.,u.| = B
Start  Einfigen  Entwurf  [berginge  Animationen  Bildschirmprisentation  Uberpriifen  Ansicht  Add-Ins Format = @

[l Speichern .

Speichern und Senden Video erstellen
Speichern unter
q Erstellen Sie ein Video aus dieser Prasentation in voller Qualitat, das mithilfe von

5 Otffnen — | PerE-Mail senden Datentrigern, perWeb oder per E-Mail verbreitetwerden kann,

. Schlielit alle aufgezsichneten Zeitabliufe, Kommentare und Laserpointerbewegungen

4 Schlieren

ein.
° Im Web speichern Enthilt alle Folien, die in der Bildschirmprisentation nicht ausgeblendet sind,

Informationen Alle &nimationen, Ubergange und Medien werden beibehalten,

Zuletzt ml In SharePoint speichern

Der Zeitaufwand fiir das Erstellen eines Wideos hingtwon der Lange und Komplexitat der
verwentlet

Présentation ab, Sie kiinnen weiter mit PowerPoint arbeiten, wahrend das ideo erstellt

| - a wird,
Nl 3 Bildschirmprisentation Gbertragen
9 Hilfe zurn Brennen des Videos der Bildschirmprésentation auf OWD oder zum

Drucken |j T Hochladen ins Web anfordern
Dateitypen El Cnmf)uterr L.md HD',.QHZEIQEH ) ) ) .
Fiir die Anzeige auf einem Computermonitor, einem Projektor ader giner hoch..,
Hilfe E Dateityp dndern _:-ui Aufgezeichnete Zeitabliufe und Komrmentare nicht wervenden .
Eswurden keine Zeitabliufe oder Kormmentare aufgezeichnet,
AddIns + o
POF/PS- Dokurment erstellen Sekunden, die jede Folie angezeigtwerden soll: | 05,00 %
2] Optionen
R
= @z
B3 seend @
EE0HED @01 viden erstellen !
Video

erstellen

Bildschirmprasentation fir CD
:t ‘ verpacken

i
% Handzette| erstellen

Die gesamte Prasentation auf CD

Wenn Sie beim Speichern Ihrer Prasentation die Option Speichern und Sen-
den » Bildschirmprasentation fiir CD verpacken wéhlen, wird die gesamte
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Présentation sozusagen mit Zubehdr zu einem Paket verschniirt, sodass
sie mit allen Einstellungen, Ubergingen und Animationen sogar auf einem
Computer gezeigt werden kann, auf dem PowerPoint nicht installiert ist. Es
wird also nicht nur die Prasentation selbst gespeichert, sondern auch ein
PowerPoint-Viewer sowie samtliche verkniipfte Dateien und Schriftarten.
Die Funktion ist deshalb ebenfalls hilfreich, wenn Sie Ihren Vortrag auf ei-
nem fremden Rechner abspielen wollen und nicht iiber dessen technische
Gegebenheiten Bescheid wissen. So ist sichergestellt, dass der Vortrag so
ablauft, wie Sie ihn erstellt haben.

Die Prasentation an Word ubergeben

Mit der Option Handzettel erstellen konnen Sie Ihre Folien in Microsoft Word
einfiigen und dort um Fliel3text, Datum, Seitennummer usw. erganzen. (In
fritheren Versionen hiefd diese Funktion Senden an » Word.) Die Funktion
eignet sich z.B. sehr gut, wenn Sie eine Ausarbeitung Thres Vortrags oder
ein Vortragsmanuskript schreiben.

e o senden "% mw)| Sie konnen Ihre Folien auf verschiedene Arten an Word
Seitenlayout in Microsaft Ward iibergeben (siehe Abbildung).
mz @ Motizen neben den Folien
;i Wenn Sie die Folien haufig verdndern, sollten Sie die
= . . . . oo . . .
m=| ©Leere Linien neben den Folien Option Verkniipfung einfiigen vorziehen. Auf diese Weise

]

Motizen unterhalb der Folien

Leere Linien unterhalb der Folien

wird jede Anderung an einer Folie auch im entsprechen-
den Word-Dokument iibernommen. Achten Sie dabei
aber darauf, dass die PowerPoint-Prasentation nicht um-

= | Chaderuna benannt oder in ein anderes Verzeichnis (einen anderen

Folien 2u Micresoft Word-Dokument hinzufigen Ordner) verschoben wird, denn sonst erkennt Word die
@ Einfiigen . . . .

Uerbiaop g Sibftigen Verkniipfung nicht mehr. Am besten speichern Sie auch

das Word-Dokument und die zugehoérige PowerPoint-
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Kapitel 10
Weiterfiihrende Informationen

Prinzipiell 1asst sich sagen, dass es in PowerPoint 2010 gegeniiber den Vor-
gangerversionen einige neue Befehle gibt, z.B. im Bereich Video, deren
Anzahl aber dennoch iiberschaubar ist. PowerPoint 2010 sticht eher durch
praktische Details hervor. Die meisten Befehle haben noch mehr Funktions-
tiefe bekommen, was sich besonders bei der Bildbearbeitung, in der Team-
arbeit und bei den Ausgabemoglichkeiten als Vorteil erweist. Mit diesen
Verbesserungen sparen Sie eine Menge Zeit, und dariiber hinaus benotigen
Sie weitaus weniger externe Werkzeuge und Programme als mit &lteren
Versionen (z.B. bei der Bild- und Videobearbeitung). Insgesamt erscheint
mir also ein Umstieg durchaus lohnenswert.

Neuerungen

Im Folgenden stelle ich Thnen die wichtigsten Neuerungen noch einmal ein-
zeln vor:

® Video und Audio: Im Bereich Video und Audio (Einfiigen » Medien) hat
die Formatvielfalt sehr stark zugenommen, sodass nun auch QuickTime
(Mac) oder andere Movie-Formate in die Prasentationen geladen wer-
den konnen. Neu ist auferdem die Moglichkeit zur Einbettung von Me-
diendateien in PowerPoint (anstatt sie zu verkniipfen). Das macht den
Transport auf andere Rechner oder ins Internet moglich bzw. erleichtert
ihn erheblich. Die Méglichkeiten zur Bearbeitung von Video- und Audio-
dateien wurden stark erweitert: PowerPoint beinhaltet jetzt viele zusatz-
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liche Funktionen, z.B. das Ein- und Ausblenden, die Moglichkeit zum
Kiirzen und interessante Formatierungseffekte bis hin zur rdumlichen
Anordnung. Durch die Definition von Sprungmarken kénnen Videos mit
Text, Formen oder Bildern tiberlagert werden. Dabei kann die Einblen-
dung eines Elements an einer definierten Stelle im Video gestartet und
gestoppt werden.

Bildbearbeitung: Es gibt neue und verbesserte Bildbearbeitungswerk-
zeuge (auf der Registerkarte Bildtools), mit denen Sie Thre Fotos noch
leichter und professioneller anpassen kénnen. Dazu gehéren die kiinst-
lerischen Effekte ebenso wie erweiterte Tools fiir die Fehlerbehandlung
sowie Farbanpassungen und Optionen zum Zuschneiden. So ist es z.B.
moglich, einen Ausschnitt im Verhiltnis 4:3 anzulegen, um immer ein
festes Verhéltnis von Hohe zu Breite zu haben. Damit konnen Sie Bilder
ohne grofRe Nacharbeit passgenau zuschneiden. Eine besonders spannen-
de und wichtige Funktion ist das Freistellungswerkzeug, mit dem Sie Per-
sonen oder Objekte vom Bildhintergrund »trennen« (freistellen) kénnen.

Ubergiinge und Animationseffekte: Auch Anzahl und Qualitit der Fo-
lientibergénge (Registerkarte Uberginge) haben zugenommen. Es gibt
nun dynamische 3D-Folieniibergdnge und noch weichere Animations-
effekte. »Weicher« bedeutet in diesem Zusammenhang, dass die Effekte
eine sanftere Uberblendkante haben und dadurch einen angenehmeren,
weil geschmeidigeren Eindruck erzeugen.

SmartArt-Grafiken: Die Anzahl der SmartArt-Grafiken wurde erneut
deutlich erhoht. Inzwischen stehen in PowerPoint 2010 tiber 200 Smart-
Arts zur Verfligung (Einfiigen » lllustrationen » SmartArt).

Folienabschnitt: Sie haben nun die Moglichkeit, Ihre Prasentation in lo-
gische Abschnitte zu unterteilen, indem Sie eine Abschnittsbezeichnung
zwischen den Folien eingeben. (Sie finden diese Funktion im Folienbe-
reich oder iiber die rechte Maustaste und den Kontextmeniieintrag Ab-
schnitt hinzufiigen.) Mit diesen Folienabschnitten konnen Sie Ihre Folien
ganz einfach organisieren und z.B. in ldngeren Prisentationen gezielt



Neuerungen

ansteuern. Die Abschnittsbezeichnungen konnen mit Namen versehen
werden, wodurch z.B. die Zuweisung von Folien zu einem bestimmten
Autor vereinfacht wird. Aulserdem konnen Sie auf diese Weise einzelne
Folienabschnitte zum Druck auswéhlen. Die Funktionen zu Folienab-
schnitten finden Sie {iber das Kontextmenii im Folienverwaltungsbereich
(siehe Abbildung).
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® Backstage-Ansicht: Die Backstage-Ansicht (Registerkarte Datei) ersetzt
in allen Anwendungen von Microsoft Office 2010 das herkémmliche Da-
teimenii, um einen zentralen und geordneten Bereich fiir alle Aufgaben
bereitzustellen. In Verbindung mit der Prasentationsverwaltung konnen
dariiber z. B. Medien fiir verschiedene Zwecke komprimiert werden, um
ihre Dateigrof3e zu verringern.
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® Meniiband: Das Meniiband kann nun einfach angepasst werden, wo-
durch Sie unmittelbar auf die Befehle zugreifen kdnnen, die Sie am héu-
figsten benotigen. Es lassen sich so auch eigene benutzerdefinierte Re-
gisterkarten erstellen oder vorhandene Registerkarten anpassen. Klicken
Sie einfach mit der rechten Maustaste auf eine der Registerkarten.

¢ Verteilung von Prisentationen: Prasentationen konnen jetzt einfach
live ins Internet gestellt werden, sodass Ihr Publikum nicht anwesend
sein muss, um Thren Vortrag zu verfolgen. Dariiber hinaus lassen sich
Prasentationen in vielen Formaten ausgeben, z. B. als Bild, PDF, als Word-
Dokument oder in einem Internetformat, z. B. HTML, MHTML oder XML.
Bei der Ausgabe als Video kénnen Sie die Ubergéinge, Animationen, Kom-
mentare und Zeitabldufe vollstdndig erhalten.
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® Arbeit mit mehreren Monitoren: In PowerPoint 2010 wird jede Prasen-
tation in einem separaten Fenster gedffnet (nicht wie vorher alle in ei-
nem Fenster). Das ist deshalb praktisch, weil so mehrere Préasentationen
gleichzeitig und dabei unabhéngig voneinander angezeigt und bearbeitet
werden konnen, und das sogar auf unterschiedlichen Monitoren.

Insgesamt hat sich PowerPoint sehr gut entwickelt und wird auch zukiinftig
den Office-Standard beherrschen.

Ausblick

Seit der Version 2007 hat sich PowerPoint zu einem professionellen Tool mit
vielen Moglichkeiten gemausert. Schon die Einfiihrung der SmartArts war
ein grofSer Sprung, und die grofite Innovation in PowerPoint 2010 sind nun
die erweiterten Moglichkeiten fiir die Verwendung von Video- und Audio-
dateien in Prisentationen.

Da Microsoft bislang nur wenige Informationen zu einer Folgeversion preis-
gegeben hat, kann ich nur aus meiner eigenen Erfahrung schlieen, wohin die
Reise vermutlich gehen wird. Aus meiner Sicht sollten in einer kommenden
Version folgende Funktionen und Moglichkeiten weiterentwickelt werden:
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® Die Anzahl der SmartArts wird weiter steigen. Besonders praktisch wire
diesbeziiglich, wenn der Anwender in Zukunft auf einfache Art und Wei-
se eigene SmartArt-Bibliotheken erstellen konnte.

® Die Bildbearbeitungsmoglichkeiten werden zunehmen. Denkbar wire
z.B. ein Stempelwerkzeug, wie wir es aus vielen Bildbearbeitungspro-
grammen kennen.

® Die Bearbeitung von Videos und Audios ist bislang nur fiir einfache Ope-
rationen geeignet. Hier werden voraussichtlich auch noch einige Fea-
tures hinzukommen.

® Ein ganz grofler Sprung wére die Einfiihrung von 3D-Funktionen, wie
wir sie aus 3D-Programmen wie 3ds Max oder Cinema 4D kennen. »3D«
bedeutet in diesem Zusammenhang die Moglichkeit, dreidimensionale
Objekte und Korper zu bauen und mit Bildern und Strukturen zu belegen
(texturieren). An eine solche Funktion schlief3en sich natiirlich Méglich-
keiten zur Animation in 3D an.

® Eine weitere Entwicklung, die sich fortsetzen wird, ist die Fahigkeit,
PowerPoint-Dateien im Internet zu nutzen — sei es in der Zusammen-
arbeit oder in der Live-Prasentation Thres Vortrags. Hier werden noch
weitere Optionen, z.B. eine Chat-Funktion, vielleicht auch eine Online-
Live-Abfrage hinzukommen.

Bevor die Zukunft beginnt, gebe ich IThnen aber jetzt noch einige wichtige
Tipps und Hinweise fiir die Gegenwart.

Tipps und Hinweise

Ich mochte Thnen abschlieRend noch ein paar Tipps mit auf den Weg geben,
mit denen Sie die Qualitét Threr Prasentationen deutlich steigern konnen:

e Sammeln Sie gute Folienideen in einem Ordner.

® Legen Sie sich eine eigene Folienbibliothek mit besonders gelungenen
oder aufwendigen Folien an, auf die Sie immer mal wieder zuriickgreifen
konnen.



Downloads und Hilfe

® Legen Sie einen Bilderordner an, den Sie themen- und teamiibergreifend
nutzen konnen, eventuell sogar auf einer Online-Plattform oder Online-
Galerie, damit Sie von tiberall Zugriff darauf haben.

® Arbeiten Sie moglichst immer mit der neuesten Version von PowerPoint.
(Versionen fiir den Privatgebrauch sind dabei vergleichsweise kosten-
glinstig.) Die Aktualitét bietet Thnen zwei grof3e Vorteile:

1. Sie erleichtern sich die Arbeit und sparen viel Zeit.

2. Sie bleiben immer auf dem Laufenden, was Trends und Techniken
angeht.

¢ Bilden Sie sich in Bezug auf Prasentationen und deren Gestaltung konti-
nuierlich weiter. Dies ist sehr wichtig, denn Techniken, Stile und Gepflo-
genheiten entwickeln sich stetig.

Wenn Sie diese Tipps beherzigen, werden sich Ihre Prasentationen deutlich
von anderen Prisentationen abheben. Am besten legen Sie direkt los.

Downloads und Hilfe

Downloads mit weiteren Ideen, Workshops sowie Hilfestellungen finden Sie
auf der Buchseite www.ratgeber-powerpoint.de. Fiir einen Newsletter mit
aktuellen Tipps und Tricks melden Sie sich unter www.smavicon.de an. Eine
Website mit Blogs und neuesten Infos und Prasentationstrends finden Sie
dariiber hinaus unter www.smavicon.eu.

Falls Sie Unterstiitzung bei Ihren Prasentationen brauchen, falls Sie Fra-
gen, Anregungen und Ideen haben oder falls Sie eine Riickmeldung zum
Buch geben mochten — schreiben Sie mir einfach eine E-Mail an kontakt@
smavicon.de, oder kontaktieren Sie mich iiber Facebook und XING.

Ich wiinsche Thnen viel Erfolg und kreative Momente bei Ihren PowerPoint-

Priasentationen!

Thr Matthias Garten
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Die DVD zum Buch

Der Inhalt der beiliegenden DVD-ROM ist auf zwei Hauptordner mit den
Namen Beispieldateien und Video-Lektionen aufgeteilt. Im Folgenden finden
Sie eine kurze Zusammenfassung ihrer Inhalte.

Ordner »Beispieldateien«

Sie finden in diesem Ordner mehrere Unterordner, die nach den Buch-
kapiteln gegliedert sind. Sie enthalten alle Beispieldateien, die fiir die An-
leitungen im Buch verwendet werden. Welche Datei als Grundlage dient,
wird immer in der jeweiligen Anleitung genannt.

Ordner »Video-Lektionen«

In diesem Ordner finden Sie ausgewihlte Video-Lektionen zum Thema
PowerPoint, in denen Ihnen unser Autor Matthias Garten live am Bildschirm
zeigt, wie Sie Ihre PowerPoint-Folien interessanter gestalten konnen. Sie
finden hier Lernvideos zu folgenden Themen:

Phasen einer Entwicklung darstellen [5:49 Min.]

Einen dynamischen Zeitstrahl anlegen [7:42 Min.]
Zitate mit einem Textmarker hervorheben [13:59 Min.]
Textzeilen fokussieren [6:41 Min.]

Eine Kugel als Zugpferd einsetzen [5:05 Min.]

AR

Ein Video zur Hervorhebung nutzen [3:22 Min.]

Umdie Lernvideos zu starten, 6ffnen Sie einfach den Ordner Video-Lektionen,
und klicken Sie doppelt auf die Datei start.exe (Windows) bzw. start.app
(Mac). Sollten Sie Probleme bei der Verwendung der Video-Lektionen ha-
ben, finden Sie Hilfe unter www.galileodesign.de/hilfe/Videotrainings_FAQ.

Systemvoraussetzungen: Windows Vista, XP bzw. Mac OS X (Intel), mit
DVD-Laufwerk, Auflésung 1024 x 768 Pixel, mind. 512 MB RAM.


http://www.galileodesign.de/hilfe/Videotrainings_FAQ

Glossar

Add-In Erginzende Programme, die die Funktionen von Microsoft Power-
Point erweitern, indem sie benutzerdefinierte Befehle und spezielle Fea-
tures hinzufiigen. Das PowerPoint-Add-In hat die Dateiendung .ppa. Die
aktuell installierten Add-Ins finden Sie unter Datei » Add-Ins.

Auflésung Anzahl der Bildpunkte (Pixel) in horizontaler und in vertikaler
Richtung (Breite und Hohe). Die Auflosung spielt eine wichtige Rolle bei
der Bildanzeige auf Computermonitoren, Projektoren, LCD- und Plasma-
displays, Digitalkameras usw.

AVI (Audio Video Interleaved Container) Microsoft-Standard fiir Audio-
und Videodaten.

Beamer Synonym fiir »Videoprojektor«. Heutzutage haben jedoch fast alle
Beamer auch Datenanschliisse, sodass der Begriff generell Gerate bezeich-
net, die sowohl Daten als auch Videos projizieren konnen.

Benutzerdefinierte Prasentation Auch »zielgruppenorientierte Prasenta-
tion«. Bei der Prasentation werden nur die von Thnen ausgewahlten Folien
angezeigt. Auf diese Weise sind verschiedene Présentationen moglich, z.B.
eine Kurzversion mit nur 10 Folien und eine Langversion mit 30 Folien.

Bildkomprimierung Die Auflésung des Bildes wird verringert und zuge-
schnittene Bildteile werden geloscht. PowerPoint bietet diese Funktion,
aber mit externen Programmen wie NXPowerLite ldsst sich eine noch gro-
Bere Komprimierung erzielen (siehe auch Komprimierung).
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Chart Der Begriff kommt aus dem Englischen und bezeichnet urspriing-
lich ein Diagramm. Im Deutschen wird der Begriff allgemeiner fiir projizier-
te elektronische Folien verwendet.

ClipArt Urspriinglich: Illustrationen, die aus sogenannten ClipArt-
Biichern ausgeschnitten und in eigene Collagen eingeklebt wurden. Heute
bezeichnet man damit eine Sammlung von kleinen, in der Grofde verdnder-
baren Computergrafiken, die sich als einfache Verzierung ohne iiberfliissige
Details verwenden lassen.

Codec Kunstwort aus den englischen Begriffen coder und decoder. Es be-
zeichnet die Kompression eines Datenstroms. Videos werden codiert, um
die Dateigrofde klein zu halten und ein fliissiges Abspielen zu gewéhrleisten.
Codecs sind in sogenannte Container-Formate integriert (siehe Container).

Container Ein Dateiformat, das verschiedene Datenformate enthalten
kann, in der Regel Daten verschiedener Codecs, z.B. Video- und Audiospu-
ren. Containerformate sind z. B. AVI, MOV (QuickTime) oder MPEG.

Design Um Ihren Présentationen ein professionelles Erscheinungsbild zu
verleihen, z.B. durch ein oder mehrere Folienlayouts mit harmonierenden
Farben (Farbdesign) und einem passenden Hintergrund sowie entsprechen-
de Schriftarten (Schriftartendesign) und Effekte (Effektdesign), konnen Sie
ein Design nutzen. Designs konnen in Folien auch auf Tabellen, SmartArt-
Grafiken, Formen oder Diagramme angewendet werden.

Effektdesign Eine Gruppe von visuellen Attributen, die auf Elemente in
einer Microsoft-Office-Datei angewendet werden. Zusammen mit einem
Farbdesign und einem Schriftartendesign bildet das Effektdesign das Ge-
samtdesign der Prasentation (siehe auch Design).

Farbdesign Eine Gruppe von Farben, die in einer Microsoft-Office-Datei
verwendet werden. Ein Farbdesign, ein Schriftartendesign und ein Effekt-
design bilden ein zusammen das Gesamtdesign der Prisentation (siehe
auch Design).



Feature Merkmal, Charakteristik. Bei Computerprogrammen wie Power-
Point versteht man darunter dessen Funktionen und Eigenschaften.

Folienbibliothek Bezeichnet a) eine bereits vorhandene Datenbank mit
Einzelfolien zur weiteren Verwendung und b) eine Datenbank, in der eige-
ne Folien verwaltet werden kénnen (siehe auch Folienmanager).

Folienlayout Anordnungvon Elementen aufeiner Folie, z. B. Titel- und Un-
tertiteltext, Listen, Bilder, Tabellen, Diagramme, AutoFormen oder Filme.

Folienmanager Add-In, mit dessen Hilfe Sie PowerPoint-Folien freigeben,
speichern und verwalten konnen. Wenn Sie eine Prasentation in einem Fo-
lienmanager veroffentlichen, werden die Folien als einzelne Dateien (Bild)
dargestellt, damit sie schneller gefunden werden und aktualisiert werden
konnen Es gibt Einzelplatz, Netzwerk- und Webversionen (z.B. www.tjool.
de oder http://sharepoint.microsoft.com).

Folienmaster Die iibergeordnete Folie in einer Hierarchie von Folien, in
der sdmtliche Informationen {iber das Design und das Folienlayout einer
Préasentation gespeichert sind (einschlief8lich der Hintergriinde, Farben,
Schriftarten, Effekte, der Grof3e der Platzhalter und deren Positionierung).
Jede Prasentation enthélt mindestens einen Folienmaster. Er wird oft auch
»Masterfolie« genannt.

Font Elektronische Form (Zeichensatz) einer Schriftart.

Freistellen In der Fotografie, in der Druckvorstufe und in der Computer-
grafik die Befreiung eines Motivs von einem stérenden Hintergrund; die
Maske zum Freistellen eines Bildes nennt man iiblicherweise »Freisteller«.
Funkmaus Computermaus, die mit Funk arbeitet und daher kein Kabel
braucht. Haufig wird der Begriff fiir die Fernbedienung zur Steuerung der

Priasentation verwendet (siehe auch Remote Control).

Handout Unterlagen, die an das Publikum ausgegeben werden.
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Kompatibilitit Die Versionen PowerPoint 2007 und 2010 bieten beim
Speichern die Méglichkeit, Dateien so abzuspeichern, dass sie auch mit frii-
heren Versionen von PowerPoint getffnet werden konnen.

Komprimierung Verkleinerung der Dateigrof3e unter Beibehaltung der
maximalen Qualitdt. In der Regel kann die Qualitdt der Komprimierung je-
doch eingestellt werden. PowerPoint bietet beispielsweise die Komprimie-
rung von Bildern und Videos an.

Layout Siehe Folienlayout.
Masterfolie Synonym fiir den Folienmaster in PowerPoint.

Meniiband/Multifunktionsleiste Enthélt alle wichtigen Programmfunkti-
onen und besteht aus Karteireitern, die wiederum Aufgaben- bzw. Befehls-
gruppen umfassen. In diesem Gruppen finden sich die einzelnen Befehle.
Zusatzliche Karteireiter, z.B. Bildtools, Diagrammtools oder Tabellentools,
erscheinen in Abhangigkeit von der aktuellen Markierung auf der Folie.

MPEG (Moving Picture Experts Group) Eine Gruppe von Experten, die sich
mit der Standardisierung der Videokompression und den dazugehorigen
Bereichen beschiftigt, z.B. Audiodatenkompression oder Containerfor-
mate. Umgangssprachlich wird hiermit meistens jedoch nicht die Exper-
tengruppe, sondern ein spezieller Standard der Video- und Audiodaten-
kompression bezeichnet. Die wichtigsten Videoformate bzw. Codecs sind
MPEG-1, MPEG-2 und MPEG-4. Die Dateiendungen lauten z. B. .mpg, .mpeg
oder .mp4.

Notizen Stichworter bzw. Texte fiir den Prasentierenden, die das Publi-
kum nicht sieht.

Pixel (px) Einheit fiir die Bild- oder Bildschirmauflosung (Bildpunkt).
Platzhalter Eingabefelder, die im Folienmaster definiert werden und

in der normalen Bearbeitung als leere Rahmen erscheinen. Sie enthalten
Texte oder Elemente wie SmartArts, Tabellen, Diagramme oder Bilder. Der



Vorteil der Platzhalter liegt in ihrer leichten Anpassbarkeit an neue Folien-
master und Vorlagen.

PowerPoint Viewer Mit dem PowerPoint Viewer lassen sich PowerPoint-
Prasentationen auch ansehen, ohne dass Microsoft Office installiert ist. Der
Viewer ist in PowerPoint selbst integriert und kann iiber Datei » Speichern
und Senden » Bildschirmprasentation fiir CD verpacken mit ausgegeben wer-
den. (Alternativ lasst sich die Viewer-Software aus dem Internet herunter-
laden.) Mit dem Viewer konnen Sie Prasentationen anzeigen und ausdru-
cken, jedoch die Dokumente nicht bearbeiten. Ein weiterer Nachteil besteht
darin, dass Makros nicht ausgefiihrt werden, doch werden so auch keine
Viren eingeschleust.

PowerPoint-Vorlage Siehe Vorlage.

.pps/.ppsx Dateiendung fiir eine PowerPoint-Bildschirmprasentations-
datei. Wenn Sie PowerPoint-Dateien in diesem Format speichern, werden
diese nach dem Aufruf sofort im Bildschirmprasentationsmodus gestartet.
Die Endung .pps bezeichnet das Format bis zur Version 2003, .ppsx wird ab
Version 2007 genutzt.

.ppt/.pptx Dateiendung fiir eine PowerPoint-Datei. Die Endung .ppt be-
zeichnet das Format bis zur Version 2003, ab Version 2007 wird die Endung
.pptx genutzt. Wenn die Datei in PowerPoint 2010 im Kompatibilitdtsmo-
dus abgespeichert wird, kann sie dennoch in fritheren Versionen gedtffnet
werden.

QuickTime Eine von Apple entwickelte Multimedia-Architektur. Im
QuickTime-Containerformat (Dateiendung .mov) kann eine Vielzahl von
Audio-, Video- und Grafikformaten eingebunden und wiedergegeben
werden.

Remote Control Infrarot- oder Funkfernbedienung. Sie dient der Steue-
rung von Geriten wie Fernsehern, Projektoren, Monitoren und neuerdings
auch Computern. Im Zusammenhang mit PowerPoint wird sie auch haufig
»Funkmaus« genannt.
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Schriftartendesign Gruppe von Haupt- und Hilfsschriftarten, die auf eine
Microsoft-Office-Datei angewendet werden. Ein Schriftartendesign, ein
Farbdesign und ein Effektdesign bilden ein zusammen das Gesamtdesign
der Prasentation (siehe auch Design).

Slide Synonym fiir »PowerPoint-Folie«.

Template Wird im Webdesign als Vorlage (Schablone) verwendet, die die
Moglichkeit bietet, komplette Layouts einer Website auf einfache Weise aus-
zutauschen. Im Zusammenhang mit PowerPoint ist damit der Folienmaster
gemeint.

Theme Themenvorlage fiir unterschiedliche Themen, z.B. Winter, Urlaub
oder Sport.

Viewer Siehe PowerPoint Viewer.

Vorlage DasMuster (Blaupause) einer Folie bzw. einer Gruppe von Folien,
das als .potx-Datei gespeichert wird. Vorlagen konnen Layouts, Designfar-
ben, -schriftarten und -effekte, Hintergrundformate und sogar Text enthal-
ten. Sie konnen eigene Vorlagen erstellen und diese speichern, wiederver-
wenden und fiir andere Benutzer freigeben. Aulerdem finden Sie {iber
Datei » Neu » Office.com-Vorlagen kostenlose Vorlagen der unterschiedlichs-
ten Arten, die Sie fiir Ihre Priasentation verwenden kénnen.

XPS (XML Paper Specification) Ein Dokumentformat, mit dem Sie den In-
halt eines Dokuments anzeigen, speichern, freigeben, digital signieren und
vor Anderungen schiitzen kénnen. In Windows 7 lésst sich ein XPS-Doku-
ment in jedem Programm erstellen, in dem Sie drucken kénnen. Ein solches
Dokument anzeigen, signieren oder schiitzen konnen Sie jedoch nur mithil-
fe eines XPS-Viewers.
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Feinjustierung 252
Fernbedienung 363, 365
Figur 156,173, 268
Finanzplan 198
Flache, transparente 207
Flowchart 242, 254, 256
Flussdiagramm 242, 255,
256,257, 262
Fokus 72,299
Balken 299
lenken 275
Folie 366
Abschnitt 354
duplizieren 23
Hintergrundfiillung 150
Idee 359
ndchste 342
Sortierung 341
Standard 113
Folienbibliothek 29, 53, 359,
363
anlegen 30
Folienlayout 363, 364
Folienmanager 363
Folienmaster 363, 364, 366
anpassen 19,23
Layout 61
Folieniibergang 350
Folieniibergreifende Wieder-
gabe 327
Font 363

Form 155, 156
Abgerundetes Rechteck 249
Abgeschrdgtes Oval 272
Abstand 39, 161
dndern 158
ausrichten 161
Ebene dndern 163
Effekte 195
einfiigen 191
extrahieren 169,178
gruppieren 164
hinzufiigen 342
in Bildern 160
kombinieren 156, 165, 166
mit Text 159
Schnittmenge 165
Seitenverhdltnis 158
Subtraktion 165, 167
verdndern 168,170
vereinigen 165

Formatierung
Absatz 56, 60
Laufweite 57
Schriftart 56
SmartArt 101
Spationierung 57
Text 56
iibertragen 40
Unterstreichung 57

Formel 227

Formkontur 253

Fotoalbum 339, 341

Framing 286

Frauenfigur 174

Freistellen 137, 138, 139,
144, 291, 363
Werkzeug 354

Freitext 62, 68

Fiihrungslinie 18,127, 268,
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kopieren 22
loschen 22
verschieben 22
Fiillung 41
Bild oder Textur 209, 212
einfarbige 209
Funkmaus 363, 365
Funktionen im Unternehmen
172

G

Gefiihl 43, 51
Gegensatz 33, 53
Gesamtdarstellung 264
Gesperrt 283
Gestaltung

1-7-7-Regel 70

4x4-Regel 69

7x7-Regel 69

20-Sekunden-Regel 73

Farbe 34

Schrift 75

Text 69

Video 326
Gestaltungsrahmen 224
Gestaltungsraster 18, 52

Dreier-Regel 26,123

eigenes anlegen 20

Goldener Schnitt 26

vordefiniertes 19
Gestapelte Sdulen 226
Gewinn 150, 205
Gliederungsebene 191, 284
Glithbirne 224
Goldener Schnitt 26, 123
Grafikelement 155, 156
Grundfarbe 35

Gruppe skalieren 164

Gruppieren 164, 195, 240
Gruppierung aufheben 164,
211

Gruppierte Balken 205, 217,
235

Gruppierte Saulen 208

H

Handout 363
Handschrift 256, 260
Handzettel 349
erstellen 352
Haus 334
Hervorhebung 45, 147, 342
Effekte 279,290
Hierarchie 189
Element 191
Stufe 194
Highlight
eines Produkts 294
Folie 314
Hilfe 360
Hilfslinie 18,127, 268, 300
kopieren 22
loschen 22
verschieben 22
Hintergrund 38, 163
Bild 212
Ebene 207
entfernen 138
formatieren 150
Hinweis- oder Signalgeber
172
Horizontal
kippen 167
verteilen 162

Idee 360

Infografik 184, 188

Informationsaufnahme 43,
53

Informationsmenge
begrenzen 278

Informationsrelevanz 24, 52

In Freihandform konvertieren
250

Inhaltsplatzhalter 302, 312

Inhaltsverzeichnis mit Farb-
abstufungen 37

Interesse schaffen 275

Internationales Publikum
277

Internetverbindung 325

Interpretation 80

Investitionsplan 200

J

Jahreszahl 244
Jahrzehnt 245

K

Kamera 329
Karteikasten 197
Kategorie 235
Kennzahlensystem 189
Kennzeichnung 172
Klon-Diagramm 304
Knotenpunkt 261
Kommentar 350
Kompatibilitidt 364
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Komprimierung 364
Bild 361
Video und Audio 327
Konig 182
Kontakt 360
Kontrast 35, 53,78
Kontur 41
Konzept
diagrammbasiertes 201
Zeitstrahl 243
Krafteverhiltnis 185
Kreis 239
Kreisdiagramm mit 3D-Objek-
ten 221
Kreislauf 258
Kriterien 235
Krone 182
Kugel 156
animierte 316
Kiinstlerische Effekte 134
Kurve 269

L

Landkarte 286
Laufweite 57, 58
Layer-Technik 207
Layout 19, 364
Leerraum 26
Legende 209, 227
Leistungsportfolio 149
Lesbarkeit 75, 253
Kontrast 78
Lesegeschwindigkeit 320
Leserichtung 266, 277
Leuchtbalken 295
Linie mit Datenpunkten 215,
237
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Liniengrafik 215,239

als Bild 236

bildhafte Datenpunkte 215
Linux-Rechner 347
Listenebene 284
Live-ID 346
Live-Ubertragungsgerit 347
Logo 85,321

halbtransparent 208

M

Ménnerfigur 173

Markierung, Optionen 237

Marktanteil 202

Marktposition 205

Masterfolie 363, 364

Masterlayout 61

Medien 324, 343
komprimieren 328, 332

Meilenstein 241

Meniiband 356, 364

Mikrofon 327, 350

Mindestauflosung 340

Minimalgrofle 348

Monitore, mehrere 357

MOV 328

Movie File 329

MP4 Video 329

MPEG 328, 329, 364

Multifunktionsleiste 364

Multimedia-Prasentation 273

Musikstiick 344

Muster 194

Musterfolie 29

N

Nachhaltigkeit 44, 53
Néhe 32

Negativer Raum 26
Nicht gesperrt 283
Notizen 364
Nutzungsrechte 113

)

Objekt positionieren 162,
239, 251, 269
Office.com 217
Online
Festplatte 346
Veroffentlichung 348
Optik, sachliche 202
Optionen, Bildschirm-
prasentation 349
Orientierungspunkt 261

P

Packshot 138
Parallelogramm 251
PDF 346
Converter 349
erstellen 348
Format 347
Reader 348
Person 258
Perspektive 220, 223, 323
Pfad 283, 289
Anfang 315

Animation 278, 282,338

benutzerspezifischer 331



Pfeil 286

Blockpfeil 334

gebogener 258
Pfeilart 269
Phase 257
Phasendiagramm 184
Piktogramm 156, 185, 204,

205, 224, 262
Pinsel 234
Pixel 361, 364
Pizzalieferung 258
Plastische Wirkung 259
Platzhalter 364

anlegen 65

Inhalt 302,312
PowerPoint

live 346

weiterverwenden 345
PowerPoint Viewer 365, 366
Prasentation

benutzerdefinierte 361

zielgruppenorientierte 361
Prasentationsart 202
Préasentationstyp 70
Prasentationsverwaltung 355
Produktbestandteile 149
Produktfoto 138
Produktion 203, 225
Produktlebenszyklus 248
Prognose 150
Projektablauf 241
Projektor 340, 361
Projektprasentation 229, 241
Prozess 261, 264, 266

Beschreibung 256
Prozessdarstellung 159
Pseudo-3D-Effekt 321
Publikum, internationales

277

Pufferzeit 246

Punkt 77
bearbeiten 168, 250, 269
gldtten 169, 250
viereckiger 269

Q

Qualitat, Video 350

QuickTime 365
Movie 329
Player 332

R

Rad 305
Rahmenlinie 234
Raster 18, 52
eigenes anlegen 20
vordefiniertes 19
Ratio 51
Regeln fiir die Textmenge 71
Reihenfolge, Effekte 298
Reihenoptionen 209, 218
Remote Control 363, 365
Ressourcenplan 189
Richtungspfeil 266
Rubrik 214
Rumpf 182

S

Sachlichkeit 51, 52
Saulen
gestapelte 226
gruppierte 208
Saulendiagramm 303

Saulengrafik mit bildhaften
Werten 219
Schatten 206, 223
Schaubild 184, 187, 188, 275
Schematische Darstellung 97
Schleife 258
Schnellformatvorlage 41, 53
Schreibschutz 349, 366
Schrift
Bradley Hand ITC 260
Farbe 78
Format 79
Gestaltung 75
Grofse 77
Laufweite 57, 58
mit Serifen 75
serifenlose 75
Spationierung 57
Schriftart 75,79, 363
Design 366
einbetten 75
formatieren 56
Schriftfarbe 38
Schritt 241, 247
Segment 258
Seitenrand, innerer 160
Seitenverhaltnis 130, 158,
271
Sequenz 303, 312
Serifenschrift 75
Skala 229
Slide 366
SmartArt 97,101, 188, 190,
354
animieren 312
Bibliothek 358
eigenes 358
erweitern 196
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SmartArt (Forts.)
formatieren 101
Formatvorlage 193
Geschachteltes Ziel 189
Grundstruktur verdndern
103

Smartphone 350

Soft-Style 121

Softwareentwicklung 256

Sound 349

Spannung 275

Spationierung 57

Speichern 305
als Grafik 238

Sperren 58

Spiegelung 196, 221

Spielerei 273

Spotlicht 334

Springer 183

Sprungmarke 331, 337, 338

Standardfolie 113

Stapeln 213,218,232

Starken und Schwéchen 185,
232

Station 261

Stempelwerkzeug 358

Stern, sechszackiger 231

Steuern und Lenken 43, 53

Stil 41

Strategie, Teile 294

Strecken 213, 219

Struktur 189

Strukturgramm 97

Suchbegriff 272

Symbol 186,213, 233

Symbolleiste fiir den Schnell-
zugriff 165
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T

Tabelle 187
Beschriftung 228
Formatvorlage 199
Spalte 306

Tastenkombination 60

Teilplan 198

Template 366

Tendenz 178

Text 45
auf einem Bild 147
farbig markieren 298
Formatierung 56
Gestaltung 69
Hinweis 334
in Formen 159
Laufweite 57
mit Bild koppeln 90, 92
Platzhalter anlegen 65

Textanimation, dezente 284

Texteffekt
erstellen 64
formatieren 160

Textfeld 62, 196, 199
Video 336

Textmarke 338

Textmarker 295

Textmenge 69
1-7-7-Regel 70
4x4-Regel 69
7x7-Regel 69
20-Sekunden-Regel 73
bestimmen 70, 71, 72
Zielgruppe 70

Texturieren 358

Theme 366

Tickertext 319
Geschwindigkeit 320

Tiefenebene 208,210
Tipps 52, 359

Titeleffekt 314
Tortendiagramm 198, 304
Tragbare Gerédte 350
Transparenzfunktion 138
Trapezoid 177, 252
Treiber 329, 330

Trend 360

Trigger 338

Typografie 57

U

Ubergang 278, 342, 354
Uberlagerung 334
eines Videos 334
Umsatz 150, 202, 205, 221
Uberblick 189
Verteilung 214
Ungleichgewicht 168
Unternehmensprésentation
119,241
Unterstreichung 57
Unveranderbarkeit 345

\"

VBA 306

Vektorgrafik 156, 170, 178
zerlegen 170

Verblassen 341

Vergleich 203

Verkniipfen
Datei 352
Verkniipfung einfiigen 352
Video und Audio 324, 325,
330



Verteilung 189, 194, 203,
205, 356
horizontal 162
vertikal 162
Vertriebskonferenz 187
Verzogerung 173
Video 323, 346, 349, 353,
358
auf Buchseite 333
aus Datei 324, 335
Ausschnitt 332
Basisfunktionen 324
Bearbeitung 353
Codec 328, 330
drehen 336
Effekte 332,335
endlos laufen lassen 334
erstellen 350
Form 333, 334
Format 328
mit Untertiteln 334
Programm 339
iiberlagern 332
von Website 325
wandeln 350
Videotools 325
Video und Audio
einbetten 324,330
komprimieren 327
verkniipfen 330
Videowiirfel 332
Viewer 365, 366
Visual Basic for Applications
306
Visualisierung 179
Voraussetzungen, Video und
Audio 328
Vordergrund 163
Voreinstellungen 151, 195
Vorlage 365, 366

Vorschau 304
Vortrag 187

W

Wachstum 150, 205
Kurve 249
Wasserfalldiagramm 226
Web 356
anschauen 346
Format 356
hochladen 350
speichern 346
Weichzeichnen 253
Weinverkauf 219
Weilsraum 26, 53
Weiterbearbeitung 345
Wellenbewegung 270
Wertebereich 240
Wertepunkt 236
Wettbewerbsanalyse 225,
229
Wiedergabe 327
beenden 343
folieniibergreifende 343
Pause 336
Wiederholung 28
Wiederkennungswert 28
Windows Media Video 329
Windows-Metadatei 210
Wischen 282
Word
Dokument 352
konvertieren 346
WordArt, Format 201
Workflow 172, 241, 242, 254
Workshop 360
Wiirfel 332

X

XPS 366

Z

Zeichenabstand 57
erweitern 58
verringern 58

Zeichencode 233

Zeichnen 269

Zeichnungsflache formatie-
ren 209

Zeilenabstand 59

Zeilenldnge begrenzen 68

Zeilenumbruch
harter 60
Tastenkombination 60
weicher 60

Zeitabfolge 241

Zeitphase 246

Zeitpunkt 244

Zeitraum 245

Zeitstrahl 241, 242
3D 243, 247
aufbauender 243, 247
bidirektionaler 243, 245
dynamischer 251
Fldche 243, 246
horizontaler 242, 244
Konzept 242
schlangenformiger 247
vertikaler 242, 244

Zelle
Grofse 233
verbinden 233

Zerlegetechnik 170

Ziehmarker 182, 249

Ziehpunkt 200
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Zielgruppe 70
Zielgruppenorientierte
Prasentation 361
Zierrahmen 182

Zitat 107
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Zoom Zusammenhang 189
Einstellungen 271 Zuschneiden 126, 211
Funktion 269 Zustimmung 178

Zooming 292
Zuordnung 189
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